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Welcome and Participant Information 

As a new caseworker responsible for certifying or approving foster homes, you are taking on a 
vital role in promoting safety and permanence for children placed in foster homes. Child welfare 
practice in New York State strives to achieve the following five outcomes for children and 
families: 

• Children are safe 
• Families are preserved, consistent with the safety of the children 
• Children are adopted when their birth family cannot be preserved 
• Children leaving care at the age of majority can live independently 
• Children and youth in care develop normally 

You, the caseworker, have a primary role in achieving these outcomes within the child welfare 
system. In these modules, you will learn how to use CONNECTIONS, New York State’s 
automated child welfare information system, to record your efforts to protect the health and 
safety of children in foster care.  

CONNECTIONS is the official system of record. Where the CONNECTIONS system is not 
operative or does not support data entry, information must be recorded and retained in the 
External Foster Home Case Record. All information must be recorded accurately and in a timely 
manner. 

This guide provides various techniques for using the CONNECTIONS system effectively and 
efficiently. It also provides best practice methods for documenting casework activities. You will 
find information ranging from approved shortcuts, such as the best ways to copy and paste, to 
information about state regulations and their impact on documentation requirements. 
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The Content of this Guide 
The Complete Guide to Support Foster and Adoptive Home Development begins by covering 
general computer skills and navigation in CONNECTIONS.  

Throughout the first five modules, you will find the following information: 

• How to manage your Assigned Workload using the Task List and the Foster and 
Adoptive Home Record Summary (FRS), 

• How to use search features (e.g., Person Search, Case Search) to access case and 
person information, and 

• How to use the Online Help system and the New York State Help Desk to solve your 
CONNECTIONS questions. 

The Complete Guide to Support Foster and Adoptive Home 
Development continues beyond basic computer skills. In the 
remaining modules, this guide leads you through the 
CONNECTIONS functions involved in foster home 
certification/approval, recertification/reapproval, and numerous 
other casework activities encountered throughout the life of a 
foster or adoptive home. For each casework task performed in 
CONNECTIONS, you will find detailed step-by-step 
instructions. Introductory remarks are provided at the beginning of each set of instructions to 
describe casework context and offer hints on how to carry out tasks efficiently and effectively. 

 

Note: 
Any visible identifying data in 

this guide is simulated. 

This guide also includes New York State regulatory requirements. These mandates must be 
met, and documented in CONNECTIONS and in the External Foster Home Case Record. The 
majority of this guide focuses on the life cycle of Certified or Approved Foster Boarding Homes. 
However, time is spent considering the special requirements for Adoptive Homes (Module 21) 
and Emergency Homes (Module 20). 
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The Complete Guide to Support Foster and Adoptive Home Development concludes by 
providing a variety of supplemental information. In the back of the guide, you will find an 
Appendix section, and a grouping of practice exercises. The practice exercises require you to 
use the CONNECTIONS Training Database to accomplish work activities you will perform as a 
FAD caseworker. Practice Exercises may be used during a SUNY Training Strategies Group 
class. 

Two features of this guide help you quickly identify the information you need: 

• Tips, set apart in margin boxes, provide information to help you carry out 
CONNECTIONS tasks efficiently and effectively. Icons in the boxes help focus your 
attention on two kinds of tips: 

Helpful hints 

Things to watch out for 

• Regulation Guidelines provide instructions for meeting qualitative standards 
for foster or adoptive home development. They are based on OCFS policy and are 
presented to assist you in documenting FAD casework. 

We hope you find this to be a useful aid in completing your foster and adoptive home 
development responsibilities! 
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Using the Training Database with this Guide 
You can use this guide in two ways: as a training tool to develop new skills, and as a job aid for 
your daily work in CONNECTIONS. In either case, we suggest that you use this guide while 
working directly in CONNECTIONS, in the Training Database or in the Preview Application. 

The Training Database 
The Training Database provides a safe environment for workers to learn and practice 
CONNECTIONS skills using simulated case data. SUNY Training Strategies Group acts as 
custodian for a prescribed number of sign-on IDs to the Training Database. These sign-on ID 
numbers are referred to as Desktop User (DU) numbers and Instructor Led (IL) numbers. Sign-
on numbers begin with either DU or IL, and are followed by four digits.  

The Training Database has the look and feel of the CONNECTIONS system currently in 
production. When you sign on to the Training Database using a DU number, you will see a 
simulated environment displaying the Assigned Workload of a fictitious worker, Darryl Wilson. 
Darryl Wilson has been assigned stages of service, including two FAD homes/stages. These 
homes/stages have been created specifically for training purposes. In the New York City training 
labs, you will use IL numbers, which display the Assigned Workload for a fictitious worker 
named Jamie Miller. 

As Darryl Wilson or Jamie Miller, you have the ability to complete the tasks necessary to 
maintain and progress each home/stage. You will be able to complete tasks specific to foster 
and adoptive home development, such as: 

• re-opening or creating a foster home in “Inquiry” status; 
• adding or relating a person to a home/stage; 
• viewing and editing information using the FRS; 
• making changes to the F/A Home License window; and 
• recording a home closure. 

The Training Database also includes features commonly used by FAD caseworkers and other 
CONNECTIONS users (e.g., CPS caseworkers). These features include: 

• Person Search; 
• Resource Search; and 
• Staff To-Do List. 
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Darryl Wilson has the ability to access the Assigned Workload 
of his supervisor, Sally May. Jamie Miller has the ability to 
access the Assigned Workload of his supervisor, Cassie 
Landers. You may approve work submitted by Darryl Wilson by 
opening Sally May’s Staff To-Do List and completing related 
approval tasks. Work submitted by Jamie Miller is approved by 
opening the Staff To-Do List for Cassie Landers. 

Information is deleted when the computer system is refreshed 
each night; any data you enter into the system is available only 
until the end of that day. 

The Preview Application 
The CONNECTIONS system is periodically enhanced and new 
elements are introduced to make the system more efficient. 
Updates to the system are referred to as Builds. In an effort to gradually introduce 
CONNECTIONS users to builds, OCFS makes a preview of the enhanced system available 
prior to the actual build.  

 

The ability to approve your own 
work is a feature of the Training 

Database only.  

It has been created to enhance 
the training experience and 
does not reflect actual case 

practice.  

In production, you will have to 
submit work to a supervisor or 

unit approver for approvals. 

This extra application, referred to as the “Preview Application” can be found on your 
CONNECTIONS desktop during the time frame prior to the build implementation date. The 
preview application is actually a snapshot of your workload as it will look with the new build 
changes. Since the information comes from your Assigned Workload, you will need to use your 
own User Name and Password to log on, not a DU or IL number.  

Some builds contain enhancements that require special Business Function Profiles. The 
Security Coordinator at your agency must assign the new BFP(’s) to your security profile, or you 
will not be able to perform new build functions in the Preview Application. 
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Logging On to Your PC 
The CONNECTIONS application can be accessed only by designated individuals on computers 
that are set up to run the application.  

Once you have completed logging on to Windows, the step-by-step instructions in the next 
section will show you how to access CONNECTIONS. 

Your agency should be following established OFT password standards, which you must be 
following habitually. (See Appendix I: Security Awareness Materials.) Here are some ways to 
keep your password protected: 

• Make it difficult 
Select a password that is easy for you to remember, but difficult for others to guess. 
Don’t be stingy—make your password as long as possible (at least 8 characters and up 
to a maximum of 13 characters), in order to help reduce the likelihood of allowing 
someone to guess it. You cannot use all or part of your logon ID in your password, nor 
can you reuse any of your last 13 passwords. 

• Mix it up 
Your OCFS password must contain at least one uppercase letter, one lowercase letter 
and one number. CONNECTIONS users must never use symbols in their passwords. 

• Keep it to yourself 
Don’t share your password with others. Never display your password; if you need to 
write it down, don’t keep the information at your desk or anywhere it can be easily seen 
by others. 

• Embrace change 
You must change your password periodically—at least once every 90 days. If you think 
your password has been compromised, change it immediately. (Don’t forget to report the 
situation to your LAN/Security Administrator as soon as possible!) 

• Be yourself 
Use only your logon ID and password; never use a current or former co-worker’s ID or 
password. 

• Let your fingers do the walking 
Never store passwords in macros or automatic log-on features. Enter your password 
manually every time. 

 

Step-by-Step: 
Logging on to Your Computer 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On to Windows dialog box displays.  

3 Enter your user name, password and domain in the respective fields. 
If pre-filled, make sure that your user name and domain (HSEN) are listed correctly 
in the log on dialog box.  

4 Click on the OK button. 
Your local desktop displays. 
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Accessing CONNECTIONS 
The CONNECTIONS application is made available to users in three different ways: 

Production Database The Production Database contains “live” data. This is the 
database that all workers use to record information in 
CONNECTIONS. 

Training Database The Training Database contains simulated data and allows you 
to practice functions necessary for your casework activities. It 
mirrors the functionality of the Production Database. 
(See “The Training Database” on page 6 for more information.) 

Preview Application The Preview Application contains a “snapshot” of actual case 
data. Information entered into the Preview application does not 
carry over to the Production database. 

The Preview Application provides the opportunity to preview 
changes and enhancements planned for the CONNECTIONS 
system. The Preview Application is available for a limited time 
when changes to the system are made. You will receive special 
notice when the Preview application becomes available. 

To distinguish between the Training Database and the Preview application, keep in mind that 
the Training Database contains simulated data, while the Preview application is a “snapshot” of 
actual case data. The Training Database allows you to practice functions necessary for your 
casework activities. Information entered into the Preview application does not carry over to the 
Production database. 

Using the CONNECTIONS Production Database, you can access your Assigned Workload from 
any CONNECTIONS workstation throughout New York State. All you need is a valid User ID 
and password to gain access to your workload. This Citrix desktop covers your local desktop 
and remains open for the length of your Citrix session. Citrix uses Windows 2000. The Citrix 
desktop also has an easily recognizable background. 

On the Citrix desktop, program icons appear directly on the desktop, rather than in Program 
Group windows. Double-clicking an icon starts the application represented by that icon, opening 
a window on your desktop for that application. 

The Task Bar at the bottom of the Citrix desktop provides a method of organizing the 
application windows that you have open in Citrix. You can have more than one window open on 
your desktop at a time. Minimize a window by clicking on the Minimize button ( ). The 
minimized window displays as a button on the Task Bar. This makes room for other windows 
you need to use at that moment. To re-open a window, click on its button on the Task Bar; the 
window displays as the active window, placing it “on top of” any other open windows. 

Clicking on the Start button (in the lower left corner of the Citrix desktop) displays the Start 
menu, which provides access to the Citrix Log Off procedure (see page 11 for details on this 
procedure). 
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When you log on to Citrix via the Connections Desktop 95 Percent icon, three icons display 
on the Citrix desktop: 

• Connections 
• CIN/PID (Data Warehouse; limited to designated users) 
• Policy Library 

Double-clicking one of these icons opens the corresponding application. 

 

Step-by-Step: 
Launching CONNECTIONS (Production) 

1 From your local desktop, double-click the CONNECTIONS and 
other Citrix Applications icon.  
The Program Neighborhood (PN) Agent displays the 
CONNECTIONS and other Citrix Applications window, 
containing icons of applications that are available to you based 
on your NT logon.  

2 Double-click the Connections Desktop 95 Percent icon.  
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the Confidentiality Warning. 
The Citrix desktop displays and your Citrix session begins. 

4 Double-click the Connections icon.  
When the CONNECTIONS Production Database has launched 
successfully, the CONNECTIONS Toolbar displays, reading: Production 
– CONNECTIONS Toolbar – <Your Name>. 

 

Step-by-Step: 
Launching CONNECTIONS (Preview Application) 

1 From your local desktop, double-click the CONNECTIONS and other Citrix 
Applications icon. 
The CONNECTIONS and other Citrix Applications window displays, containing icons of 
applications that are available to you based on your NT logon. 

2 Double-click the Connections Preview icon. 
A Confidentiality Warning message displays. 

3 Click on the OK button in response to the Confidentiality Warning. 
The Citrix desktop displays and your Citrix session begins. 

4 Double-click the Connections Preview icon. 
When the CONNECTIONS Preview Application has launched successfully, the 
CONNECTIONS Toolbar displays. The title bar reads: Preview – CONNECTIONS 
Toolbar – <Your Name>. 
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Closing CONNECTIONS and Logging Off Your PC 
When you have finished your work in CONNECTIONS, you should close both CONNECTIONS 
and your Citrix session. This is best done as a two-step process: first close CONNECTIONS, 
then log off of Citrix. Doing so (as opposed to logging off of Citrix while CONNECTIONS is still 
open) reduces the likelihood of problems occurring during the log off procedure. 

At the end of your workday, it is important to log off your PC; if you completely shut down (turn 
off) your computer, it will not be able to receive any updates that may occur overnight. Leaving 
the computer logged off (but with the power still on) will enable it to receive these updates. 

The step-by-step instructions below will assist you in closing down your system when you have 
completed your work. 

 

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Click on the File menu (represented by the Globe icon in the upper left 
corner of the CONNECTIONS Toolbar) and select Close.  
You may need to use the vertical scroll bar to scroll up on the desktop to 
reveal the Globe icon (File menu) on the CONNECTIONS Toolbar. 

2 Click on the Start button in the lower left corner of the Citrix desktop and select Log 
Off <User name> from the resulting menu. 
The Log Off Windows dialog box displays the 
following message:  
“Are you sure you want to log off?” 

 
The Shut Down command in 

the Start menu provides  
four choices: 

 ♦ Log off [User Name] 
 ♦ Shutdown 
 ♦ Restart 
 ♦ Stand by 
Select the Log off command to 
exit the system and leave your 
computer powered on; this will 

enable your computer to receive 
automated system updates.  

3 Click on the Yes button. 
This does not log off your machine; it only ends 
your session with the Citrix server. Your local 
desktop displays. 

4 Close all applications still open on your local 
desktop. 

5 Click on the Start button and select the Shut 
Down… command. 
The Shut Down Windows dialog box displays. If 
necessary, click on the drop-down arrow and select 
Log off <user name>. 

6 Click on the OK button. 
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Module 1: 
CONNECTIONS and the Child Welfare System  

An understanding of CONNECTIONS’ role in New York State’s child welfare system helps 
provide context for the work you perform as a FAD worker. This module introduces you to the 
history of the CONNECTIONS system, its role in the state’s child welfare system, basic 
concepts used in CONNECTIONS, and how CONNECTIONS ensures the confidentiality of 
records. 

By the end of this module you will be able to describe: 

• what CONNECTIONS is; 
• how CONNECTIONS supports New York State’s child welfare system and the foster 

home certification/recertification and approval/reapproval process; 
• what cases, stages and tasks are in CONNECTIONS—including the specific functions 

that support FAD casework activity; and 
• how CONNECTIONS ensures the confidentiality of records. 
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What is the CONNECTIONS System? 
CONNECTIONS is a child welfare computer system that allows for documentation of 
information about families and children in New York State. The CONNECTIONS system is part 
of a Federal initiative called the Statewide Automated Child Welfare Information System 
(SACWIS).  

As a CONNECTIONS user it is very important for you to understand your role and 
responsibilities regarding the security of the information in the system. Workers have an 
obligation to protect and preserve all information in a consistent and reliable manner. As a 
CONNECTIONS user staff, you are responsible for ensuring that appropriate [physical, logical 
and procedural] controls are in place to preserve the security properties of confidentiality, 
integrity, availability and privacy of CONNECTIONS information. Information must be protected 
and classified based on security best practices, as defined in the International Security 
Standards ISO/IEC 17799, A Code of Practice for Information Security Management. This 
information can be found at www.iso-17799.com. 

In 1993, the Federal government provided financial incentives for states to develop statewide 
automated child welfare processes in an effort to provide more efficient and effective 
administration of programs and Federal reporting. CONNECTIONS is the name of the statewide 
automated data management system for child welfare in New York State. Many other states 
have similar systems with other names. 

CONNECTIONS is designed to create a single, statewide, integrated system for the collection 
and recording of child protective, preventive, foster care and adoption service information. The 
CONNECTIONS system currently interfaces with existing New York State “legacy” systems—
the Welfare Management System (WMS), the Child Care Review Service (CCRS) and the 
Benefits Issuance Control System (BICS). However, only the BICS system interfaces with the 
Foster and Adoptive Home Development functionality in CONNECTIONS (for payments). In the 
future, CONNECTIONS will replace some of these “legacy” systems.  

CONNECTIONS has been implemented in a series of packages, originally called Releases. 
Release 3 was the last production release. Currently, updates to the system are rolled out as 
Builds (e.g., Build 18). 
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How CONNECTIONS Supports the Child Welfare System 
No matter what our roles may be in the child welfare system, each of us shares and contributes 
to the mission of child welfare: to promote safety and permanence for children. To achieve this 
mission, child welfare practice must remain focused on the five child welfare outcomes: 

• Safety of children 
• Family preservation/reunification 
• Adoption when the birth family cannot be preserved 
• Independent living 
• Normal child and youth development 

 
Foster and Adoptive Home Development is a specific area of the child welfare system that 
strives to achieve the following outcomes: 

• Find prospective foster and adoptive parents/homes. 
• Certify/approve foster and adoptive parents. 
• Provide ongoing quality assurance (maintenance) of foster and adoptive homes. 

 
CONNECTIONS supports child welfare’s mission and achievement of the outcomes stated 
above by providing a way to manage information related to work with children and families, and 
to save that information for future reference.  

Specifically, CONNECTIONS assists the foster home certification and approval process by: 

• maintaining a database of all foster care facilities, including foster homes; 
• maintaining a database of all individuals residing in foster homes; 
• providing automated recording of home certification/approval and 

recertification/reapproval; 
• providing automated recording and tracking of foster home certification and approval 

history; 
• providing automated documentation of services rendered to foster homes (e.g., training 

of foster parents); and 
• supporting state and local regulations, policies and procedures. 

 
Caseworkers need to document their efforts in order to facilitate the management of their 
workloads. Documentation provides an historical record of information to others involved with 
the foster and adoptive home, including supervisors, subsequent workers, etc. Information in 
the system is also used to conduct the required background checks (e.g., conducting a Person 
Search to check on any previous CPS history) needed to clear staff for work with children and 
families. Workers continue to conduct background and clearance checks outside of the system 
using the LDSS-3370 State Central Register Database Check form; CONNECTIONS provides a 
means for workers to document this information. 
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Understanding Cases, Stages and Tasks in CONNECTIONS 
CONNECTIONS organizes information about a family or individual situation into cases and 
stages: 

Case – The term case is used to define a grouping of one or more stages of services. In 
CONNECTIONS there is only one type of FAD stage; therefore, the term case is not 
frequently used. 
Stage – The term stage (stage of service) is used to identify a logical grouping of related 
casework activities. In FAD, “stage” is also referred to as a foster home, facility, or resource.  

The following stages exist in the CONNECTIONS: 

• CPS Intake (INT) 
• CPS Investigation (INV) 
• Foster/Adoptive Home Development (FAD) 
• Administrative Review Investigation (ARI) 
• Family Services Intake (FSI) 
• Family Services Stage (FSS) 

Stages are organized further into tasks—predefined activities—which must be performed. 
CONNECTIONS tasks mirror and document the casework activities you do in developing and 
maintaining foster homes. FAD caseworkers use the Task List to access casework and/or 
record tasks for a given FAD home/stage. The CONNECTIONS Task List for FAD contains the 
following 13 tasks: 

• Maintain Non-Licensing Information 
• Maintain Licensing Information 
• Maintain Person 
• View Home Placements (not currently functional) 
• View Home History 
• Home Study 
• Annual Reauthorization 
• View FAD Record Summary * 
• Vacancy Control Bed Maintenance (for NYC only) 
• Corrective Action Plan * 
• Serious Incident * 
• Waiver/Exception * 
• Close Home 

Asterisk (*) indicates task not required to perform 

You may repeat some of these tasks and perform them at several key intervals throughout your 
work with foster and adoptive homes.  
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Understanding Your Role in a Stage 
As a FAD caseworker, you will be assigned as either a Primary or Secondary worker on a 
stage. These roles describe different levels of responsibility for a stage or overall case. 

Primary Worker — A Primary worker has overall responsibility for a home/stage. 
Primary workers can view and maintain (modify) information in the home(s)/stage(s) to 
which they’re assigned. There can be only one Primary worker for a stage. 

Secondary Worker — There can be any number of Secondary workers also assigned 
to work on a home/stage. Secondary workers also can view and maintain (modify) some 
information in the home(s)/stage(s) to which they’re assigned.  

Basic Concepts About Security in CONNECTIONS 
All CONNECTIONS users receive security profiles that determine the windows or types of 
information they can open and view, as well as which windows they can modify or “maintain.” 
Security profiles are based on the tasks that workers perform and the level of access to records 
needed to complete those tasks. CONNECTIONS users’ security profile may be composed of 
multiple Business Functions based on their job responsibilities. These security attributes are 
designed to protect the confidentiality of client records in CONNECTIONS. 

Before you see what information is available to you, we need to discuss some important security 
guidelines that you need to be aware of when using CONNECTIONS.  

Access to information in CONNECTIONS is restricted to those individuals for whom access is 
necessary in the normal performance of their job responsibilities. Each CONNECTIONS user is 
granted a unique User ID.  

CONNECTIONS information needs to be maintained in a secure, accurate and reliable manner 
but also be readily available for use by workers needing information.  

All connections from the OCFS network to any external network must be approved in writing by 
the OCFS Information Security Officer. 

Some agencies may find it necessary to allow workers to complete their job functions outside of 
the office. When working from a remote location the following security controls need to be 
considered and are not limited to: 

• the existing physical security of the remote location; 
• the communication security requirements; 
• the sensitivity of the information that will be accessed and transmitted; and 
• the threat of unauthorized access. 

Confidential information should not be stored on (or transmitted from/to) portable computer 
devices. If workers must store or transmit confidential information, protective measures must be 
implemented. When using mobile computing devices such as laptop computers, Personal 
Digital Assistants (PDAs) and cellular phones, special care should be taken to ensure that 
information is not compromised. 

When traveling, CONNECTIONS staff using portable computers should not check these items in 
airline luggage systems. No wireless connections to CONNECTIONS should ever be made.  
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Dial-up modems should not be connected to computer systems that are on a LAN or another 
internal communication system, unless approved by OCFS. Also, no wireless network or 
wireless access point should be installed without performing a risk assessment and obtaining 
appropriate written approval from the OCFS Information Security Officer.  

Workers should avoid using internet, third-party or wireless fax services to send or receive faxes 
containing confidential information. If it is necessary to send confidential information via fax, 
workers need to verify the phone number prior to sending the fax and contact the fax recipient to 
ensure the fax is picked up immediately. Workers should also avoid sending teleconference 
call-in numbers and passwords to a pager if sensitive information will be discussed in the 
conference; confirm that all participants are authorized to participate prior to starting any 
discussion.  

Precautions need to be taken when exchanging information over the telephone. All employees 
should take care that they are not overheard when discussing confidential matters on the 
telephone. Workers should avoid leaving sensitive or confidential messages on voicemail 
systems. Confidential CONNECTIONS information should not be exchanged over a messaging 
system, unless authorized by management after a formal risk assessment of the situation is 
performed. Workers must take extra precautions when using mobile devices in public areas 
outside of the workplace. Any use of wireless or cellular phones should be avoided when 
discussing sensitive or confidential information.  

Workers should not have any expectation of privacy in the information stored in or sent through 
CONNECTIONS, as the Security Coordinator reserves the right to monitor or search the system 
at all times. The Security Coordinator may need to monitor network events. 

All CONNECTIONS users should be aware of the procedure for reporting security incidents that 
may have an impact on the security of information. Workers must report any incidents to their 
appropriate supervisor and/or the Security Coordinator. 

In CONNECTIONS, a collection of Business Functions for a particular worker is called a 
Business Function Profile. Business Functions are developed by OCFS. Security Coordinators 
at the local district and voluntary agency level assign specific BFPs to staff in their offices. 
Business Functions commonly assigned to FAD workers are MAINTAIN FAD and MAINTAIN 
FAD HISTORY. 
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As you use CONNECTIONS, you may see buttons and menus, which are gray instead of black. 
The gray color indicates that this function is disabled and, therefore, not available to you. 
Features are sometimes disabled based on your BFP. For example, the UNIT button on the 
CONNECTIONS Toolbar is gray for most FAD caseworkers, since this function is usually 
available only for supervisory staff. If you feel there is information on the system that you need 
to access in order to complete your work, but that information is not available to you, talk with 
your supervisor. 

 

Viewing Your Own Security Profile 
If you are working on a home/stage and cannot view or modify information that relates to your 
job responsibilities, you should review your security profile with your supervisor to make sure 
the Business Functions you have been assigned are adequate for the work you are doing. A 
special Business Function, VIEW SECURITY PROFILE, lets you review your own security 
profile in CONNECTIONS to find out what Business Functions are assigned to you. If, in 
reviewing your profile, you find that you do not have the security access for a task you need to 
complete, speak with your supervisor and your office’s Security Coordinator. 

 

Step by Step: 
Reviewing Your Security Profile 

1 Click on the Options menu at the top of the CONNECTIONS Toolbar and select 
Security. 
The Security fly-out menu displays. 

2 Click on View Staff Security… from the fly-out menu. 
The Staff Search Criteria window displays. 

3 Enter your first and last names in the Person section at the top of the Staff Search 
Criteria window. 

4 Click on the Search button. 
The Staff List displays. 

5 Click on your name to select it from the Staff List. 
6 Click on the OK button. 

The Staff Security window displays. Within the window is a Business Function list 
box containing Business Functions that have been assigned to you. 

7 Use the scroll bar inside the Business Function list box to view your security profile. 
The Business Functions assigned to you are identified with red check marks. 

8 When you are done, click on the Cancel button to close the Staff Security window. 
The CONNECTIONS Toolbar displays. 
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Module 2: 
Getting Started in CONNECTIONS 

The CONNECTIONS system is a Windows-based application. Therefore, many features found 
in CONNECTIONS are common to other Windows-based applications. This module focuses on 
two items: 

Navigation — You will also be introduced to the main navigation methods in 
CONNECTIONS (e.g., closing, minimizing windows, copying and pasting information). 

Basic Tasks — You will learn how to accomplish basic system tasks that are similar to 
other Windows-based applications.  

By the end of this module, you’ll be able to: 

• use CONNECTIONS Toolbar buttons; 
• use CONNECTIONS menus; 
• use buttons in CONNECTIONS windows. 
• minimize and maximize windows; 
• use scroll bars and “mega scroll” buttons; 
• switch between windows using the Alt+Tab keyboard shortcut; and 
• copy and paste information in CONNECTIONS and (specifically) in the FRS. 
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Getting Around in CONNECTIONS  
CONNECTIONS consists of a number of windows, all linked at the highest level through 
controls on the CONNECTIONS Toolbar. 

The principal methods for navigating in CONNECTIONS are: 

• buttons on the CONNECTIONS Toolbar; 
• commands in menus from the CONNECTIONS Toolbar and on many other windows in 

the application; and 
• buttons on CONNECTIONS windows. 

Sometimes buttons and menu commands will be disabled. Features are disabled either 
because that function is not available from that window, or because your security profile does 
not allow you access to that information 

 

Using CONNECTIONS Toolbar Buttons 

 
The CONNECTIONS Toolbar is always available at the top of your window when you are 
working in CONNECTIONS. It is the gateway into the CONNECTIONS system. Sometimes the 
Toolbar may display beneath another window on your desktop. Click on the title bar to bring the 
Toolbar to the forefront of all of your open windows. 
 

The CONNECTIONS Toolbar 
The first two buttons on the CONNECTIONS Toolbar (TO-DO and WORK) help you organize 
your day-to-day work. The TO-DO button opens the Staff To-Do List, containing items needing 
your attention. The WORK button opens the Assigned Workload, a list of your stage 
assignments. This is the method you use to access your tasks in CONNECTIONS. 

The third button, UNIT, opens the Unit Summary window, which is available only to 
CONNECTIONS users with a special Business Function. For example, supervisors assigned 
this Business Function can access to the Assigned Workloads of the caseworkers they 
supervise.  

The next four buttons (PERS, CASE, RSRC and STAFF) are search buttons which enable you 
to search for people, cases, resources (including foster homes, agencies and service 
providers), and staff in CONNECTIONS.  
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The following list provides more information about each of these buttons. 

PERS This button opens the Person Search window, which is used to 
search for individuals in the CONNECTIONS system.  

CASE This button opens the Case Search window, which is used to 
search for specific cases within CONNECTIONS.  

RSRC This button opens the Resource Search Criteria window, which is 
used to search the CONNECTIONS system for resources (e.g., 
agencies, facilities) that provide services to children involved with 
the child welfare system. 

STAFF This button opens the Staff Search Criteria window, which is used 
to search for employees of child welfare agencies that are 
CONNECTIONS users. 

The final button, RPRTS, opens the Report List, which provides access to reports you have 
generated (or “launched”) from within the application. Monthly management reports are also 
downloaded directly to the RPRTS window for people with special Business Functions. 

 

Using CONNECTIONS Menus  
Just above the buttons on the CONNECTIONS Toolbar (and at the top of every window opened 
within CONNECTIONS) is the Menu bar, a row of key words that, when clicked, open menus 
(see the CONNECTIONS Toolbar graphic on the previous page). 

Commands available from the menus vary by window and are related to the actions you may 
need to perform at that point. They provide an alternative way to open windows available from 
buttons, as well as serving as a means for opening additional CONNECTIONS windows. 

 

Step by Step: 
Navigating Using Menus 

1 Click on a key word from the Menu bar at the top of any window. 
A menu displays with commands related to the selected key word. 

2 Click on a command from the resulting menu. 
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Using Buttons in CONNECTIONS Windows 
Most windows contain additional buttons, often near the bottom of the window. These buttons 
serve as shortcuts to frequently performed functions or frequently visited windows from that 
window. A partial list of these buttons appears in the chart below. 

 

Partial List of Buttons and Their Functions 
Button Description 

Add Adds information to a list on certain windows. To save to the database, 
you also need to click on the Save button. 

Cancel Ignores any changes, closes the window and returns you to the 
previous window.  

Clear Clears detail fields from certain windows, or criteria from search 
windows.  

Close Closes the window and returns you to the previous window.  
Delete Deletes information from the database. You will usually receive a 

confirmation message before the item is deleted. 
Detail… Opens a window with detailed information for a selected item.  
Generate 
Report 

This button is used to display the Generate Report window in the FRS, 
where you can choose any/all of the FRS tabs to be formatted into a 
single document that can be printed. 

Help On 
Narratives 

This button displays the Online Help index, including the Online Help 
for using the Home Study and Reauthorization narratives in the FRS. 

Modify Modifies existing information in a list on certain windows. To save to 
the database, you also need to click on the Save button. 

New… Creates a new Detail window with blank data entry fields. 
OK Responds to a message box and returns to the previous window. Also 

accepts a selection from a list. 
Save Stores new or modified information in the database. 
Search Displays all records that match the search criteria. 
Submit This button initiates the Save and Submit process from the FRS once 

changes have been made that require supervisory approval. 
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Basic Windows Skills in CONNECTIONS 
When you launch the CONNECTIONS application, the CONNECTIONS Toolbar displays. The 
CONNECTIONS Toolbar contains buttons and menus that enable you to open CONNECTIONS 
windows. Since CONNECTIONS is a Windows-based application, to use it effectively you need 
to be familiar with how Windows works. 

 

Understanding Windows 
Every window, like the CONNECTIONS Toolbar, has buttons and menus. These features 
enable you to change information on the window and/or navigate to other windows in 
CONNECTIONS. Each window also includes a Close button ( ) located in the upper right 
corner of the title bar (the colored bar at the top of the window) that you can use to close the 
window.  
Important Note: It is recommended to click on the upper left 
corner of the window and select the Close/Exit command, 
rather than the Close button ( ) to prevent the loss of 
information.   

Some features of 
CONNECTIONS windows are 

different than windows  
in other applications.  

For example, you cannot resize 
CONNECTIONS windows. 

You can have more than one window open within 
CONNECTIONS and have multiple applications (e.g., email, 
Microsoft Word) open within Windows, each with its own 
window. When you have a number of windows open, they will 
be stacked one on top of another, like sheets of paper. The 
“active window” will be topmost in the stack. You can only work 
in the active window.  

The ability to have multiple windows open (“multi-tasking”) is a feature that lets you use a 
number of applications at once, but it can be confusing. This section explains how to manage 
and manipulate multiple windows. 

 

Moving Windows 
Windows in the CONNECTIONS application are slightly smaller than the size of your screen. 
Although you cannot resize them, you can move them to see the windows that are open but 
may be displayed underneath the active window. 

To move a window, position your cursor over the title bar and hold down the left mouse button 
while you drag the mouse (“click & drag”). 

 

Minimizing and Maximizing Windows 
While you cannot change the size of most of the windows in CONNECTIONS, you can 
manipulate some (e.g., Microsoft Word documents that you open within CONNECTIONS and 
CONNECTIONS Help windows). These windows can be minimized or maximized like windows 
in other applications. To understand how this works, it is helpful to know a bit about window 
states. 
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At any point a window displays one of three states: normal, maximized or minimized. A normal 
window partially fills the screen and can usually be resized. A maximized window fills the entire 
screen. A minimized window is still open, but is represented only by an icon on the task bar. 

Most CONNECTIONS windows are set to a uniform size and cannot be maximized or 
minimized. You can, however, change the size of Microsoft Word and CONNECTIONS Help 
windows by using the Minimize ( ) and Maximize ( ) buttons in the top right corner of the 
window. 

When you minimize a window, the application displays as an icon on the Task Bar. To open the 
window again, click on the icon. This returns the window to its previous state, either normal or 
maximized. 

 

Scrolling 
The vertical and/or horizontal scroll bars display on the right side and bottom, respectively, of 
windows whenever there is more information than can be displayed on a window at one time. 
There are three ways to scroll through a document: 

• Click on the top or bottom (or right or left) arrow on the scroll bar to scroll up or down 
(or side to side) through the document in increments. 

• To scroll more quickly, click and drag the center block in the scroll bar up or down (or 
right or left) until you locate the appropriate section of the document. 

• In some windows, “mega-scroll” buttons (which look like dog-eared pages) display at 
the juncture of the vertical and horizontal scroll bars. Use the mega-scroll buttons to 
move beyond the last record you can view with the scroll bar. 

 

Switching Between Windows Using the Alt and Tab Keys 
The Alt and Tab keys enable you to move between CONNECTIONS and an open window in 
another Windows application (e.g., between CONNECTIONS and a Microsoft Word document). 

 

Step by Step: 
Switching Between Windows Using Alt+Tab 

1 Hold down the Alt key. 

 
Using Alt+Tab does not close 

your Citrix session. If you leave 
CONNECTIONS open while 
viewing another application 

(e.g., Microsoft Word), the Citrix 
session for CONNECTIONS 

locks after 15 minutes and times 
out after 30 minutes of inactivity.   

2 Briefly press the Tab key to cycle through open 
application windows. 
With each press of the Tab key, a message window 
displays with the name of an open application. 

3 When you see the name of the application you want 
to access, release the Alt key. 
The open application you selected becomes the 
active window. 
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Copying and Pasting 
In CONNECTIONS, as in other Windows-based applications, 
you can use the Copy and Paste functions to duplicate 
information without retyping it. This is handy for transferring 
notes from a Microsoft Word document into a Microsoft Word 
document within CONNECTIONS, or copying information from 
one location to another within CONNECTIONS.  

You can copy and paste only in those windows where your 
security profile allows you to maintain information. 

Be careful when using the copy and paste function so that 
information is not inadvertently lost or misplaced. See the boxes on the right side of these 
pages for more Copy/Paste tips. 

 

Step by Step: 
Copying and Pasting 

1 Hold down the mouse button while you drag the over 
the text you want to copy. 
The text highlights as you drag the mouse. 

2 Click on the Edit menu and select Copy. 
(If an Edit menu is unavailable on a particular 
CONNECTIONS window, use 
the hot-key method described on the next page.) 
The system copies your highlighted text onto the 
Windows clipboard. It will remain on this clipboard until you copy another selection of 
text or close the application. 

3 Click in the location where you want to paste the text. If you are moving from a 
stand-alone Word document to an open Word document in CONNECTIONS, use 
Alt+Tab to move from one document to the other, or minimize the first document by 
clicking on the Minimize button in the top right 
corner of the window. 

 
To save time, use Copy and 

Paste to copy information while 
recording Home Study 

narratives.  
See “Copying and Pasting 

Using the FRS” on page 2-8. 

 
Save the document you are 

copying from before minimizing 
and/or pasting. 

 
Make sure the paste location is 
large enough for the text you 
have copied. If it is too small, 

CONNECTIONS will paste only 
what fits. Most comments boxes 
can contain 200 characters of 

information, but some hold only 
40 characters. 

4 Click on the Edit menu and select Paste. 
(If an Edit menu is unavailable, use the hot key 
method on the next page.) 
The copied text pastes next to the cursor. 

5 To save the newly transferred information, click on 
the File menu and select Save. 
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“Hot Key” Method for Copying and Pasting 
If an Edit menu is unavailable on a window where you want to copy and/or paste, you can use 
the following keyboard method to copy and paste. 

 

Step by Step: 
“Hot Key” Method for Copying and Pasting 

1 Highlight the text you wish to copy. 

 
Be careful when using “Select 
All,” a command in some Edit 

menus. It selects everything on 
the page for copying, including 
headers, footers and template 

commands. 
Using this may delete the 

template style of the document 
into which you are pasting text. 

 

The “Copy and Paste” method 
of arranging text is 

recommended over the 
“Cut and Paste” method. 

The “Cut” function on the Edit 
menu removes highlighted text 
from your document and saves 

it temporarily to a system 
clipboard. Highlighted text can 

easily get deleted and lost.  

2 Press the Ctrl and C keys on your keyboard at the 
same time. 
The highlighted text is copied onto the Windows 
clipboard. 

3 Click in the location where you want to paste the 
text. 

4 Press the Ctrl and V keys on your keyboard at the 
same time. 
The copied text pastes next to the cursor. 

 

Copying and Pasting Using the FRS 
The Foster and Adoptive Home Record Summary (FRS) is the 
primary location for recording the Home Study and Annual 
Reauthorization narratives and for recording information in a 
variety of Comment Boxes. Narratives and comments can be 
typed directly into the FRS. CONNECTIONS will maintain a 
historical record, allowing you to continue to add new 
information without losing previously recorded information. 

You may choose to copy information from outside of the FRS 
and paste it into a narrative or comment box in the FRS. For 
example, home study documents may be created in Microsoft 
Word, and pasted into the FRS. Or, you may want to paste 
information from a Microsoft Word document into one of the 
many comment boxes found in the FRS.  

In this section, we offer insight into some elements of Word 
documents that may affect your ability to successfully copy and 
paste information from one Word document to another. 

Page 2-8 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Templates and Formatting 

The Home Study and Annual Reauthorization Word narratives located in either FRS or in 
CONNECTIONS are completed in templates. Templates contain pre-formatted sections where 
information is recorded in designated text fields. Sections of a template can be protected or 
unprotected. If you’ve completed a Home Study narrative in a locally saved Word document, it 
may or may not be in the form of a template. If you are not sure, you can check with staff in your 
own district or agency to determine if the locally created document contains protected fields. 

Information is recorded in the unprotected areas of Word templates. These areas may display 
with a shaded background. In the Home Study narrative in the FRS, shading indicates where 
information can be entered. Click at the beginning of a shaded area to begin typing in your text. 
When text exists in a shaded area, you can copy and paste that text from one section to another 
(see “Hot Key” method on page 2-8). 

Protected areas in a template act as field labels and other instructional information. These areas 
are not shaded. You cannot type over these areas. Copying and pasting these protected areas 
can prove problematic if not done properly. Your goal will be to copy the information out of the 
document, and paste it into the narrative or comment box as “unformatted text.”  Instructions on 
how to do this are located in the next section of this module. 

Many problems that occur when copying and pasting between documents can be avoided. Here 
are two tips to keep in mind when copying and pasting information: 

• Typing information directly into the Home Study and Annual Reauthorization 
templates is the easiest way to avoid having to copy and paste. Additionally, you do 
not have to format text when you record it directly in the appropriate sections of 
formatted documents. 

• When recording and saving information outside the FRS, use a blank Microsoft Word 
document and do not add formatting (e.g., headings, protected sections). Using a 
new Word document without pre-formatted fields and labels simplifies the process of 
copying and pasting into the FRS narratives and Comment boxes. 
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Copying and Pasting Word Documents into the FRS 
Many of the same steps are used to copy information from a separate Microsoft Word document 
into the FRS. You may choose to take information from a Home Study, or another record you 
maintain outside of CONNECTIONS, and paste it into the FRS narratives or comment boxes.  

Remember that CONNECTIONS and the FRS are running in a Citrix session. To access your 
locally saved Home Study document, you will need to switch to your local desktop.  

 

Step by Step: 
Copying and Pasting from a Separate  
Microsoft Word Document into the FRS 

1 Switch to your local desktop by pressing down the 
Alt key and pressing the Tab key until your open 
Microsoft Word document displays as an icon. 

 
If you do not have the document 

open, hold down the Ctrl and 
Esc keys. You can then select 

the path to the document. 

2 Release the Alt and Tab keys. 
3 Open your Word document. 
4 Highlight the portion of the document that you wish 

to bring into the FRS. 
5 Click on the Edit menu and select Copy. 
6 Switch back to your Citrix session by pressing down the Alt key and pressing the 

Tab key until the Citrix session appears with a box around it. 
7 Release the Alt and Tab keys. 
8 Access the Home Study or other document/comment box in the FRS. 
9 Click in the area where you want to paste information. 
10 Click on the Edit menu. 
11 If there are no protected fields in the document you are copying, select Paste. If you 

do have protected fields, select Paste Special. 
(Note: you may have to click on the down arrow at the bottom of the menu to reveal 
this command). 

12 If you have selected Paste Special, click on Unformatted Text. 
The information displays in the chosen area, and can be edited as needed. 
 

You may copy and paste information from your own documents (outside of CONNECTIONS) 
into FRS comment boxes. However, special formatting (e.g., tab sets, fonts, styles) is lost when 
copied text is pasted into an FRS comment box. To avoid problems, keep the formatting of your 
source document as generic as possible. 
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Module 3: 
Managing Your Workload  

CONNECTIONS provides tools to help you manage your caseload. These tools include the 
Assigned Workload, Foster and Adoptive Home Record Summary (FRS), and To-Do Lists. 

The Assigned Workload — The Assigned Workload is your gateway into CONNECTIONS 
for documenting the casework activities you complete for the foster and/or adoptive homes 
assigned to you. The Assigned Workload provides a structure for the information you record 
for each home assigned to you. From the Assigned Workload, you can choose to access 
tasks for completion, or access different windows to view and print information. In this guide, 
you will find that the Assigned Workload is often the starting step in each set of instructions 
for a task. 

The Task List — CONNECTIONS provides a central listing of casework activities. Use this 
list to navigate to view and edit home and person information. 

The Foster and Adoptive Home Record Summary (FRS) — The Foster and Adoptive 
Home Record Summary (FRS) is a single, multi-tabbed window that displays all current 
information recorded for a selected foster or adoptive home. This unique structure provides 
easy access for viewing and printing, and access to comment boxes and specific fields 
where you can record and modify additional information. 

To-Do Lists — The Staff To-Do List and Case To-Do List support the completion of timely 
work required by state regulations. More than one worker may be involved in completing 
work on a home/stage. To-Do Lists organize information and facilitate communication. They 
also help manage shared responsibilities for foster and adoptive homes, particularly 
between caseworkers and supervisors. 

By the end of this module, you will be able to: 

• sort the Assigned Workload to manage your caseload and navigate to tasks; 
• complete tasks using the Options menu; 
• access the FRS,  
• name the different sections of the FRS;  
• complete and save Contact Notes in the FRS; 
• use the Staff To-Do List to manage necessary tasks, send To-Do’s to yourself or 

others, and navigate to tasks; 
• keep track of necessary tasks using the Case To-Do List; and 
• use the Event List to keep track of events that have occurred in your homes/stages 

and navigate to view details of specific events. 
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Managing Your Assigned Workload 
The Assigned Workload is an important workload management tool in CONNECTIONS. It lists 
all of the homes/stages assigned to you, as either a primary or secondary worker, along with 
basic information about the home/stage (e.g., home/stage name, the date you received the 
assignment). You can sort stages in different ways to organize the work you need to do. 

New assignments are highlighted in gray and displayed at the top of the window when it is 
initially opened. They remain highlighted until the assigned worker displays the home/stage 
information on screen. New assignments do not automatically display on the Assigned 
Workload if it is open at the time of the assignment. It is necessary to Refresh your workload for 
these assignments to appear. To refresh the Assigned Workload, click on the Options menu 
and select the Refresh command, or click on the Refresh button at the bottom of the window. 

Opening the Assigned Workload 

 

Step by Step: 
Opening the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar 
The Assigned Workload displays. 
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The following columns on the Assigned Workload provide an abbreviated view of relevant 
information about each home/stage assigned to you. 

! This column displays an exclamation point (!) if a case has been 
marked “sensitive.”  

Role This column denotes your assigned role in the stage. The roles 
that display depend on the type of stage. 
For CPS Investigation and FAD stages, the following roles are 
available: 

• “PR” indicates that you are the Primary worker for the stage. 
• “SE” indicates that you are the Secondary worker for the 

stage. 
For Family Services Stages (FSS), the following roles are 
available: 

• “CM” indicates that you are the Case Manager for the stage. 
• “CP” indicates that you are the Case Planner for the stage. 
• “CW” indicates that you are a Caseworker assigned to the 

stage. 
• “WM” indicates that you are the CPS Worker/Monitor for the 

stage. 

Stage 
Name 

FAD homes/stages are usually named for the foster or adoptive 
mother. 

County Represents the county where the home/stage is located. 

Zone Displays a code for New York City addresses only. 

Stage The stage of service the selected item represents. 

Type Describes the type of home/stage. In FAD, the type is always 
Regular (REG) in CONNECTIONS. 

Start The date the home/stage is first opened/reopened in 
CONNECTIONS. 

Assigned The date the home/stage was assigned to the caseworker. 

Unit This column indicates the unit to which the worker is assigned. 

Stage ID 
and 
Case ID 

The Stage ID and Case ID numbers are unique, system-generated 
identification numbers assigned to cases and stages, respectively. 
Each stage has a unique Stage ID; all stages related to the same 
case will share the same Case ID. 
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The Assigned Workload for ACS caseworkers (New York City) displays three additional 
columns: 

HPF Indicates the ranking of the High Priority safety factor associated with 
the CPS stage.  

* An asterisk (*) in this column indicates that the CPS stage has more 
than one High Priority factor. 

CD Displays the Community District (CD) code for the address associated 
with the stage. 

 

Sorting the Assigned Workload 
Your Assigned Workload may have more foster homes/stages than are visible on the window at 
one time. You may need to organize the data in the list to find a particular home/stage. You can 
change the sort of your assignments, which by default sorts in alphabetical order by new 
assignment then by alphabetical order previous assignments, on the Assigned Workload by 
using the Sort menu. When you close your Assigned Workload, the next time you open it your 
stages return to the default sort order. 

You can arrange your assignments using one of the following sorts: 

Case Sorts assignments by Case ID number. 
Alphabetical Sorts assignments in alphabetical order by Stage Name. 

Worker Role Sorts based on the worker’s assigned role (e.g., Case Worker). 

Stage of 
Service, 
Stage Name 

Sorts assignments by Stage of Service (e.g., FAD), then alphabetically by 
Stage Name. 

County Sorts assignments by County code. 
Chronological Sorts assignments by Start date, earliest (oldest) date first. If two or more 

stages have the same Start date, a secondary sort is performed by Stage 
ID, with Stage IDs listed from lowest to highest. 

Reverse 
Chronological 

Sorts assignments in reverse order by Start date, most recent (latest) date 
first. If two or more stages have the same Start date, a secondary sort is 
performed on Stage ID, with Stage IDs listed from highest to lowest. 

Date 
Assigned 

Sorts assignments in order of the date on which the CPS report was 
assigned to the caseworker, based on the Intake Start date for Intake and 
Investigation stages. If two or more stages have the same Date Assigned, a 
secondary sort is performed on Stage ID, with Stage IDs listed from lowest 
to highest. 

 
 

 

Step by Step: 
Sorting the Assigned Workload 

1 On the Assigned Workload, click on the Sort menu. 
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2 Click on a sort command from the menu. 
The Assigned Workload displays according to the sort command you selected. 

3 To change the sort, click on the Sort menu again and select another sort command. 
4 To return the sort to the default setting, click on the Refresh button at the bottom of 

the Assigned Workload. 

The Options Menu 
The Options menu on the Assigned Workload is a drop-down listing of commands that help you 
accomplish a variety of tasks. Some commands simply reorganize the look of the Assigned 
Workload, and others complete tasks such as retracting an assignment.  

Clicking on the Options menu displays the following commands (you may find that all 
commands are not enabled, depending on your security): 

• Accept • Create Family Services Stage 
• Reject • Unlink FSS Stage 
• Intake Priority/Closure… • Stage Progression… 
• Case (Stage) Name/CD • Task List… 
• Assign… • Event List… 
• Case To Do’s…  • List Assignments Made… 
• Case Summary… • Workload Filter… 
• Person List… • Refresh 
• Record Family Services Intake  

In this section we will take a look at two of the commands on the Options menu.  

 

Step by Step: 
Using the Options Menu 

1 Click on the WORK button on the CONNECTIONS Toolbar 
The Assigned Workload displays. 

2 Select the foster home/stage you want to work on. 
3 Click on the Options menu and select a command. 

The window associated with the selected command displays. 
4 To return to the Assigned Workload, click on the Close, Cancel or Save button on 

any open window. 

CONNECTIONS Step-by-Step Guide: Page 3-5 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



Workload Filter 

The Workload Filter… command on the Options menu opens the Workload Filtering window. 
You can use this window to view a sub-set of assignments from the Assigned Workload. This is 
especially helpful if you have a very long listing of home/stage assignments. 

Your Assigned Workload can be filtered according to Stage ID, Case ID, and Match Retrieve 
by Stage Name. Once the filter is in place, the title bar on the Assigned Workload reads: 

Assigned Workload - <worker’s name> (Filtered). 
 

 

Step by Step: 
Filtering the Assigned Workload 

1 Click on the WORK button on the CONNECTIONS Toolbar 
The Assigned Workload displays. 

2 Click on the Options menu. 
A drop down menu displays. 

3 Select the Workload Filter command. 
The Assigned Workload (filtered) displays. 

4 Enter information in the Stage ID, Case ID or Match 
Retrieval by Stage Name field. 

5 Click on the Search button. 
The Assigned Workload displays the results of the 
filter. 

6 To remove the filter from the Assigned Workload, 
click on the Refresh button. 

List Assignments Made 

This command, also found on the Options menu of the 
Assigned Workload, provides access to the List Assignments 
Made window. You can use the List Assignments Made window 
to view assignments you have made to other workers, and to 
cancel assignments that may have been made in error. This 
window only displays assignments that have not yet been 
accessed by the assignee. If the assignments have been 
accessed, the following message displays: 

“No Assignments to Retrieve. All Assignments Retrieved by 
Assigned Worker.” 

An assignment is considered to have been “accessed” when 
the assignee selects the home/stage from his/her Assigned 
Workload and selects an Options menu command or clicks on 
the Tasks… button. An assignment can only be cancelled if it displays on the List Assignment 
Made window, and therefore has not yet been accessed by the assignee.  

 
A minimum of two characters  

of the stage name (recorded as 
case-sensitive; i.e., first letter 
capitalized, remainder lower-
case [e.g., Smith]) must be 

entered in the Match Retrieved 
by Stage Name field to enable 

that particular filter. 

 

Once the cancellation has been 
completed, the home/stage is 

removed from the original 
assignee’s Assigned Workload. 

The original assignee and 
his/her supervisor receive an 

Alert To-Do that reads: 

“Stage #### was reassigned by 
<worker name>.” 
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Step by Step: 
Listing Assignments Made 

1 Click on the WORK button on the CONNECTIONS Toolbar 
The Assigned Workload displays. 

2 Click on the Options menu. 
A drop down menu displays. 

3 Select the List Assignments Made… command. 
The List Assignments Made window displays. 

4 Select the assignment (home/stage) to be canceled, and click on the Assign… 
button. 
The Assign window displays. 

5 Reassign the home/stage to the correct worker, by selecting the appropriate staff 
person’s name from the Available Staff list at the top of the Assign window. 

6 Click on the Primary or Secondary button, as applicable. 
Clicking on the Primary button displays the following message:  
“This action will remove the current primary worker from the stage. Continue?” 

• Clicking on the Yes button adds the selected worker to the Assignments 
grid. 

• Clicking on the No button does not add the worker as Primary. 
• Clicking on the Help button displays Online Help. 

7 Click on the Save button. 
The List Assignments Made window displays. 

8 Click on the Close button to return to the Assigned Workload. 
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The Task List 
As a caseworker responsible for completing the home certification or approval process, you 
must access areas of CONNECTIONS that allow you to complete and record your casework 
activities. These activities must be documented in CONNECTIONS (the system of record) or in 
the External Foster Home Case Record. 

The Task List is a tool provided by CONNECTIONS to help caseworkers conduct/document 
their work in an organized fashion. The Task List for a foster home stage identifies 13 tasks that 
you may complete in CONNECTIONS during the certification or approval process. These tasks 
reflect many of the processes that caseworkers complete in the course of foster home 
certification or approval—from gathering and evaluating specific types of information, to making 
decisions about certifying or approving a foster home. The CONNECTIONS Task List is used to 
guide this information documentation and decision making process. 

FAD Tasks in CONNECTIONS 

Maintain  
Non-Licensing 
Information 

This task opens the Home Demographics window (and associated 
windows). Use this task to record and maintain demographic 
information about the resource home (see Module 6: Responding 
to an Inquiry). 

Maintain Licensing 
Information 

All licensing processes are recorded via this task. This task opens 
the F/A Home License window, where you identify all licensing 
requirements; Facility Type, Program Type, Home Study, 
Capacity, etc.) and submit information for supervisory approval 
(see Module 8: Maintaining Licensing Information). 

Maintain Person This task enables a caseworker to add, modify, delete and view 
information regarding persons associated with the selected stage 
(see Module 7: Maintaining Person Information). 

View Home 
Placements 

This task is not currently supported. 

View Home History This task opens the F/A Home History window, which is used to 
retrieve historical home records. It contains a listing of all licensing 
and status changes that have transpired since the home was 
initially created in the system. The ability to modify information on 
this window requires a specific Business Function Profile (BFP). 

Home Study This task provides access for viewing and updating information 
about the home, and the ability to create and update home Study 
narratives. 

Annual 
Reauthorization 

This task provides access for viewing and updating information for 
the home, and the ability to update Home Study narratives and 
complete the Annual Reauthorization process. This task is only 
available during the 90 days prior to the home’s 
recertification/reapproval date. 

Continued on next page  
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(Continued from previous page) 

View FAD Record 
Summary 

This task provides view-only access to information and any in-
process Home Study or Annual Reauthorization narratives for the 
home. 

Vacancy Control 
Bed Maintenance 

This task opens the Vacancy Control Bed Maintenance window, 
which enables workers to maintain beds (e.g., add beds, delete 
beds, modify bed characteristics) for a home/facility in Accepted-
Active or Applicant status. Performing this function in a timely 
manner allows agencies to optimize their placement potential. 
The buttons for this task enable based on your Business Function 
Profile. 

Corrective Action 
Plan 

This task opens a window to access a Microsoft Word document 
where you can document an agreement with foster or adoptive 
parents to correct a violation of state regulations. 

Serious Incident This task opens a window to access a Microsoft Word document 
where you can record information about a serious incident that 
has occurred in the foster or adoptive home. 

Waiver/Exception This task opens a window to access a Microsoft Word document 
where you can record a request for a waiver or exception to 
particular state regulations. Only Relative Foster Homes are 
eligible to request waivers/exceptions. 

Close Home This task enables you to document the reasons for a home 
closure and to submit that information for supervisory approval to 
officially close the home in CONNECTIONS. Supportive 
documentation for home closure must be recorded in the External 
Foster Home Case Record. 

 

Navigating from the Assigned Workload to Accomplish Tasks 
From the Assigned Workload, you accomplish tasks either by opening the Task List or by 
navigating to specific tasks through the Options menu. 

Using the Task List 
The Task List includes all of the tasks associated with a particular home/stage and provides an 
entry point to each of these tasks. Follow the steps below to open the Task List from the 
Assigned Workload. 

 

Step by Step: 
Opening the Task List 

1 Click on the WORK button on the CONNECTIONS Toolbar 
The Assigned Workload displays. 

2 Select the foster home/stage you want to work on. 
The Tasks... button enables. 
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3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 To close the Task List, click on the Close button. 
The Assigned Workload displays. 

Reassigning a Home/Stage 
The Assign window is used to reassign a foster home from your Assigned Workload to that of 
another worker in CONNECTIONS. By default, this window contains available staff within your 
unit or district. 

Assignment of foster homes in CONNECTIONS does not override policy parameters or off-line 
procedures/communications that are often required prior to transferring or assigning a 
home/stage. 

The top half of the Assign window, the Available Staff grid, lists the eligible unit staff to whom 
you can reassign a foster home/stage. A list of the staff currently assigned to the home/stage is 
displayed in the Assignments grid at the bottom of the window. If you were assigned the Primary 
role and that role is reassigned to another worker, the stage will no longer display on your 
Assigned Workload. 

 

Step by Step: 
Reassigning a Home/Stage 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the foster home/stage you need to reassign. 
3 Click on the Assign… button. 

The Assign window displays. 
4 Select another worker in your unit from the Available 

Staff section.  
 

You can search for additional 
staff by clicking on the Options 
menu and selecting the Staff 
Search Criteria command. 

5 Click on the Primary button. 
The following message displays:  
“This action will remove the current primary worker 
from the stage. Continue?” 

• Clicking on the Yes button adds the selected 
worker to the Assignments grid. 

• Clicking on the No button does not add the worker as Primary. 
• Clicking on the Help button displays Online Help. 

6 Click on the Save button. 
The Assigned Workload displays. 

Page 3-10 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



A Staff Search needs to be conducted when reassigning a home/stage to a caseworker from a 
different unit or district. 

 

Step by Step: 
Conducting a Staff Search when Reassigning a Home/Stage 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate home/stage on the Assigned Workload, and click on the 
Assign… button. 
The Assign window displays. 

3 Click on the Options menu in the Assign window and select Staff Search Criteria… 
The Staff Search Criteria window displays. 

4 Enter the name or Person ID number of the caseworker to whom you want to 
reassign the foster home. 

5 Click on the Search button. 
The Staff List displays. The name you entered in the search criteria displays at the 
top of the Staff List. 

6 Select the name at the top of the list. 
7 Click on the OK button. 

The Assign window displays with the selected caseworker’s name highlighted in the 
Available Staff section. 

8 Click on the Primary button. 
The following message displays:  
“This action will remove the current primary worker from the stage. Continue?” 

• Clicking on the Yes button adds the selected worker to the Assignments 
grid. 

• Clicking on the No button does not add the worker as Primary. 
• Clicking on the Help button displays Online Help. 

9 Click on the Save button. 
The Assigned Workload displays. 

 

CONNECTIONS Step-by-Step Guide: Page 3-11 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



The Foster and Adoptive Home Record Summary (FRS) 
In addition to using CONNECTIONS to manage and access caseload information, you will need 
to use CONNECTIONS to record case notes and narratives in an organized manner. 
Supervisors and managers also need to access case notes and narratives for review. 

The Foster and Adoptive Home Record Summary (FRS) provides a comprehensive view of the 
FAD information you record in CONNECTIONS. This is accomplished through the use of a 
single, multi-tabbed window that provides you access to maintain, view, and print FAD home 
information easily. This multi-tabbed window is organized to be consistent with the existing 
foster/adoptive home development process. Comments and contact notes may be recorded at 
appropriate points throughout this process. 

Currently, not all of the information you see in the FRS can be updated within the FRS. Much of 
the information presented in the FRS is drawn from other CONNECTIONS windows, and can 
only be updated in those windows. However, most tabs do allow for the recording of various 
types of comments and notes. The Home Study Narrative and Annual Reauthorization tabs, 
allow for the creation and editing of narratives directly within the FRS.  

In each module of this guide, the use of the FRS will be discussed for each topic covered, as 
applicable. For example, in Module 6 (Responding to an Inquiry and Recording Inquiry 
Information) you will learn how the FRS is used, in addition to the traditional Task List, to record 
and view information for each foster home inquiry. 

The Layout of the FRS 
Before learning how to access the FRS, let’s take a moment to consider the major features and 
the layout of the FRS.  

Information in the FRS is organized into three sections; the Heading (top portion of window), 
the Tab Section (middle portion) and the Buttons (lower window). 

Heading

This section is always present when the FRS is open. It includes the following information:  

• Resource Name • Resource ID 
• Authorized From Date • Authorized To Date 
• Vendor ID • Agency Name/Resource ID 
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Buttons 

The buttons found at the bottom of the FRS window are always present when the FRS is open. 
The table below lists each button and provides a brief description of their uses.  

Submit This button initiates the Save and Submit process. Clicking the 
Submit button opens the F/A Home License window, allowing 
you to Save and Submit the FRS and the Home license 
information together. 

The Submit button is disabled when the FRS is entered in view-
only mode or if no changes have been saved to the FRS since 
opening it. 

Help on Narratives This button accesses help information on how to use the Home 
Study and Annual Reauthorization documents. If you click on 
the Help on Narratives button while on the Home Study or 
Annual Reauthorization tabs, you will open help information 
about that document. (Clicking on the button while on any other 
tab will open an index of help topics relating to these narratives.) 

This separate help is made available to provide information on 
completing the narrative documents. (see Module 5: Getting 
Help When You Need It) 

Generate Report Clicking on this button will open the Generate Report window. 
This window lets you choose any or all of the FRS tabs to be 
formatted into a single document that can be printed (see 
Module 11: FAD Reports). 

Close Clicking on this button will close the FRS and return you to the 
window from which you entered the FRS, either the Task List 
window or the Event List window. 

Tabs 

The home information is separated into nine major areas that make up each tab. Tabs appear, 
from left to right, in the following order (the tabs can be accessed in any order): 

• Home Demo. 
• Licensing Information 
• Household Member Detail 
• Home History Events 
• Agy./Worker Information 
• Home Study Narrative  
• Annual Reauth. Narrative 
• FAD Checklist  
• Contacts  

Each of the nine tabs is briefly introduced below. Use the references following each description 
to locate information on how to complete the FAD Recording Process using the FRS. 
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Home Demographics Tab 

The Home Demo. tab contains demographic information taken from the Home Demographics 
window. Demographic information on this window is general information about the home. For 
example, the Religion field is filled in with the item that best indicates the overall Religion 
practiced in the home. Specific information about the religion practiced by each individual in the 
home is located on the Household Member Detail tab.  

This tab also contains two buttons: Emergency Back-up and Directions to Home.  

• Clicking on the Emergency Back-up button displays the Emergency Comments window 
where you can record any additional contact information such as names, telephone 
numbers and addresses of emergency contacts.  

• Clicking on the Directions to Home button displays the Directions to Home Comments 
window where you can record information related to the facility/home, such as driving 
directions or a physical description of the facility/home. 

When the FRS is accessed via the Event List or View FAD Record Summary tasks, it displays 
the Home Demo. tab by default. Accessing the FRS through other venues may cause a 
different tab to be viewed first (See Module 6: Responding to an Inquiry). 

Licensing Tab 

The Licensing Information tab displays information taken from the F/A Home License window. 
Most of the information on the Licensing Information tab is view only and cannot be updated 
from within the FRS.  

This window contains two buttons: Child Characteristics and Child Race/Eth/Rel/Languages 
that display comment boxes when selected. These comment boxes provide a place to record 
and modify the following information: 

• “Child Characteristics Accepted”  
(i.e., the characteristics preferred by the foster parents) 

• Race 
• Ethnicity 
• Religion 
• Languages 

Protected check boxes next to each button automatically display a checkmark once comments 
have been recorded and saved to the database. (See Module 8: Maintaining Licensing 
Information in CONNECTIONS). 
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 Household Member Detail Tab 

The Household Member Detail tab displays information from the Person Detail window 
organized into two main grids. 

UPPER GRID 
Name  Sex  

Date of Birth Age  
Language Religion  

Marital Status Ethnicity 
Race 

Date Added to Stage 
Rel/Int 

 

LOWER GRID 
Medical Exam Date  FP Cards Sent  

FP Cards Recd † FP Results 
† Safety Asmnt Dt † SCR DB Check Sent 

† SCR DB Check Recd † SCR Results 

† The last five columns of the lower grid can only be updated from within the FRS. 

The Household Member Detail tab includes buttons that allow you to access comment boxes. 
Comment boxes provide you with a place to record and edit FAD information. Below is a list of 
buttons that open related comment boxes on the Household Member Detail tab: 

• Training Comments 
• Med/CHRC and SCR Comments 
• Employment Comments 

 
A check box next to each button becomes system-filled with an “X” once comments have been 
recorded and saved in the appropriate comment box. 

The Household Member Detail tab contains another set of buttons to allow viewing access for 
associated sub-windows. These sub-windows display information recorded in CONNECTIONS 
via the Maintain Person task. These windows cannot be updated from within the FRS: 

• A.K.A. Names 
• Person ID 
• Case List 
• Person Detail FA 
• Training Details 

 
This tab is also discussed in Module 7: Maintaining Person Information. 
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Home History Events Tab 

The Home History Events tab lists all events that relate to the history of the home. This 
includes all approvable events and any assignment events where the agency or sub-agency has 
changed. The information on the Home History Events tab is view-only.  

The following columns display in the Home History Events tab: 

Event Date The date an event was completed, as recorded on the specific window or 
during the events evaluation. If no date was recorded, the Event Date 
column will be blank for that event. 

Tx Date The system transaction date, which is the date an event was updated by 
the worker using one of the Save functions (i.e., Save, Save and Submit, 
Save and Close, Save and Stay). 

Event Status Status of the event (i.e., new, proc, pend, rejt, comp). 

Event Type The type of event generated (e.g., Home, Assignment).  

Event 
Description 

A description of the event (e.g., New Home Created).  

Although the titles are similar, the Home History Events tab of the FRS does not display the 
same information as the F/A Home History window found elsewhere in CONNECTIONS. (See 
Module 12: Maintaining FAD Homes in CONNECTIONS for information about accessing the F/A 
Home History window.) 

Agency/Worker Tab 

Information found on the Agy./Worker Information tab identifies the primary worker and any 
other individuals working in the facility/home. An arrow displays to the left of the worker currently 
selected on the Agy./Worker Information tab. This information is view-only. 

This tab contains the following columns: 

Worker Role The worker’s assigned role in the stage. 

Worker Name The worker’s name as recorded in CONNECTIONS. 

Worker Phone The worker’s office phone number, if recorded in CONNECTIONS. 

Agency Name The agency of the assigned worker. 

Agency Code The agency code. 

Home Study and Annual Reauthorization Narrative Tabs 

The FRS has mechanisms for recording FAD Home Study narratives and Annual 
Reauthorization narratives. Using the FRS to create these narratives eliminates the need for 
duplicate entry of information into external documents and CONNECTIONS. OCFS templates 
are provided for recording these narratives. The result is a more complete online record for each 
home. 
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Each time a new Home Study or Reauthorization is initiated, a new FRS is created. 
CONNECTIONS maintains an historical listing of all narratives for the home. To avoid 
confusion, only one active FRS will exist at a time. Because of this historical listing, each home 
study template can be maintained to reflect changes in address, household composition or 
other status updates (Refer to Module 8: Maintaining Licensing Information for FAD Homes). 

FAD Checklist 

The FAD checklist is an organized listing of the tasks required for certification, approval, 
recertification, and reapproval of foster homes. It is strongly recommended that you use this 
checklist to date each task as you complete it, or as a review to make sure you have finished all 
tasks necessary for the licensing goal you are working on. (See Module 8: Maintaining 
Licensing Information for FAD Homes). 

Contacts Tab 

The Contacts tab provides a place for workers to record all contacts made for a home, creating 
a contemporaneous document. The use of the Contacts tab is discussed later in this module. 

CONNECTIONS Step-by-Step Guide: Page 3-17 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



Accessing the FRS 
The FRS can be accessed in two ways, through the Task List and through the Event List. Any 
worker able to access a FAD Home from their workload can also access the FRS via the Home 
Study, Annual Reauthorization or View FAD Record Summary tasks on the Task List. 

Accessing the FRS from the Task List  
The Task List contains three tasks, which allow you to access the FRS for different reasons. 
Descriptions of the tasks are listed below: 

Home Study —- This task provides access to view and update the current active FRS. Use 
this task to create and update current Home Study narratives, contacts, and home and 
person information.  

Annual Reauthorization —This task provides access to view and update home and person 
information, update Home Study narratives, and complete the Annual Reauthorization 
narrative. This task can access the FRS only during the 90 days prior to the home’s 
recertification or reapproval due date. 

View FAD Record Summary — This task provides view-only access for an in-process 
FRS. If there is no in-process FRS buttons do not enable once you select the task. When 
the FRS is accessed using this task, changes cannot be made in the windows displayed. 

The buttons at the bottom of the Task List are affected by whether or not the FRS has been 
accessed and/or saved in the past. 

New vs. Use Prior 
When opening the FRS to start an Initial Home Study, only the New button enables. At other 
times, you will have a choice between New or Detail. Also, in the process of opening the FRS to 
complete an Interim Home Study, you will notice that two buttons enable on the Task List —
New and Use Prior. Use Prior becomes enabled when one Home Study or Reauthorization 
narrative already exists for the home. You are given the option to use information you have 
already entered, or to start with a blank document.  

Let’s take a closer look at what these different options mean. 

New This button displays a version of the FRS where all data fields are pre-filled 
with current information from the CONNECTIONS database. The Home Study 
and Reauthorization narratives will contain blank templates and all comment 
boxes will be blank. Information can be entered in the Home Study narrative 
and comment boxes. 

Use Prior This button displays a version of the FRS where all data fields are pre-filled 
with current information from the CONNECTIONS database. The Home Study 
and Reauthorization narratives and all comment boxes will contain information 
from the latest approved/frozen FRS. The Home Study narrative and comment 
boxes can be modified or added to as necessary. 

Detail… This button can be selected any time you have an in-process FRS that 
requires editing. 

Page 3-18 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



 

 
Step by Step: 
Accessing the FRS from the Task List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select a FAD home and click on the Tasks… button. 
The Task List displays three tasks that can open the FRS window. 

3 Select the task that best reflects why you are opening the FRS. 
For example, select Annual Reauthorization when you need to complete the 
Annual Reauthorization Document. 

4 Click on the corresponding button. 
For example, if you select the Home Study task you would click on the New or 
Use Prior button. 

Accessing the FRS from the Event List 

The primary reason for accessing the FRS via the Event List is to view a Home Study or Annual 
Reauthorization narrative. Such events are referred to as “navigable events.”  This means that 
you may select the event, and use the Detail button to view information related to that event. 

Events with a status of PROC, PEND, or REJT allow view-only access to the current FRS. 
Events with a status of APRV allow view-only access to frozen/approved Home Study or 
Reauthorization documents. 

The Event List can be displayed using the Options menu on both the Assigned Workload and 
on the Task List. The directions below begin from the Assigned Workload. 

 

Step by Step: 
Accessing the FRS from the Event List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the Options menu and select the Event List command. 
The Event List window displays. 

3 Select the appropriate “navigable event,” and click on the Detail… button. 
The FRS displays in view-only mode. 
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Completing Progress/Contact Notes in the FRS 
Contact notes may be recorded in the Contact Tab of the Foster and Adoptive Home Record 
Summary (FRS). Documenting casework contacts and activities in this tab, keeps all information 
about a home/stage together in one record, unlike writing notes in MS Word and saving these 
files separately.  

The Contacts tab is simply a listing of separate notes documented for casework contacts and 
activities. The following information is displayed (in columns) for each contact: 

• Date/Time Recorded • Contact Date 
• Contacted By • Method 
• Purpose • Location 

Three buttons display at the bottom of the tab. Use the Add New button to record new contact 
notes. The Contact Details button displays a selected contact note, and the Delete button will 
remove a selected contact. 

The directions on how to access the Contact tab and complete a Contact Note are described 
below. Instructions on how to Delete a contact follow. 

 

Step by Step: 
Creating and Saving Contact Notes in the FRS 

1 On the Assigned Workload, select the FAD home/stage you need to update and click 
on the Tasks… button. 
The Task List displays. 

2 Select the Home Study task. 
3 Click on the New, Detail or Use Prior button (Detail is enabled when there is an  

in-process FRS). 
The FRS displays. 

4 Click on the Contacts tab, and click on the Add New button. 
The Contacts window displays. 

5 Complete the following fields: Contact Date, Contacted By, Method, Participants, 
Location, Purpose and Comments. 

6 When you are finished, click on the Save button to store information in 
CONNECTIONS (click on the Cancel button to leave the window without saving 
information). 
The FRS displays with the Contacts tab active. 

7 Click on the OK button in response to the following message:  
“Changes have been saved.” 
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Step by Step: 
Deleting Contact Notes in the FRS 

1 On the Assigned Workload, select the FAD home/stage you need to update and click 
on the Tasks… button. 
The Task List displays. 

2 Select the Home Study task. 
3 Click on the New, Detail or Use Prior button (Detail is enabled when there is an  

in-process FRS). 
The FRS displays. 

4 Click on the Contacts tab. 
5 Select the contact you would like to remove from the list. 
6 Click on the Delete button. 

The Delete button disables when the selected contact is part of an FRS that has 
already been approved and frozen. 

7 Click on the Yes button in response to the following message: 
“Are you sure you wish to delete this Contact?” 

8 Click on the OK button in response to the following message: “Delete successful.”  
The FRS displays with the contact deleted from the list. 

Additional Features of the FRS 

Saving your work 
You have probably already heard that saving your work and saving often is imperative – 
especially when writing long narratives like a Home Study or Annual Reauthorization. 

This is important because the CONNECTIONS Citrix servers will “time out” when a connection 
to the system that has been idle for 15 minutes. If you receive a phone call, or experience any 
other type of interruption while writing in a narrative, make a habit of saving your work right 
away. Any narratives that are open when the Citrix server times out will be closed down without 
saving. Only work last saved by you or Microsoft Word will appear in the narrative when 
reopened.  

Microsoft Word is set to periodically “AutoSave” your document. Every three minutes, your 
machine will automatically save whatever changes you’ve made to the document. These 
changes are made to an alternate copy of your document (known as an auto recover 
document). The locally saved document can be located by clicking on the Start button in the 
Citrix window, and selecting the Local Save folder. The information remains available for 30 
calendar days and can be copied and pasted into the appropriate document. 

The auto recover document is intended for use if your original document is damaged or lost. It is 
a safety net; do not depend on this function as the only protection for your work.  

The procedure for saving narratives in the FRS is very similar to that for the rest of 
CONNECTIONS. 
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Step by Step: 
Saving Narratives in the FRS 

1 Click on the File menu on the Foster and Adoptive Home Record Summary window 
and select Close. 
The following message displays: “Save Changes?” 

2 Click on the Yes button. 
If you click on the No button, your changes will not be saved. 

3 Click on the Retrieve/Edit Narrative button to reopen the narrative and continue 
working on it. 

When reading a narrative that you have accessed in view only mode, closing that document will 
not result in seeing these Save reminders. 

Enhanced Narrative Locking 

The FRS utilizes a feature called “Enhanced Narrative Locking” to protect the save process 
involved when working on narratives, such as the Home Study and Reauthorization narratives. 
This feature allows you work to be saved even when two caseworkers are working on the same 
document and try to save their work at the same time. 

If you try to save your work after another worker has just modified the same document, the 
following message displays: 

“Unable to Save! Save Failed: The Data has been changed by another user. 
Press Yes to Save a local Copy or No to Discard.” 

Click on the Yes button to see the following message: 
“Narrative <document number.doc> Saved in Start – Local Save” 

The locally saved document can be located by clicking on the Start button in the Citrix window, 
and selecting the Local Save folder. The information remains available for 30 calendar days 
and can be copied and pasted into the appropriate document. 

Additional Features in Word 

As you use the Word templates in the FRS to create the Home Study and Annual 
Reauthorization narratives, you will find that there are several features available in Word in the 
FRS that are not always available when using other word templates in CONNECTIONS. 

This includes the following features: 

Spell Check — Spell Check identifies spelling errors in your narrative by underlining them in 
red. This makes it easy for you to find and correct them. 

Grammar Check — Grammar Check underlines grammatical errors and provides 
suggestions if you right-click on the mouse with your cursor on the word. 

Auto-Correction — Auto Correction will automatically correct common misspellings. For 
instance, if you mistakenly type “t-e-h”, Auto-Correction would automatically change it to “t-
h-e” without you having to take any action. 
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Online Help in the FRS 
The FRS Help system is an enhancement to the CONNECTIONS Online Help System that 
provides information specific to the functions and windows of the Foster and Adoptive Home 
Record Summary (FRS).  

The FRS Online Help System contains several unique features, including: 

• A Table of Contents allowing access to all Help information. 
• Index and Search functions provide alternate means of finding information. 
• Interactive graphic examples of FRS elements.  

Clicking on certain portions of a graphic within FRS Online Help will open 
explanations of that element.  

• Hyperlinks appear throughout the Help information.  
These links will take you directly to related information such as definitions and 
procedural guidelines. 

• Context Sensitive Help. 
• Help on Narratives for the Home Study and Reauthorization narratives in the FRS. 

The complete Online Help System is a combination of separate sections. Some of these exist 
currently in CONNECTIONS, and others are being developed. Once you are in the Help system, 
the Table of Contents allows you to have access to help information on these other elements of 
FRS. 

The table on below highlights each element of the FRS Help System. 

Sub-Sections of the FRS Online Help System 
(accessed via the Table of Contents) 

Section Description 
FRS Overview This section of Online Help provides a high level summary of the 

FRS, including a listing of its features and functions.  

This overview can be accessed directly by clicking the word Help 
that appears in the upper left corner of the FRS window and then 
clicking on FRS Help which appears in the small menu. 

“How Do I?” Help This section includes information on how to navigate within the 
FRS and how to best utilize its functions. 

Glossary This glossary provides definitions of terms commonly used in FAD 
casework, and definitions of FRS elements and concepts. 

Guidelines This section provides background on the legal, policy, and 
procedural guidelines followed by FAD workers as they develop 
and record the information viewed in the FRS. 

Help on Help This section provides instructions on how to use the FRS Online 
Help system. 
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Context Sensitive Help 

Context sensitive help information is available for all elements of the FRS including tabs, grids, 
buttons, and individual fields. 

To access context sensitive help, click on an element (e.g., field name) to make that element 
“active,” and press the F1 key on your keyboard. Information about that element of the FRS will 
be displayed.  

The F1 key will not activate FRS Help when you are viewing the Home Study or Annual 
Reauthorization narratives. Help for these documents is 
available through the Help On Narratives button. 

 

The Help on Narratives button 
is “hidden” when a narrative is 

actually open, because the 
Word document covers the 

entire FRS window. You need to 
minimize the narrative you are 

working on in order to locate the 
Help on Narratives button. 

Help on Narratives 

The Help on Narratives button on the FRS provides quick 
access to the section of the Online Help System that discusses 
how to use the narratives found in the FRS. When this button is 
clicked while in a Home Study or Reauthorization narrative, the 
Help System opens directly to this portion of the Table of 
Contents. You will have easy access to definitions and 
information on how to navigate while in a narrative. 

To-Do Lists 
CONNECTIONS provides two To-Do Lists to organize information and assist in communications 
regarding homes/stages. These lists are, the Staff To-Do List and the Case To-Do List. To-Do 
Lists are useful workload management tools in CONNECTIONS. 

Staff To-Do List — Your Staff To-Do List is a listing of To-Do’s sent to you. These To-Do’s 
may be from the CONNECTIONS system, co-workers or supervisors. You can even send 
reminder To-Do’s to yourself. The Staff To-Do List contains To-Do’s that are about the 
homes/stages on the Assigned Workload, and To-Do’s regarding non-case related items. 

Case To-Do List — The Case To-Do List includes displays To-Do’s related to a specific 
home/stage. To access this list, you must start by selecting a home/stage. 
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Types of To-Do’s 
Three types of To-Do’s can be found on either of the To-Do Lists. They are: Alert To-Do’s, 
Reminder To-Do’s and Task To-Do’s. 

Alert Alert To-Do’s are created by CONNECTIONS to notify workers that 
something has happened or needs to happen. For example, you are sent 
an Alert To-Do when you receive a new assignment. Alert To-Do’s are 
identified by an “A” in the Type column of a To-Do List. You can delete 
Alert To-Do’s at any time. Because they are not directly task-related, you 
cannot navigate directly from Alert To-Do’s to task-related windows. 

Reminder Reminder To-Do’s are created by CONNECTIONS users and are not 
related to a task from the Task List. You might create this kind of To-Do to 
remind yourself of an upcoming appointment. You can also send Reminder 
To-Do’s to other people. Reminder To-Do’s can be deleted at any time. 
Reminder To-Do’s are identified by an “R” 
in the Type column of a To-Do List. 
Because they are not directly task-related, 
you cannot navigate directly from Reminder 
To-Do’s to task-related windows.  

Task Task To-Do’s can be either system- or 
user-generated to notify workers that there 
is a task they must complete. Task To-Do’s 
are identified by a “T” in the Type column 
of a To-Do List. System-generated Task 
To-Do’s cannot be deleted; the only way to 
remove them from your Staff To-Do List to 
complete the Task. Task To-Do’s received 
from another worker can be deleted by 
entering a Completed Date on the Task To-Do Detail window. 

 

Creating a Task To-Do  
can be useful if you need 

another worker to complete  
a task for your case. 

The person receiving the Task 
To Do must enter a Completed 

Date on the Task To Do to 
remove the To-Do from his/her 

Staff To-Do List. 
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System Alerts 
The CONNECTIONS system sends Alert To-Do’s to notify you of actions you must perform, as 
well as events that occur regularly during the certification/recertification or approval/reapproval 
process. It is recommended that you organize your To-Do Lists. You can keep the list current by 
completing task To-Do’s, deleting outdated To-Do’s, and reassigning To-Do’s that should be 
handled by another worker. 

Below is a table of Alert and Task To-Do’s that are system-generated by CONNECTIONS. This 
table is not a complete listing of system-generated To-Do’s; it illustrates how much 
communication does occur with each casework activity. 

To-Do 
Type Description 

Alert To the primary worker when a new assignment is received. 

Alert To the primary worker’s supervisor(s) when a new assignment is received. 

Alert To the primary worker when secondary workers unassign themselves. 

Alert To secondary workers’ supervisor(s) when secondary workers unassign 
themselves. 

Alert To secondary workers’ supervisor(s) for new secondary assignments. 

Alert To secondary workers when another worker unassigns them from a case. 

Alert To secondary worker when a new assignment is received. 

Alert To the primary worker when a secondary worker Saves and Submits the 
Home Demographics or Case (Stage) Name/CD window for approval. 

Alert To the Unit Approver if a worker Saves and Submits an item to anyone other 
than the Unit Approver. 

Alert To the primary worker when s/he Saves and Submits a home name or 
address change for approval. 

Alert To the primary worker when a submitted name and/or address change is 
approved. 

Alert To the primary worker when Saving and Submitting name or address 
changes; informs the worker that these changes require the completion of a 
Home Study update. 

Alert To the primary worker when a FAD Record Summary event is approved; 
reminds the worker to print a copy of the F/A Home Certificate or Approval 
Letter for the foster parents. 

Continued on next page  

Page 3-26 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



To-Do Description Type 

(Continued from previous page) 

Task To the supervisor when the FRS is submitted for approval (e.g., initial 
certification or approval of a home/stage, recertification/reapproval of a 
home/stage). 

Task To the primary worker when a submitted name and/or address change is 
rejected.  

Task To the supervisor when the Case (Stage) Name/CD window is Saved and 
Submitted. 

Task To the supervisor when the Home Name, Primary Address or Business 
Address is changed in the Home Demographics window and the window is 
Saved and Submitted. 

 

Viewing To-Do’s on the Staff To-Do List 
The Staff To-Do List contains all of the To-Do’s assigned to you, regardless of which stage they 
relate to. 

 

Step by Step: 
Viewing To-Do’s on the Staff To-Do List 

1 Click on the TO-DO button on the CONNECTIONS 
Toolbar. 
The Staff To-Do List displays. 

2 Click on a To-Do to select it from the list. 
3 Click on the Detail… button. 

The To-Do Detail window displays for the selected To-
Do. 

4 To close the To-Do Detail window, click on the Cancel 
button. 
The Staff To-Do List displays. 

 
By default, the To-Do List is 
sorted by date and includes 
To-Do’s with due dates up to 
seven (7) days into the future. 

New To-Do’s appear at the 
bottom of the list. You can 

change the way they are sorted 
(see “Sorting To-Do Lists” in this 
guide), but To-Do’s revert to the 
default sort each time you open 

the To-Do List. 

5 To close the Staff To-Do List, click on the Close button. 
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Viewing To-Do’s on the Case To-Do List 
The Case To-Do List contains all of the To-Do’s for a specific case, regardless of assignment. 

 

Step by Step: 
Viewing To-Do’s on the Case To-Do List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select a foster home/stage. 
3 Click on the Options menu on the Assigned 

Workload and select Case To Do’s… 
The Case To-Do List displays with To-Do’s for the 
selected case. 

4 Click on a To-Do to select it from the list. 
5 Click on the Detail… button. 

The To-Do Detail window displays for the selected To-Do. 
6 To close the To-Do Detail window, click on the Cancel button. 

The Case To-Do List displays. 
7 To close the Case To-Do List, click on the Close button. 

The Assigned Workload displays. 

Navigating from Task To-Do’s 
From a Task To-Do, you can navigate directly to the window needed to complete the task. For 
example, if you receive a Task To-Do from your supervisor notifying you to complete the Home 
Study, you can navigate directly to the Home Study for that home/stage. This feature is 
available only for Task To-Do’s. 

 

Step by Step: 
Navigating from Task To-Do’s 

 
Voluntary agency staff cannot 
view case information in CPS 

Intake and Investigation Stages. 

 
When supervisors receive 

Task To-Do’s to review work 
completed by staff, they can use 

the Navigate… button to go 
directly to the work submitted 

for approval. 

1 Open the Staff To-Do List or Case To-Do List, using 
the instructions in Module 3: Managing Your 
Workload. 

2 Click on a Task To-Do to select it from the list. 
The Navigate… button enables. 

3 Click on the Navigate… button. 
The task-related window associated with the 
selected To-Do displays. 

4 If you make changes in that window, save your work 
by clicking on the Save button. 
The To-Do List displays. 

5 To close the window without saving changes, click on the Cancel button. 
The To-Do List displays. 
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Sorting To-Do Lists 
To-Do Lists can be “sorted” to assist you in setting priorities, organizing information, and 
maintaining the lists. The tables below and on the next page illustrate the sorts available on 
the Staff To-Do List and the Case To-Do List. 

Sort Name Primary Sort Secondary Sorts 

To-Do Type Sorts To-Do’s by type of To-Do. Items of the same type are sorted 
by date, then by Stage ID. 

Event 
Status 

Sorts To-Do’s by Event status 
(NEW, PROC, PEND, REJT, 
COMP). 

Items with the same status are 
sorted by type, then by date. 

Date Sorts To-Do’s in ascending order 
by date.  

Items with the same date are 
sorted by type, then by stage ID. 

Case Name 
Sorts To-Do’s alphabetically by 
Case Name.  

Items with same Case Name are 
sorted by stage ID, then by type, 
then by date. 
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Created By Sorts To-Do’s alphabetically by 
the To-Do creator’s initials. 

Items with the same creator are 
sorted by type, then by date. 

Sort Name Primary Sort Secondary Sorts 

To-Do Type Sorts To-Do’s by type of To-Do. Items with the same type are 
sorted by date, then by Stage ID. 

Event 
Status 

Sorts To-Do’s by Event status 
(NEW, PROC, PEND, REJT, 
COMP). 

Items with the same status are 
sorted by type, then by date. 

Date Sorts To-Do’s by ascending date.  Items with the same date are 
sorted by type, then by Stage ID. 

Stage ID Sorts To-Do’s by Stage ID. Items with the same Stage ID are 
sorted by type, then by date. 

Assigned 
To 

Sorts To-Do’s alphabetically by 
the initials of the worker to whom 
the To-Do is assigned. 

Items with the same assignees 
are sorted by type, then by date. 

Created By  Sorts To-Do’s alphabetically by 
the To-Do creator’s initials. 

Items with the same creator are 
sorted by type, then by date. 
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Worker Role Sorts To-Do’s based on the 
assigned worker’s role. 

Items with the same worker role 
are sorted by role type, then by 
date. 
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Step by Step: 
Sorting To-Do Lists 

1 Click on the Sort menu from either To-Do List. 
2 Click on a sort command to indicate how you want to sort the list. 

The To-Do List displays in the order of the selected sort command. 

Searching for To-Do’s 
When first opened, the To-Do List includes all outstanding To-Do’s created before the current 
date, as well as To-Do’s that will be due up to seven days into the future. If you to want to plan 
ahead and see what will be due beyond that seven-day period, you can extend this date by 
completing a search from within the To-Do List. 

 

Step by Step: 
Searching for To-Do’s 

1 Click on the From field at the top of the To-Do List and 
enter the date from which you want to start your 
search. 

 

When you send a Task To-Do 
to another worker, you give that 

person access only to the 
CONNECTIONS window 

required to complete the task, 
not the entire home/stage. 

2 Press the Tab key to move to the To field and enter 
the date through which you want to end your search. 

3 Click on the Search button. 
To-Do’s display which fall within the selected time 
period. 

Creating or Reassigning Task To-Do’s 
CONNECTIONS allows you to create a Task To-Do and send it to another worker, or reassign 
one of your Task To-Do’s to another worker. In either case, the other worker can navigate 
directly from this Task To-Do to windows related to the task, then view or update information on 
those windows. 

 

Step by Step: 
Creating a Task To-Do  

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the stage for which you want to create a To-Do. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the task for which you want to create the To-Do. 
The To Do button enables when you select a Task which can have a Task To-Do 
created (e.g., Maintain Non-Licensing Information window). 
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5 Click on the To Do… button. 
The To-Do Detail window displays. The short 
description field on this window is pre-filled with the 
name of the task you selected from the Task List. 

 
To conduct a search for a 

worker outside your agency 
when you do not know the 

Agency Code, complete the 
following steps: 

1. Click on the PERS icon on 
the CONNECTIONS Toolbar 

and complete a Person Search 
(see the “Person Search” 
section in Module 4 of this 

guide). 
When you click on a staff 

member’s name in the Person 
Search List, CONNECTIONS 

displays the following message: 
“This person is an Employee. 

For more information, use Staff 
Search. 

2. On the results list of the 
completed search, note the 
worker’s Person ID (write it 

down). 
3. Close the Person Search 
window by clicking on the 

Cancel button. 
The Staff Search Criteria 

window displays. 
4. Enter the worker’s Person ID 
number in the Person ID field. 

This is the only field you need to 
complete. 

6 From the To-Do Detail window, click on the Staff… 
button. 
The Staff Search Criteria window displays. The 
Agency field is pre-filled and the Active check box 
is selected. 

7 Enter search criteria—either the Person ID number 
or the staff member’s last name. (Just a portion of 
the last name is enough, unless you are searching 
for a common name in a large agency.) If you are 
searching for a worker outside your agency and you 
know that person’s agency code, enter it in the 
Agency field. 
The Agency field defaults to your own agency code. 

8 Click on the Search button. 
The Staff List displays with the results of your 
search. 

9 Click on the staff person’s name from the Staff List. 
10 Click on the OK button. 

The To-Do Detail window displays. The Assigned To 
field at the top of the window displays the name of 
the selected staff member. 

11 You can add a description of the To-Do or extra 
notes in the Descr./Notes field. You can add a due 
date by clicking in the Due field and entering the due 
date. 

12 Click on the Save button. 
The Task List displays. 

 

Step by Step: 
Reassigning a Task To-Do 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on a To-Do from the list to select it. 
3 Click on the Detail… button. 

The To-Do Detail window displays for the selected To-Do. 
4 Follow steps 6-12 above to assign the To-Do to another staff person. 

Remember, once it is reassigned, the To-Do no longer displays on your Staff To-Do 
List. 
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Creating a Reminder To-Do 
There are two types of Reminder To-Do’s: Stage Related Reminders and “Generic” Reminder 
To-Do’s. 

Stage Related Reminder To-Do’s —  These To-Do’s are directly associated with your 
assigned homes/stages. Once created, they will appear on both your Staff To-Do List and 
on the Case To-Do List for that home/stage. You might create a stage-related Reminder To-
Do to alert you of upcoming home visits or court dates. 

“Generic” Reminder To-Do’s — These To-Do’s are not associated with a stage and 
therefore can only be viewed on the Staff To-Do List. You may create a generic reminder to 
remember meetings such as Foster Parent Orientations, or MAPP Programs. 

The directions below instruct you on how to create generic, and stage related reminder To-Do’s, 
respectively. 

 

Step by Step: 
Creating a (Generic) Reminder To-Do 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on the New button. 
The To-Do Detail window displays. The short description field on this window is 
empty, since you have not associated this To-Do with a task. To send the reminder 
to another worker, refer to Step II under “Creating a Task To-Do.” 

3 Enter information in the Short Description field and the Description/Notes field, if 
desired. 

4 If you want to send the Reminder To-Do to another worker, follow steps 6-12 of 
“Creating a Task To-Do” on page 30. 

5 If the Reminder is for you, click on the Save button. 
The new To-Do is saved and displays on the Staff To-Do List. 

6 Click on the Close button to close the Staff To-Do List. 
The CONNECTIONS Toolbar displays. 

 

Step by Step: 
Creating a Stage-Related Reminder To-Do 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the appropriate foster or adoptive home/stage. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the To-Do… button. 
The To-Do Detail window displays with the name of the selected foster home/stage. 
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5 Change the date in the Due field by entering it in the field. 
6 Enter a subject for the To-Do in the Short Desc. field. 
7 Enter information in the Description/Notes field, if appropriate. 
8 If you want to send the Reminder to another worker, follow steps 6-12 of “Creating a 

Task To-Do” on page 30. 
9 If the Reminder is for you, click on the Save button. 

The new To-Do is saved and the Task List displays. 
10 Click on the Close button to exit the Task List. 

The Assigned Workload displays. 
11 If you sent the Reminder to yourself, click on the TO-DO button on the 

CONNECTIONS Toolbar to view the new Reminder To-Do. 

Deleting Alert and Reminder To-Do’s 
It is strongly recommended that you delete Alert and Reminder To-Do’s that you no longer 
need. Otherwise, your Staff To-Do List will become so long that you may have difficulty finding 
the To-Do’s you need.  

You can delete only Alerts and Reminders. Task To-Do’s received from another worker can be 
removed by entering a Completed Date on the Task To-Do Detail window. You cannot delete 
system-generated Task To-Do’s. Once completed, these To-Do’s are removed from the list 
automatically. 

 

Step by Step: 
Deleting Alert and Reminder To-Do’s 

 

Deleting Alert and Reminder To-
Do’s facilitates your ability to 

find To-Do’s on your Staff To Do 
List 

Completing a system-generated 
Task To-Do is the only way to 

remove it from your 
Staff To-Do List.  

1 Click on the TO-DO button on the CONNECTIONS 
Toolbar. 
The Staff To-Do List displays. 

2 Click on the Alert or Reminder To-Do(s) you want to 
delete. 

3 Click on the File menu and select Delete. 
The selected To-Do is removed from the list. 
You cannot delete system-generated Task To-Do’s. 

4 To close the Staff To-Do List, click on the Close button. 
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Using the Event List 
Event Lists in CONNECTIONS display tasks and case/stage-related activities that have been 
completed or are in progress. CONNECTIONS automatically updates Event Lists each time 
casework activities are performed (e.g., when you receive a new assignment, or when a 
supervisor approves or rejects a submission). The Event List in CONNECTIONS can be 
accessed via the Options menu from the Assigned Workload, or the Task List.  

Event Lists can be accessed via homes/stages that are 
currently open and from homes/stages that are closed. You 
may need to open the Event List for a variety of reasons, some 
of which are covered in this guide.   

When you return to the Event 
List after examining other 

windows, the Event List displays 
the previous scroll position, with 

the previously selected Event 
still highlighted. 

Some of these reasons are: 

• To view the status of supervisory approval (see 
Module 9: Checking the Status of Approvals 
Submitted for FAD Homes) 

• To access Historical F/A Certificates and Approval Letters (see Module 10: F/A 
Home Certificates and Approval Letters) 

Events also can be viewed as a printed report. The Event History Report contains events for a 
stage or a case (see Module 11: FAD Reports).  

In the next few pages, you will find instructions on how to access the Event List for open and 
closed homes, how to navigate from the Event List, and how to search for events that match 
specific criteria. 

Opening the Event List for an Open Home 

 

Step by Step: 
Opening the Event List for an Open Home 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select a stage. 
3 Click on the Options menu and select the Event List… command 

The Event List displays for the selected stage. 
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Opening the Event List for a Closed Home 

 

Step by Step: 
Opening the Event List for a Closed Home 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the Case ID, Stage ID or Case Name in the respective fields. 
3 Click on the Search button. 

The Case List displays the case that matches the search criteria. 
4 Click on the case to select it from the Case List. 
5 Click on the Options menu and select the Event List… command. 

The Event List displays for the selected case. 

Navigating from the Event List 
For task-related events, you can navigate to detail windows directly from the Event List. 

 

Step by Step: 
Navigating from the Event List 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select a stage. 
3 Click on the Options menu and select the Event List… command 

The Event List displays for the selected stage. 
4 Click on an event to select it from the Event List. 

If there are details to view, the Detail… button enables. 
5 Click on the Detail… button. 

The task-related window associated with the selected event displays. For example, if 
you select an event related to an approved Home Study, clicking on the Detail… 
button opens the formalized Home Study. 

6 To close the window, click on the Cancel button. 
The Event List displays. 
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Searching for Events 

 

Step by Step: 
Searching for Events 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
3 Click on the Options menu and select Event Search… 

The Event Search Criteria window displays. 
4 Enter search criteria in this window. To search by date, enter a date range. To 

search by event type, select from the list box by double-clicking a type. (You can 
select more than one type.) 

5 Click on the Search button. 
The Event List displays with events matching the search criteria. 

6 Click on the Close button to close the Event List. 
The Event Search Criteria window displays. 

7 Click on the Close button to close the Event Search Criteria window. 
The Assigned Workload displays. 
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Module 4: 
Retrieving Information in CONNECTIONS 

In the previous module you learned how to use CONNECTIONS to manage your Assigned 
Workload, view information about casework tasks, and record progress notes. In this module, 
you’ll learn how to use CONNECTIONS to retrieve information recorded into the system by 
CONNECTIONS users.  

State, local district, and voluntary agency staff record the results of their work with children and 
families into CONNECTIONS. This includes data regarding residents of FAD facilities; 
individuals named in Child Protective Service (CPS) reports and investigations; state level, local 
district and voluntary staff; and community resources. CONNECTIONS can be used to locate 
information related to your assignments — including the insights of staff who worked with a 
particular individual or family before you. 

By the end of this module, you will be able to: 

• determine if a person is known to CONNECTIONS and access detailed information 
about a person; 

• locate information about a case; 
• obtain information about providers of child welfare services in New York State; and 
• locate information about offices, units and other CONNECTIONS users. 
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Person Search: 
Locating Person Information in CONNECTIONS 
The CONNECTIONS database includes information about individuals associated with foster or 
adoptive homes; child protective cases; Family Services Intakes and Family Services Stages, 
and state, local district, and voluntary agencies. As a FAD caseworker, you may need to locate 
information regarding some of these individuals. Person Search is a tool that locates information 
about people in CONNECTIONS. 

Person Searches are used: 
• to determine if a person is known to CONNECTIONS; and 
• to find specific information on a person in CONNECTIONS. 

 
In the course of your work, you may need to add a family member to the Person List for a 
home/stage. Before doing so, you need to conduct a Person Search to determine whether that 
individual is already known to the CONNECTIONS database. This precaution prevents the 
creation of duplicate records for the same person in CONNECTIONS. 

Routes to the Person Search Window 
All Person Searches are conducted from the Person Search window. The Person Search 
window can be accessed via two routes, and your ability to use each route is affected by job 
function and security level. The two routes to accessing the Person Search window are: 

• from the CONNECTIONS Toolbar, and 
• from the Maintain Person task within a stage. 

 
The ability to access the Person Search window via the CONNECTIONS Toolbar is referred to 
as a “stand alone” search. This means that it is purely a search function, and cannot be used as 
a method for finding and adding/relating a person to a home/stage. FAD caseworkers will 
generally conduct Person Searches via the Maintain Person task because this is the only way 
to add or relate a person to a home/stage. 

Accessing the Person Search Window 
The directions on how to begin a “Stand Alone” Person Search and a Person Search from within 
a home/stage are detailed below. 

Step by Step: 
Opening the Person Search Window from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

Page 4-2 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Step by Step: 
Opening the Person Search Window from a Home/Stage 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select a stage. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 
5 Click on either the New or List… button. 

The Person List displays. 
6 Click on the New… button. 

The Person Search window displays. 

Person Search Methods 
The Person Search window includes a Search Type field that 
provides a means for you to select one of three methods for 
conducting a person search. The three methods are: Phonetic 
Name Search, Exact Search, and Phonetic Address Search. 
Each of three methods is discussed in the following sections. 

 
Required fields on the Person 

Search window display in yellow 
when the search type is 

selected. Fields that are not 
available for a given search 

type disable when that search 
type is selected. 

Phonetic Name Search 
Person Search defaults to the Phonetic Name search type. 
Phonetic Name search returns matches that sound similar to 
the search criteria, which usually produces the largest pool of 
results. You can use Phonetic Name search even if the name 
you are searching for is not spelled correctly. The Last name 
field is required to enable a Phonetic Name search. It is 
recommended that a first and last name be used to conduct a 
Phonetic Name Search. 

If you want to search again 
using other criteria, click on 
the Clear button to clear the 
fields prior to conducting the 

new search. 
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Exact Search 
An Exact search looks for names that match the search criteria character for character and 
space for space. You can use Exact search when you know the exact spelling of the name of 
the person for whom you are searching. This is also useful if you want to narrow the search 
results; this assumes the name was recorded accurately the first time. 

Last Name 
Street 1 
Social Security Number (SSN) 
Client Identifier Number (CIN)  “Identifiers” 

Required fields 
for an Exact Search: 

Person ID  

Only one of these five fields needs to have data entered to 
execute the search. Once information is entered into the first 
Identifier field (SSN, CIN or ID) the remaining Identifier fields 
disable. Likewise, once a non-Identifier criterion is entered, the 
other Identifiers fields disable. 

You can also filter Exact search results by using other search 
criteria; this helps you retrieve the best possible results for your 
search. When you use filters, the criteria you enter (other than 
one of the required criteria) acts as a filter to the selection 
criteria’s original pool. 

If you enter address criteria, validating the address criteria 
before executing the search increases the likelihood of 
receiving address matches, since most addresses in the system 
are validated when they are recorded. 

Phonetic Address Search 
A Phonetic Address Search returns results that sound like the 
information entered in the Address section of the Person 
Search window. A Phonetic Address Search creates a large 
pool of potential matches by including search results that are 
based on partial address information. Results can be scored 
and/or filtered, depending on how much information is entered 
in the Street 1 field, and whether information is added into 
additional address fields.  

To achieve a “scored” Phonetic Address search result, you 
must enter a minimal amount of information into the Street 1 
field. Enter no more than the street name in the Street 1 field. 
By doing this, you receive all results in the database that 
include streets of the same or similar sounding names — including results with the same/similar 
street name, but different street numbers and cities. This is the broadest Phonetic Address 
Search that can be conducted. 

 

Entering Partial Name in the 
Search Criteria does not work 

when conducting an Exact 
Search. Search Results display 

only exact matches to the 
Search Criteria. 

For example, if you enter “John” 
when attempting to search for 
“Johnston,” the search results 
will only display results where 

the last name is “John.” 

 

It is advisable to conduct a 
Phonetic Address search using 
only the street name (without a 
house number or suffix) in the 

Street 1 field.  

This reduces the likelihood of 
filtering out a valid match. 
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Entering more than just a street name in the Street 1 field (e.g. a street number and the street 
name), creates a filtered search returning a smaller and more select pool of results. The table 
below provides examples of possible Phonetic Address Search results. 

A Phonetic Address Search using the following 
criteria: 

Street 1 City 
Produces the following results: 

Willow Apple City Willow, Apple City 

Willow, Beachville 

Willow, Chippertown 

5 Willow, Apple City 

5 willow, Beachville 

63 Willow, Beachville 

The results in this example would 
continue, including all matches that are 
phonetically similar to the Street 1 
search criteria. 

5 Willow Apple City 5 Willow, Apple City 

5 Willow, Beachville 

5 Willson, Beachville 

5 Willout, Chippertown 

The results in this example would all 
have “5” in the Street 1 field. House 
numbers greatly influences the search 
results. 

Instructions on how to conduct a Phonetic Address Search are located on page 4-12. 

Choosing a Search Method 
When conducting a search, you can conduct a Phonetic Name search, Phonetic Address 
Search, or an Exact search. The system defaults to a Phonetic Name search, which returns 
records with names that sound similar to the search criteria. For example, if you conduct a 
Phonetic Name search for “Stewart,” CONNECTIONS may also return “Stuart” in the results. 
Phonetic Name search also returns common equivalencies for names (e.g., searching for 
“James” also returns matches for “Jim” and “Jimmy”). 

You can also use the Phonetic Name search type to search for all forms of hyphenated last 
names in a single search. Results for all potential hyphenated name combinations are 
important, since the person you are searching for may have had only one of the two names 
originally recorded in the system, or the hyphenated last name may originally have been 
recorded in the opposite order from the way the current search is entered. 

This feature applies to the Last name field only, not for First or Middle names. In order to use 
this feature effectively, you need to add a hyphen between the two names listed in the last 
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name search field. Without the hyphen, the system will only search on the two last names as a 
multiple last name in the order in which they appear in the search field. 

A Phonetic Name search on these 
criteria: 

First Name Last Name 

Produces a single candidate pool 
consisting of the following names: 

Mary Smith-Jones 

Mary Smith-Jones 
Mary Jones-Smith 

Mary Smith 
Mary Jones 

Mary Smith Jones 
(no hyphen) Mary Smith Jones 

Scoring and Filtering of Search Results 

Results returned on the Person Search window are either 
Scored or Filtered. 

 
CONNECTIONS calculates the 
age from DOB information. If 

you do not know the exact date 
of birth, enter an 
approximate age. 

CONNECTIONS identifies the 
type of date of birth with a code 
in the T column (DOB Type) on 
the Person List, Person Search 
Output and Person Search List. 
• E (estimated) indicates a 

DOB converted from 
Legacy that has not been 
modified. These types are 
not considered when 
scoring candidates in a 
Person Search. 

• A (approximate) indicates 
an approximate DOB. 

• A blank column indicates an 
exact DOB. 

Scoring — Scoring ranks the search results. Matches most 
similar to the search criteria display at the top of the list, 
followed by less similar matches.  

Filtering—Filtering eliminates candidates from the pool of 
results that do not exactly match search criteria.  

In a Phonetic Name search, names in the candidate pool are 
compared to the specific search information entered. Names 
phonetically further from the search criteria score lower, but are 
included in the results list. Entering additional search criteria 
during a Phonetic Name or Phonetic Address search affects 
scoring, but does not cause potential results to be eliminated 
(as in an Exact Search). 

Since Phonetic Searches have the potential to generate long 
lists of results, you may need to use the scroll bar and/or “mega 
scroll” buttons to view all results in the list. 

If you perform an Exact search, all names return which exactly 
match the search criteria. An Exact search returns matches that 
are identical to the search criteria. The ability to filter Exact 
search results by using other search criteria and the ability to 
validate the search address information using address 
validation allows users to retrieve the best possible results. 
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The table below illustrates the differences between the results achieved by the search types 
offered on the Person Search window. 

Search Results: 
Scoring vs. Filtering 

Result Description Search Type (s) 

Scoring 

Phonetic searches are “scored” by any and all 
additional search criteria entered in the Person 
Search window. 

Scoring ranks candidates in the pool of results, 
depending on how closely they match the 
search criteria. 

Phonetic Name 
Search 

 

Phonetic Address 
Search 

Filtering 

Exact Searches are “filtered” by any and all 
additional search criterion entered. 

Filtering eliminates candidates from the pool of 
results. 

Exact Search 

Use the vertical scroll bar and “mega-scroll” buttons to view all of the results. 

All Person Searches display a message on the Person Search List title bar. These messages 
provide a short description of the results. The message which displays depends on the type of 
search you conduct. 

A Phonetic Search displays the following messages: 

• Phonetic Name Results Returned: All records in the database that sound like the 
search criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 

A Phonetic Address Search displays the following messages: 

• Phonetic Address Results Returned: All records in the database that sound like 
the search criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 

An Exact Search displays the following messages: 

• Exact Results Returned: All records in the database that exactly match the search 
criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
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Deciding which search to conduct depends on the available search criteria. Here are some 
general rules of thumb to start your search: 

• When you are not sure of the proper spelling of the name of the person for whom 
you are searching, begin with a Phonetic Name search. 

• If you are certain of the exact spelling of the name you are searching for, conduct an 
Exact search. Be aware that if the person’s name was previously entered incorrectly, 
an Exact search will not return the misspelled name. Exact searches do not always 
return the best results. 

• When conducting a Phonetic Name search on a common name, it’s a good idea to 
enter as much information as possible about the person you are searching for, in 
order to better score the search criteria. 

• Selecting “M” (male) or “F” (female) in the Sex field ranks your search results, with 
records matching the selected criterion in the Sex field returning higher in the Person 
Search List, followed by records with other values in the Sex field.  

• Phonetic Name search returns “flip-flops” (also know as Reverse Name Matches)—
that is, results that reverse the first and last names (e.g., searching on “John 
Williams” returns matches such as “William Johnson”). These results appear at the 
bottom of the list in a Phonetic Name search. Flip-flop matches do not return in an 
Exact search. 

• Entering an age and/or date of birth (DOB) also affects your search results. Results 
are listed by score. The results at the top of the Person Search List are the closest 
match to the name and age/DOB you entered. CONNECTIONS considers adults’ 
ages a bit differently than children’s ages: 
o If you enter an age/DOB representing an age of 18 or older, the system returns 

matches within a ten-year range (+/- 5 years of the age/DOB entered) toward the 
top of the Person Search List. 

o If you enter an age/DOB representing an age under 18, the system returns 
matches within a six-year range (+/- 3 years of the age/DOB entered) toward the 
top of the Person Search List. 
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Conducting Person Searches 
During the life cycle of a foster or adoptive home, you may need 
to add people to the Person List for that home. Every individual 
residing in the foster or adoptive home must be added to the 
Person List, and all known information about that person must 
be documented in CONNECTIONS.  

Below are situations that require you to add individuals to the 
Person List for the home/stage: 

• Following an adoption finalization, the adopted child 
must be added to the Person List and identified as a 
“son” or “daughter;” 

• When a single foster parent marries, or a significant 
other moves into the household, the new individual 
must be added to the Person List; 

• When a foster child has his/her 18th birthday, the 
child must be added to the Person List and identified 
as a “Foster Child;” 

• When any individual (e.g., aunt, uncle, grandparent, niece, nephew) age 18 or older 
moves into the home on a temporary or permanent basis, that individual must be 
added to the Person List. 
 

 

Step by Step: 
Conducting a Person Search from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS 
Toolbar. 
The Person Search window displays with Phonetic 
Name as the default search.  

2 Click on the drop-down arrow for the Search Type 
field and select the appropriate type.  
The Phonetic Name Search Type returns the largest 
number of search results.  

3 Enter the person’s first and last name in the name 
fields. 

4 Enter the date of birth or approximate age, if known, in the DOB or Age fields. 

 

Person Search is also helpful 
for finding staff persons when 
you do not know their agency 
code. By conducting a Person 

Search in this situation, you can 
obtain the Person ID for a staff 

person, and then use the 
Person ID to conduct a Staff 
Search. You cannot obtain 
detailed information about a 

staff person in Person Search; 
use the staff person’s Person ID 

to conduct a Staff Search in 
order to retrieve detailed 

information. 

 
If you know the individual’s 

Person ID number, just use that. 
This is the most efficient way to 
find people in CONNECTIONS. 

You must conduct an Exact 
search to search by any field in 

the Identifiers section. 

5 Click on the Search button. 
CONNECTIONS performs a search based on your criteria and returns the results of 
your search in a list at the bottom of the Person Search window. Use the scroll bar to 
scroll down the list. 

6 Review the results and determine if any match is the person you are searching for. 
You may need to revise the search, depending upon your results. 
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7 If you find the person, see the tip box at right for 
information on how to review information about the 
person. 
If your search resulted in no matches, the following 
message displays on the Person Search List title 
bar: “Person Search List - No Results Returned.” 
You can try the search again with broader or 
different search parameters. 

 
If your search returns one or 

more prospective matches, you 
need to determine which, if any, 
of the matches is the person for 
whom you are searching. Here 

are some tips for doing this: 
• Review the information on 

the Person Search List. Use 
the horizontal scroll bar to 
view information to the right 
of the screen. Given clear 
differences in Dates of Birth, 
Sex, Ethnicity, Address 
information or Social 
Security number, a potential 
match may be ruled out 
right away. 

• Review information on the 
individual’s family. To do 
this, highlight a name on the 
list, click on the Options 
menu and select Case 
List…. Highlight a case and 
click on the Comp button. 
The Case Composition 
window displays a list of the 
people associated with that 
case. 

Revising Search Criteria 
1 Add any additional information you did not include in 

the original search by filling in fields like Age, Date 
of Birth (DOB), Sex, etc. 

2 Click on the Search button to perform the new 
search. 
CONNECTIONS performs a new search based on 
your revised criteria and returns the results of your 
search in a list at the bottom of the Person Search 
window. 

3 Review the search results to determine if any match 
is the person you are searching for.  
You may need to revise the search, depending upon 
your results. 

Person Searches can also be conducted from within a 
stage/FAD home. The Person Search window is the same, but 
is not accessed from the CONNECTIONS Toolbar. To learn 
how to access the Person Search window from within a 
stage/FAD home, turn to page 4-3. 

Detailed person information can also be accessed from the Case Summary window. Taking this 
route enables CONNECTIONS to verify that you have proper security rights to access detailed 
information on this case. If you do not have rights to view this information, buttons and options 
are disabled. 
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From the Person Search window (containing the results of your search), you can view detailed 
information about the person by following the steps below: 

 
The Case Summary window 

provides a means you to view 
summary information for a 

specific case. The Case Name 
displays in the title bar to 

identify the FAD home for which 
the case summary information 

applies. On this window you will 
find: Vendor and Case ID 
information, current and 

historical primary/secondary 
assignment information, 

Community District (CD NYC 
only) information.  

Information displayed on this 
window cannot be modified from 

within the window itself. 

 

Step by Step: 
Viewing Detailed Information About a 
Person 

1 On the Person Search window, select a person’s 
name from the Person Search List. 

2 Click on the Options menu and select Case List… 
The Case List displays a list of cases with which the 
individual is associated. 

3 Click on a case to select it from the list. 
4 Click on the Summary button. 

The Case Summary window displays with a list of all 
stages in the case. 
The Summary button may not be enabled if you do 
not have the appropriate security to view the 
information (e.g., Voluntary Agencies are not allowed 
access to CPS INV stage information.) 

5 Click on a stage to select it from the Case Summary 
window. 

6 Click on the Options menu and select the Person List… command. 
The Person List displays. 

7 Click on a person’s name to select it from the list. 
8 Click on the Options menu and select an enabled command. 
9 When you are done reviewing information about the person, close each window by 

clicking on either the Close or Cancel button. 
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Conducting a Phonetic Address Search 

The Street 1 field is required for a Phonetic Address Search. It remains highlighted in yellow 
until an entry is made.  

 

Step by Step: 
Conducting a Phonetic Address Search 

1 Click on the PERS button on the CONNECTIONS 
Toolbar. 
The Person Search window displays. 

 
Review the entire list of search 
results for possible matches. 

Street addresses from the same 
city will not score the same, and 
may display lower in the list of 
results. Use the scroll bar to 

proceed through the list. 
The page up/page down buttons 

( )indicate that there are 
more results on the list. Click on 
the page up/page down button, 

as applicable, to view the 
remaining search results. 

2 Click on the drop-down arrow for the Search Type 
field on the Person Search window and select 
Phonetic Address from the resulting list. 

3 Enter the street name in the Street 1 field. 
4 Enter other known information in the remaining 

address fields (e.g., City, County). 
5 Click on the Search button. 

Search results display on the Person Search List at 
the bottom of the person Search window.  

The Person Search List title bar displays a message indicating 
the results returned (see table below). The Match column on 
the Person Search List displays “ADDR,” to indicate that a 
Phonetic Address Search was conducted. 

If No Records Match If Records Do Match 

“No Results Returned” “Phonetic Address Results Returned” 
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Case Search 
Occasionally in Foster and Adoptive Home Development, it may be necessary to view 
information about a home that has been closed (see also Module 15 Maintaining Closed FAD 
Homes/Stages). Performing a Case Search enables you to 
retrieve and view historical information about a closed case. 

A Case Search is a direct route to case information when you 
know the Case ID number or the Case Name. When searching 
by Case Name, the search criteria must match the 
CONNECTIONS Case Name exactly in order for the search to 
return a match. Other names in the Case Composition for that 
case will not return. (For example, if a home is named after Angela Jarret, her husband Marty 
will be included in the Case Composition, but will not return a match if the Case Search uses 
Marty’s name as the search criteria.) 

 
Voluntary Agencies do not have 

access to Case Search 
functionality. 

The Case List provides access to the Case Composition window, the Case Summary window 
and the Event List for the case. If the case you are viewing is outside your district (and you have 
no implied role) you are only able to view the Case Composition window and the Case 
Summary window. The primary worker’s name is listed in the Primary column of the Case List. 

Conducting Case Searches 
A Case Search offers a direct route to case information when you know the Case ID number or 
Case Name. All Case Searches are conducted from the Case Search Criteria window, which is 
opened via the CASE button on the CONNECTIONS Toolbar. 

Since there is only one stage of service for foster and adoptive home development (FAD) in 
CONNECTIONS, the F/A Home Search is the preferred method for obtaining information about 
a foster home. This method of searching is described in Module 1: Responding to an Inquiry of 
this guide. 

Conducting a Case Search by Case ID Number 
The Case ID number is a unique, system-generated, 8-digit identification number. Using the 
Case ID in the search criteria is the most direct method for conducting a Case Search, since 
only one case will display in the search results on the Case List. 

 

Step by Step: 
Conducting a Case Search by Case ID Number 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the eight (8)-digit Case ID number in the Case ID field. 
3 Click on the Search button. 

The Case List displays with the only case that matches the search criteria.  
4 Select the case from the Case List window. 

Click on the Comp and/or Summary buttons to access specific case information, if 
desired.  
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Step by Step: 
Viewing Case Summary Information 

1 Select a case from the Case List. 
2 Click on the Summary button. 

The Case Summary window displays with a list of stages in the selected case. You 
can access both person- and case-specific information from here by selecting a 
stage and clicking the Options menu, then navigating from these related windows. 

3 To return to the Case List, click on the Close button. 

 

Step by Step: 
Viewing Case Composition Information 

1 Select a case from the Case List. 
2 Click on the Comp button. 

The Case Composition window displays, containing a list of all individuals in the 
case. You can compare this family composition with the list of individuals in a stage 
you’re working on to make sure the information is consistent. 

3 Click on the Close button to exit the Case Composition window. 
The Case List displays. 
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Resource Searches 
The Resource Directory is considered the “yellow pages” of CONNECTIONS. It contains 
information about providers of child welfare-related services throughout New York State. 

A Resource is an entity or individual that provides services to children and families. When a 
Resource is created in CONNECTIONS, the system automatically assigns it a unique Resource 
ID number. 

Each resource has a designated Resource Type. Six Resource Types exist in the 
CONNECTIONS Resource Directory: 

• Agency 
• Facility 
• Hotline/Helpline 

• Law Enforcement 
• Provider 
• School 

You will generally be searching for a Facility, Agency or Provider. 

When searching for a resource, selecting the appropriate Resource Type enables 
CONNECTIONS to return accurate results. For example, if you search for “Baker Hall” (which 
has a Resource Type of “Agency”), but select the Resource Type of “Law Enforcement,” 
CONNECTIONS returns no results. 

A Facility is any foster care home, adoptive home, or congregate care facility such as an 
institution, runaway shelter, or intermediate care facility. Foster and adoptive homes can be 
certified or approved by local districts and voluntary agencies. Congregate care facilities are 
licensed by state agencies such as NYS/OCFS, NYC/OMRDD and NYS/OMH. 

Providers are resources (non-foster/adoptive homes) that are 
paid for services. Local districts are responsible for recording 
and maintaining providers in the CONNECTIONS Resource 
Directory. Examples of such organizations and individuals that 
provide services for the local district are: 

 
Providers in CONNECTIONS can 

only be maintained in 
CONNECTIONS. Only the district 

displayed as the maintainer for 
that provider can maintain it. 

• Day Care 
• Housing vendors (preventive) 
• Adoption vendors 

An Agency is a legally incorporated entity that has the authority to provide child welfare and 
other related services. A local district (LDSS) or a voluntary agency are examples of an agency. 
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Conducting Resource Searches 
In the course of your casework, you may need to locate information on agencies, facilities or 
providers. The Resource Search window provides a means for you to conduct three different 
types of searches; Phonetic Name, Phonetic Address, and Exact/Directory. 

The table below describes the different search types and the results they generate. 

Search Type Description 

Phonetic Name 
(default) 

This search type returns results that sound like the information 
entered in the Resource Name field. 

Phonetic Address 

This search type returns results that sound like the information 
entered in the Address section (the Street 1 field is required to 
enable a Phonetic Address search). See the tip box and table on 
page 4-4 for more information about Phonetic Address search. 

Exact/Directory 
This search type returns results that exactly match the search 
criteria. You must enter at least two characters of a last name, 
when using this exact search. 

CONNECTIONS returns all results that match the search type and search criteria, regardless of 
which search type is selected. Also, if you are looking for a resource that matches certain 
service and/or location characteristics, you can conduct a Resource Search using the 
resource’s characteristics in the search criteria. 

 

Step by Step: 
Conducting a Phonetic Name Resource Search 

1 Click on the RSRC button on the CONNECTIONS Toolbar. 
The Resource Search Criteria window displays. 

2 If searching for a particular type of resource, click on 
the drop-down arrow for the Resource Type field 
and select from the resulting list. 

3 If searching by the name of a resource, enter 
Resource Name in the Resource Name field. If you 
are not sure of the spelling, enter the name based 
on how it sounds (phonetic name). 
The Search… button enables. You don’t need to 
enter any other search criteria, but you can do so if 
you want to narrow the search. 

4 If you know the resource’s Facility Type, click on 
the drop-down arrow for that field and select from 
the resulting list. 

5 Click on the Search… button. 
The Resource List window displays, containing the 
results of your search. Use the scroll bars to view 
information that doesn’t fit on the screen. 
If no records match the search criteria, the following message displays: 

 
From the Resource Detail 

window of an Agency listing, 
you can generate a report of 

all facilities in the agency. 
Here’s how: 

1. Click on the Options menu 
and select Resource 
Relationships. 

2. Click on the Reports menu 
and select Facilities by 
Agency/District. 

You will need to access the 
report from the RPRTS button 

on the CONNECTIONS 
Toolbar. 

“No matches were found for these search parameters.” 
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Step by Step: 
Viewing Detailed Information About a Resource 

1 From the Resource List window, click on a resource 
to select it from the list. 

2 Click on the Detail… button. 
The Resource Detail window displays. You can 
review a variety of information about the resource by 
clicking the Address…, Phone…, Facility…, Svc 
Area… and Comments… buttons on this window. 
If no records match the search criteria, the following 
message displays: 

“No matches were found for these search 
parameters.” 

3 To close the Resource Detail window, click on the 
Cancel button. 
The Resource List displays. 

4 To close the Resource List, click on the Close button. 

 

Step by Step: 
Conducting a Phonetic Address Resource Search 

 
From the Resource Detail 

window of an Agency listing, 
you can launch a report of all 

facilities in the agency. 
Here’s how: 

1. Click on the Options menu 
and select Resource 
Relationships. 

2. Click on the Reports menu 
and select Facilities by 
Agency/District. 

You will need to access the 
report from the RPRTS button 

on the CONNECTIONS 
Toolbar. 

1 Click on the RSRC button on the CONNECTIONS Toolbar. 
The Resource Search Criteria window displays.  

2 Click on the drop-down arrow for the Search Type field, and select Phonetic 
Address from the resulting list. 
The Street 1 field highlights. 

3 Enter the street name in the Street 1 field. 
4 Enter other known information in the remaining address fields (e.g., City, County). 
5 Click on the Search button. 

Search results display on the Resource List.  
If no records match the search criteria, the following message displays: 

“No matches were found for these search parameters.” 
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Staff Search 
You can use CONNECTIONS to locate contact information about staff who are also 
CONNECTIONS users. You can do a stand-alone Staff Search from the CONNECTIONS 
Toolbar or search from specific task windows when searching is part of the task, like sending a 
To-Do or reassigning a case to another worker. 

Completing a Staff Search in CONNECTIONS is similar to looking for someone in a telephone 
directory. Names are listed alphabetically and the search information you enter brings you to a 
particular point on that alphabetical list. For this reason, if you are unsure of the exact spelling of 
the staff member’s name, it is best to search on only the portion of the last name about which 
you are sure. 

To locate basic information about a staff member, conduct your search from the 
CONNECTIONS Toolbar. If you are conducting a Staff Search in order to send a To-Do, 
conduct the search from within the To-Do Detail window. 

Staff Search from the CONNECTIONS Toolbar 

 

Step by Step: 
Conducting a Staff Search from the CONNECTIONS Toolbar 

1 Click on the STAFF button on the CONNECTIONS 
Toolbar. 
The Staff Search Criteria window displays. The 
Agency field is pre-filled and the Active check box 
is selected. 

2 Enter search criteria: either the Person ID number or 
the person’s last name. (Just a portion of the last 
name is enough, unless you are searching for a 
common name in a large agency.) 

3 If you are searching for a worker outside your 
agency and you know that person’s agency code, 
type it in the Agency field and skip to 
#8 (the Agency field defaults to your own agency 
code). 

4 If you don’t know a worker’s agency code, click on 
the PERS button on the CONNECTIONS Toolbar 
and complete a Person Search (see the Person 
Search section of Module 4 of this guide). 

5 When you have completed the Person Search, write 
down the individual’s Person ID number from the 
Person Search List. 

6 Click on the Cancel button to close the Person Search window. 
The Staff Search Criteria window displays. 

 
If you are unsure how to spell 

the staff member’s name, enter 
only the portion of the name 

that you know. 

 
When you click on a staff 

member’s name in the Person 
Search List, the following 

message displays: 
“This person is an Employee. 
For more information use Staff 

Search.” 
This message helps you identify 

employees in the listing. 

7 Type the worker’s Person ID number in the Person ID field. 
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8 Click on the Search button on the Staff Search Criteria window. 
The Staff List displays with the results of your search. 

9 Click on a name to select it from the Staff List. 
10 Click on the Detail… button. 

The Staff Detail window displays. 
11 To close the Staff Detail window, click on the Cancel button. 

The Staff List displays. 
12 To close the Staff List, click on the Close button. 

The Staff Search Criteria window displays. 
13 To close the Staff Search Criteria window, click on the Close button. 
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Module 5: 
Getting Help When You Need It 

When you’re using CONNECTIONS, you may have questions that are not answered in this 
guide. There is a wealth of additional information available to you that will help you answer 
these questions. 

By the end of this module, you will be able to: 

• contact the Help Desk to get basic trouble-shooting questions answered; 
• access Online Help for assistance in accomplishing CONNECTIONS tasks; and 
• access training materials (e.g., Step-by-Step Guides, Job Aids, Tip Sheets) from the 

OCFS intranet site. 

 

The Enterprise Help Desk 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff are available 
to answer basic questions related to your equipment, or to solve problems you’re having with 
the CONNECTIONS application. If they cannot solve your problem, they will record your 
information and forward it to others who can. 

Your agency may have procedures in place for contacting the Help Desk. Check with your 
supervisor before you call. 

The Help Desk is staffed 24 hours a day, seven days a week. The telephone number is: 

1-800-NYS-1323 
(1-800-697-1323) 

If the Help Desk is not able to resolve the issue while speaking with you on the telephone, you 
will be given a ticket number to use for tracking your issue and its resolution. Keep a record of 
this number; you will need it for any follow-up conversations with the Help Desk. 



Online Help 
The development of comprehensive Online Help is a continuing goal of the Office of Children 
and Family Services. Online Help provides comprehensive information about the area of 
CONNECTIONS being used, at the time you access help. This includes definitions, information 
on how to navigate within windows, and how to best utilize functions in CONNECTIONS. 

Online Help exists in three areas of CONNECTIONS: 

• CONNECTIONS Online Help  
(located on the CONNECTIONS Toolbar); 

• Foster and Adoptive Home Record Summary (FRS) Online Help  
(located on the FRS window); and 

• Local Data Maintenance (LDM) Window Online Help  
(located on the LDM window).  

Additionally, context sensitive help is available while working in the FRS and LDM windows. 

Accessing Online Help 
The directions for accessing Online Help from the CONNECTIONS Toolbar begin below. 
Additional information is provided in the following locations: 

LDM Help—For information on accessing Online Help for the Local Data Maintenance, see 
Module 16: Maintaining Closed FAD Homes/Stages. 

FRS Help—For information on accessing Online Help for the Foster and Adoptive Home 
Record Summary (FRS), see Module 3: Managing Your Workload. 
 

 

Step by Step: 
Accessing Online Help 

1 Click on the Help menu on the CONNECTIONS Toolbar. 
Choose from the following selections: 

Contents: A table of contents for the help facility with links to major sections. 
How Do I?: Step-by-instructions to help you 
complete tasks using CONNECTIONS. 

 
You can also access a list of 
Hot Keys (keyboard shortcuts 

to specific tasks) from the 
Help Contents page. 

Window Descriptions: Descriptions of windows 
in CONNECTIONS, along with information on 
various fields. 
DSS Policy: Online OCFS policy handbooks, 
under revision. 
Help On This Window: Window description help 
for the window you are on. 
Help for Help: Instructions on how to use the help functionality. 
About CONNECTIONS: Information about the current CONNECTIONS version 
and build loaded on the hard drive of the computer. 
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2 Click on a command from the Help menu. 
The window related to your selection displays. In some cases, you will need to make 
another selection in that window to obtain instructions. At the top of each window, 
you’ll see additional buttons and menus. Use the Search button to search for 
specific information in the Help function and use the 
Back button to return to windows you’ve just visited 
in Help. The Glossary button opens a list of 
important CONNECTIONS terms and the Print 
button allows you to print Help information.  

To keep a Help topic open 
while you work in 

CONNECTIONS, click on the 
Minimize icon ( ) in the 
upper right corner of the 

window. 

3 When you’re done reviewing information in Help, 
close each Help window by clicking on the staple in 
the top left corner of the window and selecting Close 
from the resulting menu. 
The system returns to the window your were using 
when you accessed help. 
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Locating Training Materials on the Intranet 
A CONNECTIONS home page is available on the New York State OCFS intranet site, where 
you can find a variety of training-related materials. 

 

Step by Step: 
Accessing the OCFS CONNECTIONS Intranet Site 

1 From your desktop, double-click on the Internet Explorer icon. 
2 If the browser does not display the OCFS intranet site automatically, enter 

http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet site home page displays. 

3 Click on the CONNECTIONS link. 
The CONNECTIONS intranet home page (http://ocfs.state.nyenet/connect/) displays. 

4 Click on a topic to access information. 
For access to various Step-by-Step Guides and Job Aids, click on the Step-by-
Step/Job Aids/Tips link. 

5 To close Internet Explorer, click on the File menu and select Close. 

 



Module 6: 
Responding to an Inquiry 

Responding to an Inquiry 
Individuals inquire about becoming certified or approved foster parents in a variety of ways. 
They may contact a local district or voluntary agency after seeing a Public Service 
Announcement (PSA) or other advertisements in their community about the need for foster 
parents, or they may make an inquiry during a Foster Parent Recruitment presentation at their 
place of worship. 

Upon receiving an inquiry from an individual who is interested in becoming a foster parent, an 
authorizing agency operating a foster boarding home program must undertake a series of 
activities in accordance with New York State regulations. Often, there are local policies and 
procedural requirements that also must be met. These regulations, policies and procedures 
translate into tasks/activities that must be implemented by the caseworker(s) assigned to work 
with the potential applicant through the certification or approval process. 

For example, as the caseworker assigned to work on an inquiry from a person interested in 
becoming a certified or approved foster parent, State regulations require that you: 

• respond in writing to the inquiring person within 10 days of the initial contact (this 
letter is not supported in CONNECTIONS; each agency must develop its own); 

• offer an individual appointment to the person(s) or invite them to a group orientation 
on family foster care; 

 
You may want to create for 

yourself a Reminder To-Do to 
send the Orientation Letter to 

the prospective 
foster parent(s). 

• provide an application for a Home Study and 
Medical Report form to the person(s) for completion 
at the time of the initial interview or at the orientation 
meeting; and 

• provide a fingerprint notification letter and fingerprint 
cards. 
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Orientation 

The process for orienting prospective applicants who are interested in becoming certified or 
approved foster parents may vary by local district or voluntary agency, based on their own local 
procedures. However, regardless of the process, state regulations require that certain 
information be provided to prospective applicant(s) during the orientation. As the caseworker 
who is conducting an orientation meeting, it is your responsibility to inform prospective 
applicants of the application requirements, which include (but are not limited to): 

• age (prospective foster parents must be age 21 or over); 
• a Criminal History Record Check (CHRC) performed by the Division of Criminal 

Justice Services (DCJS), which requires the fingerprinting of prospective foster 
parents and members of their household ages 18 and older; 

• a joint application for married couples living in the same household; 
• a medical report for each applicant; 
• three personal references; and  
• completion of a Home Study (18 NYCRR §443.2). 

Consult New York State regulations and your supervisor for clarification and additional 
information regarding New York State Foster Boarding Home regulatory requirements. 
 

 
External Foster Boarding Home Case Record 

Throughout the process of preparing the prospective applicant for certification or approval, you need to 
maintain a record of all of the information you gather. The information/data that is obtained on the 

prospective applicant should be documented in CONNECTIONS, where possible. 

Where the CONNECTIONS system is not operative or does not support data entry, 
information must be recorded and retained in hard copy/paper format. 

This copy is referred to as the External Foster Home Case Record (00 OCFS INF-6). 

The rest of this module will instruct you on how to record inquiry information in CONNECTIONS 
for a foster or adoptive home and assign it to a caseworker.  

By the end of this module, you will be able to: 

• conduct an F/A Home Search; 
• record basic demographic information in the Home Demographics window; 
• save and assign the home/stage; and 
• open your Assigned Workload. 
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Recording the Inquiry in CONNECTIONS 
All inquiry information should be recorded in CONNECTIONS 
regardless of whether or not the home becomes fully certified or 
approved. Record inquiry information about the prospective 
foster home as early as possible.  

Maintaining the most current 
information in CONNECTIONS 
may help authorizing agencies 
with planning and recruitment 

practices. 

 
F/A Home Search is a separate 
process from Person Search. 

F/A Home Search runs a search 
of all foster homes known to 

CONNECTIONS; Person 
Search runs a search of all 

individuals known to the 
CONNECTIONS database (see 

Module 4: Retrieving 
Information in CONNECTIONS). 

F/A Home Search 
The recording of an inquiry contact begins with a search of the 
FAD database to determine if there is a history of the home in 
CONNECTIONS. This search, the F/A Home Search, is 
different from the Resource Search conducted via the RSRC 
button on the CONNECTIONS Toolbar. 

The F/A Home Search window is accessed via the Options 
menu on the CONNECTIONS Toolbar. This search filters 
through foster homes of every status level (e.g., Inquiry, 
Applicant, Accepted-Active, Closed) and returns any homes 
meeting the search criteria you entered. 

The F/A Home Search is the first step in creating a foster home 
in CONNECTIONS. This step is necessary to avoid creating a 
duplicate home in CONNECTIONS.  
 

 
Common vs. Uncommon Names 

Some names are currently misspelled in the system. To increase the likelihood of generating 
a more complete list of results, enter partial name information when conducting a search.  

For example: 
• Smith, Mary 
• Smith,Mary (no space) 
• Smith, M 
• Smith,M (no space) 

• Smyth, Mary 
• Smyth,Mary (no space) 
• Smyth, M 
• Smyth,M (no space) 

 
Search the database using all possible variations of both foster parents’ names. If your F/A 
Home Search reveals that the home exists in CONNECTIONS, you need to determine the 
status of the home. The flowchart on the next page presents the possibilities you will find. 
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F/A Home 
Search

No Results Found

Results Found 

Record 
New Inquiry 

in CONNECTIONS 
(Module 6) 

Home exists and 
is in Inquiry , Applicant , or

Accepted-Active  status 

Speak to applicant(s) about 
the home’s status with the 
other authorizing agency. 

Home exists and is
in Closed  status

Should the home 
be transferred? 

(Module 19) 

Should the home
be reopened?
(Module 17)

 

If the home exists in CONNECTIONS and is in Inquiry, Applicant or Accepted-Active status 
in another district/voluntary agency, you will need to speak with the foster parent(s). Under no 
circumstances should you recreate the home. A decision needs to be made about whether the 
home will remain with the current agency or be transferred to the agency now processing the 
inquiry (see Module 19: Transferring Foster Homes).  

If the home exists, but is in Closed status, you need to review the closing information before 
proceeding with the inquiry (see Module 17: Reopening Closed Foster Homes). 
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F/A Home Search Types 

The F/A Home Search function searches exclusively for foster homes in CONNECTIONS, 
regardless of home status (unless the worker enters search criteria in the Status field).  

Search Type Description 

Phonetic Name  
(default) 

This search type returns results that sound like the criteria entered 
in the Home Name field. All fields are enabled, but search criteria 
must be entered in the Home Name field to initiate a Phonetic 
Name search.  

If search criteria are entered in any of the Identifier fields 
(Resource ID, Case ID or Vendor ID), all other fields disable and 
the search type changes automatically to Exact. 

Phonetic Address This search type returns results that sound like the information 
entered in the Address section (the Street 1 field is required to 
enable a Phonetic Address search).  

When the Phonetic Address search type is selected, all non-
address fields disable. All address fields are enabled, but search 
criteria must be entered in the Street 1 field to initiate a Phonetic 
Address Search.  

Refer to Module 4: Retrieving Information in CONNECTIONS, for 
more information on conducting this type of search. 

This search type returns results that match the search criteria 
character for character and space for space. 

In an exact search, all fields are active. Entering search criteria in 
more than one field filters the search results. 

The search can be initiated once search criteria is entered in at 
least one of the following required fields:  

Exact Search 

• Resource ID 
• Case ID 
• Vendor ID 
• Agency ID 
• Home Name 

• Street 1 
• City 
• County 
• NYC Sub-Agency 
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Regardless of the search type chosen, F/A Home Search results will return all possible options. 
The resulting list does not have a pre-set limit. 

Follow the steps below to conduct an F/A Home Search.  

 

Step by Step: 
Conducting an F/A Home Search 

1 Click on the Options menu on the CONNECTIONS 
Toolbar and select F/A Home. 
A fly-out menu displays. 

 
Edits protect the Home Name 
field once you progress to the 
Home Demographics window. 

When entering a home name for 
an F/A Home Search, use the 

following method: 
Smith,Mary  

Do not place a space between 
the first and last names.  

 
On occasion a worker may 

create a FAD Home not 
realizing the home already 

exists in CONNECTIONS. The 
result is a duplicate home. 
This can lead to duplicate 
homes being reopened or 

reactivated. 
Refer to Module 15: 

The Close Home Task in 
CONNECTIONS to close 

duplicate homes. 

2 Click on F/A Home Search… from the fly-out menu. 
The F/A Home Search window displays. 

3 Click on the Clear button (or highlight the Agency 
Code and press the Delete key) to delete the 
Agency Code and perform a statewide search. 
Once the Agency Code field is empty, the Home 
Name field highlights in yellow.  

4 Enter the name of the inquiring family in the Home 
Name field in the following format (Last Name,First 
Name). 

5 Click on the Search… button. 
The F/A Home List displays. If the search does not 
return a match, the window is blank and displays the 
following message: 
“The criteria entered results in no information being 
returned.” 
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The F/A Home List 
The F/A Home List displays the results of the F/A Home Search and includes the following 
information for each FAD home/stage returned: 

• Resource Name • VID (Vendor ID) • Setting 
• Status • Sub-Agency (NYC only) • Ethnicity 
• Race • Address 1 • City 
• County • State • CD (NYC only) 
• Zip Code • Worker Name • Case ID 
• Worker Phone  • Ext.  

 

To review information about a FAD Home/Stage on the F/A Home List, you can select the 
home/stage and click on the Home Demographics button (see Module 17: Reopening Closed 
Homes for more information). 

If in your home search you do not find a result, you must click on the New button at the bottom 
of the F/A Home List to generate the Home Demographics – New window.  
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The Home Demographics Window 

 
Home demographic information 

can now be viewed on the 
Home Demographics tab of 

the Foster and Adoptive Home 
Record Summary (FRS). 

The Home Demographics window is used to record basic 
demographic information about the initial inquiry. Information 
you receive from the prospective foster or adoptive parent(s) 
must be recorded on the Home Demographics window.  

To help streamline the FAD Home recording process, a 
significant amount of information is recorded on the Home 
Demographics – New window. The ability to record this much 
data on one window reduces the number of times you may 
have to move in and out of windows to enter information 

See Module 3: Managing Your 
Workload to find out how to 
access the FRS and review 

home/stage information. The table on the following page summarizes the fields located 
on the Home Demographics – New window.  This information can be 

modified via the Maintain Non-
Licensing task. Definitions for field names can be found in Appendix A: FAD 

Glossary. Items in the glossary are arranged in alphabetical 
order. 

 

All information known about the 
home should be recorded when 

you open the Home 
Demographics – New window.  
(See “Completing the Home 

Demographics-New Window” on 
page 6-13 for step-by-step 

instructions on how to 
complete the window.) 

For information on how to 
update this window once a 
home has been saved and 

assigned to a primary 
caseworker, refer to 

Module 12: 
Maintaining FAD Homes 

in CONNECTIONS. 

An F/A Home Search that 
produces no results indicates 
the prospective foster parents 
have never been recorded (in 
CONNECTIONS) as providing 
foster care in New York State. 
To continue processing a new 
inquiry, we clicked on the New 

button (on the F/A Home List) to 
generate the Home 

Demographics window.  
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Fields to be Completed on the  
Home Demographics Window 

Upper Window 

Home Name Legal Name 

Setting † Auth. Agency 
† Sub-Agency (A66 Homes in NYC only) Respite 

Inquiry Source † Status 

Religion Language 

Marital Ethnicity 

Hispanic or Latino Origin Race 

Primary Address Section 

Street Zip 

PO Bx/Apt Use as Business (check box) 

City Vendor ID 

County Sch District 
‡CD (NYC Only) Validate Button 

State Address… Button 

Primary Phone Section 

Number 

Extension 

Phone… button 
† Indicates fields that are system-filled with applicable information once the home is saved and 

assigned. 
‡ The Community Districts (CD’s) for NYC homes are system-filled once the Address of the 

home is validated. 

CONNECTIONS Step-by-Step Guide: Page 6-9 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



Home Name 

This field is pre-filled with the information you entered in the 
Home Name field of the F/A Home Search window. Generally, 
the foster or adoptive mother’s name is used for the Resource 
Name, not a combination of both parents’ names. For homes 
without a foster or adoptive mother, the primary caregiver’s 
name should be used as the Resource Name.  

If the Home Name field is not completed in the proper format 
(Smith,Mary), CONNECTIONS will not allow you to save and 
assign the FAD Home/Stage. See the tip box to the right for 
more information. 

Legal Name 

Located below the Home Name, this field indicates the official 
name of the facility. A Legal Name must be recorded to identify 
Foster and Adoptive homes and Congregate Care facilities. This name may or may not be the 
same as the Resource Name. If no legal name is entered, CONNECTIONS will automatically fill 
this field with the Home Name once the home is Saved and Assigned. 

OCFS recommends that you use this field to record both Foster Parent names in the following 
format: 

“Smith,Joan/Smith,John” 

Setting 

The Setting that the foster home will have must be identified on 
this window. The setting is just one of the elements that 
determines the type and amount of funding the home receives. 
Available Settings are Congregate, Adoptive and Foster 
Home. The Adoptive setting is used only for FAD homes that 
are receiving Adoption Subsidies (see Module 21: Adoptive 
Homes). 

FAD homes identified with the setting of Foster Home receive 
foster care payments and are further classified by Level of Care (also known as Facility Type). 
Foster Home Facility Type choices are: Certified Foster Home, Foster/Adoptive Home and 
Approved Relative Home. Facility Type will be discussed further when we cover the 
certification and approval process in Module 8: Maintaining Licensing Information. 

 
If information in the Home 

Name field is incorrect, click on 
the Cancel button and return to 
the F/A Home Search window. 

You will want to correct the 
name/name format in this field  

and, 
you must conduct your F/A 

Home Search on the 
appropriate home name to be 
sure you do not duplicate the 

FAD home/stage. 

 
Congregate Care facilities are 
not addressed in this guide, 

since they are created by OCFS 
staff, not by local districts or 

voluntary agencies. 

Respite 

Select either “Accepted” or “Not Accepted” in this field to indicate whether or not the prospective 
foster home will accept temporary foster care placements for the purpose of providing respite 
services to other foster parent(s).  
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Respite care and services means the provision of brief and temporary care and supervision of children for 
the purpose of relieving parents or foster parents of the care of such children or foster children when the 
family or foster family needs immediate relief in order to be able to maintain or restore family functioning 

or to provide relief for foster parents from the stress of providing care for a severely handicapped or 
emotionally disturbed foster child or for a foster child with a chronic or recurring illness 

[18 NYCRR §435(d)]. 

Status 

FAD homes progress through various status types in CONNECTIONS. A status type indicates 
the state the home is in, in relation to its progression through the certification or approval 
process. Some statuses (such as “Pending Emergency” for Emergency Homes) are used only 
with certain types of foster or adoptive homes.  

The Home Demographics-New window has a pre-filled status of “Inquiry.” This is the entry point 
to the system for recording information on foster home applicants.  

The statuses are listed below. Refer to “Appendix A: FAD CONNECTIONS Glossary” for the 
definitions of each status.  

• Inquiry • Applicant 
• Pending Acceptance • Pending Emergency 
• Emergency • Accepted-Active 
• Pending Closure • Closure 
• Extended Accepted-Active • Extended Emergency 

 

Language 

Select the appropriate choice to indicate the language used in the prospective foster home. You 
can only select one language; for bilingual households, select “Multiple” or the primary 
language. 
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Race and Ethnicity 

CONNECTIONS allows you to record multiple races and clearly define ethnicity categories for 
the FAD home/stage and for individuals residing in the foster home.  

In the Race (or Race Sub-Group) field, you can select from any of the following choices: 

Race (or Race Sub-Group) 
Black or African American 

Caribbean 
Haitian 
Native African 
Other – Black or African American 

Alaskan Native 
American Indian 
Asian 

Chinese 
Indian 
Japanese 
Korean 
Other Asian 

Pacific Islander/Native Hawaiian PI 
White 

 

In the Ethnicity field, you are provided with two choices to identify the family: Hispanic or Latino 
origin OR non-Hispanic/Latino origin. If you select Hispanic or Latino origin, identify one or more 
of the following ethnic backgrounds: 

• Central American • Dominican • Puerto Rican 
• Caribbean • Mexican • South American 
• Cuban • North American • Other 
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Primary Address and Primary Phone Section 

A primary address, primary phone number, and business address must be recorded for every 
FAD home/stage in CONNECTIONS. The primary address 
indicates the physical location of the foster home, and the 
business address is the location where payments are mailed. 
These two addresses are usually identical. 

CONNECTIONS will not allow the Home Demographics –New 
window to be saved if primary address and phone information 
is not recorded; this information can be recorded directly on the 
window. Once the primary address and phone numbers are 
recorded, you may select the Use as Business check box if 
the physical location of the home and the business address are 
the same. If the two addresses are not the same, click on the 
Address button to record the business address.” Additional 
phone information can be recorded by clicking on the Phone 
button to access the Resource Phone Detail window. 

Once address and phone information is recorded for the FAD 
home/stage, this information is used to streamline the process 
of entering the Person Information you record for each individual residing in the home. The 
primary address and phone information you enter in the Home Demographic-New window is 
used to pre-fill the address and phone information for each new individual added to the system. 
Refer to Module 7: Maintaining Person Information, for more information on this default feature. 

 

The business address must be 
entered, including the Vendor ID 
number, prior to submitting the 

home for certification or 
approval.  

When you submit the home for 
initial certification or approval, 

CONNECTIONS will alert you if 
the Vendor ID is missing. (See 

Module 8: Maintaining Licensing 
Information). 

Completing the Home Demographics Window 

 
 

Step by Step: 
Completing the Home Demographics-New 
Window 

1 On the Home Demographics-New window, record 
all known information in the appropriate fields, 
except the Primary Address section (see below).  
See the table in Module 6: Responding to an 
Inquiry, for a table of fields to complete.  

Where am I? 

Toolbar > Options > F/A Home 
> F/A Home Search > Search 

button > New button 

 
Once you have saved the Home 

Demographics window, the 
information can be reviewed in 
the Foster and Adoptive Home 
Record Summary (FRS). Refer 

to Module 3: Managing Your 
Workload for more information. 

2 To record the Primary Address (the physical home 
address) section, begin by entering information in 
the following fields: Street, PO Bx/Apt, City, 
County, State, Sch Dist, Zip. 

3 If the business address is the same as the physical 
location you have just recorded, click on the Use as 
Business check box. 
A checkmark displays in the check box. 
If the addresses are not the same, record the 
business address via the Address button (see 
Recording Additional Address information on page 
6-15). 
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4 Click on the Validate button. 
The address validation window displays. 

5 Check the accuracy of the address listed in the 
address validation window (see the tip box below). 

6 Click on the Yes button to accept the validated 
address.  
The Resource Address Detail window displays.  

7 Enter information in the Number and Extension 
fields of the Primary Phone section. 

8 Review the window before clicking on the Save and 
Assign button (see page 6-16). 

 
Validation of Addresses Recorded in CONNECTIONS 

CONNECTIONS launches a search to verify the validity of the address and format it to comply with U.S. 
Postal Service standards. When you click on the Validate or Add button, the address validation window 
displays with the validated address and a message asking if you would like to replace the address you 

recorded with the validated address. 

Compare the address you have recorded to the address provided by the address validation process. 

If the address provided does not match your entry, verify the address with the prospective foster or 
adoptive parent. If the address you have is correct, do not accept the replacement. If a message displays 
stating that the address is invalid, it may be that the address you recorded is new and has not yet been 
recorded in the Postal Service database. It is also possible that the address is invalid and needs to be 

verified and corrected. 

Note: 
If an address is rejected, check to see if you have the correct ZIP code and County. 

 
Address validation accepts a 
PO Box address as long as a 

number symbol (#) is recorded 
on the PO Box field (e.g., 

#203). Recording anything other 
than 

a number in the PO Box field 
(e.g., PO Box 203, or Apt.) 
creates problems with the 

address validation process. 
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Recording Additional Address and Phone Information 

 

Step by Step: 
Recording Additional Address information 

1 On the Home Demographics- New window, click on 
the Address…button. 
The Resource Address Detail window displays. 

 

Where am I? 

Toolbar > Options > F/A Home 
> F/A Home Search > Search 

button > New button 

 

Only use this method to record 
Addresses and Phone Numbers 

that are different from the 
Primary Address and Phone 
Number. For example, this 

method can be used to record 
information about where a foster 

parent works. 

If you recorded a business 
address on the Home 

Demographics window, the 
following message displays at 

the bottom of the Resource 
Address Detail window when 

recording a business address: 

“Perform Business Address 
updates on the Home 

Demographics window.” 

2 Click on the Type field and select the appropriate 
type for the address you are adding. 
Select Business if you are recording a business 
address that is different from the primary address; 
this is where payments will be mailed. 

3 Record the street address. 
4 Record a PO Box number, if appropriate. 
5 Record the city. 
6 Record the ZIP code. 
7 Click on the drop-down arrow for the County field 

and select the appropriate county (New York City 
counties/boroughs appear at the end of the list). 

8 Use the Comments field to record additional 
narrative.  

9 After recording all the address information in the 
Resource Address Detail window, click on the 
Validate button.  
The address validation window displays. 

10 Check the accuracy of the address listed in the 
address validation window. 

11 Click on the Yes button to accept the validated 
address.  
The Resource Address Detail window displays. 

12 Click on the Add button to transfer the information 
to the list section of this window. 

13 Verify that the information is correct. 
14 Click on the OK button. 

The Home Demographics window displays. 
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Step by Step: 
Recording Additional Phone Number Information 

1 Click on the Phone button on the Home Demographics- New window. 
The Resource Phone Detail window displays. 

 

Where am I? 

Toolbar > Options > F/A Home 
> F/A Home Search > Search 

button > New button 

 

Only use this method to record 
Addresses and Phone Numbers 

that are different from the 
Primary Address and Phone 
Number. For example, this 

method can be used to record 
information about where a foster 

parent works. 

2 Click on the drop-down arrow for the Phone Type 
field and select a type (do not select “Primary,” as 
the Primary phone number is recorded on the Home 
Demographics window). 
If you select Primary, the following message 
displays in the footer of the window:  
“Perform Primary phone updates on the Home 
Demographics window.” 

3 Record the telephone number in the Number field. 
4 If there is an extension number, record it in the 

Extension field. 
5 The Comments field can be used to record 

additional information, such as the best time to call 
or whether or not there is an answering machine.  

6 Click on the Add button.  
The phone information is added to the list section at 
the top of the Resource Phone Detail window. 

7 Verify that the information added to the list section is 
accurate. 

8 Click on the OK button. 
The Home Demographics window displays. 

 

Save and Assign the Inquiry 
Once you have completed the Home Demographics- New window and, if necessary, the related 
Resource Address Detail and Resource Phone Detail windows, you need to Save and Assign 
the Home Demographics-New window.  

Save and Assign is unique to the CONNECTIONS application. Completing this function saves 
the information in CONNECTIONS and assigns the responsibility of the ongoing development of 
the foster or adoptive home to a primary worker. Saving and assigning establishes the home as 
a prospective resource in CONNECTIONS and opens a stage on the Assigned Workload of 
the person(s) receiving the assignment.  

The Assign Window 

Selecting the Save and Assign command opens the Assign window. The purpose of 
completing this window is to identify who will have primary and, if applicable, secondary 
responsibility for completing the home certification or approval process. 

This window is divided into two list sections. The top section displays an Available Staff list. This 
is a listing of staff members in your unit to whom you might assign work. The bottom section 
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displays the Assignments that have been made regarding the selected stage. CONNECTIONS 
assigns you as the primary worker, unless you assign this responsibility to another caseworker.  

Once an assignment is made, this window will contain information regarding the local district or 
voluntary agency responsible for completing the home certification or approval process. The 
worker’s name and agency code are found in the text for assignment events.  

The role of Case Manager does not apply to FAD stages. 

 

Step by Step: 
Saving and Assigning Initial Inquiry Information 

1 Click on the File menu on the Home Demographics- 
New window and select Save and Assign. 
-OR- 
Click on the Save and Assign button. 
The Assign window displays. 

2 Click on the line of the staff person to be assigned 
from the Available Staff list at the top of the 
window. 

3 Click on the Primary button to assign that worker as 
the primary worker for the home. 

4 Click on the Save button to save the primary worker’s assignment. 

There are times when the staff member to whom you are trying to assign the stage may not be 
included on your Available Staff list. For example, you may work in a FAD Intake Unit and need 
to assign the stage to a supervisor in another unit, such as the Specialized Foster Care Unit.  

The directions below will assist you in searching for a staff member within your own agency who 
is not on your Available Staff list. 

 

Step by Step: 
Adding Staff to the Available Staff List 
(within the same agency) 

 

Where am I? 

Toolbar > Options > F/A Home 
> F/A Home Search > Search 

button > New button 

 

Where am I? 

Toolbar > Options > F/A Home 
> F/A Home Search > Search 

button > New button > Save and 
Assign button 

1 Click on the Options menu on the Assign window 
and select Staff Search Criteria.  
The Staff Search Criteria window displays. 

2 Enter the first and last names of the staff person you 
are searching for. 
The Agency field is pre-filled with your agency code. 

3 Click on the Search button.  
The Staff List displays, containing the search 
results. 
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4 Select the name of the staff person whom you want 
to assign and click on the OK button.  
The Assign window displays. The information for the 
person you selected is now included and selected 
on the Available Staff list. 

 
Homes in Inquiry status should 
not be assigned outside of your 
agency, unless specified by an 

agreement between the two 
agencies. 

5 Click on the Primary button. 
6 Click on the Save button. 

Page 6-18 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Module 7: 
Maintaining Person Information 

This module focuses on the many ways that CONNECTIONS supports documentation of person 
information. Much of the information you record in this module will come from the completed 
foster parent application. 

By the end of this module, you will be able to: 

• conduct a Person Search from within a stage in CONNECTIONS; 
• view and interpret the results of a Person Search; 
• add a new person to CONNECTIONS; 
• relate a person (who is known to CONNECTIONS) to a stage; 
• record address and telephone information for each member of the home; 
• copy and paste address and telephone information; 
• record information on the Person Detail FA window (e.g., CHRC results); 
• record information about trainings completed by foster or adoptive parents; and 
• add A.K.A. names for individuals; and 
• view person information in the FRS. 
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The Maintain Person Task 
The Maintain Person task is used to document demographic, training and other required 
information/data on the prospective foster parent(s) and each person who currently resides in 
the home. This information can be recorded when the home is in Inquiry or Applicant status—
upon receipt of a completed application from the prospective foster parent(s) or at any time 
during the course of certifying or approving the home. 

 

Complete and accurate information is vital to protecting the health and safety of children living in 
foster care settings. New York State Foster Home Certification and Approval regulations require 
you to obtain and document specific information about the prospective foster parent(s) and each 
person who will be residing in the home if the home is to be certified or approved for the 
placement of foster children. The information you gather and record in CONNECTIONS and in 
the External Foster Home Case Record will support your (and your supervisor’s) decision to 
either accept or deny an individual’s application for a Home Study or home certification or 
approval. It also supports New York State OCFS’s ability to meet federal child welfare data 
reporting requirements. 
There are a number of ways in which caseworkers obtain this information: 

• foster parent application—used to elicit information including, but not limited to, age, sex, 
health, occupation, income, ethnicity, religion, physical functioning, marital status, 
employment status, employment history, names of individuals residing in the home, prior 
foster care or adoption history; 

• physician’s report; 
• criminal attestation; 
• personal references, personal interviews, home visits, home site assessments, results of 

foster parent training; and 

• external record checks—State Central Register (SCR) Database Check, Criminal History 
Record Check (CHRC). 

 
Selecting the Maintain Person task and clicking the List button displays the Person List. As 
you create FAD homes, you will use this list to identify each person residing in the foster home 
(excluding foster children under the age of 18 years). CONNECTIONS requires to you conduct 
a Person Search to begin this process, in order to avoid duplicating individuals that already exist 
in the system.  

Page 7-2 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Person Search 
The CONNECTIONS database contains information on foster care providers, as well as 
individuals associated with child protective cases, Family Services Intake and Family Services 
Stages, state and local district staff, and voluntary agency personnel. Person Search is a tool 
for locating information about persons in CONNECTIONS. 

Person Search is used: 

• to find out if an individual is known to CONNECTIONS; and 
• to find specific information about a person in CONNECTIONS. 

 
An individual may have been recorded in CONNECTIONS if he 
or she is currently or has previously been:  

• an employee of a state, district or voluntary agency 
that uses CONNECTIONS; 

Searching for an individual in 
the CONNECTIONS database 
is separate from completing the 

• a subject or other person named on a Child 
Protective Service report; or 

SCR database check. 
Conducting “good” searches 
and relating when necessary • a foster or adoptive parent, or an individual residing 

in a foster or adoptive home, or will significantly reduce data 
integrity problems. 

• Family Services Intake and/or Family Services 
Stages. 

When adding a person to a home/stage that has been assigned to you, you need to conduct a 
Person Search to determine whether that individual has a history in CONNECTIONS. 
CONNECTIONS requires you to conduct a search prior to adding an individual. This 
functionality is intended to preserve data integrity by preventing the creation of duplicate 
records. 

Search Types 
Once you access the Person Search window, you will first need 
to decide which type of a search to conduct. There are three 
options in the Search Type list box:  

Refer to Module 4: Retrieving 
• Phonetic Name (default) Information in CONNECTIONS 

for more details on conducting • Phonetic Address 
Person Searches. 

• Exact 
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Each Search Type is described in the table below: 

Search Type Description 
This search type returns results that sound like the criteria entered in the 
Home Name field. All fields are enabled, but search criteria must be 
entered in the Last Name field to initiate a Phonetic Name search.  

Phonetic Name  
(default) 

If search criteria is entered in any of the Identifier fields (Social Security 
Number, CIN, and Person ID), all other fields disable and the search type 
changes automatically to Exact. 
This search type returns results that sound like the information entered in 
the Address section (the Street 1 field is required to enable a Phonetic 
Address search).  

Phonetic Address 

When the Phonetic Address search type is selected, all non-address fields 
disable. All address fields are enabled, but search criteria must be entered 
in the Street 1 field to initiate a Phonetic Address Search.  
Turn to Phonetic Address Search in Module 4: Retrieving Information in 
CONNECTIONS, for more information on conducting this type of search. 
This search type returns results that match the search criteria character for 
character and space for space.  

Exact Search 

When this search type is selected, all fields enable. The Search button 
becomes enabled once search criteria is entered in a required field (e.g., 
Person ID field). 

 

The Phonetic Name Search is usually the preferred Person 
Search method, since it returns the largest pool of results. A 
Phonetic Name search searches the entire database for names 
that sound similar to the search criteria you enter. Ten results 
can be seen on the Person Search List at a time without 
scrolling. To view the remaining results, use the scroll bar. The 
mega-scroll buttons (which look like dog-eared pages and are 
located at the juncture of the horizontal and vertical scroll bars) 
can be used to view subsequent pages of results.  

 

Selecting Person Search List 
from the Forms menu on the 
Person Search window allows 

you to print Person Search 

If you conduct a Person Search on an individual with a common 
name, you can achieve better results by entering more search criteria (e.g., middle initial), if 
known, then performing the search again. As a result, the persons most closely matching all of 
your entered criteria display at the top of the Person Search List, while not excluding any 
potential matches. Exact searches also search the entire database and return all results that 
exactly match the search criteria.  

results.  
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F/A Home and Person Searches: 

Two distinct areas of the CONNECTIONS database 

“I already recorded the person’s name when I created the home. Why do I have to put in the 
same information again?” 

There are two distinct areas of the database in CONNECTIONS, which directly impact the 
development of FAD homes/facilities. The first is the F/A Home Search area of the database, 
which contains all homes and facilities that have been opened over the last 20 years. The second 
is the Person Search area of the database, which contains all people who are known to the 
CONNECTIONS system, including those known to the State Central Register (SCR), stage 
members in Family Services Intake stages and Family Services Stages, and people who provide 
care to children.  

For all people (with the exception of foster children under the age of 18) living in the prospective 
foster or adoptive home, you must conduct a Person Search to support the accuracy of 
information in CONNECTIONS.  

All FAD homes/stages must be created or reopened using the F/A Home Search functionality.  

 

Step by Step: 
Conducting a Person Search from Within a Stage 

 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on the appropriate FAD home/stage to select 
it. 
The Tasks… button enables. 

 3 Click on the Tasks… button. 
The Task List displays. For directions on how to 

conduct a Phonetic Address 
4 Click on the Maintain Person task. Search see Module 4: 

5 Click on the List… button at the bottom of the Task 
List. 
The Person List displays. If you have yet to add any people in this home, the list is 
empty. 

Retrieving Information in 
CONNECTIONS. 

6 Click on the New… button at the bottom of the Person List. 
The Person Search window displays. 

7 Enter search criteria in the appropriate fields in the Person Search window. 
8 Click on the Search button in the bottom left corner of the Person Search window. 

CONNECTIONS performs the search and returns results which match the search 
criteria. Search results display in the Person Search List at the bottom of the Person 
Search window. 
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Checking the Results of a Person Search 
There are two possible outcomes of a person search: the 
search criteria you enter does not match any individuals in the 
system, or the search returns all matches. 

 
If the search criteria you enter does not return a match (and you 
have checked all variations of that person’s name), begin the 
process of Adding a Person to the home. (See page 7-

For additional information about 
Person Search results, refer to 

Module 4: Retrieving 7.) 

If the search returns a large number of matches, entering 
additional search criteria (e.g., sex, DOB) returns better search results. 

Information in CONNECTIONS. 

If you find that an individual is already known to CONNECTIONS, you must determine how that 
person came to be known to CONNECTIONS. Steps in this determination process may include 
(but are not limited to): 

• viewing the Person Detail window;  
• viewing the Case List and Case Summary for the potential match; 
• contacting the prospective foster or adoptive parent; and 
• awaiting SCR Database Check results. 

 

Step by Step: 
Viewing the Results of a Person Search 

1 In the Person Search List, select the potentially 
matching name for which you want to view 
information. 

2 Click on the Options menu on the Person Search 
window. 
Select each of the following commands to view 
information necessary in determining if the match is, 
in fact, the person you are trying to add to the 
home/stage: Address List/Detail…, Phone 
List/Detail… and Case List… 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button > Maintain Person 
task > List button > New button 

If you determine that there are no matches, add this new 
person to CONNECTIONS, using the steps detailed in the next section. If there is a match, 
proceed with “Person Relate” on page 7-

> Search button 

10. 
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Adding a New Person to CONNECTIONS 
Once you have conducted a Person Search and learned that 
the person is not known to CONNECTIONS, you are ready to 
add the person. Biological children of the foster parent need to 
be recorded as daughter or son. 

 
 Completing this task successfully adds the individual to the FAD 

stage (i.e., to the foster or adoptive home) and to the 
CONNECTIONS database to be available for future searches. 

For a relative/kinship home, the 
relative caretaker still is 

identified with the “Foster 
Parent” Rel/Int code, not the Prospective foster or adoptive parents must be recorded with a 

Rel/Int code of “Foster Parent.” If you do not select this Rel/Int 
code, you will not be able to progress the home to Accepted 
Active status. The following message displays if this 
identification has not been made when you attempt to submit 
the home for initial certification or approval: 

actual familial relationship to the 
foster child (e.g., “Aunt”). 

Otherwise, you will not be able 
to progress the home to 

Accepted Active status. You 
also need this in order to have 
the relative caretaker’s name “The home must have at least one foster parent identified.” 

appear on the Approval Letter. 
Recording a Rel/Int code of “Foster Parent” adds their names to 
the F/A Home Certificate and/or the Approval Letter.  

Before we add a person to CONNECTIONS, let’s take a closer look at the Person Detail – NEW 
window. This window contains a lot of information and should be completed correctly and with 
as much information as possible.  

The Person Detail – New Window 
Following a Person Search that does not produce a match, you will be ready to add a new 
person to the Person List. To do this, you will click on the New button of the Person Search 
window to generate the Person Detail – New window. Think of this window as being similar to a 
blank form you complete for each person recorded in CONNECTIONS. 

The tables below illustrate the fields located in each section of the Person Detail window. 
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Fields to be Completed on the Person Detail – New Window 

Top of Window 
†  Middle Initial First Name 
†  Sfx: (Suffix) Last Name 

†Status 
 

Current Stage 
†  †  Type Role 

Rel/Int (Relation/Interest) 
 

Demographics 
Sex Language 

Marital Religion 
DOB Approx DOB (check box) 

†  DOD Age (once DOB is recorded) 
Approx DOD (check box) Reason 

Ethnicity Race 
Hispanic or Latino Origin List Box (see page 7- *) 9

 
Primary Address Section 

†  †  Street State 
†  †  PO Box/Apt Zip 

†  †  City Type 
†  Validate button County 

†  Address… button CD (NYC only) 
 

Primary Phone Section 
†  Number 

†  Extension 
Phone… button 

† Indicates fields that are pre-filled by CONNECTIONS. 

As noted earlier in this module, much of the information you record on this window comes from 
the Foster Parent Application. You will also want to discuss race and ethnicity with applicants to 
make sure you are recording an accurate reflection of their heritage.  

As you record information you will notice that some fields are pre-filled by CONNECTIONS. For 
example, the Type field defaults to PRN (principal) for new individuals added to a home/stage. 
Other fields pre-filled by CONNECTIONS are noted in the above tables with the † symbol. 

Some fields are required and will affect your ability to save information on the window. 
Examples include the Marital Status, DOB, Ethnicity, Gender, Religion and Language fields. 
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Race Fields 

The Race (or Race Sub-Group) field can be filled in with any of the following choices: 

Race (or Race Sub-Group) 
Black or African American 

Caribbean 
Haitian 
Native African 
Other – Black or African American 

Alaskan Native 
American Indian 
Asian 

Chinese 
Indian 
Japanese 
Korean 
Other Asian 

Pacific Islander/Native Hawaiian PI 
White 

Ethnicity Field 

In the Ethnicity field, you are provided with two choices to identify the person: Hispanic or 
Latino origin OR non-Hispanic/Latino origin. If you select Hispanic or Latino origin, identify one 
or more of the following ethnic backgrounds: 

• Central American • Dominican • Puerto Rican 
• Caribbean • Mexican • South American 
• Cuban • North American • Other 

Address and Phone Information 

As you look at the Person Detail – New window, you will notice that the Primary Address 
and Primary Phone information has been pre-filled by CONNECTIONS. These fields will, by 
default, contain the same information recorded in matching sections of the Home 
Demographics window. An exception is when relating a person found in an open CPS case, 
and the person’s primary address and phone number are different from those recently 
entered on the Home Demographics window. CONNECTIONS alerts you to this situation by 
displaying the following message: 

“Addr/Ph does not match Home Addr/Ph. Contact worker(s) of open stage(s).” 

The Options Menu 

The Options menu on the Person Detail – New window includes some commands that will help 
you find information without exiting the Person Detail window: 

• A.K.A. Name List/Detail • Person Identifiers 
• Address List/Detail • Phone List/Detail 

CONNECTIONS Step-by-Step Guide: Page 7-9 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



Page 7-10 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 

Adding a Person to the FAD Home/Stage 

 

Step by Step: 
Adding a New Person to the FAD Home/Stage 

1 Click on the New button at the bottom of the Person 
Search window. 
The Person Detail - New window displays. 

2 Enter all known demographic information into the 
appropriate fields (e.g., Sex, Marital Status, DOB), 
selecting from the drop-down lists where necessary. 

3 Click on the drop-down arrow for the Rel/Int field 
and select the individual’s relationship to the home. 
Your selection identifies whether the person is a 
foster child over the age of 18, foster parent, 
biological child, etc. 

4 Click on the Save button.  
The Person List displays. The newly added person 
now appears on the Person List. Other information 
for that person may now be recorded (see 
“Recording Person Information” on page 7-12). 

Person Relate 
There is always the possibility that your Person Search may 
reveal that the individual you searched for is known to 
CONNECTIONS.  

If, after reviewing all available information, you determine that there is a match to the search 
criteria entered, you must Relate that individual. When an individual is “related” to a FAD 
home/stage, the “historical” person is selected in the Person Search and added to the current 
home/stage. 

Correct use of the Relate function avoids duplication of records 
and maintains the integrity of the CONNECTIONS database. 

To minimize the occurrence of misrelates, CONNECTIONS 
generates warnings if the following conditions are present when 
you attempt to relate two people in the system: 

• If there is a DOB/age discrepancy of more than 5 
years between the persons; 

• If there is a gender mismatch between the persons; 
• If there is a county code mismatch between the 

persons; and  
• If the relationship/interest is Foster Parent (FP) for 

one person and not the other. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button > Maintain Person 
task > List button > New button 

> Search button 

 
Information that you record on 
the Person Detail window is 

transferred to other documents 
in CONNECTIONS and may be 

“frozen” there once the 
document is saved. Therefore, it 

is important to record all 
available information as 
accurately as possible. 

 
You must make every effort to 

acquire as much information as 
possible about the individual 

before proceeding. Thoroughly 
review information in 

CONNECTIONS, speak to the 
foster parent and consult with 

your supervisor prior to making 
a decision to use the Relate 

function. 
You should never relate an 

Employee Person ID to  
any stage. 
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If an individual is related incorrectly, you must remove the person by clicking on the Options 
menu on the Person List window and selecting the Remove Person-Added in Error command. 
 

 

Step by Step: 
Relating a Person to a FAD Stage 

1 On the Person Search window, click on the name of 
the person you are going to relate from the Person 
Search List. 

2 Click on the Relate… button. 
The Person Detail window displays. 

3 Click on the drop-down arrow for the Rel/Int field and 
select the relationship that the individual has to this 
stage of service. 
Complete any required fields. 

4 Click on the Save button.  
The related person displays on the Person List. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button > Maintain Person 
task > List button > New button 

> Search button 

 
If an individual is incorrectly 
related, you can delete that 
individual from the stage by 
selecting Remove Person – 

Added in Error on the Options 
menu of the Person List.  

See Module 12 for more details. 



Recording Person Information 
In the course of foster home certification or approval, you will need to organize information you 
obtain about the prospective foster parent(s) and other persons residing in the home. Once you 
have completed the Person Search and added or related the individual to the home/stage, 
record other person information in CONNECTIONS. 

The next five topics provide instruction on how to record the 
following data in CONNECTIONS: 

 • Person address information 
As you use the techniques in 

• Person phone information this section, you might make 
mistakes recording information. • Person Detail FA Home information (including 

CHRC data) Refer to Module 12: Maintaining 
FAD Homes in CONNECTIONS 

• A.K.A. name information for information about how to 
modify information. • Foster parent training information 

Recording Person Address and Phone Information 
The prospective foster parent(s) and all individuals residing in the prospective foster home 
(excluding foster children under the age of 18) must have a primary address and telephone 
number recorded that matches the primary address and 
telephone number of the foster home. This information is linked 
to the person’s name and Person Identification number and is 
stored in the Person Search area of the CONNECTIONS 
database. 

 

Additional Address and Phone 
Information should only be Primary address and telephone information is recorded in 

CONNECTIONS when the FAD home/stage is created or 
reopened (via the Home Demographics – New window). 
CONNECTIONS defaults to show home information recorded 
when the home was opened/reopened for each person added 
to the home.  

added to CONNECTIONS when 
it is different from the Primary 
Address and Primary Phone 

Information already recorded in 
the system. 

If an individual is Related to the home, and he/she is not currently involved in an open stage of 
service, CONNECTIONS displays the default primary address and phone information. If the 
Related individual is currently involved in an open CPS stage of service, and the address/phone 
information is different from the Home information, the following message displays:  

“Addr/Ph. does not match Home Addr/Ph. Contact worker(s) of open stage(s).” 

CONNECTIONS then displays the address and phone information from the open stage. You 
must speak to the individual, and/or a caseworker on the open stage, to resolve the conflict of 
information. 

Having current information on file may directly impact the health and safety of a child. For 
example, the information you record may need to be accessed by a worker at the State Central 
Register who is taking a report of suspected abuse or maltreatment. The worker will view the 
person’s address and phone number to make a positive identification—or to rule out a potential 
match. 
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Step by Step: 
Recording Additional Person Address Information 

 

1 On the Person List, click on the name of the person 
for whom you want to record information. 

2 Click on the Options menu and select Address 
List/Detail…  
The Address List/Detail window displays.  

Where am I? 3 Click on the drop-down arrow for the Type field and 
select the appropriate type. Assigned Workload > FAD > 

Tasks button > Maintain Person 4 Enter the street address.  
task > List button 

5 Enter the PO Box/Apt where applicable. 
6 Enter the City. 
7 Enter the ZIP code. 
8 Click on the drop-down arrow for the County field and select the appropriate county 

(New York City counties/boroughs display at the end of the list). 
9 The Comments field can be used to record additional information, such as directions 

to the home. 
10 After recording all of the address information in the 

Address List/Detail window, click on the Validate 
button. 
The address validation window displays.  

The CD (Community District) 
field is required for New York 11 Check the accuracy of the address listed in the 

address validation window. City only. 

12 Click on the Yes button to accept the validated address. 
The Address List/Detail window displays. 

13 Click on the Add button to transfer the information to the list section at the top of this 
window. 

14 Verify that the information is correct. 
15 Click on the Save button. 

The Person List displays. 
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Step by Step: 
Recording Additional Person Phone Information 

 

1 In the Person List, click on the name of the person for 
whom you want to record information. 

2 Click on the Options menu and select Phone 
List/Detail… 
The Phone List/Detail window displays.  

Where am I? 3 Click on the drop-down arrow for the Type field and 
select the appropriate type. Assigned Workload > FAD > 

Tasks button > Maintain Person 4 Enter the phone number for the person in the 
Number field. 

task > List button 

5 Use the Comments field to record additional information. 
6 Click on the Add button.  

The phone information displays in the list section at the top of the window. 
7 Verify that the information displayed is accurate. 
8 Using the same steps as above, add any other known phone types at this time. 

Do not select the Primary check box for these other numbers, since there can be 
only one Primary phone number. 

9 Click on the Save button. 
The Person List displays. 
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Recording Information on the Person Detail FA Window 
The Person Detail FA window is another area in CONNECTIONS where you can record 
important information for each person in the home, such as citizen status, level of education, 
Criminal History Record Check (CHRC) dates for materials sent and received, medical exam 
date, employment and other background information.  

CHRC (Fingerprint) Information  

Section 378-a(2) of the Social Services Law, as added by Chapter 7 of the Laws of 1999, 
requires that the following individuals be fingerprinted and undergo a CHRC as part of home 
certification/approval: 

• All foster parent applicants; and 
• All other persons age 18 and older residing in any of these homes, including foster 

children. 

 

In the event that a foster home has a visitor for an extended period of time (e.g., more than 2 weeks with 
no plans for leaving, or for a visit of 6 months or more) or for frequent short term visits (e.g., a paramour 
who sleeps over in the home every weekend), the decision to fingerprint and collect medical exams for 

the visitors is made at the agency’s discretion. It is expected that the agency will make the decision based 
upon the best interest of the foster child(ren) and in the interest of his/her safety. 

In addition, OCFS regulation 18 NYCRR 430.11(c) (2) (vii) requires that the safety of the foster child is a 
primary consideration of the authorized agency and therefore, before a foster home allows visitors of any 

kind into the home, the agency must in all cases consider the safety of the foster child first. All of the 
following considerations should be made when allowing visitors into the home: 
♦ That there is adequate space for sleeping, 
♦ That sleeping accommodations follow OCFS regulations, and 
♦ That the foster parent(s) will be able to adequately supervise the 

 foster child with the addition of the visitor in the home. 

The CHRC has three possible results (see Appendix A for definitions): 
• No Criminal Record Found (or No Reportable Criminal Record Found) 
• History of One or More Crimes (includes Presumptive and Discretionary 

Disqualifying Crimes) 
• Pending Matter/Hold in Abeyance 

CHRC Information in CONNECTIONS 

Every person residing in the prospective foster home who is 18 years of age or older (including 
foster children) must send fingerprint information to OCFS for review by the Division of Criminal 
Justice Services (DCJS). Information related to the CHRC must be recorded on the Person 
Detail FA window, and the window must be saved each time it is updated. 
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Fingerprint cards should be sent to OCFS on or after the date 
that the foster parent inquiry is recorded in CONNECTIONS. 
Workers must include the CONNECTIONS Home Resource ID 
number and the person’s CONNECTIONS Person ID number 
on the fingerprint cards (see Appendix K for further 
information). 

 
The Date Card Sent cannot 
be prior to 2/11/99 (the date 

The date that the fingerprint cards are submitted to OCFS and 
the date results are returned must be recorded in the Date 
Card Sent and Date Results Received fields on the Person Detail FA window. 

ASFA went into effect in 
New York State). 

Fingerprint Notification Letters 
The foster or adoptive caseworker is responsible for notifying applicants that they and all people 
age 18 or older residing in the prospective foster or adoptive home must be fingerprinted. 
CONNECTIONS provides the ability for caseworkers to generate and store these letters in the 
database and to print them as needed.  

The FAD Fingerprints Requirement Letter (available in English 
and Spanish) is used to notify prospective foster or adoptive 
parents that they and all people age 18 years and older who 
reside in their home must be fingerprinted. The letter contains 
the following fields: Resource Name (the name of the FAD 
Home), Date (the date on which the letter was generated), 
Supervisor, Agency Representative (Primary Worker) and 
Telephone (Primary Worker’s telephone number). 

 
There is space at the top of the 

letter for your agency’s 
letterhead. Be sure to print the 

letter on agency letterhead. 

 

Step by Step: 
Generating and Printing the FAD Fingerprints Requirement Letter 

1 On the Assigned Workload, select the home for 
which you need to send 
the letter. 
The Tasks… button enables.  

OCFS recommends that 
workers create a 30-day 2 Click on the Tasks… button. 

The Task List displays. reminder To-Do for themselves 
from the date the prints 

3 On the Task List, select the Maintain Person task. are submitted to OCFS to 
remind them to look for 4 Click on the List… button.  

The Person List displays. the fingerprint results. 

5 Click on the Reports menu and select FAD Fingerprint Req. Ltr. (E) [English] or 
FAD Fingerprint Req. Ltr. (S) [Spanish], as required. 

6 Click on the OK button in response to the following message: 
“The report has been launched. Check the Report List Window.” 
Letters remain unopened on the Report List for seven days before being purged. 

7 Click on the RPRTS (Reports) button on the far right side of the CONNECTIONS 
Toolbar. 
The Report List displays. 
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8 Confirm that the Status column reads “Done” for the letter you want to view. If it 
does not read “Done,” click on the Refresh button at the bottom of the window. 

9 Click on the letter to select it. 
The Open button enables. 

10 Click on the Open button. 
The FAD Fingerprints Req. Ltr. displays as a Microsoft Word document. 

11 To print the letter, click on the File menu and select Print. 
The Microsoft Word Print dialog box displays. 

12 Click on the OK button to print. 
13 To close the letter, click on the File menu and select Close. 

The Report List displays. 
14 To close the Report List, click on the Close button. 

The Person List displays. 

Medical Exam Date Information  
One of the foster or adoptive caseworker’s first casework 
activities when responding to a foster/adoptive inquiry is to 
provide the applicant(s) with Medical Report forms. Current and 
historical medical information about potential foster or adoptive 
parents and those who reside in their homes is an essential 
factor in determining whether or not to accept an applicant for 
home study. 

 
When completing an Initial 

Home Study or Re-Opening a 
Closed home the Medical Exam 
date must be within 18 months 
of the Authorization Date. For 
Reauthorizations the medical 
exam date must be within 24 

Once a home has been accepted for home study and is 
certified or approved, medical exams continue on a regular 
basis. This information is required for the successful 
recertification or re-approval of all foster homes. 

months of the current 
Authorization To Date (the date 

the home will expire if not 
reauthorized). 

 
 “A written report from a physician on the health of a family, including a 

complete physical examination of the applicant, shall be filed with the Once a valid Medical Exam 
agency initially and biennially thereafter.” [18 NYCRR  444.5(a)(2)] Date is recorded and validated 

on the Person Detail F/A 
The medical exam date is recorded in the Medical Exam Date 
field on the Person Detail FA window for each person who 
resides in the prospective foster home. 

window for all foster parents, a 
check mark displays in the 
Medical Dates Complete 

check box on the F/A Home 
License window. 
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Valid medical exam dates must be recorded in CONNECTIONS 
for a home to receive initial certification or approval, and for a 
home to be successfully recertified or re-approved. 

  
When approving an Out-of-

State Foster Home,  
CONNECTIONS does not 

 require that a Medical Exam 
Date or Fingerprint results be 

 entered into the system. 

 

Step by Step: 
Recording Information on the Person Detail FA Window 

1 On the Person List, click on the person for whom 
you want to record information. 

2 Click on the Options menu and select the Person 
Detail FA Home command. 
The Person Detail FA window displays.  

Where am I? 3 Enter all known information into the appropriate 
fields on the Person Detail FA window, selecting 
from drop-down lists where necessary. 
You can record and save information incrementally. 

Assigned Workload > FAD > 
Tasks button > Maintain Person 

task > List button 

4 Record the date that the fingerprint card was mailed 
to OCFS in the Date Card Sent field. 

5 Record the date the CHRC results were received by 
your agency in the Results Received field. 
The system will not allow you to record a date in the 
Date Results Received field that is prior the Date 
Card Sent date. 

 
For all foster homes, including 

all new homes, separate 
fingerprint documentation must 

be recorded for each foster 
6 In the Medical Exam Date field, record the date that 

the medical exam was conducted. 
The date cannot be a future date. If a future date is 
recorded, the following message displays: 
 “Date cannot be later than the current date.” 

parent and each person 
age 18 and older currently 
residing in the household, 
including foster children. 

7 Click on the Save button. 
The Person List displays. 

  If you need to modify any 
information recorded, simply 

click in the cell and click on the 
Save button when finished. 
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Foster and Adoptive Parent Training Information 
Home Member Training information must be completed separately for each prospective parent. 
Training that is required for certification or approval of the foster home should be completed and 
recorded prior to submitting the foster home for supervisory review and approval. 

  

“Authorizing agencies must provide training to each certified or approved foster parent in a training 
program approved by OCFS which will prepare the foster parent to meet the needs of children in their 
care so that the best interests of the children placed by the certifying or approving agency will be met.” 

Foster parent training should prepare the parent with the appropriate knowledge and skills to provide for 
the needs of the child and should continue after the placement of the child, as needed. 

[18 NYCRR §443.2(e)(1)] 

Information regarding the type of courses and training hours completed should be recorded on 
the F/A Home Member Training List/Detail window. FAD caseworkers use this window to 
maintain a cumulative log of all training completed by the prospective foster parents. 

Step by Step: 
Recording Training Information 

 

1 On the Person List, click on the name of the person 
for whom you want to record information. 

2 Click on the Options menu and select the Home 
Member Training List/Detail command. 
The F/A Home Member Training window displays. 

 

Where am I? 
3 Record the date the training was completed in the 

Date field. Assigned Workload > FAD > 
Tasks button > Maintain Person 

4 Record the title of the training in the Title field. task > List button 
5 Click on the drop-down arrow for the Type field and 

select the specific area of training. 
6 Record the number of sessions completed in the Session field, if desired.  
7 Record the number of hours completed for the training session in the Hours field, if 

desired. Leave this field blank if no training hours should be counted. 
8 Click on the Add button. 

The training information is added to the list at the top of the window. 
9 Repeat steps 3-8 if you are adding multiple trainings. 
10 After recording all information for training completed by the prospective foster or 

adoptive parent, click on the Save button.  
The Person List displays. 
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A.K.A. Names 
Prospective foster parents and members of their household 
may be known by more than one name. For example, a 
prospective foster or adoptive parent may have recently 
married. She may be known as Mary Smith (her maiden name) 
and as Mary Smith Johnston (her married name). You need to 
document both names in your records on this applicant, to 
maintain complete and accurate information. 

 
Use the SCR Database Check 

Form as a source for 
AKA Name information. 

CONNECTIONS allows you to record currently used names (called Primary names), maiden 
names and aliases (A.K.A. names). This can be accomplished using the Maintain Person task 
to open the A.K.A. Name List/Detail window. 

 

Step by Step: 
Recording A.K.A. Names 

1 On the Person List, click on the name of the person 
for whom you want to record information. 

2 Click on the Options menu and select the A.K.A. 
Name List/Detail… command. 
The A.K.A. Name List/Detail window displays.  

Where am I? 3 Record the name you want to add in the appropriate 
fields in the Name Information section at the bottom 
of the window. 
Do not select the Primary check box if this is not a 
name change. If you are recording a name change, 
click on the Primary check box. 

Assigned Workload > FAD > 
Tasks button>Maintain Person 

task > List button 

4 Click on the Add button. 
The name you have recorded is added to the list at 
the top of the window.  

 
Only use the Invalid button 

if the name in the record 5 Click on the Save button. 
The Person List displays. 

was never correct. 
If a name is invalidated, 
there will be no historical 

record of that name. 

Page 7-20 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Person Information and the FRS 
The Foster and Adoptive Home Record Summary (FRS) provides a comprehensive view of the 
information added to CONNECTIONS via tasks, such as the Maintain Person task. The 
Household Member Detail tab displays the person information you have entered and 
maintained for each individual in the selected FAD Home. In addition to being able to view 
information, workers can record notes, comments and certain other information in the FRS. 

The lower grid of the Household Member Detail tab contains the following information for each 
household member: 

• Medical Exam Date • Safety Asmnt Dt* 
• FP Cards Sent Date • SCR DB Check Sent* 
• FP Cards Received Date • SCR DB Check Recd* 
• FP Results* • SCR Results* 

The information in the asterisked (*) fields can only be updated in the FRS. Details for recording 
these fields are described below. 

Clicking in this cell of the grid for the selected person opens 
a drop-down list with the following choices: 

Fingerprint Results 

1. No Record Found 
2. Presumptive Disqualification 
3. Discretionary Disqualifier 
4. Hold in Abeyance 

If option 2, 3 or 4 is selected, the following message 
displays: 

“Option selected for Fingerprint Results 
requires a Safety Assessment.” 

 

In each of these columns, the date in question can be 
entered directly into the grid by clicking in the cell and typing 
in the date. 

Safety Assessment Date 
SCR Database Check Sent 
SCR Database Check 
Received 
 

Clicking in this cell for the selected person opens a drop-
down list with the following choices: 

SCR Results 

• No Record Found 
• Record Found 

 
Once information is recorded in any cell in the lower grid, the Save button enables so the 
worker can save the information to the database. The worker uses the Cancel button to move 
from this grid to other parts of the FRS without saving information. 
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The following person information can be edited directly in the FRS: 
• Fingerprint Results; 
• Safety Assessment Date; 
• SCR Database Check Sent Date; 
• SCR Results; 
• The Safety Assessment; 
• Training Comments; 
• Medical, CHRC, and SCR Comments; and 
• Employment Comments. 

The following sub-windows cannot be updated within the FRS and must be updated via the 
Person List: 

• A.K.A. Names 
• Person ID 
• Case List 
• Person Detail FA 
• Training Details 

 

Step by Step: 
Recording Information in the Household Member Detail Tab 

1 From the FRS window, click on the Household 
Member Detail tab. 

2 Select a person from the upper grid, click in the FP 
Results field and select from the resulting list.  

3 If a Safety Assessment is required based on the 
fingerprint results, click on the Safety Assessment 
Template button and record information in the 
document. 
The FRS Safety Assess Microsoft Word document 
displays. 

Where am I? 

Assigned Workload > FAD > 
Tasks button > Home Study 

task > New, Use Prior or Detail 
button 

4 Click on the File menu and select the Close 
command. 
The FRS displays.  

You can record information in 5 Click on the Yes button in response to the following 
message: “Save changes.” any of these fields as 

appropriate and information can 
6 Click in the Safety Asmnt Dt field and record a date 

using the following format (5/5/2005). 
be recorded incrementally.  

7 Click in the SCR DB Check Sent field and record a date. 
8 If appropriate, click in the SCR DB Check Recd field and record a date. 
9 Click in the SCR Results field and select from the resulting list. 
10 Click on the Save button. 
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Recording Additional Comments 

The Household Member Detail tab includes buttons that allow you to access comment boxes. 
Comment boxes provide you with a place to record and edit FAD information. Below is a list of 
buttons that open related comment boxes on the Household Member Detail tab. 

• Training Comments 
• Medical/CHRC and SCR Comments 
• Employment Comments 

A check box next to each button becomes pre-filled with a check mark once comments have 
been recorded and saved in the appropriate comment box. 

Step by Step: 
Recording Comments 

 

1 On the Household Member Detail tab, select a 
person from the upper grid. 

2 Click on a comment box (i.e., Training Comments, 
Medical/CHRC and SCR Comments or Employment 
Comments).  

Where am I? 3 Record/edit comments. 
Assigned Workload > FAD > 4 Click on the Save button. 

A check mark displays next to the Tasks button > Home Study 
task > New, Use Prior or Detail 

button 
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Module 8: 
Maintaining Licensing Information for FAD Homes 

So far in this guide, we have looked at two major roles that CONNECTIONS plays in supporting 
foster and adoptive casework — maintaining a database for person and home information, and 
providing documentation of casework activities. CONNECTIONS also supports foster and 
adoptive casework by providing an automated recording of home certification/approval (see 
page 8-18). This role refers to the actual licensing of the FAD homes, which is the topic of this 
module. 

The authorizing agency must balance two goals; the desire to place children who need foster 
care services, and the need to thoroughly assess the home environment. In the process of 
certifying or approving a foster home, two crucial decisions must be made by the authorizing 
agency that determines if the home progresses to Accepted-Active status and can accept child 
placement. These decisions are: 

• the decision to accept or deny an applicant for Home Study; and 
• the decision to accept or deny the home for full certification or approval. 

This module reviews some of the criteria involved in making these decisions. Additionally, we 
will instruct you on how to use CONNECTIONS to document the licensing process and submit a 
home record for supervisory review. By the end of this module, you will be able to: 

• use the Maintain Licensing Information task; 
• open the F/A Home License window; 
• progress a foster home/stage to Applicant status; 
• record a Vendor Identification (VID) number; 
• use the Foster and Adoptive Home Record Summary (FRS) to complete and submit 

the Home Study narrative; and 
• submit the entire home record for certification or approval. 
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Decision: Accepting an Applicant for Home Study 
At this point in this guide, we have received the completed foster parent application and have 
begun collecting additional information about the prospective foster parent(s) and other 
members of the household, as well as the foster home itself. 

The decision of whether to accept an application for Home Study must be based upon the 
information provided in the application, the medical report and (if results have been received) 
the results of the SCR Database Check and the CHRC. An agency has ten days, upon receiving 
the completed application, to inform the prospective foster or adoptive parents of its decision. 
Acceptance must be conditional on the submission of an acceptable medical report form. 

A rejection of the application must be based solely upon the information noted in the paragraph 
above. When an application for Home Study is denied and the home is in Applicant status, the 
caseworker must take steps to close the home in CONNECTIONS that are consistent with New 
York State regulations. For example, the prospective foster or adoptive parents must be notified 
of the rejection in writing and the letter must contain the reasons for denial of the application 
(see Module 15: Closing Foster Homes). 

Out of State Foster/Adoptive Homes in CONNECTIONS 

When a child in the custody of a Local DSS Commissioner is placed in a Foster and/or Adoptive 
Home in a different state, it is the responsibility of the receiving state to certify or approve the 
home as being suitable for placement. As other states may have different licensing standards, 
such as criminal history background checks (fingerprinting) requirements, foster/adoptive 
parent’s medical exams requirements, or home study and reauthorization requirements, 
CONNECTIONS does not edit for these items for “Out of State” homes. A home is designated 
as “Out of State” when this choice is selected in the County drop down field on the Home 
Demographics window.  

When the worker receives confirmation from the NYS OCFS Interstate Compact on the 
Placement of Children (ICPC) that the home has been approved or certified by the receiving 
state, the home is to be opened in CONNECTIONS by completing the required information on 
the Home Demographics (making sure to select “Out of State” in the County dropdown) and 
Home License windows and entering the home members via the Maintain Person task. When 
the home has been approved and placed in Accepted-Active status, the Vendor ID would be 
sent to BICS and the LDSS can begin making payments.  
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Recording License Information 

F/A Home License Window 
Certification or approval of a foster home includes recording all required licensing information on 
the F/A Home License window. This window is closely tied to the Foster and Adoptive Home 
Record Summary (FRS), and other windows in CONNECTIONS; information recorded on this 
window (as well as other windows in the FAD stage) displays in the FRS. As we will learn in this 
module, when the FRS is submitted for supervisory approval, the F/A Home License window is 
generated, and the submission is completed on this window.  

The table below highlights the fields on the F/A Home License window. Following this table are 
instructions on how to access the window from the Task List. 

Field Name Description 

Setting Upon opening the F/A Home License window, the Setting field is pre-
filled with the setting selected when the foster home/stage was 
created (see Module 6: Responding to an Inquiry). Possible settings 
are “Foster Home,” “Congregate” and “Adoptive Home.” 

Facility Type For the Foster Home setting, Facility Type choices are “Certified 
Foster Home,” “Approved Relative Foster Home” and “Certified 
Foster/Adoptive Home.” For the Adoptive setting, the Facility Type of 
“Adoptive Home” identifies a home that is receiving an adoption 
subsidy. 

Status This field indicates the current the status of the home, in relation to 
the home’s certification or approval process. CONNECTIONS 
updates this field once supervisory approvals are logged. You will 
manually change this setting when progressing a home from Inquiry 
to Applicant, and when submitting information for supervisory 
approval. 

Facility Type For the Foster Home setting, Facility Type choices are “Certified 
Foster Home,” “Approved Relative Foster Home” and “Certified 
Foster/Adoptive Home.” 

For the Adoptive setting, the Facility Type of “Adoptive Home” 
identifies a home that is receiving an adoption subsidy. 

Age Range Use these fields to identify the age ranges accepted for both female 
and male foster children for whom that the home will be approved to 
provide care. 

Renewal/ 
Extension 

This section of the window is used to indicate when a home is 
submitted for annual reauthorization, and when the home status is 
extended because fingerprint results have not been received. 

 Continued on next page  
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Field Name Description 

(Continued from previous page)  

Cert./Approval 
Requirements 
section 

This section of the window is automatically updated by 
CONNECTIONS based on information recorded on the Person Detail 
F/A Home window (see Module 7: Maintaining Person Information) to 
include Medical Dates Complete and Fingerprint Results Complete 
check boxes. 

Capacity In this field, identify the number of children for whom the home will be 
certified or approved.  

Open Slots The number of open slots is pre-filled based on the home’s capacity 
and the number of children in placement.  

# Placement This field displays the number of placements currently in the home. 
Currently, not supported in CONNECTIONS. 

# Unavailable This field displays the number of placements currently unavailable in 
the home/facility. Currently, not supported in CONNECTIONS. 

Program Types Upon selecting a Program Type, workers must also record applicable 
dates in the following fields (which fields enable depends on the 
Program Type(s) selected): 
Therapeutic, Special Needs, Regular and/or Emergency. See page 8-
5 for detailed information about recording the Program Type. 

On Hold 
check box 

This status identifies a foster home/stage that has been certified or 
approved and may have existing placements, but intake to the home 
is closed for additional placements. This function should not be used 
in CONNECTIONS; child placement information should be recorded 
in CCRS. 

 

 

Step by Step: 
Opening the F/A Home License Window 

1 Select the appropriate foster home/stage on the Assigned Workload. 
The name of the home is highlighted and the Tasks…  button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Licensing Information task. 
4 Click on the New button. 

The F/A Home License window displays. If information has previously been recorded 
on this window, the Detail…button enables. 
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Program Type  
In CONNECTIONS, the Program Type selected in the F/A Home License window must reflect 
the foster home’s actual classification. CONNECTIONS contains an edit to prevent improper 
relationships between the Program Type and the home’s Setting. If you attempt to select an 
improper Program Type, the following message displays in the 
lower right corner of the window: 

 

 The following factors affect 
 the amount of payment a 
 foster home receives: 

  Degree of care and 
  supervision in the foster 
  home; 
 
  and 

  Training completed by 
  the foster parents. 

“The Program Type selected is invalid for the setting.” 

The Benefits Issuance Control System (BICS) pays foster 
homes for the services they provide to children placed in their 
care. BICS is being enhanced to pay Voluntary Agencies based 
on an established rate. The amount of these payments for 
Voluntary Agency-certified or approved foster homes is based 
on a number of factors, including the Program Type recorded 
on the F/A Home License window in CONNECTIONS. The 
Program Type reflects the degree of care and supervision in 
the foster home. For this reason, it is imperative that a foster 
home’s Program Type accurately reflects the home’s actual 
classification. To determine the appropriate Program Type for 
foster homes at your agency, see your supervisor or program 
director. The table below lists the available program types: 

BICS Program Type Group Existing CONNECTIONS Program Types 
Therapeutic Therapeutic 
Special Needs Hard to Place* 

HIV + / AIDS 
Maternity* 
Mother/Child* 
Special Needs Behavioral* 
Special Needs Medical 

Regular Regular 
Emergency Emergency 
Congregate Care Diagnostic Reception Center 

Refugee Assistance Program 
Sex Offenders 
Supervised Independent Living Program 

It is imperative that the Program Types in the above table marked with an (*) never be chosen 
with a setting of Foster or Adoptive Home.  

At least one Program Type must be selected for a foster home; multiple Program Types may 
also be selected. If a worker attempts to save the F/A Home License window without recording 
a Program Type, the following message displays: 

“You must have at least one program type checked in order to save.” 

A Facility Type must also be selected for each home/stage. This field is used to identify the 
specific type of home being certified/approved. 
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Completing the Program Type field and the Facility Type field 
are the two minimum steps necessary to progress a home from 
Inquiry to Applicant Status. Directions for completing this 
progression are listed below.  

Keep in mind that the 
“Emergency” Program Type 
denotes a particular type of 

foster home that is certified to 
accept emergency placements 

on an ongoing basis. 

This is not to be confused with 
a foster home that is in 
“Emergency” Status. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Maintain Licensing 

Information task>Detail button 

The determination of when to progress a foster home from 
Inquiry to Applicant status varies due to local policies and 
procedures, but must include the completion of the Application 
form by the potential foster or adoptive parent(s). 

 

Step by Step: 
Progressing the Home to Applicant Status 
(on the F/A Home License Window) 

1 On the F/A Home License window, review the 
Setting to ensure it is accurate. 

2 Click on the drop-down arrow for the Facility Type 
field to record the appropriate Facility Type. 

3 Click on the drop-down arrow for the Status field 
and select Applicant from the resulting list. 

4 Select the appropriate Program Type(s) by double-
clicking on it. 
A red check mark displays to the left of any selected 
Program Type. 

5 Record applicable From and To dates as required for each Program Type selected 
(i.e., Therapeutic, Special Needs, Regular and Emergency).  

6 Click on the Save button. 
The Task List displays. 
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Program Type Authorization Dates 
Four pairs of From and To date fields are located on the F/A Home License window. Each pair 
of date fields corresponds to one of the BICS non-Congregate Care program type groups 
(Therapeutic, Special Needs, Regular and Emergency). These date fields will be required for 
any FAD home with a Setting of “Foster Home” and a Program Type selected from one of these 
four groups. 

 
These From and To dates are not the same as the certification/approval (or 
recertification/reapproval) From Date and To Date fields in the upper right corner of the F/A 
Home License window. While the certification/approval From Date and To Date fields reflect 
the current certification/approval period for the foster home (and are system-generated when 
the certification/approval or recertification/reapproval is approved by the supervisor), the 
Program Type group From date fields at the bottom of the window reflect the dates when the 
foster home was authorized to begin operations in accordance with the corresponding Program 
Type. With the exception of the one-time data fix at implementation, the From type for the 
applicable Program Type group must be recorded by the worker. 

For example, a foster home began operations as a Therapeutic foster home (and progressed to 
Accepted-Active status for the first time) on April 30, 2001; at that time, the home’s certification 
From Date and To Date would be 4/30/2001 – 4/30/2002. The home was recertified in April 
2002, changing the certification From Date and To Date to 4/30/2002 – 4/30/2003. The 
Therapeutic (Program Type) From field still reads 4/30/2001, because that was the date on 
which the home first began operations as a Therapeutic foster home. Since the Therapeutic 
Program Type has never been deselected, the Therapeutic (Program Type) To field remains 
blank. Recertification/reapproval of a foster home does not change the Program Type From or 
To date fields. 

For many foster homes in CONNECTIONS, the From date for a selected Program Type group 
will be the same as the date the home was certified or approved to provide care. There are, 
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however, situations in which a foster home’s program type(s) may change. For example, a 
home may originally have been certified as a Regular foster home on 5/15/2002, but the foster 
parents subsequently met the regulatory requirements (including specialized training) and 
receive certification to provide Therapeutic foster care services on 10/23/2002. This particular 
change would result in a change in the amount of payment the foster parents would receive 
from BICS for affected children who are placed in the home. This change would be reflected not 
only in the Program Type field, but also in the corresponding Program Type From and To date 
fields, as applicable.  

A BICS program type group is considered selected when at least one of its associated 
CONNECTIONS program types is selected; it is considered deselected if none of its associated 
program types is currently selected. 

When one of these choices is selected in the Program Type field, the corresponding From date 
field highlights in yellow, indicating that it is a required field. 

If a worker attempts to save the F/A Home License window after selecting an item in the 
Program Type field without recording a corresponding From date, the following message 
displays: 

“Program Type From Date required for selected program type(s).” 

Valid program type dates are defined as follows: 
• Both the From date and, if applicable, the To date must be within the past two years. 
• Both the From date and, if applicable, the To date must not be more than six months in 

the future. 
• The value in the To date can never be less than the value in the From date. 

If the worker records an invalid date in one of the date fields, one of the following messages 
displays, as applicable: 

“Program Type Dates must be within the past 2 years.” 
“Program Type Dates must not exceed 6 months in the future.” 

“Program Type To Date cannot be less than From Date.” 

For both open and closed homes, the From date for each applicable program type group will be 
the date the home progressed to Accepted-Active or Emergency status for the first time. The 
From field must contain the date the foster home is authorized to begin operations. This date 
cannot be greater than the To date. The To date will always be blank until a particular home’s 
program ends. (The worker must deselect the applicable Program Type and then enter the 
appropriate date in the To field for that Program Type group. The To date is never system-
generated.) 

When a worker opens the F/A Home License window, if the Program Type field is blank, the 
corresponding From and To date fields will enable when an applicable program type is 
selected. If a valid date is already present when the worker opens the F/A Home License 
window, the date is modifiable regardless of which program type is selected (or if no program 
type is selected). 

Once a home has been progressed to Accepted-Active status, if a worker deselects a previously 
selected item in the Program Type field to another non-Congregate Care program type group, 
the To date must be completed for the deselected program type group. 
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If a worker records a program type From date and saves the F/A Home License window, but 
then needs to remove the entry, the worker must deselect the recorded program type, record 
the same value from the From field into the To date field and save the change. Each deselected 
program type group’s From and To field should contain valid data. 

If a worker attempts to save the F/A Home License window after deselecting an item in the 
Program Type field without recording a corresponding To date, the following message displays: 

“Program Type To Date required for de-selected program type(s).” 

If you modify the program type From and To date fields after the home has progressed to 
Accepted-Active status, you must obtain supervisory approval; you can modify the Program 
Type(s) and the corresponding dates prior to progressing the status. 

CONNECTIONS will retain and display all saved Program Type From and To dates, regardless 
of the Program Type that is currently selected for the foster home. 

 

Step-by-Step: 
Recording Program Types and Corresponding Program Dates 
on the F/A Home License Window 

1 From the Assigned Workload, select the appropriate FAD stage and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Maintain Licensing Information task and click on the New button. 
The F/A Home License window displays. The Detail… button enables once you 
have recorded a Program Type. 

3 In the Program Type field, double-click to select a program type. 
A system edit requires you to select at least one program type; multiple program 
types may be selected. The program type(s) you select must be appropriate for the 
Setting and Facility Type recorded on the window. 

4 If a Therapeutic, Special Needs, Regular or Emergency program type is selected, 
the corresponding From date field highlights in yellow, indicating that it is a required 
field. 

5 Enter a valid date in the applicable From date field. 
6 If the foster home is in any status other than Accepted-Active or Emergency, click on 

the Save button to save the changes to the window. 
 

—OR— 
 

If the home is in Accepted-Active or Emergency status, click on the Save and 
Submit button to save the changes and submit them for supervisory approval. 
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Effect of Program Type Changes on F/A Home History 
Every time the F/A Home License window (including the Program Type field and any applicable 
From and To date fields) is modified and saved, an event is generated on both the Event List 
and the F/A Home History window. This occurs regardless of the status of the foster home. 

The historical record of these Program Type changes, as well as their corresponding From 
and/or To dates, can be viewed on the Event List or the F/A Home History window for a FAD 
home. The Event List provides view-only access to this information (on the F/A Home License 
window for an historical event).  

Like the F/A Home License window, the F/A Home History Detail window will also contain the 
reclassified Program Types and corresponding From and To date fields. Historical From and 
To dates will display in this window. 

 
When the F/A Home History Detail window is opened in modify mode, only the Status, 
Auth. From and Auth. To fields can be modified; all other fields are protected. When the 
Auth. From date is advanced, the new Auth. To date cannot exceed the Auth. To date that was 
first displayed on the F/A Home History Detail window. This ensures that the certification period 
is valid. 

 

Step-by-Step: 
Viewing Program Type/Date Changes on the Event List 

1 After selecting a FAD stage from the Assigned Workload, click on the Options menu 
and select the Event List… command. 
The Event List displays for the selected stage. 

2 Select an event with a description of “maintained licensing information.” 

Page 8-10 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



3 Click on the Detail… button. 
The F/A Home License window displays. 

4 Click on the Cancel button. 
The Event List displays. 

 

Step-by-Step: 
Viewing Program Type/Date Changes 
on the F/A Home History Detail Window 

1 From the Assigned Workload, select the appropriate 
FAD stage and click on the Tasks… button. 
The Task List displays 

 
Note for Supervisors: 

The Program Type From and 
To date fields cannot be viewed 
from the FRS or via a Resource 

search. To view these fields, 
open the F/A Home License 

window from the Event List or 
the Task List (both lists can be 
accessed from caseworker’s 

Assigned Workload). The 
instructions below open the F/A 
Home License window from the 

Assigned Workload: 

1 Open the caseworker’s 
Assigned Workload (via the 
Unit Summary window), 
select the applicable FAD 
stage and open the Task 
List. 

2 Select the Maintain 
Licensing Information task 
and click on the Detail… 
button. 
If the F/A Home Licensing 
window is pending approval, 
the following message 
displays: “Saving will 
invalidate the pending 
approval. Continue in 
modify mode?” 

3 Click on the No button, 
since you only want to view 
(not modify) the information. 
The F/A Home License 
window displays in view-
only mode. 

2 Select the View Home History task and click on the 
List… button. 
The F/A Home History window displays. 

3 Click on a home history event to select it from the 
list, then click on the History Detail… button. 
The F/A Home History Detail window displays for 
the selected historical event. 
If you select the first (most recent) event on the list, 
the follow message displays when you click on the 
History Detail… button: 
“The most current row was selected. Only the Auth. 
From date may be modified.” 
If you select any other event on the list (which does 
not have an End Date), the F/A Home History Detail 
window displays in view-only mode, unless you are 
assigned the MAINT FAD HIST Business Function. 
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Vendor Identification Numbers 
A Vendor Identification number (VID) must be recorded for each FAD home/stage in order for 
the home to receive reimbursement. A Vendor ID number (VID) is a unique eight-digit number 
(beginning with a zero). Only the specific number assigned by your voluntary agency or local 
district for the prospective foster home/stage by OCFS should be used for a home/stage you 
create. A home/stage that is missing a VID cannot become fully certified or approved.  

Obtaining Vendor ID numbers is a local process; the worker should contact his/her supervisor, 
director of services, or implementation coordinator to obtain a VID. The supervisor, director of 
services, or implementation coordinator will have already obtained a block of numbers from 
OCFS for that particular agency (see Appendix D for information about obtaining Vendor 
Identification numbers). 

The Vendor ID (VID) number is recorded as part of the Business Address on the Home 
Demographics window. It should be recorded after the home progresses to Applicant status and 
before the home is submitted for approval. Prior to recording the VID, the following events 
should have occurred: 

• The F/A Home application has been received; 
• The Medical form has been provided to the applicant(s) and you are awaiting the 

report; 
• The SCR Database Check Form has been submitted to the SCR; 
• Fingerprints have been taken and submitted for all members of the household age 

18 and older; 
• The F/A Home status has been progressed to Applicant on the F/A Home License 

window; and 
• The Facility Type has been recorded on the F/A Home License window. 

 

Step by Step: 
Recording the Vendor ID Number 
(via the Maintain Non-Licensing Information Task) 

1 On the Assigned Workload, select the appropriate foster home. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Non-Licensing Information task. 
4 Click on the Detail… button. 

The Home Demographics window displays. 
5 If the Primary Address is also the Business address, click on the Vendor ID field and 

enter the Vendor ID number. 
-OR- 
Click on the Address button and record the Vendor ID for the associated Business 
address by clicking in the Vendor ID field. 

6 Click on the Validate button.  
The address validation window displays. 
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7 Click on the Yes button to accept the validated address. 
The VID number is added to the foster or adoptive home’s record and displays in the 
Address column in the list section at the top of the window. 

8 Click on the Save button. 
The Task List displays. 

Preparing for Certification/Approval 
New York State foster care regulations require authorizing agencies to complete a Home Study 
within four months after acceptance of a completed application, unless delays occur as a result 
of extenuating circumstances beyond the agency’s control. The agency has six months to 
complete the entire certification or approval process. An application for certification or approval 
that is still pending after six months should be considered expired; a new application is required 
to continue the process. 

The Home Study and the FRS 
The Home Study is a narrative summary of all of the information gathered on the prospective 
foster parents and household members, based on information provided on the application, 
personal interviews, family assessment, home site inspection, external record checks, etc. A 
home study is required for home certification or approval and must be completed in compliance 
with the certification criteria set forth in NYS regulations, Part 443 of the Social Service Law. In 
addition to age, medical, CHRC, SCR, employment and marital status, other factors that you 
must assess and address in the home study include: 

• the character of the prospective foster parents; 
• ability and motivation to care for foster children; 
• understanding of the role and responsibility in relation to the foster child, the agency, 

and the child’s birth family; 
• psychological readiness to assume responsibility for a child and ability to provide for 

a child’s physical and emotional needs; 
• attitudes of household members regarding foster care; and 
• understanding of child development and approach to disciplining children. 

Home Study narratives must comply with the standards set forth in 18 NYCRR Part 443. For 
further clarification on items you must cover in the Home Study, refer to New York State foster 
care regulations (18 NYCRR Part 443) and consult with your supervisor. 
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The Home Study in the FRS 

Home Study narratives must be completed in CONNECTIONS. 
The Home Study Narrative tab in the Foster and Adoptive 
Home Record Summary (FRS) is the primary tool for creating 
the Home Study narrative. The FRS can be accessed via three 
tasks on the Task List. How you access the FRS affects your 
ability to edit and view home study narratives. (See Module 3: 
Managing Your Workload.) 

In this module, we will focus on how to create the initial Home 
Study narrative. To initiate a Home Study narrative, click on the 
Home Study task on the Task List (see Module 3: Managing 
Your Workload for more information about the New, Use Prior, 
and Detail buttons on the Task List). 

The Home Study tab is divided into two main sections: 

• Reason(s) for the Home Study — You will complete 
this section first. Choose the reason you are creating the home study narrative, and 
click on the Save button before moving to the Home Study Narrative. 

• Home Study Narrative — This section contains a listing of three options for Home 
Study narrative format. Use the radio button to select 
Standard Home Study, MAPP/GPS Home Study, 
or “Other.” The “Other” option is a blank template 
that is available to all users. This area can used to 
paste a Home Study that has been completed 
according to an agency template. 

Once selections are made on the Home Study Narrative, the 
Retrieve/Edit Narrative button is used to generate the Home Study narrative in Microsoft Word.  

 
For information on Interim 

Home Studies refer to Module 
12: Maintaining FAD Homes in 

CONNECTIONS. 

 
If you click on the Use Prior 

button, you cannot change the 
option format of the narrative 

 
For Help using the Home Study 

Narrative tab, minimize your 
document and click on the Help 

on Narratives button. 



 

 

Step by Step: 
Beginning an Initial Home Study Narrative 

1 On the Assigned Workload, select the appropriate FAD home/stage, and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Home Study task, and click on the New button. 
The Foster and Adoptive Home Record Summary (FRS) displays. 

3 Click on the Home Study Narrative tab. 
4 In the Reason(s) for Home Study section, click in the 

box next to Initial Home Study. 
A check mark displays in the box. 

5 Click on the Save button to record this selection. 
6 Click on the OK button in response the following 

message: “Changes have been saved.” 
7 Under the Home Study Narrative section, select the 

appropriate Home Study template by clicking in the corresponding radio button. 
Choose Standard Home Study, MAPP/GPS Home Study, or “Other.” 

8 Click on the Retrieve/Edit Narrative button. 
A Microsoft Word template of the Home Study narrative is generated. 

9 Record home study information. 
10 When you have finished entering information, click 

on the File menu and select Close. 
The Home Study Narrative tab displays. 

11 Click on the Yes button in response to the following 
message: “Save Changes?”. 

 

When the FRS is approved, the Home Study and Annual Reauthorization 
documents are “frozen” and cannot be modified. Frozen documents are 

associated with their approval events and can be printed at any time. 

These documents are formatted in two parts: 

 Part 1 is the formal document, which is given to the foster parents. 

 Part 2 contains supporting information, such as worker/contacts notes, 
 supervisor comments and the FAD checklist. This part is not given to the 
 foster parents; it is retained in the external case record. 

 
For information on how to copy 

and paste information in the 
Home Study Narrative, see 
Module 2: Getting Started in 

CONNECTIONS. 

 
The Home Study can be 

recorded and saved 
incrementally. 
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Step by Step: 
Modifying an Existing Home Study  

1 On the Assigned Workload, select the appropriate FAD home/stage, and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Home Study task, and click on the Detail… button. 
The Foster and Adoptive Home Record Summary (FRS) displays. 

3 Click on the Home Study Narrative tab. 
4 Click on the Retrieve/Edit Narrative button. 

A Microsoft Word template of the Home Study narrative is generated. 
5 Record/modify home study information. 
6 When you have finished entering information, click on the File menu and select 

Close. 
The following message displays: “Save Changes?” 

7 Click on the Yes button to save recorded information. 
The Home Study Narrative tab displays. 

The FAD Checklist Tab in the FRS
The FAD Completion Checklist is a listing of all of the tasks that need to be completed in the 
process of preparing a foster home for certification or approval. You can use this as a tool to 
review and track progress completing specific casework activities. 

The FAD Checklist tab contains items listed in 18 NYCRR Part 443. Some of the items 
contained on the FAD Completion Checklist include: 

• Receipt of completed application; 
• Sworn statement on criminal convictions; 
• Verification of personal references (at least 3); 
• Verification of employment references; 
• Foster/Adoptive Parent orientation completed; 
• Key/Health/Safety/Physical Plan standards met; and 
• Home Study written.  
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The FAD Checklist tab is also 
used when working with 

Emergency Homes (see Module 
20: Certified and Approved 

Emergency Homes) 
and 

when performing the annual 
recertifications and reapprovals 
(See Module 14: Recertification 

of FAD Homes). 

The FAD Checklist Tab is divided into two sections. These 
sections identify casework activities that occur during the 
Application Process, and those that occur during the Home 
Study Process. Additional lists of casework activities are 
located via the Emergency, Reauth/Renewal, and Additional 
Items buttons. The Additional Items checklist can be used at 
any time to record casework activities specific to your agency. 

All of these listings of casework activities are associated with 
Date fields. These fields are used to record the date the 
associated casework activity was completed. If you record an 
incorrect date or record a date in the wrong field, click on the 
Cancel button; clicking on the Save button stores newly 
recorded information. You do not have to click on the Save 
button for each date you enter; you can enter multiple dates 
and click on Save when you are finished. 

Directions on how to access and record information in the FAD Checklist tab are detailed 
below. 

 

Step by Step: 
Accessing and Recording Dates in the FAD Checklist Tab 

1 From your Assigned Workload, select the appropriate home and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Home Study task and click on the New, Detail… or Use Prior button (if 
this is the first time accessing the FRS, only the New button will be enabled). 
The FRS displays. 

3 Click on the FAD Checklist tab. 
4 Record date information (format using month, day, year: 5/5/2005) in the appropriate 

section(s). 
5 Click on the Save button to store information in CONNECTIONS. 
6 Click on the OK button in response the following message: 

“Changes have been saved.” 
Once the save is complete, you may move to another tab or close the FRS. 

7 Click on the Close button to return to the Task List. 
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Decision: Determining Whether or Not to  
Recommend a FAD Home for Certification or Approval 
As the primary caseworker responsible for completing the certification or approval process, you 
will make a recommendation to your supervisor or unit approver regarding whether or not a 
foster home should be approved or certified for the care of 
foster children. 

 
Throughout the course of the 

certification or approval 
process, you should have 

regular supervisory conferences 
to address the suitability of the 

prospective foster home. 

 
See Printing a Formalized 
Home Study in Module 9: 

Checking the Status of 
Approvals Submitted for FAD 

Homes for details. 

Your decision should be based upon two types of information: 
• the factual information you have collected regarding 

the prospective foster or adoptive parents (e.g., the 
application, CHRC results, Medical report, SCR 
Database Check, home site inspection); and  

• your clinical/casework assessment, drawn from the 
interactions you have had with the prospective foster 
or adoptive parents (e.g., interviews you conducted 
while completing the home study, the applicants’ 
interactions during training, references). 

Both types of information will assist your supervisor or unit 
approver in making the decision to either accept or reject your 
recommendation regarding certification or approval. 

Your decision for or against certification or approval must be 
consistent with New York State regulatory standards. 

 

Per New York State foster care regulations, when an authorized agency decides to discontinue a 
home study, or to deny certification or approval upon completion of the home study, it must 
advise the applicant in writing of the reasons for the agency’s decision and must offer an 

interview to discuss the decision. A plan to discontinue a home study or deny certification or 
approval for foster care must be reviewed and approved by one or more supervisory level 

personnel unless the home study was discontinued at the request of the applicant. 
 

 

 

If certification or approval is denied due, in whole or in part, to the results of the SCR Database 
Check, the applicant must be informed of their right to request a hearing (18 NYCRR §443.2). 

If the rejection is based upon the results of the CHRC, the applicant must be provided with a 
written statement that includes a summary of the criminal record history provided by OCFS 

(18 NYCRR §443.8). 

Refer to New York State foster care regulations (18 NYCRR §443.8) and your supervisor for the 
complete steps you must take when a decision is made to deny certification or approval of a 

prospective foster home. 

New York State foster care regulations require that foster parents be allowed to review and sign 
the completed and approved Home Study. A copy, with all required signatures, must be retained 
in the External Foster Home Case Record. 
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Submitting FAD Home Records for Approval 
Once you have prepared the foster home for certification or approval, you must submit all 
certification and approval documentation to your supervisor or unit approver. This should 
include information maintained in the External Foster Home Case Record and information in the 
CONNECTIONS database. 

Submission of a FAD home’s record for certification or approval 
of the home should start from the Foster and Adoptive Home 
Record Summary (FRS) in CONNECTIONS. One benefit of this 
process is that starting in the FRS provides the best way for you 
to review all information prior to submission.  

Recording and saving any change in the FRS window enables 
the SUBMIT button whether or not all information (e.g., Home 
Study), is complete. Clicking on this button generates the F/A 
Home License window, which must be completed to finalize the 
submission.  

 

The following messages may display upon trying to Save and Submit the Home License from 
the F/A Home License window if you are missing information: 

 “Fingerprint received date must exist for all person in the home over 18.” 

“The home must have at least one foster parent identified.” 

“A valid medical must be on file for all foster parents in the home.” 

“The home/facility must have a business address with a Vendor ID.” 

The directions for submitting the entire FRS for initial certification or approval are outlined 
below. 

 

If the Submit button is not 
enabled, review FRS tabs for 

missing licensing information, or 
you may need to enter the 

Home Study narrative, make a 
change in the FRS, save any 
changes and close it again.  

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Home Study 

task>New, Use Prior or Detail 
button 

 
The minimum age that can be 
recorded in CONNECTIONS 

is one month. 
For children who are younger 

than one month old, record one 
month in the Min. Month field. 

 

Step by Step: 
Submitting a FAD Home/Stage for 
Certification/Approval 

1 From Foster Adoptive Home Record Summary, click 
on the Submit button. 
The F/A Home License window displays. 

2 If age ranges have not been recorded, record the 
minimum and maximum age ranges for male and 
female children for whom the home will be licensed  
to provide care by typing the numbers into the Year 
and Month fields or by using the up/down arrows for 
each field. 
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3 If the capacity has not been recorded, in the 
Capacity field (Placement Information section), 
record the number of children the home will be 
licensed to provide care for by typing the number 
into the field or using the up/down arrows. 
Once the capacity is recorded, the system 
automatically calculates the number of open slots. 
Since there is no placement yet in the home, the 
Capacity and Open Slots numbers will be the 
same. The From Date and To Date fields are 
automatically filled in by the system once the 
license has been approved; these date fields will 
reflect a one-year authorization period from the date of approval. 

4 Once all licensing information has been recorded 
and the Home Study is complete, click on the drop-
down arrow for the Status field and select 
Pending Acceptance from the resulting list. 

5 Click on the File menu and select Save and 
Submit. 
The To-Do Detail window displays. Your 
supervisor/unit approver’s name displays in the 
Assigned to field. 

6 Record any relevant information in the 
Description/Notes field. 

7 Click on the Save button. 
8 Upon submission of the FRS, the status of the 

Home Study and Home License events change 
from PROC to PEND. Once the FRS is approved, 
the status will change to APRV. All information in 
the FRS is frozen, however as you open new 
FRS’s you will have the option to use all previously recorded information (see New 
vs. Use Prior in Module 3: Managing Your Workload). 

 
If the home that is being 

submitted for approval is an Out-
of-State Foster Home with an 

Out-of-State address, you are not 
required to record medical exam 
dates or fingerprint results before 

the home can be submitted for 
approval.  

 
 

If upon trying to save and 
submit the Home License you 
receive error messages, you 
must change the home status 

back to “Applicant” and navigate 
to each window to add the 
required information. Upon 

adding and saving the 
information, return to the F/A 

Home License window, change 
the status to “Pending 
Acceptance” and then 

Save/Submit. 
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Module 9: 
Checking the Status of Approvals 

Submitted for FAD Homes

As the caseworker responsible for completing the certification 
or approval process for the foster home, you will be submitting 
the complete Foster and Adoptive Home Record (FRS) to your 
supervisor for review and approval. Upon review, the supervisor 
may approve or reject the certification or approval of the home.  

 

Any action necessary to 
respond to supervisory 

comments should be taken in a 
timely fashion and the work 

resubmitted. 

CONNECTIONS provides methods for you to check the status 
of all submissions to your supervisor, and to view comments 
that may accompany the approval or rejection.  

There are several ways to locate information about the status of 
approvals in CONNECTIONS: 

• Via the Event List 
• Via the Approval Status window 
• Via the To Do List 

This module begins by discussing the Event List, and then takes a closer look at the Approval 
Status window and the To-Do’s generated by approvals/rejections. By the end of this module, 
you will be able to do the following: 

• open the Approval Status window via the Event List; 
• open the Approval Status window via the F/A Home License window; 
• view information on the Approval Status window about the submission; 
• qccess To-Do’s from the Staff To-Do List to find more detail about 

approvals/rejections; and 
• navigate from a Task To-Do to complete revisions and resubmit the FRS. 
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Event List 
General information regarding the status of your submission is found on the Event List (see also 
Module 3: Managing Your Workload). The Event List displays the most recent case/stage 
events at the top of the list. The following information is provided for each event:  

• Event Date • Status 
• Tx Date • Description 
• Type • Stage Name 
• Stage • Caseworker Name. 
• Case ID  

 
Entries in the “Status” column of the Event List indicate the status of each event. Prior to 
supervisory review, the status column contains the code “PROC,” which means it is “pending 
supervisory approval.” The table below illustrates how the Event List changes as a supervisor 
completes an approval. 

If the Submission is Approved… If the Submission is Rejected… 

• The status displayed on the Event List 
changes from “PROC” to “APRV.” 

• You receive a system-generated alert 
on your To-Do List notifying you that 
the approval was completed. 

• The status displayed on the Event List 
changes from “PROC” to “COMP.” 

• The status change from PROC to 
COMP indicates that supervisor has 
completed the task of reviewing the 
submitted work. Since the status is not 
listed as APRV, it has been rejected.  

• You can open the Approval Status 
window (via the F/A Home License 
window or the Event List) to view 
comments from your supervisor 
regarding the rejection. 

• You receive a system-generated Task 
To-Do in your To-Do List notifying you 
of the rejection, and allowing you to 
navigate to the appropriate place to 
revise work and resubmit the FRS.. 
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The Approval Status Window 
CONNECTIONS provides a specific window that summarizes information about approvals 
and/or rejections submitted for supervisory review. This window, called the Approval Status 
window, lists each submission made for the FAD home. You can select each row/submission to 
view more information (including supervisory comments) about the approval or rejection. 

Accessing the Approval Status Window 
The Approval Status window can be accessed via the  Event List and via the Maintain 
Licensing Information task. Instructions for both methods are below. 

 

Step by Step: 
Accessing the Approval Status Window via the Event List 

1 In the Assigned Workload, click on the appropriate FAD home/stage.  
2 Click on the Options menu and select Event List… 

The Event List displays for the selected home/stage. 
3 Scan the Event List to locate the line containing the 

appropriate “Approve FRS/Home License Event” in 
the Description column. 

 
Note that the Status column 
uses several codes, including 

“COMP” (completed) and 
“APRV” (approved) and “PROC” 

(in process). 

4 Click on the appropriate Approve Home License 
event. The Status should read “COMP” to indicate 
the approval was completed. 
The Detail… button enables. 

5 Click on the Detail… button to open the Approval 
Status window. 

6 Select the appropriate approval status line in the Approval grid to view any 
comments recorded by the supervisor/Unit Approver. 

The Approval Status window can also be opened via the Maintain Licensing Information task. 
This path is convenient if you have been viewing or maintaining information on the F/A Home 
License window. 

 

Step by Step: 
Opening the Approval Status Window 
via the Maintain Licensing Information Task 

1 On the Assigned Workload, select the FAD home/stage relating to the approval sent 
to the supervisor/unit approver. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Licensing Information task. 
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4 Click on the Detail… button. 
The F/A Home License window displays. 

5 Click on the No button in response to the following message:  
“Saving will invalidate pending approval. Continue in modify mode.” 
Clicking on the No button enables you to access the window in view-only mode. 
Clicking on the Yes button invalidates the pending approval and opens the window in 
modify mode. 

6 In the F/A Home License window, click on the Options menu and select Approval 
Status. 
The Approval Status window displays. 

7 Select the appropriate approval status line in the Approval grid to view any 
comments recorded by the supervisor/Unit Approver. 

Viewing Details on the Approval Status Window 
The details of the approval action taken by your supervisor/unit approver are documented on 
the Approval Status window. If the approval is rejected, supervisory comments provide 
information about why the rejection occurred and what you are expected to do next.  

You must highlight the approval event (this row also displays the supervisor’s name) to check 
for and view any comments the supervisor entered for a completed approval or rejection. This 
also enables you to view the date and time the approval or rejection. 

The Approval Status window lists the status of the approval using one the following identifiers: 

Identifier Description 

PROC The supervisor/unit approver has not addressed the approval. 

APRV The supervisor/unit approver accepted the work submitted. 

REJT The supervisor/unit approver rejected the work submitted (in order 
to reject a submission, the supervisor must provide comments). 
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Step by Step: 
Viewing Supervisor/Unit Approver 
Comments 

1 In the Approval Status window, click on the Approval 
Status line. 
The fields below this line display information entered by 
the supervisor/unit approver (including the Comments 
field). 

2 Click on the File menu and select Print Screen. 
The screen print will print to your default printer. 

3 Click on the File menu and select Close. 
The F/A Home License window displays. 

 

 

 

 

Using the To-Do List to Check the Status of Approvals 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button > Maintain 

Licensing Information task > 
Detail button > Options menu > 

Approval Status command 

 
If the submission has been 
rejected, it is recommended 

that the worker obtain a screen 
print of the supervisor/unit 

approver’s comments as an aid 
in making corrections to the 

appropriate tasks. 

 

See Module 3: Managing Your 
Workload, for information about 
accessing the Staff To Do List, 

reviewing the To-Do Detail 
window, and navigating with 

Task To-Do’s. 

The Staff To-Do List is another way that CONNECTIONS allows 
you to keep track of the work you submit to your supervisor. 
When a supervisor completes the task of approving or rejecting 
a submission, CONNECTIONS automatically sends either an 
Alert To-Do or a Task To-Do to the primary caseworker for the 
FAD home. 

The type of To-Do sent by CONNECTIONS is dependent on the 
determination made by the supervisor.  

The table below shows the association between determination 
and type of To-Do sent: 

Decision Made by Supervisor  To-Do Generated by CONNECTIONS 

Approve the Submission Alert To-Do 

Reject the Submission Task To-Do 

 
Supervisor comments can be viewed by selecting the appropriate To-Do and clicking on the 
Detail button at the bottom of the Staff To-Do List window. For rejections, the receipt of a Task 
To-Do allows you to easily navigate to the task-related window that requires attention. This 
streamlines the process of making corrections and resubmitting the FAD home for approval. 
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Following Rejection or Approval of the FRS 

When Foster Home Certification or Approval Has Been Rejected 
Certification or approval of a foster home may be rejected if the home does not meet the 
regulatory standards set forth in 18 NYCRR Part 443. If certification or approval is denied, 
proper notification procedures must be followed.  

Authorizing agencies must provide the applicant with a written statement setting forth the 
reason(s) for denial. For information on additional procedures that must be followed, see the 
table below. 

Rejection due to… Refer to… 

Results of the SCR Database Check 18 NYCRR §443.2(b)(9) 

Results of the CHRC 18 NYCRR §443.8 

00 OCFS ADM-4 

Findings in the Home Study 18 NYCRR §443.2(c) 

When Foster Home Certification or Approval Has Been Accepted 
If an application for home certification or approval meets all health and safety standards, and is 
approved by a supervisor, the home is progressed to Accepted-Active status. 

Fully certified and approved foster parents must execute an agreement with the authorized 
agency, referred to as the Foster Parent Agreement. In signing this agreement, the prospective 
foster parents acknowledge their intent to provide the following (this is not a complete list; see 
18 NYCRR §443(b) for more information): 

• a family atmosphere of acceptance, kindness and understanding; 
• an educational plan for school-age children; 
• a safe home environment with proper supervision; 
• appropriate food, served at regular hours and sufficient in quantity; 
• appropriate clothing for all seasons; and 
• a home that is accessible to authorized representatives of the agency. 
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In certain circumstances an application for certification or approval may be granted after the 
authorizing agency has been notified of either of the following: 

• that the applicant is the subject of an indicated child abuse or maltreatment report 
on file with the Statewide Central Register of Child Abuse and Maltreatment; or 

• the prospective or existing foster parent or any other person over the age of 18 
who is currently residing in the home of the prospective or existing foster parent 
has a criminal history record. If an agency certifies a Foster Home with a criminal 
history record, a Safety Assessment must be documented within the FRS. 

If either of these situations occurs, the reasons why the applicant was determined to be 
appropriate and acceptable to receive a foster care placement must be documented in the 

External Foster Home Case Record [see 18 NYCRR §443.2(f)]. 

Completed home study narratives contain a page referred to as a “signature page.” Signatures 
are required on Home Study narratives to indicate that the involved parties have read the 
document and are in agreement about the contents of the narrative. Home Study narratives 
should contain the signatures of the prospective foster parent(s) and the caseworker. 

In order to generate and produce a Home Study narrative that includes a signature page, you 
need to access the approved Home Study. 

 

Step by Step: 
Printing the Formalized Home Study 

1 From the Assigned Workload, select the FAD stage. 
2 Click on the Options menu and select the Event List… command. 

The Event List for this home displays. 
3 Click on the Home Study event to select it. 

The Description reads, “Home Study.” 
4 Click on the Detail… button. 

The Formalized Home Study displays in .pdf (Adobe Acrobat) format. 
5 Click on the Print button. 

The Print window displays. 
6 Click on the OK button. 
7 Click on the Close button to close the Home Study. 

The Event List displays. 
8 Click on the Close button to close the Event List. 

The Assigned Workload displays. 
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Module 10: 
F/A Home Certificates and Approval Letters 

Certificates and Letters 
State and federal regulations require authorizing agencies to issue a Certificate to Board (also 
referred to as the F/A Home Certificate) or Letter of Approval to homes that have successfully 
met all certification and approval criteria, and are ready to board and care for foster children. 
These Certificates and Approval Letters list important licensing information about the home, 
including (but not limited to): the names of the foster parents, 
dates of authorization, and information about the children 
accepted in the home. Certificates and Approval Letters should 
not be issued until the foster parents have reviewed and signed 
the Foster Parent Agreement. 

A copy of the F/A Home Certificate or Approval Letter must be 
given to the foster parents when the home is certified or 
approved. If changes occur during the license/approval year, a 
new Certificate or Approval Letter must be given to the foster 
and adoptive parents. Certificates and approval letters 
generated after a foster parent has been removed from the FAD 
home via the Remove Person – Left Home function (see 
Module 11: Maintaining FAD Homes in CONNECTIONS) do not show the former foster parent 
as a current member of the foster home. Foster parents are required by state regulations to 
have a copy of the certificate/approval letter in the home for examination by authorized 
personnel on request.  

 
A home may have a Setting of 
“Foster Home “and a Status of 

“Emergency.” Although an 
Emergency home is able to 

board and care for foster 
children it does not receive 

either an F/A Home Certificate 
or an Approval Letter. 

By the end of this module, you will be able to: 

• generate, view and print an F/A Home Certificate; and 
• generate, view and print an Approval Letter. 

 

CONNECTIONS Step-by-Step Guide: Page 10-1 
The Complete Guide to Support Foster and Adoptive Home Development  (rev 04/12/2006) 



Certificate to Board (F/A Home Certificate) 

 
A certificate to board permits an individual to receive remuneration from an authorized agency for the 

care and board of a child under the age of 18 years, or under the age of 21 years who is actively 
participating in an educational/vocational program and who entered foster care prior to his/her 18th 

birthday. Such a certificate may be issued by the public or private authorized agency purchasing such 
care  

[18 NYCRR §443.1(b)]. 

A home that has a Setting of “Foster Home” and a Facility Type of either “Certified Foster 
Home” or “Foster/Adoptive Home” must receive an F/A Home Certificate (a.k.a. Certificate to 
Board) once the certification has been approved by a supervisor or unit approver. The home 
must be in Accepted-Active status in order for you to generate the certificate in 
CONNECTIONS.  

The following instructions describe how to generate and print an F/A Home Certificate. 

 

Step by Step: 
Generating and Printing the F/A Home Certificate 

1 From the Assigned Workload, click on the name of a 
FAD home/stage, making sure it is a Certified Foster 
Home or Foster/Adoptive Home. 
The Tasks… button enables.  

Foster Parents must be added 
to the FAD home/stage and 

identified with the Rel/Int code 
“Foster Parent” in order to 
generate a Certificate or 

Approval Letter.  

2 Click on the Tasks …button. 
The Task List displays. 

3 Click on the Maintain Licensing Information task. 
4 Click on the Detail… button. 

The F/A Home License window displays. 
5 Click on the Forms menu and select F/A Home Certificate. 

The F/A Home Certificate displays as a Microsoft Word document. 
6 Review the F/A Home Certificate for accuracy. 
7 Click on the File menu and select Print. 

The Microsoft Word Print dialog box displays. 
8 Click on the OK button to print. 
9 To close the certificate, click on File on the menu and select Close. 

The F/A Home License window displays. 
10 Click on the Save button to generate an event in CONNECTIONS. 

The Save button enables on the F/A Home Licensing window only if the home is a 
Certified Foster Home or Foster/Adoptive Home. 

 

Page 10-2 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



The Approval Letter 

 
A Letter of Approval permits a relative within the second or third degree of the parent(s) or stepparent(s) 
of a foster child to receive remuneration from an authorized agency for the care at board of a child under 

the age of 18 years, or under the age of 21 years who is actively participating in an educational/vocational 
program and who entered foster care prior to the age of 18 years [18 NYCRR §443.1(d)]. 

This letter is enabled for homes with a setting of “Foster Home” only when the Facility Type of 
the F/A Home License window is set to “Approved Relative Home” and the home is in Accepted-
Active status, otherwise the Approval Letter command is disabled. 

State regulations allow authorizing agencies to request (in writing) an exception for Approved 
Relative Foster Homes. An exception, if granted, can be documented on the Approval Letter. An 
exception refers to an arrangement made outside of the state regulations governing foster 
boarding homes.  

Only Approved Relative Foster Homes may request exceptions. The exception will be granted 
only if the arrangement is necessary to board a child and is consistent with the health, safety 
and welfare of the child. Certified Foster Homes and Foster/Adoptive Homes are not eligible for 
exceptions. 

 

Step by Step: 
Generating and Printing the Approval Letter 

1 From the Assigned Workload, click on the name of 
the home/stage, making sure it is an Approved 
Relative Foster Home. 

 
Relatives must be added to the 
FAD home/stage and identified 
with the Rel/Int code “Foster 
Parent” in order to generate a 
Certificate or Approval Letter. 

2 Click on the Tasks… button. 
3 Click on the Maintain Licensing Information task. 
4 Click on the Detail… button. 

The F/A Home License displays. 
5 Click on the Forms menu and select Approval 

Letter. 
The Approval Letter displays as a Microsoft Word 
document. Review the letter for accuracy. 

Workers do not record the 
relative’s actual relationship to 

the child (e.g., Aunt). 

6 Click on the File menu and select Print. 
The Microsoft Word Print dialog box displays. 

7 Click on the OK button to print. 
8 To close the Approval Letter, click on the File menu and select Close. 
9 Click on the Save button to generate an event in CONNECTIONS. 

The Save button enables on the F/A Home Licensing window only if the home is a 
Certified Foster Home or Foster/Adoptive Home. 
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Module 11: 
FAD Reports 

In the past five modules, we have followed the casework 
activities involved in creating a foster or adoptive home and 
progressing it through the certification/approval process. 
Although the home is now in Accepted-Active status, foster 
and adoptive casework is still required to maintain the home 
(see also Module 12: Maintaining FAD Homes in 
CONNECTIONS).  

 
In NYC, ACS has its own 

FAD Inquiry Tool that 
provides reports, summaries 

and exceptions. 
Contact Javier Vega at 

(212) 341-2808 for more 
information (as of 9/18/02). 

 

Your agency Data Warehouse 
contact can help you obtain 

other reports, such as a listing 
of the foster homes for your 

agency and foster parent 
reports. 

You can generate reports in CONNECTIONS to track the 
progress of a home/stage and generate mandatory forms for 
foster or adoptive parents. Some reports are located in the 
Foster and Adoptive Home Record Summary (FRS), and others 
are located through using the Task List.  

In this module, we will look at these two general methods for 
finding reports. Then we will outline each report and provide 
instruction on how to generate, view and print them in 
CONNECTIONS. By the end of the module, you will be able to 
generate, view and print the following reports: 

• FAD Home Information via the Foster and Adoptive 
Home Record Summary (FRS) 

• F/A Home Member Training Log Report 
• Event History Report 
• Approval Report 
• F/A Home Information Report 
• Corrective Action Plan 
• Serious Incident Report 
• Waiver/Exception Report 
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Generating Reports Using the FRS 
CONNECTIONS utilizes a specific window, the Generate Report window, to organize the 
printing of information displayed in the Foster and Adoptive Home Record Summary (FRS). The 
Generate Report window lists the sections of the FRS that can be printed, and includes an 
option for printing the entire FRS. The Generate Report window is accessed via the Generate 
Report button, which is always visible at the bottom of the FRS window. Clicking on this button 
opens the Generate Reports window. 

The first option displayed on the Generate Report window, is “All Tabs.”  Selecting this option 
and clicking on the OK button generates a report of all the information that is displayed in the 
FRS. 

Under the “All Tabs” option is a listing of each section of the FRS that can be printed. These 
options include:  

• Home Demographics; 
• Licensing Information; 
• Household Member Detail; 
• Home History Events; 
• Agency/Worker Information; 
• Home Study Narrative; 
• Annual Reauthorization Narrative; 
• FAD Checklist; and 
• Contacts. 

 
You may choose one or more of these options to view and print. Click on the OK button to 
generate the report. All reports in the FRS open in the Adobe Acrobat Reader application. Once 
the report displays you may print the report. 

The instructions for accessing the Generate Report window and printing a document are as 
follows: 

 

Step by Step: 
Accessing the Generate Report Window in the FRS 

1 On the Assigned Workload, select the appropriate 
FAD home/stage and click on the Tasks… button. 
The Task List displays. 

 

Refer to Module 3: Managing 
Your Workload for help deciding 
which task to use for accessing 

the FRS. 

2 Select the appropriate task to access the FRS 
(either the Home Study, Annual Reauthorization, or 
View FAD Record Summary task), and click on the 
Detail button. 
The Detail button does not always enable, in this 
instance use the New or Use Prior button.  

3 Click on the Generate Report button at the bottom of the FRS window. 
The Generate Report window displays. 
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4 Select the type of information you would like to print (e.g., All Tabs). 
5 Click on the OK button. 

Adobe Acrobat Reader opens, displaying the selected information in a formatted 
report. 

6 Click on the Print button in the lower left corner of the window. 
Your selection will print. 

7 Click on the Close button in the lower right corner of the document window, to return 
to the Generate Report window. 

8 Click on the Cancel button in the lower right corner of the Generate Report window, 
to return to the FRS. 

Additional CONNECTIONS Reports 

The F/A Home Member Training Log Report 
The F/A Home Member Training Log Report is a listing of all the trainings that the prospective 
foster parent or other family members has attended and the total number of training hours 
completed. This data can help determine if an applicant or current foster or adoptive parent has 
completed the required trainings for certification/approval or recertification/reapproval. 

The F/A Home Member Training Log Report can be used to support the requirements for the 
approval of specialized/exceptional foster boarding home payment for children with special 
needs. 

 

Step by Step: 
Generating the F/A Home Member Training Log Report 

1 Click on the appropriate FAD home in the Assigned Workload. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Person task. 
4 Click on the List… button. 

The Person List displays. 
5 Click on the person for whom you will generate the report. 

 

Refer to “Accessing Reports 
from the CONNECTIONS 

Toolbar” on page 11-6. 

6 Click on the Options menu and select Home Member Training List/Detail… 
The F/A Home Member Training window displays. 

7 Click on the Reports menu and select F/A Home Training Log Report. 
The following message displays: 
“The report has been launched. Check Report List window.” 

8 Click on the OK button. 
9 To close the F/A Home Member Training List/Detail window, click on the Cancel 

button. 
The Person List displays. 
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The Event History Report 
The Event History Report is a report of all events that have taken place with the home/stage 
over the course of its history in the system. It also displays the staff member’s name and 
agency. 

The Event History Report is generated from the Event List. This window can be opened via 
either the Assigned Workload or the Task List. The directions below instruct you on how to open 
the report via the Assigned Workload. 

 

Step by Step: 
Generating the Event History Report 
(via the Assigned Workload) 

1 Click on the appropriate FAD home/stage on the Assigned Workload. 
2 Click on the Options menu and select Event List… 

The Event List displays. 

 

Refer to “Accessing Reports 
from the CONNECTIONS 

Toolbar” on page 11-6. 

3 Click on the Reports menu and select Event 
History… 
The following message displays: 
“The report has been launched. Check Report List 
window.” 

4 Click on the OK button. 
The Event List displays. 

The Approval Report 
The Approval Report provides information about events that have been approved by a 
supervisor or unit approver. This report is generated from the Approval Status window and 
contains a listing of events requiring approval, the approver’s name for each event and the 
current status of the home/stage following the approval. 

 

Step by Step: 
Generating the Approval Report 

1 Click on the appropriate home/stage on the Assigned Workload. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Licensing Information task. 
4 Click on the Detail… button. 

The F/A Home License window displays. 
5 Click on the Options menu and select Approval Status… 

The Approval Status window displays. 
6 Click on the Forms menu and select Approval Form. 

The Approval Report displays as a Microsoft Word document. 
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7 Review the information. 
8 To print the document, click on the File menu and select Print. 

The Microsoft Word Print dialog box displays. 
9 Click on the OK button to print. 
10 To close the document, click on the File menu and select Close. 

The Approval Status window displays. 

The F/A Home Information Report 
The F/A Home Information Report compiles information from the Home Demographics window, 
the F/A Home License window, the Maintain Person window and the Close Home window (see 
Module 15: Closing FAD Homes), if applicable. This report is helpful if the worker needs a 
specific summary of current information for the home (e.g., the expiration date of the certification 
or approval). 

 

Step by Step: 
Generating the F/A Home Information Report 

1 Click on the appropriate FAD home on the Assigned Workload. 
The Tasks… button enables. 

 

Refer to “Accessing Reports 
from the CONNECTIONS 

Toolbar” on page 11-6. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Non-Licensing Information 
task. 

4 Click on the Detail… button. 
The Home Demographics window displays. 

5 Click on the Reports menu and select F/A Home Information Report.  
The following message displays: 
“The report has been launched. Check Report List window.” 

6 Click on the OK button. 
7 To close the Home Demographics window, click on the Cancel button. 

The Task List displays. 
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Viewing FAD Reports 
Once any of the reports discussed in this section have been launched, you need to open the 
Report List window in order to view and (if applicable) print the report. The Report List window 
consists of the following columns: 

Status Indicates whether the report is pending, done, or in error. 
• DONE – report has been generated and can be viewed and (if 

applicable) printed 
• PEND – report is still generating; either refresh the window by 

clicking on the Refresh button, or close the Report List window 
and try again in a few minutes. You need to wait for the report to 
generate fully before you can view it. 

• ERR – an error has occurred; report must be re-launched. 

Report Name Displays the name of the report launched. 

Report 
Description 

Displays the name of the F/A home. 

Gen Date Displays the date the report was generated. 

Purge Date Displays the date the report will drop off the report list if report is not 
viewed. 

Output Displays the application used to view the report. 
 
The footer contains three buttons: 

Open Displays the selected report. 

Refresh Refreshes the Report List window to display new reports that have 
been received since the last time the Report List was opened or 
refreshed. New reports do not automatically display on the Report List 
window if it is open at the time of the assignment.  It is necessary to 
refresh your Report List window for these reports to appear. 

Close Closes the Report List window. 

The directions for how to view and print the reports are listed below. 

 

Step by Step: 
Accessing Reports from the CONNECTIONS Toolbar 

1 Click on the RPRTS button on the far right side of the CONNECTIONS Toolbar. 
The Report List displays. 

2 Confirm that the Status column reads “Done” for the report you want to view. 
If it isn’t, refresh the window by clicking on the Refresh button, or close the Report 
List and try again in a few minutes. You need to wait for the report to launch fully 
before you can view it. 
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3 Select the report and click on the Open button. 
The report displays as a Microsoft Word document. 

4 Click on the File menu and select Print. 
The Microsoft Word Print dialog box displays. 

5 Click on the OK button to print. 
6 Click on the File menu and select Close. 

The Report List displays. 
7 To close the Report List, click on the Close button. 

Reports on the FAD Task List 
The reports listed below can be accessed from the Task List of each FAD home/stage on the 
Assigned Workload. The use of these reports is not required by OCFS. In many parts of New 
York State, these forms have been well developed by local districts and voluntary agencies to 
include an even higher level of detail than the reports in CONNECTIONS. However, many users 
still find these forms to be useful in documenting special circumstances in foster parent 
supervision. 

Corrective Action Plan — This report can be used to document when a foster parent(s) or 
foster home is out of compliance with items outlined in New York State Foster Care 
Regulations ( 18 NYCRR). It includes a section where the user can describe the plan agreed 
upon to reconcile the issue, and a section for the signatures of all parties involved. 
Serious Incident Report — This report can be used to document incidents that cause or 
potentially cause harm to the foster child. Examples include physical injuries, and discipline 
issues. 
Waiver/Exception — This request form can be used to document a request to waive certain 
state regulations, such as the limit on child capacity in the home. 

These reports can be accessed by selecting the appropriate report on the Task List window and 
clicking on the New…button (or the Detail… button if information was previously recorded). The 
Output Launch window displays.   

 

Step by Step: 
Accessing Reports from the FAD Task List Window 

1 Click on the appropriate FAD home on the Assigned Workload. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List window displays. 

3 Click on the appropriate report form (Corrective Action Plan, Serious Incident 
Report, or Waiver/Exception). 
The New… button enables. For existing reports, the Detail… button enables. 

4 Click on the New… button (or the Detail… button if information has been previously 
recorded). 
The Output Launch window displays. If a report has been started and saved click on 
the Detail button. 

 

Opening the report from the 
Report List removes the report 
from the list. The report can be 

regenerated if needed. 



Viewing Reports from the FAD Task List window 
The window contains a title bar and a standard menu bar with the File, Edit Options, Help, 
commands. The window contains two system populated fields: 

Output Type Displays the report selected from the Task List. 

Date Last 
Updates 

This field is only system populated with the date for existing reports. 
The field remains blank until the new report is saved and/or submitted.   

 
The footer contains three buttons and a checkbox: 

Document Displays the report selected. 

Document 
check box 

A checkmark indicates that a report was saved. 

Save Saves all updates. 

Cancel Closes the Output Launch window. 
 

 

Step by Step: 
Accessing Reports from the FAD Task List 
Window 

1 On the Output Launch window, click on the Document 
button. 
The selected report displays as a Microsoft Word 
document. 

2 Review and/or record the information. 
3 To print the document, click on the File menu and 

select Print. 
The Microsoft Word Print dialog box displays. 

4 Click on the OK button to print. 
5 To close the document, click on the File menu and select Close. 

The Output Launch window displays. 
6 Click on the Output Complete check box. 

A check mark displays. If the check box is not checked, you will be able to save but 
not submit the report for approval.  

7 Click on the File menu and select Save and Submit. 
The To-Do Detail window displays with the name of 
the appropriate Approver in the Assigned To field. 
Proceed to Step 8 if complete. The name of the 
Approver can be changed by clicking on the Staff 
button, entering the new Approver’s name, clicking on 
the Search button, and selecting the Approver from the resulting Staff List. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>desired report 
task (Corrective Action Plan, 
Serious Incident Report, or 
Waiver/Exception) > New or 

Detail button 

 

Click on the Save button to 
save the report without 

submitting it for approval.  

8 Click on the Save button. 
The To Do and Output Launch windows close and the Task List displays. 
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Module 12: 
Maintaining FAD Homes in CONNECTIONS 

Throughout the life cycle of a foster home, changes may occur that require you to modify or 
update information in CONNECTIONS. These changes may include (but are not limited to): 

• a change in foster family composition (e.g., foster mother has a baby); 
• marriage or divorce of foster parents; or 
• a change of address. 

The CONNECTIONS system preserves historical information while accepting and organizing 
new data related to the FAD Home (e.g., names, addresses and phone numbers). Previously 
recorded information does not need to be deleted to record changes. In fact, it is very important 
that you do not delete information from the home/stage —all information recorded is essential to 
the home’s history. 

CONNECTIONS contains several functions that work to preserve historical information. One 
function is called end dating. End dating is available on several windows, (including the Address 
List/Detail, Phone List/Detail and A.K.A. Name List/Detail windows), and allows you to show the 
exact date that a specific change in status has occurred. Two other commands allow you to 
identify when and why an individual is removed from the Person List. These functions are: 
Remove Person – Left Home, and Remove Person – Added in Error. 

Additionally, features such as the Foster and Adoptive Home Record Summary (FRS), the F/A 
Home History Detail task, and the Historical Person List provide comprehensive views of 
current and historical information pertaining to the FAD Home. 

The functions noted above are just a few of many. Organizing FAD Home Maintenance into 
three types helps to present a clear picture of how CONNECTIONS can support changes to 
home and person information. These types are:  

• Maintaining Person Information for Open FAD Homes; 
• Maintaining Home Information for Open FAD Homes; and 
• Maintaining Closed FAD Homes/Stages. 

This module will provide you with instruction on using CONNECTIONS to support 
documentation of changes pertaining to foster homes found on the Assigned Workload. The 
Maintenance of Closed FAD Homes is discussed in Module 16: Maintaining Closed FAD 
Homes/Stages. 

By the end of the module, you will be able to: 
• change a Primary name for an individual; 
• change a Primary address for an individual; 
• change a Primary phone number for an individual; 
• remove an individual from a FAD Home/Stage; 
• utilize the Person Merge and Person Split functions; 
• view and edit information in the Household Member Detail Tab of the FRS; 
• view historical person information; 
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• make changes to home demographic information; 
• complete an Interim Home Study; 
• convert an Approved Relative Foster Home to a Certified/Approved Foster Home; 
• maintain Stage (Case) Name/CD Consistency; and 
• view Historical information about a FAD Home.  
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Maintaining Person Information 

Changing a Primary Address  
A change of address for any person residing in a foster home (except for foster children age 18 
and older) is considered a major status change that must be documented in an Interim Home.  

When an individual is leaving a foster home, it is recommended that you make changes to the 
address prior to using the Remove Person Functions (see this section) to complete the removal. 
Once the removal is complete, you will not have the necessary access to update address 
information. 

CONNECTIONS will automatically assign an End Date to the former primary address, once a 
new address has been recorded and the Primary check box selected. The new primary address 
has a new Start Date, and the End Date column will be empty. 

If an individual leaves the FAD home and a new address is not yet known, you may select the 
address line and click on the Set End Date button to indicate that the individual no longer lives 
in the FAD home. 

 

Step by Step: 
Changing a Person’s Primary Address 

1 On the Assigned Workload, select the appropriate home/stage you need to update. 
2 Click on the Tasks… button. 

The Task List displays. 

 

If entire family moves updating 
the Interim Home Study and the 
Home Demographics window 

updates all household 
members’ information. For more 

information on Interim Home 
Study, turn to page 12-22.  

3 Click on the Maintain Person task. 
4 Click on the List… button. 

The Person List displays. 
5 Click on the name of the person to be updated. 
6 Click on the Options menu and select Address 

List/Detail… 
The Address List/Detail window displays. 

7 Click on the Primary check box to select it. 
8 Click on the drop-down arrow for the Type field and select the appropriate type. 
9 Record the corrected or changed address information. 
10 Click on the Validate button. 

The address validation window displays. 
11 Verify the accuracy of the address listed in the address validation window. Click on 

the Yes button to accept the validated address, if appropriate.  
The Address List/Detail window displays. 

12 Click on the Add button to add the corrected or changed information to the list 
section at the top of the window. 

13 Verify that the information is correct. Click on the Save button. 
The Person List displays. 
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Changing a Primary Phone Number 
CONNECTIONS preserves all phone number changes as a historical record. The system 
automatically assigns an end date to the former primary phone number when a new primary 
phone number is recorded. The new primary phone number will have a new Start Date and the 
End Date column will be empty. Necessary corrections to the primary phone number are 
recorded in the Phone List/Detail window and can be viewed on the Foster Adoptive Home 
Record Summary (FRS). Details can be found in this module, in the section “Viewing and 
Editing Person Information in the FRS.” 

 

Step by Step: 
Changing a Person’s Primary Phone Number 

1 On the Assigned Workload, select the appropriate home/stage you need to update. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Person task. 
4 Click on the List… button. 

The Person List displays. 
5 Click on the name of the appropriate person to 

select it. 
6 Click on the Options menu and select Phone 

List/Detail… 
The Phone List/Detail window displays. 

7 Click on the Primary check box to select it. 
A √ displays in the check box. 

8 Record the corrected or changed phone information. 
9 Click on the Add button. 

The added information transfers to the list section at the top of the window. 
10 Verify that the information displayed is accurate. 
11 Click on the Save button. 

The Person List displays. 

Changing a Primary Name 
The need for a name change in CONNECTIONS may be 
precipitated by the marriage or divorce of the foster parent(s). 
When this occurs, information in CONNECTIONS must be 
updated. 

CONNECTIONS preserves all primary name changes as an 
historical record available to be searched on in the Person 
Search section of the CONNECTIONS database. 

 

Updating the foster home 
telephone number using Home 
Demographics window updates 
all other household members’ 

telephone number. 

 
A change to the household 
composition requires the 

completion of an Interim Home 
Study.  

See page 12-22 for more 
information.  



Name changes affecting the primary name of a foster parent 
require that a new F/A Home Certificate or Approval Letter be 
generated and sent to the foster parent(s). 

AKA Name Information can also be viewed in the Foster and 
Adoptive Home Record Summary (FRS). Details can be found 
in this module, in the section “Viewing and Editing Person 
Information in the FRS.” 

 

Step by Step: 
Changing a Person’s Primary Name 

1 On the Assigned Workload, select the appropriate home/stage you need to update. 
The Tasks… button enables. 

 
Changing a person’s Primary 
name does not change the 

Stage/Case name (the FAD 
home/stage name). 

See page 12-20 for more 
information. 

 

The changing of martial status 
(e.g. married to divorce) 
changes the household 

composition. An Interim Home 
Study is required. 

See page 12-22 for more 
information. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Maintain Person task. 
4 Click on the List… button. 

The Person List displays. 
5 In the Person List, click on the name of the person 

for whom you want to record information. 
6 Click on the Options menu and select A.K.A. Name 

List/Detail…  
The A.K.A. Name List/Detail window displays. 

7 Type the name you want to add in the appropriate 
fields in the Name Information section at the bottom 
of the window. 

8 Click on the Primary check box to select it. 
A √ displays in the check box; this identifies your entry as the Primary name to be 
used in CONNECTIONS. 

9 Click on the Add button. 
The new primary name displays in the list section at the top of the window. 

10 Verify that the information in the list section is accurate. The historical Primary name 
should have an End Date. The new Primary name should have a red check mark in 
the P (Primary) column and a Start Date. It should not have an End Date. 

11 Click on the Save button. 
The Person List displays with the new Primary name. The new Primary name also 
displays in the Person Detail window. 
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Removing a Person from a Stage 
As we mentioned in the introduction to this module, CONNECTIONS contains features that 
allow for the removal of an individual from a FAD Home. Removal may be necessary for a 
variety of reasons. A foster parent or a family member to the foster parent may decide to move 
out of the foster home. An 18 year old (or older) foster child may decide to leave the home. Or, 
an individual may have been entered in error.  

In some situations, you will want the information retained in the CONNECTIONS database, to 
show that the individual did reside in the home for a period of time. In a situation where the 
person has been added in error, there is no need to retain the person information in the system. 

The Remove Person – Left Home function removes an individual from a FAD home, while 
maintaining the person’s record in the database and preserving an historical record of that 
individual in the home.  

The Remove Person – Added in Error function removes an individual from the home, but 
does not maintain an historical record of the individual’s involvement with the home. This 
feature requires the user to have a special security attribute, “Remove person – Added in 
Error.” 

Remove Person —Left Home 

The Remove Person – Left Home function can be used to 
record that an individual left a FAD home. It is just one of the 
updates you will make in CONNECTIONS when there is a 
change in household composition. A change to the household 
composition requires the completion of an Interim Home Study 
(see page 12-22).  

Once the removal is complete, the individual’s name will not be 
on the Person List or in the Household Member Detail Tab of 
the FRS.  

However, CONNECTIONS will preserve an historical record 
noting that this individual spent time living in this FAD Home. Home history reports and historical 
foster home certificates will include individuals who were living in the FAD home, as applicable. 

 

Remember that changes to 
address, phone number and 
any other person information 
should be made prior to using 
the Remove Person — Left 

Home command. 

 

Step by Step: 
Remove Person – Left Home 

1 Select the appropriate FAD home/stage from the Assigned Workload and click on 
the Tasks… button. 
The Task List displays. 

2 Click on the Maintain Person Information task. 
3 Click on the List… button. 

The Person List displays. 
4 Click on the name of the person to be removed from the home. 
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5 Click on the Options menu. 
A menu displays. 

6 Select the Remove Person – Left Home command.  
The following message displays: “Are you sure you 
want to Remove Person – Left Home?” 

7 Click on the Yes button to remove the person from 
the FAD stage.  
Click on the No button to cancel the Remove Person 
– Left Home function. 

Remove Person — Added in Error 

The Remove Person – Added in Error function can be used to remove an individual who was 
added or related to a FAD home/stage in error. Unlike the Remove Person – Left Home feature, 
this command removes information from the stage and from the CONNECTIONS database. 
Because this is so final, certain precautions are necessary. 

Not every CONNECTIONS user has the ability to use this feature. You need a specific that 
security profile that includes the REMOVE PERSON —ADDED IN ERROR Business Function. 
Additionally, you must have an assigned role in the FAD stage, or be in the primary worker’s 
unit hierarchy. 

 

An Interim Home Study is 
required for changes to 
household composition. 

See page 12-22 for more 
information. 

 

Changes to restore person 
information must be made prior 
to removing the individual from 
your Person List. You will not 
have the necessary access to 

make changes once the 
removal is complete. 

A Note About Relating 
Depending on when you realize a person has been related in 
error, you may have already “updated” the person’s information 
in CONNECTIONS.  

It is your responsibility to restore the correct person information 
before using the Remove Person function. If you have made 
changes since relating the person, the following message 
displays: 

“Changes made to Person in this stage should be reset before 
continuing.” 

The following message displays prior to removing the person 
added in error: 

“Are you sure you want to Remove Person – Added in Error?” 

 

Step by Step: 
Remove Person – Added in Error 

1 Select the appropriate FAD home/stage from the Assigned Workload and click on 
the Tasks… button. 
The Task List displays. 

2 Click on the Maintain Person Information task. 
3 Click on the List… button. 

The Person List displays. 
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4 Click on the name of the person to be removed from the home. 
5 Click on the Options menu. 

A menu displays. 
6 Select the Remove Person – Added in Error 

command.  
The following message displays: 
 “Are you sure you want to Remove Person – Added 
in Error?”  
If person was related, the following message 
displays: 
”Changes made to Person in this stage should be reset before continuing.” 
Click on the OK button. 

7 Click on the Yes button to remove the person from the FAD stage.  
Click on the No button to cancel the Remove Person – Added in Error function. 

The Impact of the Remove Person – Added in Error Function 

Once the person removal is complete, the following events happen: 

Person Information: The individual’s name will not appear on the Person List or in the 
Household Member Detail Tab of the FRS. Person information for that individual is 
completely removed from the FAD Home/Stage and no historical association to the home is 
maintained in CONNECTIONS. 

Event List: Additionally, a Remove Person – Added in Error Event is created. It includes an 
event description the indicates the Person ID (PID) has been removed from the stage. The 
event description reads: “<PID> was removed from stage.” 

System Purge: Individuals removed via the Remove Person – Added in Error function are 
purged from the database after 60 days, as long as they are not associated with any other 
cases. 

To Do: An Alert To-Do also is generated to all workers assigned to an open stage involving 
the removed person. The description column reads: 

“<Name> (<PID>) was removed from <Stage Name> (<Stage ID>).” 

The Impact of the Remove Person – Left Home Function 

The Remove Person – Left Home feature is significant 
because it allows a person to be removed from the current 
listing of household residents, while retaining information about 
their presence in the home in a historical record — the 
Historical Person List. Once the person removal is complete, 
that information is retained in the Historical Person List for the 
FAD home/stage. 

If an historical record does exist for FAD home, the following 
message displays in the lower left side of the Person List: “Historical records exist.” 

 
You must have the REMOVE 

PERSON – ADDED IN ERROR 
Business Function Profile (BFP) 

to use this 
CONNECTIONS feature. 

 

For more information about the 
Historical Person List, turn to 

page 12-17. 
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Effects of Historical Persons on Foster Home Certificates and Approval Letters 

The Remove Person – Left Home function described on page 12-6 affects the historical record 
of a FAD home, including certificates and approval letters. 

When an individual is removed from a FAD home with the 
Remove Person – Left Home function, the historical certificate 
or approval letter retains that person’s name in a “frozen” 
historical document if the person was coded as the Foster 
Parent. This helps ensure that the historical home certificate or 
approval letter reflects accurate information for the historical 
period represented by that document. 

Certificates and approval letters generated after an individual 
has been removed from the FAD home via the Remove 
Person – Left Home function do not show the person as a 
member of the foster home. 

Merge and Split Functions to Correct Duplicate and 
Accidentally Combined Records 

 

For information on accessing 
Historical F/A Home Certificates 

and Approval Letters, see 
Module 16: Historical F/A Home 

Certificates and Approval 
Letters. 

 

WARNING! 

Since it is not always possible 
to correct errors you may make 

when Merging and Splitting 
records, be sure to: 

1. Talk with your supervisor 
before proceeding. 

2. Be careful when merging 
and splitting records. 

 
The individual responsible for 

merging and splitting is subject 
to local agency policy and 

procedure.  
This task may not fall under the 

scope of the individual 
caseworker’s responsibilities.  

A specific Business Function is 
required in order to perform a 

merge or split. 

The process of merging and splitting records is complicated 
and cannot always be fully undone. Notify your supervisor if 
you notice records that should be merged or split so that 
necessary corrections can be made. 

The individual responsible for merging and splitting is subject to 
local district policy and procedure. This task may not fall under 
the scope of the individual caseworker’s responsibilities. 

In your work with CONNECTIONS, you may come upon 
multiple records for the same person, or records for two 
separate persons that have been accidentally combined into 
one. 

Duplicate records can be created during Intake if an Intake 
worker has limited or unknown demographics on a person and, 
therefore, cannot relate that person to an already existing 
person in CONNECTIONS. Duplicates can also result if a 
caseworker misses a potential match during a Person Search; 
the worker would then add this person to the case rather than 
relating to the existing person in the system. The opposite 
situation—accidentally combined records—can result if a 
caseworker merges records for two individuals who seem to be 
the same person but, in fact, are not. Regardless of the 
reason, duplicate records and accidentally combined 
records pose problems for accurate case management and 
need to be corrected once they are identified. 

Duplicate and accidentally combined records are corrected in 
CONNECTIONS with the Person Merge and Person Split 
functions. The Person Merge and Person Split functions in 
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CONNECTIONS exist to maintain data integrity. The Person Merge function merges two 
separate Person IDs (separate individual records) into the same record. The Person Split 
function separates person records merged in error. 

The ability to perform Merge/Split functions is dependent on the worker’s role and level of 
security access.  

In order to perform a Person Merge or Split in a closed stage, the worker must have the 
MERGE/SPLIT Business Function and: 

• be the historical Primary worker, Secondary worker or Case Manager; or 
• be the historical Unit Approver or have a role above that of the Unit Approver in the 

unit of the Primary worker or Secondary worker and have the CASE/PERS SRCH 
Business Function; or 

• have the ACCESS ALL DIST and CASE/PERS SRCH Business Functions (allowing 
access through a case search). 

To perform a Person Merge or Split in an open stage, the worker must be assigned the 
MERGE/SPLIT Business Function and: 

• have a role in the stage; or 
• have maintain access to the Assigned Workload of a worker with a role in the stage; 

or 
• be the Unit Approver (or have a role above that of the Unit Approver in the worker’s 

unit) and be assigned the UNIT SUM ACCESS Business Function. 

Person Merge/Split Functions 
Before completing a Person Merge, a decision must be made 
regarding which person will be carried forward to further stages 
(the Merged Forward Person) and which person will be “retired” 
after the merge (the Merged Closed Person). The Merged 
Forward Person should be the person with the most history.  
This is generally the one with the Person ID number that has 
been in the system longer. It is important to understand how the 
merge affects each of these roles in CONNECTIONS. 

The Merged Forward Person: 
• is carried forward to subsequent CONNECTIONS stages; 
• appears on the Person List in the current open stage, any closed stages and any future 

stages; and 

 
When merging two Person Ids, 
if the Merged Closed Person is 
involved in an open Intake, the 

following message displays: 
 

“The closed person is in open 
stages. Merge with extreme 

caution. Continue? 

 
There must be at least one 

Person ID in common with both 
cases/stages in order to perform 

a Case Merge. 

• is identified by a check mark in the M/S column on the 
Person List. 

The Merged Closed Person: 
• is “retired” after the merge and information for the new 

Merged Forward Person is used in all open and closed 
stages; 

• cannot be related to a new stage; and 
• cannot be involved in future system events. 
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A Person Merge results in the following system changes: 
• The Merge List on the Person Merge/Split window is updated to reflect the action taken. 
• The Merged Forward Person inherits the demographics that have been selected and 

appear in all open stages. 
• The Merged Closed Person is no longer linked to any of the stages that were open at the 

time of the merge. These will now be linked to the Merged Forward Person. 
• System-generated Alert To-Do’s are sent to the Staff To-Do List of the primary and 

secondary workers for any open stages that involve the Merged Forward Person or 
Merged Closed Person. 

The Person Forward Selection Window 

 

Because of the complexity 
involved with restoring this 

information, merges should be 
completed with care. 

The Person Forward Selection window enables you to select 
specific person information that will be applied to the Person 
Forward. The Person Forward Selection window contains the 
following information for both the Person Closed and the 
Person Forward: 

• Full Primary Name 
• Primary Address 
• Sex 
• Primary Phone Number 
• Ethnicity 
• DOB (including Approximate indicator) 
• Race 
• DOD (including reason and Approximate indicator) 
• Marital Status 

 
Displaying all of the above information for both the Person Closed and Person Forward allows 
you to choose the most accurate information to be retained for the Person Forward. The type of 
information you select—and which person you select it from—affects the information that is 
retained for the Person Forward. 

• If you are selecting information from the Person Closed, the primary information for the 
Person Forward is end-dated and the information from the Person Closed is copied to 
the primary record. 

• Valid person identifier, Person Detail FA Home, Language and Religion information is 
retained from the Person Forward, unless the field is blank. If the Person Forward does 
not have this information recorded, the information from the Person Closed is copied to 
the Person Forward. 

If you have been given approval to merge or split person records, perform the following steps to 
complete this task. 
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If you determine that the 

person selected to be merged 
closed should, in fact, 

be merged forward, use the 
Switch function: 

1. Click on the Options menu. 
2. Click on the Switch 

command. 
NOTE: 

If you attempt to use the Switch 
function to perform a Person 

Merge between a person in an 
Investigation stage and a 

person in an unprogressed 
Intake stage, the following error 

message displays: 
“The Person Closed is involved 

in an open intake.” 
Under these circumstances, you 
cannot use the Switch function. 
You need to enter the Person ID 
manually from the unprogressed 

Intake stage into the Person 
Forward field to perform the 

Person Merge. 

 

Step-by-Step: 
Completing a Person Merge Within the 
Assigned Workload 

1 From the Assigned Workload, select the stage 
containing the person information that requires 
merging. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Person task. 
The List… button enables. 

4 Click on the List… button. 
The Person List displays. 

5 Click on the name of the person to be merged. 
6 Click on the Options menu and select Person 

Merge/Split. 
The Person Merge/Split window displays. The 
highlighted name from the Person List pre-fills in the 
Merged Persons Closed section. 

7 Enter the Person ID of the Merged Forward Person. 
Note: There must be at least one Person ID in 
common with both cases/stages in order to perform 
a Case Merge. 
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8 Click on the Validate button. 
The system checks for an open case and a valid 
Person ID. Warning messages (as listed in the box 
to the right) may display. 
When the check is complete, the Merge button 
enables.  

9 Click on the Merge button. 
The following message displays when the Merged 
Closed Person is involved in an open Intake: 
“The closed person is in open stages. Merge with 
extreme caution. Continue?” 
The following message displays to confirm the 
merge  
“Merge <ID#> into <ID#>?” 
The first ID number listed is for the Merged Closed 
Person. The second ID number is for the Merged 
Forward Person. 
 
NOTE: If you realize that you have made a mistake 
in selecting your persons, click on the No button. 

10 Click on the Yes button. 
The Person Forward Selection window displays 
with the following information for both the Person 
Forward and the Person Closed: 

• Name (First, Middle, Last, Suffix) 
• Marital Status 
• Sex 
• Ethnicity 
• Race 
• DOB (including Approximate indicator, if 

applicable) 
• DOD (including Approximate indicator and 

reason, if applicable) 
• Address Line 1 
• Address Line 2 
• City, State, ZIP 
• Address Type 
• Phone 
• Phone Type 

11 Select information from the Person Forward 
Selection window by clicking on the radio button 
next to each applicable field. 
The type of information you select—and which 
person you select it from—affects the information that is retained for the Person 
Forward. See page 12-11 for details. 

 

Person Merge Warnings and 
Error Messages: 

When completing a person 
merge, you may see warnings 

and/or error messages. 
Warnings do not prevent you 
from completing a merge, but 

error messages do. 

Reasons for Warnings: 

• Both persons must be the 
same sex (if it is recorded). 

• Both people must have a 
DOB that is within 5 years 
(if recorded). 

• One of the persons is 
involved in a fatality report. 

Reasons for Error Messages: 

• Social Security numbers do 
not match. 

• Medicaid number does not 
match. 

• Entered ID is not found, 
verify ID. 

• Services CIN must match. 

• NYC Non-Service (NS) 
CIN’s must match (NYC 
only). 

• Merge will cause person to 
be a subject and MA/AB 
child in the same 
Investigation stage. 

• The ID Person entered has 
the status of person closed 
from a prior merge. 

• The Merged Closed Person 
is in an open Intake or 
Investigation stage. 
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12 When you have made all of your selections from the Person Forward Selection 
window, click on the OK button. 
The Person Merge/Split window displays. The name of the person logged on and the 
date of the merge display in the Staff NM Merge and Date Merge fields. 

13 Click on the Save button. 
The change is saved in the system and the Person List displays. 

 

Step-by-Step: 
Completing a Person Merge from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Perform a Person Search. 
3 In the Person Search List, click on the person who is to be listed in the Merged 

Persons Closed section of the Person Merge/Split window. 
4 Click on the Options menu and select Case List. 

The Case List displays. 
5 Click on the desired case to select it. 
6 Click on the Summary button. 

The Case Summary window displays. 
7 Click on the applicable stage. 
8 Click on the Options menu and select Person List. 

The Person List displays for the selected stage. 
9 Select the person to be merged from the Person List. 
10 Click on the Options menu in the Person List and select 

Person Merge/Split. 
The Person Merge/Split window displays with the selected 
person’s name pre-filled in the Merged Persons Closed section. 

 
If you determine that the 

person selected to be merged 
closed should, in fact, 

be merged forward, use the 
Switch function: 

Click on the Options menu, and  
 Click on the Switch command. 

11 Review the Name and Person ID information in the Merged Persons Closed section 
for accuracy. 

12 Enter the Person ID of the Merged Forward Person in the Forward section. 
13 Click on the Validate button. 

The system checks for an open case and a valid Person ID. The Merge button 
enables. 

14 Click on the Merge button. 
The following message displays when the Merged Closed Person is involved in an 
open Intake: 
“The closed person is in open stages. Merge with extreme caution. Continue?” 
The following message displays to confirm the merge  
“Merge <ID#> into <ID#>?” 
The first ID number listed is for the Merged Closed Person. The second ID number is 
for the Merged Forward Person. 
 

NOTE: If you realize that you have made a mistake in selecting your persons, click 
on the No button. 
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15 Click on the Yes button. 
The Person Forward Selection window displays with the following information for 
both the Person Forward and the Person Closed: 

• Name (First, Middle, Last, Suffix) 
• Marital Status 
• Sex 
• Ethnicity 
• Race 
• DOB (including Approximate indicator, if applicable) 
• DOD (including Approximate indicator and reason, if applicable) 
• Address Line 1 
• Address Line 2 
• City, State, ZIP 
• Address Type 
• Phone 
• Phone Type 

16 Select information from the Person Forward Selection window by clicking on the 
radio button next to each applicable field. 
The type of information you select—and which person you select it from—affects the 
information that is retained for the Person Forward. See page 12-11 for details. 

17 When you have made all of your selections from the Person Forward Selection 
window, click on the OK button. 
The Person Merge/Split window displays. The name of the person logged on and the 
date of the merge display in the Staff NM Merge and Date Merge fields. 

18 Click on the Save button. 
The change is saved in the system and the Person List displays. 

Person Split 

The purpose of a Person Split is to correct an incorrect Person Merge; a merge of two Person 
ID’s that should have remained separate. Performing a Person Split reinstates the Person 
Closed to the CONNECTIONS database, but does not fully return the Person Closed to his or 
her original stage, however.  

 

The Merge Forward Person 
cannot be deleted from the 

stages that were open at the 
time the Person Merge 

took place. 

After a Person Split is performed, the Merged Closed Person’s 
pre-merge information is not “reattached” by completing a Split. 
This person information can be accessed through the Person 
Detail window when conducting a Person Search. Maintenance 
of this information is up to the person performing the split. For 
open stages/homes, it will be your responsibility to: 

• update all demographic information; 
• “return” the Person Closed to all appropriate stages 

and events; 

CONNECTIONS Step-by-Step Guide: Page 12-15 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



• restore events and allegations; and 
• remove the Person Forward by performing the 

Remove Person – Added in Error function. 

 
Things to Consider  

Before Splitting: 
The Merge Forward Person 
cannot be deleted from the 
stages that were open at the 
time the Person Merge took 
place. The Merged Closed 

Person’s pre-merge information 
is not “reattached” by 

completing a Split. Follow-up 
demographics and case/stage 
maintenance are necessary to 

complete the process. 
You need to record that 
person’s demographic 

information again and re-
associate the person with the 
appropriate case(s)/stage(s). 

The Person Data report 
contains the current and 
historical information of a 

person. 
To run the report: 

1 Select the person on the 
Person List. 

2 Click on the Reports menu 
and select the Person Data 
command. 
The following message 
displays: “The report has 
been launched. Check 
Report List window.” 

4 Click on the OK button. 
5 Click on the RPRTS button. 
6 Select the Person Data 

Report and click on the 
Open button. 

This provides a hard copy of all 
information stored in 

CONNECTIONS about a 
specified person including 

merge/split history and 
demographic changes. 

If the stage is closed, speak to your supervisor to see if Local 
Data Maintenance is an option. 

A Person Split results in the following system changes: 
• The previously Merged Closed Person becomes active 

again in the database, but is not re-associated with any 
open stages. 

• The previously Merged Closed Person’s pre-merge 
demographics remain available in CONNECTIONS. 

• The events/activities associated with the reactivated 
person (and approved prior to the merge) require data 
maintenance to be associated with that person again. 

• Events that occurred while the merge was in effect are 
not associated with the reactivated person. 

• System-generated To-Do’s are sent to workers assigned 
to open stages associated with the previously merged 
person.  

 

Step-by-Step: 
Completing a Person Split 

1 On the Assigned Workload, select the stage which 
contains the person information that was merged in 
error. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays for the selected stage. 

3 Click on the Maintain Person task. 
4 Click on the List… button. 

The Person List displays for the selected stage. 
5 Click on the name of the person who was merged in 

error. 
6 Click on the Options menu and select Person 

Merge/Split. 
The Person Merge/Split window displays. The system 
pre-fills the person’s name into the Merged Persons 
Closed section. 

7 In the list section at the top of the window, select the 
merge you want to split. 
The system fills the merge information into the detail 
section of the window. 
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8 Click on the Split button. 
The following message displays: “Split ID# from ID#?” The first ID number listed is 
for the Closed Person. The second ID number is for the Forward Person. 

9 Click on the Yes button. 
10 Click on the Save button. 

The change is saved in CONNECTIONS; data maintenance is required to re-
associate with events. The Person List displays. 

Historical Person Information 
We know that CONNECTIONS preserves information in the form of historical records. Historical 
records are maintained for individuals and FAD Homes/Stages. In this section, we will look at 
ways to view historical information about the individuals residing in the FAD Homes you are 
responsible for. 

Historical Person List 

The Historical Person List is different from the Person List, which only displays individuals 
currently living in the FAD Home. An Historical Person List is created when a FAD caseworker 
uses the Remove Person – Left Home function (see page 12-6). 

The Historical Person List displays all of the individuals removed from a specific FAD stage, via 
the Remove Person –Left Home function. The list includes the date on which each person was 
removed. If a person has been involved in a merge, the Historical Person List displays the 
Person Forward information. If the person has been involved in a split, the original name 
displays with the original information prior to the merge. 

Individuals removed from a FAD home because they were Added in Error (see page 12-7) do 
not display on the Historical Person List.  

If an historical record does exist for a FAD home, the following message displays in the lower 
left side of the Person List: “Historical records exist.” 

 

Step by Step: 
Accessing the Historical Person List 

1 Select the appropriate FAD Home/Stage on the Assigned Workload, and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Maintain Person task, and click on the List button. 
The Person List displays. The bottom left side of the window must display the 
following message, in order to access an historical Person List: “Historical Records 
Exist.” 

3 Click on the Options menu and select the Historical Person List command 
The Historical Person List displays. 

4 Click on the Close button when finished. 
The Person List displays. 
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Case List 

The Case List displays a list of homes/cases that either meet the search criteria entered in the 
Case Search window or are associated with a specific person. The Case List provides important 
information that is valuable throughout the Life Cycle of the Home. For this reason, it can be 
accessed from a number of windows in CONNECTIONS, including (but not limited to): 

• The Person Search window 
• The Person List 
• The Person Detail window 
• The Foster and Adoptive Home Record Summary (FRS) 

The Case List displays high-level case information, such as the Case name, Case ID, the local 
district or voluntary agency and the primary worker assigned to the most recent open stage of 
the case. Current and historical associations with a FAD case, as well as current and historical 
CPS cases are displayed. 

To access Case List information for an individual that has left the FAD Home/Stage, you will 
need to conduct a Person Search on that individual (see Module 4: Retrieving Information in 
CONNECTIONS).  

When the Case List is opened via the Person Search window, the Person List or the Person 
Detail window, the historical FAD cases are shaded in gray. The following message displays 
when the case is selected from the Case List and the person is no longer in the FAD home: 

“Shaded rows represent historical involvement in FAD stages.” 

 

Step by Step: 
Accessing the Case List from the Person Search Window 
(within a Home/Stage) 

1 Select the appropriate FAD Home/Stage on the Assigned Workload and click on the 
Tasks… button. 
The Task List displays.  

2 Select the Maintain Person task and click on the List… button. 
The Person List displays. 

3 Click on the New button. 
The Person Search window displays. 

4 Enter search criteria and click on the Search button. 
Search results display in the Person Search List in the lower half of the Person 
Search window. 

5 Select a name on the Person Search Results List. 
6 Click on the Case List button. 

The Case List displays. 
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Step by Step: 
Accessing the Case List from the Person List 

1 Select the appropriate FAD Home/Stage on the Assigned Workload, and click on the 
Tasks… 
The Task List displays.  

2 Select the Maintain Person Information task and click on the List… button. 
The Person List displays. 

3 Select person from the Person List grid. 
4 Click on the Options menu and select the Case List… command. 

The Case List displays. 

 

Step by Step: 
Accessing the Case List from the Person Detail Window 

1 Select the appropriate FAD Home/Stage on the Assigned Workload, and click on the 
Tasks… 
The Task List displays.  

2 Select the Maintain Person Information task and click on the List… button. 
The Person List displays. 

3 Select a person from the Person List and click on the Detail… button. 
The Person Detail window displays. 

4 Click on the Options menu and select the Case List… command. 
The Case List displays. 

CONNECTIONS Step-by-Step Guide: Page 12-19 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



Maintaining Home Information  
In this section we will consider information pertaining to maintaining FAD homes that are 
currently on your Assigned Workload.  

For information on how to perform maintenance on Closed FAD Homes, refer to Module 16: 
Maintaining Closed FAD Homes/Stages. 

The Home Demographics Window 
Demographic information for FAD homes must be maintained in the Home Demographic 
window, which can be accessed via the Maintain Non-Licensing Information task. This 
window contains a significant amount of information about the FAD home, including: 

• Home Name 
•  Legal Name  
• Setting  
• Auth Agency* 
• Sub Agency*  

(NYC A66 Homes Only)  
• Respite  
• Inquiry Source  
• Primary Address  
• Vendor ID 
• Sch Dist (School District) 

• Status* 
• Religion 
• Language 
• Marital Status 
•  Ethnicity  
• Hispanic or Latino Origin  

(if applicable)  
• Race 
•  Business Address Indicator 
• Primary Phone  
• Additional Address and Phone 

information 
 
Although much of this information can be viewed on the Home Demographics Tab of the Foster 
and Adoptive Home Record Summary (FRS), maintenance of maintainable items must be made 
through the Maintain Non-Licensing Information task.  

(*The items marked by an asterisk are system-generated based on information recorded 
elsewhere in CONNECTIONS.) 

 

Step by Step: 
Opening the Home Demographics Window 

1 Select the appropriate FAD home/stage on the Assigned Workload, and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Maintain Non-Licensing Information task and click on the Detail… 
button. 
The Home Demographics Window displays. 
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3 Complete the fields that require updating/changing, and click on the Save button to 
save the information and close the window. 
The fields requiring Supervisory approval display the following message: 
”Supervisor approval is required for the action. Select Save and Submit.” 

4 Click on File, and select Save and Submit. 
A Task To-Do displays. 

5 Enter comments, if desired. 
6 Click on the Save button. 

Changing Primary Address Information 

The steps below provide instruction if you need to change only Primary Address information. 

 

Step by Step: 
Changing Primary Address Information 

1 Select the Maintain Non-Licensing Information 
task and click on the Detail… button. 
The Home Demographics Window displays. 

2 Modify the Primary Address information, and click on 
the Validate button. 
The address validation window displays. 

3 Click the Yes button to access the validation. 
The Resource Address Detail window displays. For 
more information on address validation, see the 
address validation tip box in Module 6: Responding to an Inquiry. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button 

4 Make note of the Vendor ID number, and then de-select the Use as Business 
check box. 
All Business Address information is deleted from the record. 

5 Click on the Address push button. 
The Resource Address Detail window displays. 

6 Enter the unchanged business address information (including the Vendor ID 
number). 

7 Click on the Add button. 
The validation window displays. 

8 Click on the Yes button to accept the validation.  
For more information on address validation, see Module 6: Responding to an Inquiry. 

9 Click on File, and select Save and Submit. 
A Task To-Do displays. 

10 Enter comments, if desired. 
11 Click on the Save button. 

CONNECTIONS Step-by-Step Guide: Page 12-21 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



Home Demographic Information and the FRS 

There are two areas in the Foster Adoptive Home Record Summary (FRS) where you can 
update Home Demographic Information – in fact, this information must be maintained in the 
FRS: 

• Emergency Back-up Information  
• Directions to the Home 

See Module 3: Managing Your Workload, for information on how to access the Home 
Demographics Tab of the FRS. 

The Interim Home Study 
An Interim Home Study is a reassessment of the home and an 
updating of the home information due to changes that occur 
during the annual certificate/approval period. The foster 
parent’s ability to continue providing foster care services is 
assessed, with consideration given to the impact that the status 
change has on the foster home. 

An Interim Home Study does not change or extend the 
expiration date of the certification/approval period. 
Depending on the type of changes made to the home’s 
information, an Interim Home Study may trigger updates with 
the Resource Directory, BICS, and CCRS during the overnight 
batch. 

The same status changes that make an Interim Home Study 
necessary, require changes to other information in CONNECTIONS. You will most likely need to 
make changes to one or more of the following tasks: Maintain Person, Maintain Licensing 
Information, Maintain Non-Licensing Information; Home Study (other areas of the FRS). 

 
After completing an Interim 

Home Study you may need to 
generate a new 

F/A Home Certificate or 
Approval Letter. 

Send a copy of the new 
certificate/letter to the foster 
parent(s) and place another 
copy in the External Foster 

Home Case Record. 

Below are some examples of status changes that must be documented in an Interim Home 
Studies. Notice that many of these events will require changes to the F/A Home License 
window, making a new F/A Home Certification or Approval Letter necessary: 

• Change in Age Range/Gender 
• Change in Capacity 
• Change in Criminal Records Results 
• Change in HH Comp 
• Change in Level of Care 
• Change in Martial  
• Change in Program Type 

Some types of status changes may not affect licensing information.. For example: a foster 
mother may have a baby and, due to the size of the home, this does not change the living 
accommodations of the foster children. This type of status change requires you to document the 
change in family composition in an Interim Home Study narrative (via the Home Study task) 
and update the Person List (via the Maintain Person task). However, the certificate/approval 
letter would not change. 
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Completing an Interim Home Study Narrative 

One common status change is the marriage or remarriage of a foster parent. According to 18 
NYCRR §443.10(c), the following activities must occur if an adult spouse of a foster parent 
comes into the home and applies for certification or approval: 

• Completion of a new application for certification or approval, including an SCR 
Database Check; 

• Completion of a CHRC; 
• Completion of a medical exam for the applicant; and 
• Review of the home study (update, as needed). 

Once you have completed all of these casework activities, you will document the status change, 
as well as relevant information that you have collected using the appropriate tasks in 
CONNECTIONS. 

New vs. Use Prior 

In the process of opening the FRS to complete an Interim Home Study, you will notice that two 
buttons become enabled on the Task List —New and Use Prior. Because one Home Study 
narrative already exists for the home, you are given the option to use information you have 
already entered, or to start with a blank document.  

Let’s take a closer look at what these different options mean. 

New—This button displays a version of the FRS where all data fields are pre-filled with 
current information from the CONNECTIONS database. The Home Study and 
Reauthorization narratives will contain blank templates and all comment boxes will be blank. 
Information can be entered in the Home Study narrative and comment boxes. 

Use Prior—This button displays a version of the  FRS where all data fields are pre-filled 
with current information from the CONNECTIONS database. The Home Study and 
Reauthorization narratives, and all comment boxes will contain information from the latest 
approved/frozen FRS. The Home Study narrative and comment boxes can be modified or 
added to as necessary. 

The steps for opening, completing and submitting the Interim Home Study narrative for 
supervisory approval are outlined below. 

 

Step by Step: 
Accessing and Completing an Interim Home Study Narrative 

1 Select the appropriate FAD home/stage on the Assigned Workload, and click on the 
Tasks… button. 
The Task List will display. 

2 Select the Home Study task, and click on either the New or Use Prior button. 
The FRS displays.  

3 Click on the Home Study Narrative tab. 
4 On the left side of the tab, click the checkbox (or boxes) that correspond(s) with the 

reason(s) you are conducting the Interim study.  
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5 Click the Save button at the bottom of the list to save the Home Study Reason(s) to 
the database. 
The following message displays: “Changes Have Been Saved.”  

6 Click on the OK button. 
7 For a Home Study accessed through a New FRS, select which narrative template 

you’ll be using by clicking on the right side of the tab in the appropriate checkbox. 
(Standard Home Study, MAPS/GPS Home Study or Other). 

8 Click the Retrieve/Edit button. 
An MS Word template opens. Selecting USE PRIOR in Step 2 displays template with 
previously recorded information.  

9 Enter your home study information into the 
narrative.  
(Include an explanation of why the interim Home 
Study is being conducted.) 

10 Click on File, and Close to close the Home Study 
Narrative when you are ready to leave the document 
(or save it). 
The following message displays: “Save Changes?” 

11 Click on the Yes button to save your work. 
12 Initiate submission of the Interim Home Study (and all updated information in 

CONNECTIONS) by clicking on the Submit button. 
The F/A Home License window displays. Proceed to Step 12. 
—OR— 
Exit the FRS by clicking the Close button in the bottom right-hand corner of the FRS 
window. The Task list displays. 

13 Make any necessary changes to the F/A Home License window and change the 
Status field to “Pending Acceptance.” 

14 Click on File, and select the Save and Submit command. 
A Task To-Do is generated for your supervisor. 

15 Complete the To-Do Detail window. 
16 Click on the Save button to finalize the submission. 

Interim Home Studies, like many narratives, take time to 
complete. An Interim Home Study can be completed in 
increments before you choose to submit it to your supervisor. 
Each time you access the FRS, you can open your Interim 
Home Study by selecting the Home Study task on the Task List, 
and clicking the Detail button. The “in-process” FRS will open 
with its narratives and comment boxes containing your last 
saved entries.  

Once the FRS and Home Study are submitted to your 
supervisor, the status of the Home Study and Home License 
events change from PROC to PEND. See Module 9: Checking 
the Status of Approvals Submitted for FAD Homes, for 
information on how to find out when your submission has been approved. 

 

Update all information in the 
FRS, as applicable. 

 

Closing the FRS after creating 
an Interim Home Study will 

generate a Home Study event 
with a status of “PROC.”  

Selecting this event and clicking 
the Detail button on the Event 

List will access the FRS in view-
only mode. 
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Conversion of an Approved Relative Foster Home 
The certification/approval requirements for relative and non-
relative foster care homes are consistent, with one difference. 
Exceptions may still be granted for Approved Relative Foster 
Homes. Although basic training requirements are the same, the 
content of the curricula may vary. 

Conversion of an Approved Relative Foster Home is considered 
a major status change. Depending on when the decision is 
made to change the Facility Type, you will need to complete 
either an Annual Reauthorization or an Interim Home Study. 

CONNECTIONS keeps categories distinct by using the Facility 
Type of “Approved Relative Foster Home” (for homes that are 
approved to care for specific children and receive an approval 
letter) and the Facility Type of “Certified Foster Home” or 
“Foster/Adoptive Home” (for homes that receive a Certificate to 
Board). 

For pre-existing Approved Relative Foster Homes that want to 
become Certified Foster Homes or Foster/Adoptive Homes, you 
need to change the Facility Type in the F/A Home License 
window, complete an Interim Home Study narrative, and ensure 
that all requirements are met for certification. 

You will begin the conversion process by using the Annual 
Reauthorization task or the Home Study task to complete a narrative describing the changes 
in the FAD home. 

After clicking on the Submit button at the bottom of the FRS window, the F/A Home License 
window displays. Follow the steps below to complete the conversion of the FAD home. 

 

Step by Step: 
Completing the F/A Home License Window for Home Conversion 

 

Before submitting the FRS and 
F/A Home License window, 
update all Maintain Person 
information as needed (e.g., 
Address List/Detail, Phone 

List/Detail, Person Detail, Home 
Member Training List/Detail). 
See Module 6: Maintaining 

Person Information. 

Use the Maintain Non-
Licensing Information task to 

update home information as 
necessary (e.g., Resource 

Address Information, Resource 
Phone Information). 

See Module 8: Maintaining 
Licensing Information for FAD 

Homes. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Maintain 

Licensing Information task > 
Detail button 

1 In the F/A Home License window (Maintain 
Licensing Information task), change the Facility 
Type from “Approved Relative Home” to either 
“Certified Foster Home” or “Foster/Adoptive Home,” 
as appropriate. 

2 Update Age Ranges and Capacity. 
3 If necessary, modify Program Type(s). 
4 Click on the drop-down arrow for the Status field and 

select Pending Acceptance from the resulting list. 
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5 Click on the File menu and select Save and 
Submit. 
The To-Do Detail window displays for a task To-Do 
assigned to your supervisor/unit approver. 

6 Type Comments to your supervisor/unit approver, if 
desired, in the appropriate field. 

7 Click on the Save button. 
The Task List displays. 

Stage (Case) Name/CD Consistency 
Maintaining consistency is a necessary part of preserving the 
integrity of CONNECTIONS data. In Module 6, we learned that 
FAD stages/cases are named after the foster or adoptive 
mother or other primary caretaker in the home. Therefore, if 
you change the primary name of the parent for whom the 
stage/case is named, you need to change the name of the 
stage/case itself. 

The Primary name must first be updated in the A.K.A. Name 
List/Detail window before you can change the stage/case name 
of the FAD home/stage. If you do not do this, the desired name 
will not appear in the New Name drop-down list in the Change 
Case Name window. 

Opening the Case (Stage) Name/CD window in View-only 
mode allows workers to view information; Modify mode allows 
workers to change the Case/Stage/Home name of a home (see 
the table on the next page for details regarding View-only and 
Modify mode). 

 

Step by Step: 
Changing the Stage (Case) Name/CD 

 
You do not need to select the 

Reauthorization check box on 
the F/A Home License window. 

You should select the 
Reauthorization check box 
only if you are documenting 
this status change as part of 
the Annual Reauthorization 

process. 

 

If you open the Case (Stage) 
Name/CD window when a 

Home Name change is pending 
approval, the following message 

displays: 

“Saving will invalidate the 
Pending approval. Continue in 

Modify mode?” 

Clicking on the No button opens 
the window in View Only mode.  

Clicking on the Yes button 
opens the window in Modify 

mode. 

 
Only Primary names can be 

selected for changing the name 
of a FAD home/stage.  

1 In the Assigned Workload window, click on the name 
of the appropriate FAD home/stage. 

2 Click the Options menu and select Case (Stage) 
Name/CD. 
The Change Case Name window displays. 

3 Click on the drop-down arrow for the New Name 
field and click on the appropriate primary name to 
select it from the resulting list. 

4 Click on the Save button. 
The Assigned Workload displays with the updated FAD home/stage name. The 
following message displays for the homes with Accepted Active status: 
”Supervisor approval is required for the action. Select Save and Submit.” 
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5 Click on the File menu and select Save and Submit. 
The To-Do Detail window displays for a task To-Do assigned to your supervisor/unit 
approver. 

6 Type Comments to your supervisor/unit approver, if desired, in the appropriate field. 
7 Click on the Save button. 

The Task List displays. 

View Only vs. Modify Mode 

Depending on how you access the Case (Stage) Name/CD window, you will have different 
abilities to modify information. Entering this window in “Modify Mode” allows you make changes 
or updates to the information. Entering the window in “View Only” mode means that you do not 
have the ability to change any information you are viewing. 

The table below further illustrates the differences between View Only and Modify Mode, 
regarding the Case (Stage) Name/CD window. 

View-only vs. Modify Mode 

View-only Mode Modify Mode 

• The Current Name and 
Current CD fields are 
protected (information 
cannot be changed). 

• The New Name and New 
CD fields are disabled. 

• The Save command (File 
menu) and button are 
disabled and all fields are 
protected. 

• The Save and Submit 
command (File menu) is 
also disabled. 

• Only the Cancel button and 
the Exit command (File 
menu) are enabled. 

• The Current Name and Current CD fields are 
protected. 

• The New Name field is modifiable. 

• The Save command (File menu) and button 
enable when the New Name field is populated 
with a different name than the Current Name 
field. 

• The New CD field is disabled (CD information 
cannot be changed in this window). 

• The Save and Submit command (File menu) 
enables only when the stage type is FAD and 
the home is in Accepted-Active or Emergency 
status and the New Name field is populated 
with a different name than that of the Current 
Name field. 

• The Cancel button is enabled. 

 

CONNECTIONS Step-by-Step Guide: Page 12-27 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



The Case (Stage) Name/CD window displays differently, depending on how you access the 
window. This next table illustrates the variations in how the window displays. 

Case (Stage) Name/CD Window 
Display Variations 

Path/ 
Window 

Display 
Mode 

Display 
Details 

Assigned 
Workload 

View-only 
or 

Modify 

• The Current Name field displays the current 
case/stage/home name for the selected FAD home and 
the Current CD field displays the current CD for the 
selected home (NYC only). The Current Name and 
Current CD fields are always protected. 

• The New Name and New CD fields are blank. 

• If there is a pending Home License or Home Closure for 
the selected FAD home, the Case (Stage) Name/CD 
window is view-only. 

• If there is a pending Home Name Change, the following 
message displays: “Saving will invalidate the Pending 
approval. Continue in Modify Mode?” 
 
If you click on the No button, the window displays in View-
only mode; if you click on the Yes button, the window 
displays in Modify mode. 

Event List View-only 

• The Current Name field displays the current 
case/stage/home name before the Home Name Change 
was submitted for approval. 

• The New Name field displays the new case/stage/home 
name that was submitted for approval at the time the 
Home Name Change event was created. 

• The Current CD field is blank and protected. 
The New CD field is blank and disabled. 

“Approve 
Home Name 

Change” 
Task 

To-Do 

View-only 

• The Current Name field displays the current 
case/stage/home name before the Home Name Change 
was submitted for approval. 

• The New Name field displays the new case/stage/home 
name that was submitted for approval at the time the 
Home Name Change event was created. 

• The Current CD field is blank and protected. 
The New CD field is blank and disabled.  
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Case (Stage) Name/CD Window 
Display Variations 

Path/ Display Display 
Window Mode Details 

• The Current Name field displays the current 
case/stage/home name for the selected FAD home. 

• The New Name field displays the case/stage/home name 
that was rejected after it was submitted for approval. “Rejection 

Home Name 
Change” 

Task 
To-Do 

 
Modify 

• The Current CD field is blank and protected. 
The New CD field is blank and disabled. 

 
If you click on the No button, the window displays in view-only 
mode; if you click on the Yes button, the window displays in 
Modify mode. 

Impact of Case (Stage) Name/CD Changes 

Completing the Case (Stage) Name/CD window is only one 
step in updating CONNECTIONS when the name of a resource 
changes. CONNECTIONS provides different reminders to help 
you complete all updates to the system, and CONNECTIONS 
generates certain tasks and events. The listing below 
summarizes what happens once the Case (Stage) Name/CD 
window is submitted for supervisory approval: 

 

For FAD Homes with NYC 
addresses, CD’s are changed 
by validating a new primary 

address.  

The new CD is generated once • Once the window is submitted for supervisory 
approval, this message displays: 
“This change will also update the Resource Legal 
Name.” 

the address is validated. 

• As the primary worker, you will also receive an alert To-Do on your Staff To-Do List. 
The description field reads: 
“Update Home Study/Reauthorization RE: Address/Name change.” 

• A Task To-Do is created for the approver, who will navigate to the Case (Stage) 
Name/CD window from the Task To-Do on their Staff To-Do List.  

• A new home event is created on the Event List when the Case (Stage) Name/CD 
window is Saved (or Saved and Submitted). 

• If the Legal Name of the FAD home is different from the new Resource Name, the 
worker must change the Legal Name in the Home Demographics window to include 
both foster parents names, once the Home Name change is approved by the 
supervisor (see “Maintaining Home Information on page 12-20). 
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F/A Home History Detail 
Maintaining FAD Home information can also include making adjustments to the home’s history 
in specific cases. Before we discuss the F/A Home History Detail window, let’s consider why 
history sometimes needs to be corrected in CONNECTIONS. 

Example: When Changes are Made  
to the F/A Home History Detail Window 

The certification or approval of a home may expire if a worker is unable to submit the Annual 
Reauthorization on time. If the caseworker and foster family have completed all activities 
showing that State regulations have been met by the home (and this is properly document 
outside of CONNECTIONS), this situation is referred to as a “Delayed” or “Late” System Entry 
(see Module 14: Recertification and ). 

Since FAD homes in CONNECTIONS cannot be reopened until one business day has gone by 
(see Module 17: Reopening FAD Homes), a lag is created in the history of the home’s 
certification/approval of at least one day. 

Caseworkers with the “Maintain Historic F/A Home“ Business Function may use the F/A Home 
History Detail window to maintain historical records of FAD homes. Only dates and status data 
about the selected FAD Home record can be modified; all other fields are protected. If the most 
recent record is selected from the F/A Home History window, only the date in the Authorized 
From field can be modified. 

System Edits 

To conform with regulatory requirements and to ensure that the certification dates do not 
exceed one year, CONNECTIONS contains an edit that prevents an F/A Home History record 
from being modified until the home has progressed to Accepted-Active status at least once. 

Another edit exits to make sure the home’s certification period will not extend beyond one year. 
Therefore, changing Authorized From field on the F/A Home History Detail window causes the 
Authorized To field to be updated accordingly. This edit applies only to the current F/A Home 
History record. All ensuing F/A Home History records are adjusted accordingly, but F/A Home 
History records prior to the changed record are not affected. 
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Opening the F/A Home History Detail Window 

The F/A Home History Detail window is accessed via the F/A Home History window, using the 
History Detail button. The Save button (as well as the Save command from the File menu) 
enables when any change is made to these fields. 

Step by Step: 
Opening the F/A Home History Detail Window 

 

1 Select the appropriate FAD home on the Assigned Workload, and click on the 
Tasks… button. 
The Task List displays. 

2 Select the View Home History task and click on the 
List… button. 
The F/A Home History window displays.  

3 Select the appropriate FAD Home history record and 
click on the History Detail… button. 
The F/A Home History Detail window. When 
selecting the most current row the following 
message displays: 
”The most current row was selected. Only the Auth 
From Date may be modified.” Click OK to display 
F/A Home History window. 

The Business Function, 
“Maintain FAD Home History” 

must be added to your Business 
Function Profile (BFP) in order 
for you to make changes to the 

F/A Home History Detail 
Window. 

4 Make the necessary changes to the record. 
The Save button enables. 

5 When changes are complete, click on the Save button to save your work and close 
the window. 
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Module 13: 
Vacancy Control 

The Vacancy Control function is designed to provide local district and voluntary agency workers 
with “real time” access to vacant bed information that meets the needs of the children in need of 
placement. 

FAD workers can search for bed vacancies and maintain bed 
level vacancies and bed characteristics in Foster Boarding 
Homes (FBH) or Congregate Care Facilities (CCF) that they 
authorize.  

 

Kinship Homes are not included 
in Vacancy Control. 

Vacancy Control is primarily used by New York City/ACS 
workers, although other counties in New York State are 
currently exploring the use of Vacancy Control. 

Several windows in CONNECTIONS help workers search for available beds and maintain new 
or existing beds and bed characteristics in facilities. These windows include: 

• Vacancy Control - Search ―Provides workers with the ability to search and reserve 
an available bed based on the information entered for the type of facility and bed 
desired. Only facilities in active status are returned in a search. 

• Vacancy Control - Bed Detail ―Provides workers with the ability to view all beds in 
a selected facility. Workers are able to select a Vacant bed(s) and “Reserve” or 
“Occupy” the bed(s) for a child or children in need of placement. Workers who 
reserve a bed (or a staff person in the unit hierarchy) are also able to change the 
status to Unreserve within the two-hour time limit for bed holds. 

• Vacancy Control - Bed Maintenance ―Provides workers with the ability to 
maintain beds (e.g., add beds, delete beds, modify bed characteristics) for a facility 
in accepted, active or applicant status. Performing this function in a timely manner 
allows agencies to optimize their placement potential. 

• Vacancy Control - Closed To Intake ―Provides designated OCFS and local district 
staff with the ability to remove facilities from the Vacancy Control Facility Search 
Results. The Closed To Intake status can be applied to a single facility, all facilities 
within an agency or a facility type within an agency  

• Vacancy Control - CD/Borough Award ―Provides NYC/ACS workers with the 
ability to maintain data that indicates which agencies have been awarded a 
neighborhood based service contract.  

In addition, there are a number of reports that help track placement or notify individuals of 
Closed To Intake status changes applied to facilities. 

• Vacancy Control Placement Tracking Report ― Caseworkers and supervisors 
can create a report that contains information about selected beds that are in 
Occupied status. 

• Vacancy Control Closed To Intake Report ― This report contains statewide 
information on facilities that have a Closed To Intake status. It is available to all staff 
on the Closed To Intake Distribution List. The distribution list is maintained by 
NYS/OCFS. 
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• Vacancy Control Reports in the Data Warehouse — There are several reports 
available in the OCFS Data Warehouse that contain Vacancy Control data. 

Vacancy Control Business Functions 
In order to use the Vacancy Control – Bed Maintenance function, your Business Function Profile 
(BFP) must include the Vacancy Control - Bed Maintenance Business Function. This 
Business Function is necessary in order to access the Vacancy Control Bed Maintenance 
window in modify mode. 

Also, you must work for the same district/agency that authorizes the facility, or the facility must 
be on your Assigned Workload. 

Any workers assigned to a FAD stage can view the Vacancy Control Bed Maintenance window 
from the Task List, if the district uses Vacancy Control. This provides necessary access for FAD 
workers who are not designated to maintain Vacancy Control. Such workers can view 
information contained in Vacancy Control that may be relevant to certification and licensing 
information, even though they do not the proper access to modify the information. 

Vacancy Control Search 
The Vacancy Control Search window allows local district and voluntary agency workers to enter 
child characteristics and search for a facility with a bed that matches the child’s needs. 
Searches can be conducted for both an individual child or sibling groups. Workers can review 
the results of this search and select a facility from the list. Once a facility has been selected, 
workers can view the status of all beds in that facility and “Reserve” or “Occupy” a vacant 
bed(s). Two different types of vacancy control searches can be conducted from this window: 

• An Element Search for vacancies in Foster Boarding Homes (FBH) or Congregate 
Care Facilities (CCF); or  

• An Exact Search using either Resource ID or Vendor ID. 

To access this window, select “Vacancy Control Search” from the Options menu on the 
CONNECTIONS Toolbar. Workers must have the VACANCY SEARCH Business Function to 
access this option. 

 
The Vacancy Control Search window is divided into two sections, the tab section and a button 
section. The tab section has two separate tabs, the Search tab and the Bed Characteristics 
tab. Both contain fields and grids that allow workers to enter information that is used to conduct 
the search. 
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Conducting the Search 
When the Vacancy Control Search window is first opened, only the Search tab is enabled. The 
Bed Characteristics tab enables after a type of search is selected. The type of search selected 
by the worker determines the:  

• required search criteria; 
• filters that can be added to narrow the search; and 
• type of results displayed in the Vacancy Control Facility Search Results window. 

 

Step by Step: 
Opening the Vacancy Control Search Window 
via the Toolbar 

1 Click on the Options menu on the CONNECTIONS Toolbar. 
A list of commands display. 

2 Select the Vacancy Control Search… command. 
The Vacancy Control Search window displays. 

The Search Tab — Vacancy Control Search window 

The Search tab is divided into three sections: Search Elements, Exact Search and Search 
Filters. To conduct a search using elements, workers must select either Foster Boarding Homes 
or Congregate Care Facilities from the Type of Search drop-down list located in the Search 
Elements section. Foster Boarding Homes include Certified Foster Homes and Foster Adoptive 
Homes. Congregate Care Facilities include Agency Boarding Homes, Group Homes, Group 
Residences and Institutions. Congregate Care facilities are not maintained in Vacancy Control 
Bed Maintenance at this time and, therefore, will not return in a search. 
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To conduct an Exact Search, workers must enter either the Resource ID or Vendor ID. Filtering 
eliminates results that do not match. Entering an Agency ID, Facility type or Program type that 
meets the child’s needs, can also filter the search results. For more information on filtering a 
search, refer to “Search Filters” on page 13-5. 

 
When searching for a large 

sibling group, workers may want 
to lower the number of required 

beds used in the search to 
increase the number of results. 

The beds listed in Vacancy 
Control represent the foster 
parent’s preferred number of 

beds. Some Foster Homes may 
be certified for more beds.  

To accommodate the placement 
of large sibling groups, a waiver 
may be requested to exceed the 
licensed number of beds for a 

facility (up to eight).  

 
Age Range 

When searching for a single 
bed, workers can either list the 
child’s age in both the Minimum 
Year and Maximum Year fields, 

or an estimated age range 
based on the child’s expected 

ages upon discharge. 

When searching for a bed for a 
child less than 1 year old, enter 
“0” in the Minimum Year field. 

Enter “0” or the child’s expected 
age upon discharge in the 

Maximum Year field. 

When searching for a sibling 
group, enter the youngest 
child’s current age in the 

Minimum Year and the oldest 
child’s current age or expected 

age upon discharge in the 
Maximum Year field. 

Search Elements 
Vacancy Control Search provides workers with the flexibility to 
search for a single bed or for sibling groups. The information 
entered in the required fields will differ depending on whether 
the search is for a single bed or a sibling group. When 
searching for a single bed, the search criteria entered are 
specific for the child in need of placement. When searching for 
a sibling group, the search criteria entered represents an 
overall summary of the required number of beds by gender, age 
ranges by gender (widest range) and the Bed Characteristics 
(highest severity level).  

Required fields for each search type highlight in yellow. When 
conducting a search for a Foster Boarding Home using Search 
Elements, the following fields on the Search tab are required: 

• Type of Search  
Select Foster Boarding Homes. 

• Borough/County: (of Primary Address)  
This field represents the borough for the child’s last 
known primary address. This field allows a worker to 
conduct a search by selecting a specific borough, 
county, statewide, NYC wide, or out of state. The 
Borough Sort/Filter Option check box in the Search 
Filter section is only visible when a borough is 
selected from the drop-down list. 

• Community District: (of Primary Address)  
This field represents the NYC Community District 
(CD) for the child’s last known primary address. This 
field is required when a NYC borough is selected in 
the Borough/County field. 
 
This field allows a search to be conducted for a bed 
within a specific NYC/CD. The Community District 
Sort/Filter Option check box in the Search Filter 
section is only visible when a Community District is 
selected from the Community District drop-down 
list. Select “Unknown” from the drop-down list when 
the CD is unknown. Note: When “Unknown” is 
selected from the CD drop-down list, the 
Community District Sort/Filter Option check box 
is not visible and the Borough Sort/Filter Option 
check box is disabled. 

• Male Age Range 
Minimum Year and Maximum Year  
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• Female Age Range 
Minimum Year and Maximum Year  

• Required Number of Male Beds and/or Required Number of Female Beds 
If “0” is entered for Required Number of Beds in a FBH search, at least one 
characteristic from the Bed Characteristics tab must be added. By entering “0,” 
workers are able to search for beds that are not currently available and check the 
date the bed is expected to be vacant. 

Exact Search  

When conducting an Exact Search the following fields on the Search tab are required: 
• Resource ID; or 
• Vendor ID.  

Only numeric entries are allowed in the Resource ID field. Alphanumeric entries are allowed in 
the Vendor ID field.  

 
When workers from voluntary 
agencies enter the Vacancy 
Control Search window, their 
Agency ID is pre-filled in the 
Agency ID field. This field is 

view-only for voluntary 
agencies, allowing them to 

search for homes within their 
own agency only.  

Search Filters 

In addition to these required fields, one of the three optional 
fields located in the Search Filters section on the Search tab 
can be used to narrow the search. These fields are Facility 
Type (Certified Foster Home or Foster/Adoptive Home for FBH 
or Agency Boarding Home, Group Home, Group Residence or 
Institution for CCF), Program Type (e.g., Mother/Child, 
Emergency, Therapeutic) and Agency ID (the agency’s three 
digit alpha-numeric identifier). When a search is filtered using 
one of these fields, the results of the search will only include 
beds that match the filter. For example, if you enter an Agency 
ID, your results will only include beds within that agency. 

  
The Search Filters section may also display the following two sort/filter option check boxes:  

• The Show results for <Borough> only check box displays when a New York City 
borough is entered in the Borough/County field. This check box is automatically 
selected when it displays. If the search is conducted with this check box selected, 
the search results are filtered, returning only the homes/facilities for the selected 
borough in the search results. If you de-select this check box, the search results are 
sorted, displaying facilities in all New York City boroughs with the targeted borough 
from the Borough/County field at the top of the list. 

• The Show results for <CD> only check box displays only when you select a CD in 
the Community District field. When this check box displays, it is automatically 
selected and the Show results for <Borough> only check box disables. If the 
search is conducted with this check box selected, the search results are filtered, 
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returning only the facilities in the selected CD in the search results. If you de-select 
this check box, the Show results for <Borough> only check box enables. If both 
check boxes are de-selected, the search results are sorted; displaying facilities in all 
New York City CDs, with the targeted borough and CD at the top of the list.  

The Bed Characteristics Tab — Vacancy Control Search  

The Bed Characteristics tab displays a list of all characteristics for the selected Type of 
Search (Congregate Care Facility or Foster Boarding Home). This tab provides workers with the 
ability to add characteristics to the search by selecting the severity level appropriate for the child 
in need of placement. 

Foster Boarding Homes 

When “Foster Boarding Homes” is chosen as the Type of Search, a list box with two columns 
displays. The Characteristics column displays a view-only list of characteristics (e.g., 
Behavioral, HIV, Educational) that are allowed for resources in that type of search. The Severity 
column allows workers to select the severity level for the associated characteristic by using a 
drop-down list.  
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The minimum – maximum range for Foster Boarding Homes is 0-3. The choices for Physical, 
Learning, Emotional and Behavioral Characteristics are:  

• 0 — NA (no known condition or problem) 

• 1 — Mild 

• 2 — Moderate 

• 3 — Severe 

The choices for HIV are “Yes” and “No.” Refer to Appendix N for the definitions for bed 
characteristic severity levels in Foster Boarding Homes. 

The Bed Characteristics tab also displays the Type of Search and Number of Beds fields. 
These fields are view-only and display information entered on the Search tab. 

The lower section of the window contains the buttons. The following table provides the name of 
each button and a description of the button’s function: 

Button Name Description 
Clear This button clears all search fields Vacancy Control Search 

window. (The Clear command can also be selected from the 
File menu.) 

Search This button initiates a search for facilities based on the 
criteria entered in the Vacancy Control Search window. The 
results of this search display in the Vacancy Control Facility 
Search Results window. The Search button enables when 
all required fields have been completed for the desired type 
of search. (The Search command can also be selected from 
the Options menu.) 

Close This button closes the Vacancy Control Search window. 
(The Close command can also be selected from the File 
menu.) 

 

 

Step by Step: 
Conducting a Vacancy Control Search  

1 From the Vacancy Control Search window, click on 
the drop-down arrow for the Type of Search field and 
select Foster Boarding Homes from the resulting 
list. 
Required fields highlight in yellow. 

2 Click on the drop-down arrow for the 
Borough/County (of Primary Address) field and 
select appropriate county from the resulting list. 
If you select a NYC borough, the Show results for 
<Borough> only check box displays in the Search 
Filter section. This check box enables workers to conduct a search within that 
specific borough or throughout New York City. 

 

Where am I? 

CONNECTIONS toolbar > 
Options menu > Vacancy 
Control Search command 
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3 Click on the drop-down arrow for the Community District (of Primary Address) field 
and select the appropriate district from the resulting list. This field is required when a 
NYC borough is selected in the Borough/County field. 
This field allows a search to be conducted within a specific Community District (CD). 
If you select a specific CD, the Show results for <CD> only check box displays in 
the Search Filter section in the lower part of the tab. This check box enables workers 
to conduct a search within a specific CD. If the CD is unknown, workers should 
select Unknown from the drop-down list. 

4 Record the desired minimum year and maximum year age range in the Male/Female 
Age Range sub-section. 

5 Record the required number of beds. 
If “0” is entered in this field (or in the Required Number of Female Beds field), at 
least one characteristic must be selected on the Bed Characteristics tab. By 
entering “0,” workers can search for beds that are not currently available and check 
the date on which the bed is expected to be vacant. 

6 If appropriate, deselect the Show results for <CD> only check box. 
When selected, search displays vacancies only for the selected Community District. 

7 If appropriate, deselect the Show results for <Borough> only check box. 
When selected, search displays vacancies only for the selected Borough. 

8 Click on the Behavioral Characteristics tab. 
The Behavioral Characteristics tab displays. 

9 Click in the Severity level cell to record characteristics. 
A drop-down arrow displays. 

10 Click on the drop-down arrow and record desired severity level for the selected 
characteristics. 

11 Click on the Search button. 
The Vacancy Control Facility Search Results window displays with the results of your 
search. 

Reviewing the Results 
A Vacancy Control Search returns facilities that meet or exceed the search criteria entered in 
the Vacancy Control Search window. Only facilities with the status of Accepted–Active are 
included in the results. Facilities in Applicant or Closed status will not return in the search. 
Facilities that are designated as “Closed To Intake,” or facilities that are operated by an Agency 
that is designated as “Closed to Intake,” are not included in the search results. The results 
display in the Vacancy Control Facility Search Results window.  
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The maximum number of facilities returned is 200. If more than 200 facilities matched the 
search criteria, the following message displays:  

“There were more than 200 facilities that match the Search Criteria entered. 
Only the first 200 facilities will be displayed.” 

If no facilities match the search criteria, the following message displays: 
“No matches were found for the search parameters.” 

All elements in the Vacancy Control Facility Search Results window (e.g., the Male Age Range 
and Type of Search fields) are view-only. This window is divided in to three sections. The 
header section at the top contains fields that are pre-filled with the search criteria entered by the 
worker in the Vacancy Control Search window. Only fields that were used in the search will be 
populated.  

The middle section contains the facility results grid. This grid contains the following columns that 
provide specific information for each of the facilities returned in the results:  

• Closed to Intake (Y/N) 
• Borough/County 
• CD 
• Vacancies 
• CD/Borough Award (Y/N) 
• Agency Name 
• Facility Name 
• Address 

• City 
• State 
• Zip 
• Phone 
• Vendor ID 
• Resource ID 
• Facility Type 

Use the horizontal scroll bar at the bottom of the grid to scroll to the right to view all of the 
columns. Before viewing all of the columns, you may want to note the line number for the facility 
prior to using the scroll bar. The information displayed in these columns is view-only. If any of 
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this information needs to be updated, the worker who maintains records for the facility must 
make the changes in the appropriate windows.  

Two of the columns display information from other Vacancy Control windows: 

• The Closed To Intake column displays an indicator next to the facilities that are 
designated as Closed To Intake by another district or that are owned by an agency 
that is designated as Closed To Intake by another district. For more information on 
Closed To Intake, refer to “Vacancy Control Closed To Intake” on page 13-27. 

• The CD/Borough Award Indicator column displays an indicator (“Y” for yes or “N” 
for no) next to facilities that are authorized by an agency that is awarded a 
neighborhood based service contract. For more information on CD/Borough Awards, 
refer to “Vacancy Control CD/Borough Award (NYC/ACS only)” on page 13-31. 

The lower section of the window contains the Total Facilities Returned field and the Sort, Bed 
Detail and Close buttons. The following table provides the names for each button and a 
description of the button’s function. 
 

Button Name Description 
Sort This button opens the Sort dialog box. Workers may select 

one, two or three columns to use to re-sort the Facility 
Results list. 

Bed Detail This button opens the Vacancy Control Bed Detail window. 
The Bed Detail button enables when a facility is selected 
from the list. 

Close This button closes the window. (The Close command can 
also be selected from the File menu.) 

 
When the Vacancy Control Facility Search Results window is first opened, the facilities are 
sorted based on the type of search that was conducted. The default sort for Foster Boarding 
Homes is: 

• Borough/County 

• NYC/CD (targeted CD displayed first with remaining CDs following in numerical 
order) 

• NYC/CD Award  

• Facility Name (alphabetically in ascending order) 

For example, if you are searching for a bed in CD 04 in the Bronx, the results will list CD 04 in 
the Bronx first. All non-targeted CDs in the Bronx will display in numerical order after the 
targeted CD (04, 01, 02, 03, 05). Facilities with a CD Award will display higher on the list (within 
that CD) than other facilities from that CD. 
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Sorting the Results 
The results on the Vacancy Control Facility Search Results window can be re-sorted using 
either of the following methods: 

• clicking on the column header or footer; or 
• clicking on the Sort button. 

 

Step by Step: 
Sorting the Vacancy Control Search Results 

 

Where am I? 

CONNECTIONS toolbar > 
Options menu > Vacancy 

Control Search command > 
Search button > 

 

Where am I? 

CONNECTIONS toolbar > 
Options menu > Vacancy 

Control Search command > 
Search button > 

1 On the Vacancy Control Facility Search Results 
window, click on a column header. 
The results are re-sorted in ascending order by the 
selected column. 

OR 
2 Click on the column footer. 

The results are re-sorted in descending order by the  
selected column. 

 

Step by Step: 
Accessing the Vacancy Control - Search 
Results Sort Window 

1 Click on the Sort button in the lower section of the 
Vacancy Control Facility Search Results window.  
A Sort box containing three drop-down lists displays. 
These lists have the names of each column heading  
on the facility result grid. Workers are able to sort the 
list by selecting one, two or three columns. 
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Step by Step: 
Sorting the Vacancy Control Search Results Sort window 

1 On the Sort window, click on the Sort drop-down arrow in the Sort By field and 
select from the resulting list.  
The OK button and Then By fields enable. 

2 Click on either the Ascending or Descending radio button next to this field.  
3 To further sort, click on the Sort drop-down arrow in the Then By field and select 

from the resulting list.  
The next Then By frame enables. 

4 Click on either the Ascending or Descending radio button next to this field.  
Repeat steps 3 and 4 for additional sorting. 

5 Click on the OK button to sort the results using desired choices. 
The Vacancy Control Facility Search Results window displays, sorted in accordance 
with the selections in the Sort dialog box. Click on the Cancel button to return to the 
list without changing the sort. 

 

When selecting a bed, compare 
the child’s needs to the bed 

characteristics. Select the bed 
that has the lowest severity 

levels and still meets 
the child’s needs. 

This will help ensure that 
children requiring beds with 
higher severity levels are not 
closed out of these beds by 

children with lower 
severity levels. 

Selecting a Facility 
A facility can be selected from Vacancy Control Facility Search 
Results window by clicking on the facility’s row in the grid. Only one 
facility can be selected at a time. Once a facility is selected, the 
Bed Detail button enables. Click on the Bed Detail button to 
display the Vacancy Control Bed Detail window.  

Viewing the Vacancy Control Bed Detail window 
The Vacancy Control Bed Detail window displays a list of all beds 
and bed characteristics for the facility that was selected from the 
Vacancy Control Facility Results window. Workers are able to use 
this window to “Reserve” or “Occupy” a vacant bed or beds. This 
window is divided into three sections: the header, a middle section 
with two tabs and a lower section with buttons. 

The header section at the top of the window displays the following view-only information for the 
selected facility: 

 • Resource Name 

• Agency  

• Resource ID 

• Address  

• Vendor ID  

• Phone 

• Borough/County 

• CD (NYC only) 

 

 

 
• Sub Agency  • Facility Type  

The middle section of the window contains two tabs, the Beds tab and the Bed Characteristics 
tab. When the window is first opened, the Beds tab displays.  
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The Beds Tab — Vacancy Control Bed Detail  

The Beds tab displays bed information on all beds for the selected facility. The information that 
is contained on this tab varies, depending on the type of facility (FBH or CCF) that was selected 
on the Vacancy Control Search window. The Status field is modifiable when the bed is vacant. 
The Child Info and Date Bed Expected Vacant fields are modifiable when the bed status is 
changed. The remaining fields are pre-filled with view-only information. 

The Status field allows workers to view the availability of a bed. When the status of a bed is 
“Vacant,” workers can select the bed and click on either the Reserve button or the Occupy 
button in the lower section of the window.  

A bed can be left in Reserved status for up 2 hours before 
automatically changing back to Vacant status. The worker who 
reserved the bed or a staff person (supervisor or above) in the unit 
hierarchy is able to unreserve the bed within the two-hour limit. 
Unreserving the bed changes the status of the bed back to Vacant. 
When a bed is in Reserved or Occupied status, the Reserved by 
Worker ID field displays the ID of the worker who changed the 
status. 

Workers must continue to follow current procedure and 
consult with the agency regarding the appropriateness of the 
placement prior to changing the status of the bed to 
Occupied.  

To find contact information in CONNECTIONS about the worker 
listed in the Reserved By Worker ID field, conduct a Staff Search 
from the CONNECTIONS Toolbar. For details on conducting a Staff Search, see Module 4: 
Retrieving information in CONNECTIONS.  

 

Reserved Status 

The two-hour limit refers to 
consulting with the agency 

regarding the placement. This 
limit does not imply that the 

child must be physically in the 
home within the two hours.  

Workers can reserve up to five 
beds per child.  

When reserving or occupying a bed, the worker (or a worker in the unit hierarchy) is able to 
enter information into the Child Info field and the Date Expected Vacant field. Information in 
the Child Info field is removed when the bed status changes to Vacant or Temporarily 
Unavailable. Information in the Date Expected Vacant field is removed when the bed status 
changes to Vacant. 

The child’s gender and age (e.g., M 12/06/91) should be entered in the Child Info field in the 
first 10 spaces. To enter more information, you may use the remaining 15 spaces allotted for 
this field. This information is important and provides a more complete view of the home for other 
workers making placement decisions. If there is a known date that the child expected to leave 
placement (e.g., a Planned Discharge) then this date should be entered in the Date Expected 
Vacant field. 
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Five additional columns display on this tab for Foster Boarding Homes. These columns capture 
the characteristic severity levels for Behavior, Emotional, Physical Learning and HIV.  

Column Name Description 

Physical 

Learning 

Emotional 

Behavioral 

The following choices represent the severity levels for these 
four columns: 

• 0 — NA (no known condition or problem) 

• 1 — Mild 

• 2 — Moderate 

• 3 — Severe 

HIV The choices for HIV are: 

• No 

• Yes  
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The Bed Characteristics Tab — Vacancy Control Bed Detail  

The Bed Characteristics tab displays the characteristics and severity levels of the selected 
Congregate Care Facility’s beds. Access to the Bed Characteristics tab is only available for 
beds in Congregate Care Facilities that have characteristics with severity levels greater than 
zero. (Congregate Care Facilities are not currently supported in Vacancy Control.) 

The lower section of the window contains the Total Bed field. This field is view-only and is pre-
filled with the number of beds listed on the Beds tab. This section also contains the buttons. 
The following table provides a description of the buttons’ function. 

Button Name Description 
Sort Click on this button to re-sort the list of beds. (The Sort 

command can also be selected from the Options menu.) 

Previous Click on this button to move to the previous facility in the 
Vacancy Control Facility Search Results window. 

If information is recorded but not saved when the Previous 
button is clicked, the following message displays: 

“Do you want to save changes? 
If No, modified data and/or narratives will be lost.” 

(The Previous Facility command can also be selected from 
the Options menu.) 

Next Click on this button to move to the next facility in the 
Vacancy Control Facility Search Results window. 

If information is recorded but not saved when the Next 
button is clicked, the following message displays: 

“Do you want to save changes? 
If No, modified data and/or narratives will be lost” 

(The Next Facility command can also be selected from the 
Options menu.) 

Reserve Click on this button to reserve a vacant bed. (The Reserve 
command can also be selected from the Beds sub-menu, 
located in the Options menu.) 

Occupy Click on this button to occupy a vacant or reserved bed. 
Only the assigned worker or a worker in the unit hierarchy 
can occupy a bed in reserved status. (The Occupy 
command can also be selected from Beds sub-menu, 
located in the Options menu.) 

(Table continued on next page)  
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Button Name Description 
Save Click on this button to save the changes. (The Save 

command can also be selected from the File menu.) 

Close Click on this button to close the window without saving the 
changes. (The Close command can also be selected from 
the File menu.) Clicking on the Close button prior to saving 
changes displays the following message: 

“Do you want to exit? Unsaved data and/or narratives will be 
lost” 

Clicking on the Yes button cancels the changes and all 
information reverts to its state after the last save. 

-OR- 
Clicking on the No button ends the close request and 
returns to the window for additional modifications (or to 
enable the Save button). 

Print Click on this button to print the Vacancy Control Placement 
Tracking Report. (The Print command can also be selected 
from the File menu.)This Print buttons enables when a bed 
with an occupied status is selected. 

 

 

Step by Step: 
Reserving or Occupying a Bed  

1 From the Vacancy Bed Detail window, select the bed 
to be Reserved or Occupied. 
If the bed is in Vacant status, the status can be 
changed to Reserved or Occupied. If the bed is in 
Reserved status, only the worker who reserved the 
bed, or a staff person in the unit hierarchy can 
change the status to Occupied or Unreserved.  

2 Click on the Reserve button to change the status to 
Reserved or on the Occupy button to change the 
status to Occupied. 
The Bed Detail Notes window opens. 

3 Enter information into the Child Info field.  
Enter the child’s gender and date of birth in the first 10 spaces (e.g., M 12/06/91) of 
the 25-character field. 

 

Where am I? 

CONNECTIONS toolbar > 
Options menu > Vacancy 

Control Search command > 
Search button > Bed Detail 

button 

4 If the date the child is expected to leave is known (e.g., a Planned Discharge) then 
enter this date in the Date Expected Vacant field.  
NOTE: If you have entered information into either the Child Info field or the Date 
Expected Vacant field, check for accuracy before you click on the OK and Save 
buttons. If the information has already been saved and you need to make changes, 
you must re-open the Bed Detail Notes window. To re-open the Bed Detail Notes 
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window, you must select the bed and click on 
either the Unreserve or Occupy buttons.  

 

When a child is moved  
from a bed, the bed must be 

updated using Vacancy Control 
Bed Maintenance to reflect the 

new status. 

Information in the  
Child Info and Reserved  

By Worker ID fields is removed 
when the bed status changes to 

Vacant or Temporarily 
Unavailable.  

Information in the Date 
Expected Vacant field is 

removed when the bed status 
changes to Vacant. 

5 Click on the OK button. 
6 Click on the Save button to save your changes.  

Before you close the Bed Detail window for this 
resource, record the Resource Name, Resource 
ID, Agency Phone number and any other 
information you may need when contacting the 
agency concerning the placement. 
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Vacancy Control Bed Maintenance 
Beds, Bed Characteristics, and other factors change; local 
districts and voluntary agencies must maintain accurate 
records to optimize their placement potential. The Vacancy 
Control Bed Maintenance window provides workers with the 
ability to identify beds in Foster Boarding Homes that are 
available for placement and offers designated workers the 
flexibility to make modifications to beds (e.g., add beds, delete 
beds, change bed characteristics, add comments) through the 
worker’s Assigned Workload (including unit hierarchy access to 
the Assigned Workload) or owned by their agency. 

 

If a child’s placement in a bed 
changes the foster parent’s 
overall preference, all other 
beds in the home must be 
updated to reflect these 

changes.  

For example, if a male child 
occupies one of two beds in a 
room originally available for 

either males or females, then 
the worker who is responsible 

for maintaining the foster home 
must update the vacant bed to 

reflect a change in gender 
preference for the vacant bed. 

In order for bed information to be maintained, the facility must 
be in either Accepted–Active or Applicant status. Note: Only 
Facilities in Accepted-Active status will return in Vacancy 
Control Search.  

Workers performing modifications to beds using the Vacancy 
Control Bed Maintenance window must have the VACANCY 
MAINT Business Function as well as one of the following 
conditions:  

• The worker must be from the same district/agency that owns the facility 
or 

• The facility must be on the worker’s Assigned Workload. 
Note: Workers assigned to a FAD stage are able to view the Vacancy Control Bed 
Maintenance window from the Task List. This provides FAD workers who are not 
designated to maintain Vacancy Control with access to information contained in 
Vacancy Control that may be relevant to certification and licensing information. 

You can access the Vacancy Control Bed Maintenance window from either your Assigned 
Workload or from the CONNECTIONS Toolbar using one of the following navigational paths:  

• When the facility is on your Assigned Workload, click on the WORK button on the 
CONNECTIONS Toolbar. Select the facility from the Assigned Workload and click on 
the Tasks… button. Select “Vacancy Control Bed Maintenance” from the Task List 
and click on the Detail… button.  
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• When the facility is not on your Assigned Workload, click on the RSRC button on the 
CONNECTIONS Toolbar to conduct a Resource Search for the facility. Select the 
facility from the Resource List and click on the Detail button. Select “Vacancy Bed 
Maint” on the Options menu from the Resource Detail window. 

 

 

 

 

 

 

 

 

 

Step by Step: 
Opening the Vacancy Control – Bed Maintenance Window 
via the Task List 

1 Select the appropriate FAD home on the Assigned Workload, and click on the 
Tasks… button. 
The Task List displays. 

2 Select the Vacancy Control Bed Maintenance task, and click on the Detail… 
button. 
The Vacancy Control Bed Maintenance window displays. 

 
 

 

Step by Step: 
Opening the Vacancy Control – Bed Maintenance Window 
via the Resource Detail Window 

1 Conduct a Resource Search to find the appropriate 
Resource. 

2 Select the appropriate Resource from the listing of 
search results. 

3 Click on the Detail… button. 
The Resource Detail window displays. 

4 Select the Options menu and click on the Vacancy 
Control Bed Maintenance… command. 
The Vacancy Control Bed Maintenance window displays. 

 

For details on conducting a 
Resource Search, see  
Module 4: Retrieving 

Information in CONNECTIONS 
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Understanding the Vacancy Control  
Bed Maintenance Window 
The Vacancy Control Bed Maintenance window is divided into three sections: 

• Heading (containing pre-filled, view-only information) 
• Tabs 
• Buttons 

The buttons and the information in the Heading are always visible, regardless of the tab you 
select. The Heading contains the following information for each facility: 

• Resource Name • Resource ID • Male Age Range: Min Year 
• Address  • Vendor ID • Male Age Range: Max Year 
• County • Status • Female Age Range: Min Year 
• Type • CD (NYC Only) • Female Age Range: Max Year 
• Sub- Agency • Phone • Total Capacity 
 • Agency  

Two buttons, the Facility Comments button and the Close button, display at the bottom of the 
Vacancy Control Bed Maintenance window. The Facility Comments button is used to access a 
comment box. You may record additional information about a facility in this comment box when 
the Vacancy Control Bed Maintenance window is opened in modify mode (e.g., via the Task 
List). An “√” displays in the check box next to the Facility Comments button on the Vacancy 
Control Bed Maintenance window once comments have been saved. 

 

Step by Step: 
Recording Facility Comments 

1 On the Vacancy Control Bed Maintenance window click on the Facility Comments 
button. 
The Facility Comments window displays. 

2 Record comments. 
The Save button enables. 

3 Click on the Save button. 
The following message displays: 
”Changes Have Been Saved.” 

4 Click on the OK button. 
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Tabs on the Vacancy Control Bed Maintenance Window 

The tabbed section of the Vacancy Control Bed Maintenance window is made up of two tabs: 
the Beds tab and the Bed Characteristics tab. The Beds tab is always active when the 
Vacancy Control Bed Maintenance window is opened. 

The Beds Tab 

The Beds tab is a wide grid containing a number of columns. The information displayed for 
each column will vary, depending on whether a foster home or congregate care facility has been 
selected. 

In each column, information for each bed of the facility selected may be recorded in the 
associated cell.  

Column Name Description 

Bed ID The cells in this column display a unique identifier that links beds for 
internal tracking. This field is view only. 

Status 

The cells in this column display the current status of the bed. When you 
enter this window in modify mode, you may select one of the following 
statuses: 
• Occupied 
• Vacant 
• Temporarily Unavailable (for less than 30 days) 

Beds in “Reserved” Status can only be modified by the worker who 
made the reservation, or by a staff member in that worker’s hierarchy. 

Male Min Year 

Male Max Year 

Female Min Year 

Female Max Year 

The cells in these columns display minimum and maximum age ranges 
for male and female designated beds. This information can be modified. 
Age ranges must be within the ranges specified in the F/A Home License 
window. When opened in Browse mode, these cells are “view-only.” 
Enter “0” in the minimum age range when a bed is suitable for a child 
less than 1 year old. Leave the age fields blank if the bed is not suitable 
for a gender. 

Reserved by 
Worker ID 

The cells in this column display the Person ID of the worker responsible 
for changing the status of the bed to “Reserved.” This field is view-only. 
The data in this cell will be removed when the bed status changes to 
“Vacant” or to “Temporarily Unavailable.” 
Use the Staff Search function in CONNECTIONS to locate further 
information about the worker. (See Module 4: Retrieving Information in 
CONNECTIONS.) 

Bed Location 

The cells in this column display information that identifies where the bed 
is located in the facility. For example,  
“A1-2” is used to identify 1 of 2 beds in Bedroom A.  
The modifier “Ther” (Therapeutic Contract) is added when appropriate. 

Child Info 

Each cell in this column contains 25 spaces that can be used to record 
child identifying information. The first 10 spaces should be used to 
identify the gender and date of birth (e.g., M 12/06/91). Additional 
information may be recorded in the remaining 15 spaces. 

Table continued on next page 
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Column Name Description 

(Continued from previous page)  

Date Expected 
Vacant 

The cells in this column are used to record the date that the bed is 
expected to become vacant (if known). Once the status is changed to 
“Vacant,” the information is removed from the cell. 

Physical 

Learning 

Emotional 

Behavioral 

The following choices may be recorded in each cell to indicate the 
severity level of difficulty the foster home is willing to accept: 

• 0 — N/A (no known condition or problem) 

• 1 — Mild (minor condition or problem; does not significantly affect 
functioning) 

• 2 — Moderate (moderate condition or problem; may affect 
functioning and may require specialized services or 
treatment) 

• 3 — Severe (serious condition or problem; significantly affects 
functioning and requires intensive services or treatment) 

HIV 

The cells in this column are used to indicate whether the bed is available 
to individuals diagnosed with HIV. To fill these cells, you will select one 
of two choices: 
• No 
• Yes 

For each cell, you will either record information directly or select from a drop-down list (activated 
by clicking on the cell). 

At the bottom of the Beds tab, you will find five (5) buttons. Each button allows you to complete 
an action related to the Bed(s) selected. Descriptions of each button are located in the table 
below. 

Button Name Description 

Add Beds 

This button is used to add more beds to a facility. 
The Add Beds button becomes enabled when the window is opened in 
Modify mode, and the current number of beds listed is less than the licensing 
capacity. 

Delete Beds 

This button is used to delete existing beds from a facility.  
Always delete a bed in the Vacancy Control Bed Maintenance window, 
before changing the bed capacity information in the F/A Home License 
window.  

Modify Beds 

This Modify Beds button is used to change existing bed characteristics. 
The Modify Beds button becomes enabled when the Vacancy Control Bed 
Maintenance window is opened in Modify mode and one or more beds is 
selected. 

Table continued on next page 
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Button Name Description 

(Continued from previous page)  

Save 
The Save button is used to save changes to the window. 
“Save” can also be selected from the Bed Maintenance menu. 

Cancel 
The Cancel button is used to cancel any changes that are in progress (not 
yet saved). 
“Cancel” can also be selected from the Bed Maintenance menu. 

The Bed Characteristics Tab 

The Bed Characteristics tab automatically becomes active 
when you select one or more beds on the Beds tab and click on 
the Modify Beds button. The type and amount of information 
displayed will vary, depending on how many beds you have 
selected. When only one bed is selected, the existing 
characteristics and existing severity levels for that bed are 
displayed. If multiple beds are selected, the grid displays 
characteristics but not the severity level. Workers are able to 
select and apply the bed characteristics to all selected beds. 

Adding, Deleting and Modifying Beds 
New beds can be added to a selected facility up to the certified capacity. These beds can be 
based on existing beds, or added as a “blank” bed record. The number of beds and age ranges 
by gender for each bed must be within the licensing certification. Only one bed can be added at 
a time. 

The instructions for Adding, Deleting and Modifying Bed Information are located on the following 
pages. 

 

Step by Step: 
Vacancy Control – Bed Maintenance: 
Adding “Blank” Beds to a Facility 

 

To add/modify information, 
you must have the VACANCY 
MANIT Business Function. If 
you do not have this BFP, the 

Bed Characteristics tab will only 
enable when you select one 

bed. All information is displayed 
in “view-only” mode. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Vacancy Control 
Bed Maintenance task > Detail 

button 

1 On the Beds tab in the Vacancy Control window, 
click on the Add Beds button (without selecting an 
existing bed). 
A new bed displays with a blank row. 

2 Enter specific information for the new bed in the 
blank fields. 

3 Click on the Save button. 
The following message displays: 
”Changes Have Been Saved.” 

4 Click on the OK button. 
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Step by Step: 
Vacancy Control – Bed Maintenance: 
Adding Beds to a Facility with Existing Characteristics 

1 On the Beds tab in the Vacancy Control window, 
click on the column to the left of the Bed ID column to 
select the bed. 

2 Click on the Add Beds button. 
A new bed displays with the characteristics (including 
severity levels, status and bed location) copied from 
the selected bed. If necessary, modify the copied 
information to accurately represent the new bed.  
The Bed Location field must be updated with the new 
bed information using an identifier. For example, “A1-
2” stands for Bedroom “A”, Bed “1 of 2.” The modifier 
“Ther” (Therapeutic Contract) is added when appropriate. This information is 
required for homes with vacancies).  

3 Click on the Save button. 
The following message displays: 
”Changes Have Been Saved” 

4 Click on the OK button. 

 

Step by Step: 
Vacancy Control – Bed Maintenance: 
Deleting Beds From a Facility 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Vacancy Control 
Bed Maintenance task > Detail 

button 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Vacancy Control 
Bed Maintenance task> Detail 

button 

 

When reducing the licensing 
capacity for a facility, always 

delete the beds that are beyond 
the new licensing capacity in 

Vacancy Control before 
changing the bed capacity 

information in the F/A Home 
License window. 

1 On the Beds tab in the Vacancy Control window, 
click on the column to the left of the Bed ID column to 
select the bed. 
To select multiple beds hold the control button and 
click the column to the left of the Bed ID column. 

2 Click on the Delete Beds button. 
When deleting a single bed the following message 
displays: 
“Are you sure you wish to delete this Bed?” 
When deleting a multiple beds the following message 
displays: 
”Are you sure you want to delete these <#> Beds?” 

3 Click on the Yes button to delete the Bed(s). 
The following message displays: 
”Changes Have Been Saved.” 
Clicking on the No button displays the Vacancy 
Control-Bed Maintenance tab without deleting the 
bed(s). 

4 Click on the Save button. 
The following message displays: 
”Changes Have Been Saved.” 

5 Click on the OK button. 
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Step by Step: 
Vacancy Control – Bed Maintenance: 
Modifying Severity Level Information via 
Bed Characteristics tab 

1 On the Beds tab in the Vacancy Control window, 
click on the column to the left of the Bed ID column 
to select the bed. 
To select multiple beds hold the control button and 
click the column to the left of the Bed ID column. 

2 Click on the Modify Beds button. 
The Bed Characteristics tab displays. 

3 Select the Available Characteristics (0,1,2, or 3) 
from the drop-down list. 

4  Click on the Save button. 
The following message displays: 
”Changes Have Been Saved” 

5 Click on the OK button. 

 

Step by Step: 
Vacancy Control – Bed Maintenance: 
Modifying Severity Level Information via Beds tab 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Vacancy Control 
Bed Maintenance task > Detail 

button 

 

Age ranges by gender must be 
kept within the parameters of 

the licensing certification. Enter 
“0” in the minimum age range 

for beds appropriate for children 
younger than one year old.  
Leave the age fields blank 

when the bed is not suitable 
for a particular gender. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button>Vacancy Control 
Bed Maintenance task > Detail 

button 

 

The status of “Temporarily 
Unavailable” can be applied to a 

bed for less than 30 days. 

1 On the Beds tab select the severity level (0,1,2, or 
3) from the drop-down list for the column (e.g. 
Physical column) for the appropriate row.  

2 .Click on the Save button. 
The following message displays: 
”Changes Have Been Saved” 

3 Click on the OK button. 

Bed status is another important item that must be kept current 
to reflect the movement of children in and out of facilities. The 
status of a bed can be identified as Vacant, Occupied, and 
Temporarily Unavailable. 

Beds in “Reserved” status can only be changed by the worker 
that made the reservation, or by a staff member within that 
worker’s hierarchy. 
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Step by Step: 
Vacancy Control – Bed Maintenance: 
Modifying Bed Status 

1 Click on the column to the left of the Bed ID column to select the bed. 
2 Click on the drop-down arrow in the Status field for that bed. 
3 Select the appropriate status from the list. 
4 Click on the Save button. 

The following message displays: 
”Changes Have Been Saved.” 

5 Click on the OK button. 
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Vacancy Control Closed To Intake 
The Vacancy Control Closed To Intake window allows designated local district and OCFS staff 
to remove facilities from the Vacancy Control Facility Search Results. The Closed To Intake 
status can be applied to: 

• A Facility — to remove the facility from the search results. 

• An Agency — to remove all Congregate Care Facilities and Foster Boarding Homes 
that the agency owns from the search results. 

• A Facility Type within an Agency — to remove all facilities of a selected type (e.g., 
Group Home, Institution) that the agency owns from the search results. 

To make modifications in the Vacancy Control Closed To Intake window, workers must have the 
VAC AWARD/CLOSE Business Function. To access the window in view-only mode, workers 
must have the VACANCY SEARCH Business Function. 

The status of Closed To Intake works differently, depending on whether it was applied by an 
OCFS worker or a staff member from a local district. The following table illustrates how Closed 
To Intake functions when different workers apply the status.  

Designated 
OCFS staff 
applying the 
Closed To 
Intake status 

→ The facility is removed from all Vacancy Control 
Searches for all workers statewide. 

Designated 
Local district 
staff applying 
the Closed To 
Intake status 

→ The facility is removed from Vacancy Control Search 
Results when a worker from the same district as the 
worker applying the Closed to Intake status performs the 
search. 

→ The facility returns with a “Closed To Intake Indicator” 
when a worker from another district performs the search 

 

For example, if a NYC/ACS manager from Kings County (Brooklyn) applies the Closed To 
Intake status to a facility, the facility will not return in Vacancy Control Searches performed by 
NYC/ACS workers from any of the five boroughs. If a staff member from NYS/OCFS, non-
NYC/ACS districts, or a voluntary agency (and the bed is within their own agency) performs the 
search, this same facility will be included in the Vacancy Control Facility Search Results window 
with a “Y” displayed in the Closed To Intake column.  

Applying the Closed To Intake status is not a permanent change and can be reversed by 
designated local district and OCFS staff. 
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Step by Step: 
Accessing the Vacancy Control Closed To Intake Window  

1 Conduct a Resource Search to find the appropriate 
Resource. 

 

For details on conducting a 
Resource Search, see  
Module 4: Retrieving 

Information in CONNECTIONS 

 

The Vacancy Control Closed To 
Intake window displays with 

Inquiry tab enabled for workers 
with the VACANCY SEARCH 

Business Function.  

2 Select the appropriate Resource from the listing of 
search results. 

3 Click on the Detail… button. 
The Resource Detail window displays. 

4 Click on the Options menu and click on the 
Vacancy Control Closed To Intake…command. 
The Vacancy Control Closed To Intake window 
displays. 

 

 

 

The Vacancy Control Closed To Intake window is divided into 
two sections: the header and tabs. The header at the top of the 
window is pre-filled with view-only information for the selected 
facility. 
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The tab section includes two tabs, the Maintenance tab and the Inquiry tab. The Maintenance 
tab is the active tab when workers with the VAC AWARD/CLOSE Business Function open the 
window. The Inquiry tab is the active tab when workers who don’t have the VAC 
AWARD/CLOSE Business Function (but who have the VACANCY SEARCH Business Function) 
open the window. 

The Maintenance Tab — Vacancy Control Closed To Intake 

The type of resource selected determines which fields display on the Maintenance tab. When 
the window is opened for a facility, local district workers can click on the Close to Intake for 
[worker’s district] check box to add or remove the Closed To Intake status for the facility for the 
worker’s district. An OCFS worker can use the Close to Intake for ALL check box to apply the 
status to all districts.  

Applying the Closed To Intake status is not a permanent change and can be reversed by de-
selecting the Close To Intake for [worker’s district] check box. 

When the window is opened for an agency, a grid with following two columns displays: 

• Facility Types — contains a view-only list of six facility types.  

 Agency Boarding Home 
 Certified Foster Home 
 Foster/Adoptive Home 
 Group Home 
 Group Residence 
 Institution 

• Closed — a check box for each of the six facility types.  

Local district workers can also use the Close Agency to Intake for district [worker’s district] 
check box to add or remove the Closed To Intake status for the entire agency (e.g., all Foster 
Boarding Homes within the agency) for the worker’s district. OCFS workers can use the Close 
Agency to Intake for ALL check box to apply the status to the entire agency for all districts.  
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The Inquiry Tab — Vacancy Control Closed To Intake 

The type of resource selected determines which fields display on the Inquiry tab. When the 
window is opened for a facility, a grid with following two columns displays:  

• Closed to District — lists the districts that added Closed to Intake to the facility.  

• Effective Date — captures the date the status was applied. 

When the window is opened for an agency, a grid with the following three columns displays:  

• Closed to District — lists the districts that added Closed to Intake to the agency.  

• Closed for Facility Types — lists the facility types that the status was applied to.  

• Effective Date — captures the date the status was applied.  

 

Vacancy Control Closed To Intake Report  
The Vacancy Control Closed To Intake Report contains a list of facilities and agencies (sorted 
by district) with detailed information for each facility or agency that have a Closed To Intake 
status. The report is generated weekly. All staff on the Closed to Intake Distribution List will be 
able to view this report from the Report List window. This list is maintained by NYS/OCFS. 
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Vacancy Control CD/Borough Award (NYC/ACS only) 
The CD/ Borough Award Maintenance window allows NYC/ACS administration to indicate in 
CONNECTIONS which agencies have been awarded a neighborhood based service contract. 
The CD Awards apply to agencies that license Foster Boarding 
Homes and the Borough Awards apply to agencies that operate 
Congregate Care Facilities.  

This window is accessed from the Resource Detail window by 
selecting “Vacancy Control CD Awards” from the Options 
menu. 

The CD/ Borough Award Maintenance window is divided into 
three sections, the header, a middle section with tabs and a 
lower section with buttons. The header is pre-filled with view-
only information for the selected agency. 

The tab section is divided into two tabs, the Foster Boarding Homes — CD Awards tab and 
the Congregate Care Facilities — Borough Awards tab. 

 

Step by Step: 
Accessing the CD/Borough Award Maintenance Window  

1 Conduct a Resource Search to find the appropriate 
Resource. 

2 Select the appropriate Resource from the listing of 
search results. 

3 Click on the Detail… button. 
The Resource Detail window displays. 

4 Click on the Options menu and select the Vacancy 
Control CD/Borough Awards…command. 
The CD/Borough Award Maintenance window displays. 

 

The Vacancy Control 
CD/Borough Award window 
displays in Inquiry mode for 
workers with the VACANCY 

SEARCH Business Function.  

 

For details on conducting a 
Resource Search, see  
Module 4: Retrieving 

Information in CONNECTIONS 
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Foster Boarding Homes — CD Awards Tab 

The Foster Boarding Homes – CD Awards tab is always active when the window is first 
opened. This tab displays a list of all NYC Community Districts. A check box next to each 
Community District indicates whether or not the selected agency was given an Award for the 
NYC/CD.  

Workers must have the VAC AWARD/CLOSE Business Function to modify information in this 
window. Workers who have the VACANCY SEARCH Business Function can access the window 
in inquiry mode only. 

 

 

Step by Step: 
Adding a Community District (NYC/CD) Award 

1 Click on the check box next to the CD to indicate that the selected agency is given 
an Award for the CD. 

2 Click on the Save button to save the changes.  
The following message displays: 
”Changes Have Been Saved.” 

3 Click on the OK button.  
The Resource Detail window displays. 

 

Step by Step: 
Deleting a Community District (NYC/CD) Award 

1 Click on the check box next to the CD to remove the indicator. 
2 Click on the Save button to save the changes.  

The following message displays: 
”Changes Have Been Saved.” 

3 Click on the OK button.  
The Resource Detail window displays. 
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Congregate Care Facilities — Borough Awards Tab 

The Congregate Care Facilities — Borough Awards tab displays a list of all boroughs. A 
check box next to each borough indicates whether or not the selected agency was given an 
Award for the borough.  

Workers must have the VAC AWARD/CLOSE Business Function to modify information in this 
window. Workers who have the VACANCY SEARCH Business Function can access the window 
in inquiry mode only. 

 

 

Step by Step: 
Adding a Borough Award (NYC/ACS Only) 

 1 Click on the check box next to the borough to indicate 
that the selected agency is given an Award for the 
borough. 

Where am I? 

RSRC button > Search button> 
Detail button > Options menu > 
Vacancy Control CD/Borough 

Awards command 

2 Click on the Save button to save the changes.  
The following message displays: 
”Changes Have Been Saved.” 

3 Click on the OK button.  
The Resource Detail window displays. 

 

Step by Step: 
Deleting a Borough Award (NYC/ACS Only) 

 1 Click on the check box next to the borough to remove 
the indicator. Where am I? 

RSRC button > Search button> 
Detail button > Options menu > 
Vacancy Control CD/Borough 

Awards command 

2 Click on the Save button to save the changes.  
The following message displays: 
”Changes Have Been Saved.” 

3 Click on the OK button.  
The Resource Detail window displays. 
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Vacancy Control – Reports 
NYC Voluntary Agencies require access to a “Master Vacancy Spreadsheet” listing information 
about all of their Foster Boarding Homes that are in Accepted-Active status and contain at least 
one vacant or reserved bed. This report will only include homes within the worker’s agency. 
Contract agencies will use this information to respond to requests for placement that come in 
after business hours from the Office of Placement Assistance (OPA).  

 

Master Vacancy Spreadsheet Command 
This report is intended to assist workers who receive placement requests after business hours. 
To ease the burden on system performance, the Master Vacancy Spreadsheet can only be 
generated between the hours of 3:00 PM and 8:00 AM, Monday through Friday and 3:00 PM 
Friday through 8:00 AM Monday. If a worker attempts to generate this report between 8:00 AM 
and 3:00 PM, Monday through Friday, s/he will receive the following message: 

 
When the worker selects the Master Vacancy Spreadsheet command on the Options menu 
on the Vacancy Control Search window, a report will be generated that queries the database 
and selects the homes within the worker’s agency that have a vacant bed available. The report 
displays as an Excel spreadsheet. For those homes that meet the requirements (Accepted-
Active status and at least one vacant bed), the report will also include information about all of 
the beds within the home (occupied, reserved, temporarily unavailable and vacant). The worker 
can sort and print the information. In order to save the report, the worker must copy the data to 
his/her local directory. 
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This report is in real-time, which means all information is current as of the time the report is 
generated. The following columns are listed on the Master Vacancy Spreadsheet: 

Agency ID Resource ID Resource Name Borough/County 

Sub Agency ID CD Lic Capacity Address 

Vendor ID City State Zip 

Phone Facility Type Program Type CD Award 

Bed ID Bed Status Bed Location Child Info 

BED Expected Vacant Lic Female Min Age Lic Female Max Age Lic Male Min Age 

Lic Male Max Age Pre Bed Female Min 
Age 

Pre Bed Female 
Max Age 

Pre Bed Male Min Age 

Pre Bed Male Max Age Physical Learning Emotional 

Behavioral AIDS Indicator Comments  

 

To access the Vacancy Control Search window, the worker’s BFP must include the VACANCY 
SEARCH Business Function.  

 

Step-by-Step: 
Accessing the Master Vacancy Control Spreadsheet 

1 From the CONNECTIONS Toolbar, click on the Options menu and select the 
Vacancy Control Search… command. 
The Vacancy Control Search window displays. 

2 Click on the Options menu and select the Master Vacancy Spreadsheet command. 
The Spreadsheet generates and then displays. 

 

Step-by-Step: 
Copying the Master Vacancy Spreadsheet Data to a Local Directory 
(NOTE: You must have Microsoft Excel installed on your local PC) 

1 With the Master Vacancy Spreadsheet open, click and drag to select any or all of the 
cells you wish to copy. 

2 Click on the Edit menu and select the Copy command. 
3 Click on the Start button on the local desktop (not the Citrix desktop) and open 

Microsoft Excel. 
4 Click on the Edit menu and select the Paste command. 

The information you copied from the spreadsheet in CONNECTIONS will paste into 
new spreadsheet. 

5 Click on the File menu and select the Save command. 
6 Name the document and designate where you would like to save it, then click on the 

Save button. 
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Print Screen Command 

 

The Print Screen command is available in the Facility Search 
Results and Bed Detail windows. This command is listed under 
the Options menu. The Print Screen command will launch a 
report containing all of the data on the window (including all 
rows and columns). 

For the Facility Search Results window, the report lists all 
facilities that return in the search results grid. For the Bed 
Detail window, the report includes all beds that return in the 
search results grid.  

Print Screen for Facility Search Report 
Any worker who has access to the Facility Search Results 
window via the Vacancy Control Search window will have the ability to print the Facility Search 
Results window. 

Workers can sort the search 
results and view the sorted list 
on screen; however, the new 

Print Screen function will print 
the search results in the default 
(or original) order. Reports will 

not print sorted. 

NOTE: This report is formatted 
for legal size paper. Load legal 

size paper into your printer 
before printing. 

 

 

Step-by-Step: 
Accessing the Print Screen Command 
for the Facility Search Results Window 

1 From the CONNECTIONS Toolbar, click on the Options menu and select the 
Vacancy Control Search… command. 
The Vacancy Control Search window displays. 

2 Conduct a Facility Search. 
The Facility Search Results window displays. 

3 Click on the Options menu and select the Print Screen command. 
The Report window displays. 
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4 Click on the Printer icon ( ) to print the results.  
5 Click on the Close button to close the Vacancy Control Facility Search Report 

window.  

 

Print Screen for Bed Detail Report 
Any worker who has access to the Bed Detail window via the Vacancy Control Search window 
will have the ability to print the Bed Detail window. 

 

 

Step-by-Step: 
Accessing the Print Screen Command for the Bed Detail Window 

1 From the CONNECTIONS Toolbar, click on the Options menu and select the 
Vacancy Control Search… command. 
The Vacancy Control Search window displays. 
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2 Conduct a Facility Search. 
The Facility Search Results window displays. 

3 Select a facility and click on the Bed Detail button. 
The Bed Detail window displays. 

4 Click on the Options menu and select the Print Screen command. 
The Bed Detail Report window displays. 

5 Click on the Printer icon ( ) to print the results.  
6 Click on the Close button to close the Vacancy Control Bed Detail Report window. 
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Module 14: 
Recertification and Reapproval of FAD Homes 

Foster and adoptive homes must undergo an annual renewal process, referred to as an Annual 
Reauthorization, in order to extend the certification or approval of the foster home for one year. 
The term “Reauthorization” is used in CONNECTIONS to indicate both the “recertification” and 
the “reapproval” of foster homes. As the caseworker, you will follow your agency’s procedure for 
performing an assessment of the foster home and the quality of foster care being provided. 
Based on this information, you will make a recommendation as to whether or not the 
certification/approval of the home should be extended for another year. 

This module focuses on the steps necessary to prepare and complete the Annual 
Reauthorization process for FAD homes. Both casework activities and CONNECTIONS features 
will be discussed. By the end of the module, you will be able to: 

• identify when reauthorizations need to be documented; and 
• complete the Annual Reauthorization process using the Foster and Adoptive Home 

Record Summary (FRS) in CONNECTIONS. 
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Annual Reauthorization of FAD Homes 
Agency practice and procedure for annual renewal of the certificate or approval must include 
the following: 

• A written evaluation of the home and family; 
• A written evaluation of the care provided to children in the home and the working 

relationship of the foster parents or relatives with the agency; 
• A written statement from a physician about the foster family’s or relative family’s 

health, if it has been within 18 months since the date of the last medical exam; 
• An oral review of the evaluation with the foster parents or relative foster parents 

before the certificate or approval is renewed; and 
• The completion of a Criminal History Record Check (CHRC) for the foster parent and 

each person age18 and older who currently resides in the foster home (if such a 
check has not yet been performed). Additionally, workers should perform a Criminal 
History Record Check prior to Annual Reauthorization when an individual turns age 
18 or an individual age 18 or older moves into the home.  
Note: The New York State Division of Criminal Justice Services (DCJS) keeps the 
fingerprint cards on “Search & Retain,” which means the information is kept on file 
and the district/voluntary agency is informed if there is a subsequent arrest after the 
original CHRC is run. 
 

Once all of the above information has been collected and submitted for supervisory approval, 
the authorizing agency must review the information and make a determination of whether to 
renew the certification or approval, or, if there is cause, revoke the certification or approval. 

Expiration of a FAD Home/Stage 
Expiration of a foster home on your Assigned Workload occurs 
when the Annual Reauthorization process including approval is 
not completed by the last date of the certification/approval 
period.  

Expiration of the home/stage causes the home to be closed and 
removed from your Assigned Workload. Once this happens, the 
home/stage cannot be accessed unless it is reopened and all 
requirements for opening/reopening/ reauthorizing the home 
must be completed (see Module 17: Reopening FAD Homes for 
reopening standards and procedures). 

Children must not be placed in a home that is closed. If children 
are already placed in a home that has been closed by the 
system, and the intention is for them to remain in that home, it 
must be reopened immediately. Once a home is closed, it cannot be reopened in 
CONNECTIONS until the next business day (see Module 17: Reopening FAD Homes). 

 
According to State law, foster 
children may not remain in a 
foster home that is in Closed 

status.  
If the intent is for the home to 
remain closed, foster children 

must be removed in accordance 
with proper regulatory 

procedures, including removal 
notification. 

A foster home that expires due to the failure to complete a recertification or reapproval will not 
receive state and federal reimbursement until it is again placed in Accepted-Active status. A 
closed home in this situation is referred to as Non-Reimbursable (NR). 
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“Late” or “Delayed” Entry 

The term “Delayed Entry” refers to situations where all casework activities have been 
completed, yet the information was not able to be recorded in CONNECTIONS in time to 
prevent the expiration (and system closing) of the home. Such a situation must be thoroughly 
documented in case notes, showing that the home’s eligibility for certification did not lag. The 
home will have to be reopened and the Home History Detail dates may have to be adjusted. 
Refer to Module 12: Maintaining FAD Homes in CONNECTIONS for more information. 

Non-Renewal of Certification/Approval 
Foster homes must continually meet all standards set forth by OCFS. Failure to meet these 
standards may result in non-renewal or revocation of a license. 

Agency practice and procedure for non-renewal or revocation of a foster home’s certificate or 
approval must include the following: 

• Foster parents must be advised, before the expiration date of the 
certification/approval, that the agency does not plan to renew the license for the 
home. 

• Non-renewal of a certified or approved foster or adoptive home may be based upon 
such factors as failure to meet one or more of the criteria for certification or approval 
(see Module 2: Maintain Licensing Information) or lack of need for a foster home with 
its particular characteristics. 

• The reasons for such action must be specified in a letter postmarked at least 20 days 
before the expiration date of the certification/approval before the child(ren) may be 
removed, discharged or transferred from the home. 

• An arrangement must be made for the certified or approved foster or adoptive parent 
to meet with an official of the agency to review the decision and the reasons for it. 

• The foster parent shall be advised of his/her right to appeal to the Office of Children 
and Family Services and request a fair hearing in accordance with §400 of the Social 
Services Law. 

 

The Annual Reauthorization Process 
in CONNECTIONS 
CONNECTIONS supports the Annual Reauthorization process in several ways. Prior to the 
expiration date of a certification/approval period, a caseworker receives an Alert To-Do on his 
or her Staff To-Do List. These alerts appear 90, 60 and 30 days prior to the expiration date.  

Alerts are also sent to remind caseworkers that valid medical dates are necessary for the 
successful recertification/reapproval of a FAD home. These alerts are sent 120, 90, 60, and 30 
days prior to the expiration date of the home’s certification/approval period. 

CONNECTIONS lists tasks on the Task List for each FAD home/stage to assist in recording the 
Annual Reauthorization process. All casework activities must be completed and documented in 
CONNECTIONS and in the External Foster Home Case Record prior to submitting the Annual 
Reauthorization in CONNECTIONS.  
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Preparing for an Annual Reauthorization 
The key to successfully completing an Annual Reauthorization is to begin as early as possible. 
As the primary caseworker for a FAD home, you will go through three major steps in completing 
the Annual Reauthorization process in CONNECTIONS: 

• Review/update all person and home information; and 
• Complete the Annual Reauthorization task, using the Foster and Adoptive Home 

Record Summary (FRS); and 
• Submit the FRS (home record) for supervisory approval. 

Reviewing and Updating Information 
We will see that some areas of CONNECTIONS are time sensitive; they are not active until the 
90 days prior to the expiration of the home. However, a significant amount of work can be 
accomplished before this period. 

The Foster and Adoptive Home Record Summary (FRS) can be utilized at any point in the year 
through the Home Study task to review home and person information. Take time to look at 
each tab of the FRS early in the process of preparing for each Annual Reauthorization. Errors 
that you find in person demographics or home demographics can be corrected at any time 
during the licensing period. 

This Step-by-Step Guide contains detailed information on how to maintain person and home 
information. Module 12: Maintaining FAD Homes in CONNECTIONS provides valuable 
information on how to change information that is already in CONNECTIONS. Additionally, you 
may want to record newly discovered information about the home or individuals residing in it. 
Turn to Module 6 (Responding to an Inquiry) and Module 7 (Maintaining Person Information) to 
add information for the home and for people, respectively. 

The Annual Reauthorization Task 
Annual Reauthorizations are completed in CONNECTIONS via 
the Annual Reauthorization task on the Task List. This task is 
also used when the home undergoes a change that affects the 
home’s “from/to” certification dates (see Module 19: Certified 
and Approved Emergency Homes).   

When the Annual 
Reauthorization task is 

selected at any time other than  
90 days prior to the home’s 

expiration date, the buttons on 
the Task List disable.  

The Annual Reauthorization task is only available during the 
90 days prior to the expiration date of the certificate/approval. 
The Annual Reauthorization will open the Foster and Adoptive 
Home Record Summary (FRS). In the FRS, you have the ability 
to retrieve historical Annual Reauthorizations, as well as create 
new ones.  

The Annual Reauthorization task may enable different buttons when selected. These buttons 
are affected by the existence of an In-Process Home Study, and/or by the existence of historical 
Annual Reauthorizations for the home.  

The tables at the end of this module illustrate these different levels of available buttons, and 
may be useful in making decisions when selecting the Annual Reauthorization task. 
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The Annual Reauthorization Tab 

The Annual Reauthorization tab in the FRS consists of one section, titled “Annual 
Reauthorization.” In this section, CONNECTIONS lists two choices with associated radio 
buttons; Standard Annual Reauthorization and Other. After selecting the appropriate radio 
button, the Retrieve/Edit Narrative button is used to generate the Annual Reauthorization 
Narrative. This narrative opens as an Microsoft Word document.  

The Standard Reauthorization Annual Document is a template. It contains protected sections 
containing questions and instructions, and unprotected areas where you can record information. 
This document may have previously recorded information if you have chosen the Use Prior or 
Detail (for an in-process document) buttons. The Other radio button is a blank Microsoft Word 
template where workers can copy and paste individual agency template.  

You may refer to Module 2: Getting Started in CONNECTIONS, for information on “Copying and 
Pasting”, and additional features of MS Word. 

Completing the Annual Reauthorization  
Task CONNECTIONS 

 The steps for opening, completing and submitting the FRS for 
an Annual Reauthorization are outlined below. When you have 
completed the Reauthorization Document and click on the 
Submit button in the FRS, CONNECTIONS displays the F/A 
Home Licensing. You will complete this window to finalize the 
submission of the Annual Reauthorization. 

Refer to Module 8: Maintaining 
Licensing Information for FAD 
Homes to learn about the F/A 

Home License window. 

 

Step by Step: 
Using the FRS to Complete a New Annual Reauthorization  
Step I: Accessing the FRS and Completing the Reauthorization Document 

 

Selecting the New button when 
an FRS already exists displays 

the following message:  

“Start with New (blank) 
narratives instead of those last 

saved” 

Click on the Yes button to 
display new FRS. 

1 Select the appropriate foster home from your 
Assigned Workload. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Annual Reauthorization task. 
4 Click on the New button. 

The Foster and Adoptive Home Record Summary 
displays, containing current data from database and 
the most recently saved Home Study narrative. The 
Annual Reauthorization tab is showing. If there is an 
existing FRS you may click on the Use Prior button. 

5 Select the Reauthorization document radio button, if 
appropriate. 

6 Click on the Retrieve/Edit Narrative button. 
The Reauthorization document displays as a Microsoft Word document. 

7 Record information in the Reauthorization document. 
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8 Upon completion, click on the File menu and select Close. 
The following message displays: 
“Save Changes?” 

9 Click on Yes to save information. 
The Annual Reauthorization tab displays.  

You might not complete the Annual Reauthorization document all at once, and you may need to 
go into other tabs of the FRS to record updates to the home (e.g., the Home Study narrative). 
The directions below instruct you on how to finish the submission, once all information has been 
recorded in CONNECTIONS, and the Submit button on the FRS has become enabled. 

 

Step by Step: 
Using the FRS to Complete a New Annual Reauthorization  
Step II: Completing the F/A Home License Window and Submitting the FRS for 
Supervisory Approval 

1 Select the appropriate foster home from your 
Assigned Workload. 
The Tasks… button enables. 

 

Recording and saving any 
change in the FRS window 
enables the SUBMIT button 

whether or not all information 
(e.g., Home Study), is complete. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Annual Reauthorization task. 
4 Click on the New, Use Prior or Detail button. 

The Foster and Adoptive Home Record Summary 
displays with the Annual Reauthorization tab active.  

5 Record all information necessary for the Reauthorization.  
6 Click on the Submit button at the bottom of the FRS. 

The F/A Home License displays. 
7 Click on Reauthorization check box in the Renewal/Extension section of the F/A 

Home License window. 
8 Change the Status field to Pending Acceptance. 
9 Click on File, and select ‘Save and Submit’. 

A Task To-Do assigned to your supervisor displays. 
10 Record Comments, if desired. 
11 Click on the Save button. 

The Task List displays. 

If you attempt to Save and Submit the F/A Home License window without selecting the 
Reauthorization check box, the following message will appear: 

“Check Reauthorization check box when submitting license for recertification.” 
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After Reauthorization Approval 
Once the Reauthorization is approved, the following occurs: 

• The status of the Annual Reauthorization event changes from PEND to APRV. 
• All information in the FRS is frozen. Selecting that Annual Reauthorization event 

from the Event List and clicking the Detail button opens the frozen Annual 
Reauthorization document which includes all information in the FRS in view-only 
mode for viewing or printing.  

• A Home License event with a status of APRV will be created.  
• The “From” and “To” dates on the Home License window update to reflect the new 

certification or authorization period. 
• An alert is sent to the worker, to remind him/her that a current home certification or 

approval letter should be printed. 
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Annual Reauthorization Tables 
As mentioned earlier in this module, the following tables are provided to help understand the 
different pathways that may occur using the Annual Reauthorization task. Specific 
descriptions of what happens when some buttons are selected have been added at the end of 
each table. 

If No In-Process Home Study Exists… 

Annual Reauthorization is 
selected and… 

Buttons 
Enabled State of FRS 

No Previous 
Reauthorization exists 

Approved/Frozen HS exists 

New 

Use Prior 

FRS contains current data from the database. 

Narratives and comment boxes are blank. 

In-Process Reauthorization 
exists Detail 

FRS contains current data from the database. 

The most recently saved Home Study 
narrative and comment boxes are opened. 

The In-Process Reauthorization is opened. 

New 

(A) 

FRS contains current data from the database. 

The most recently saved Home Study 
narrative and comment boxes are opened. 

The Reauthorization document is blank. 
Approved/Frozen FRS 

HS or Reauthorization exists 

Use Prior 
FRS contains current data from the database. 

The most recently saved narratives and 
comment boxes are opened. 

 
(A) Clicking New, when a previous Approved/Frozen FRS exists will produce the following 
message: 

“Start with new (blank) narratives instead of those last saved?” 

This refers to any existing historical Reauthorization narratives. You can click on Continue to 
retrieve the FRS with a blank Reauthorization narrative, or click on the Cancel button to return 
to the Task List and make another selection.  
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CONNECTIONS cannot maintain simultaneous, in-process FRSs. Below is a table explaining 
what buttons are enabled when you select the Annual Reauthorization task under specific 
conditions and what information is contained in the FRS.  

Annual 
Reauthorization is 

selected and… 

Buttons 
Enabled System Messages Information on the 

FRS 

An in-process 
Home Study 

exists  

OR  

An in-process 
Annual 

Reauthorization 
exists 

Detail 

 

When you access the Annual 
Reauthorization task for the first time, the 
following message displays when you 
click on the Detail button: 
 “In-process Home Study exists and will 
be converted. Continue?” 

• If you click on the Yes button, 
the in-process Home Study 
FRS will convert to an Annual 
Reauthorization FRS.  

 

• If you click on the No button, 
the Task List displays and the 
in-process Home Study FRS will 
NOT convert. Before you are 
able to work on the Annual 
Reauthorization, you must 
complete, Save and Submit the 
Home study. 

  

  

If you selected the Use 
Prior button when you 
started the in-process  
Home Study or Annual 
Reauthorization, the 
following information will 
be populated in the FRS: 
 
• Current data from the 

database; and  
 

• The most recently 
saved and approved 
narratives, including 
comment boxes. 
These narratives can 
be viewed or 
modified. 

 
If you selected the New 
button when you started 
the Home Study or 
Annual Reauthorization, 
the following information 
will be populated in the 
FRS: 
• Current data from 

the database and 
any narrative entries 
you have made in 
the in-process FRS. 

New 

 

If you click on the New button when a 
previous Approved/Frozen FRS exists, 
the following message displays: 
 “Start with new (blank) narratives 
instead of those last saved?” 

• If you click on the Yes button, a 
blank FRS (including all text 
boxes) displays. 

• If you click on the No button, 
the Task List displays. 

FRS contains current 
data from the database. 
All of the narratives and 
comment boxes are 
blank and may be 
modified.  

 

No in-process 
FRS exists  

and  

an Approved and 
Frozen 

Reauthorization    
OR  

Home Study  
exists 

 

 

Use 
Prior 

If you click on the Use Prior button, no 
message displays. 

FRS contains current 
data from the database, 
and the most recently 
saved and approved 
narratives, including 
comment boxes. These 
narratives can be viewed 
or modified. 
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Home Certification/Approval Extensions 
In specific situations, you may need to extend the current 
certification/approval of a FAD home. This would most likely 
occur if an individual aged 18 or older moved into the home, 
and the results of the CHRC (a.k.a. fingerprint check) have not 
been received in time to complete the recertification/reapproval. 

A FAD Home in Accepted –Active status may be extended for 
four 90-day periods while fingerprinting results are pending. In 
order to complete an extension, valid medical reports must be 
on file for all Foster Parent(s). Also, fingerprint extensions are allowed only if the Date Card 
Sent field on the Person Detail FA window has been recorded for all principals age 18 and 
older. 

 
Refer to Module 20 for 

information about Extensions of 
Emergency Homes. 

Date Changes 

First Extension When the first extension is requested, the new Authorized 
From date will be set to the current Authorized To date; the 
new Authorized To date will be 90 days from the new 
Authorized From date. 

Subsequent Extensions When the second or third extension is requested, the 
Authorized From date is unchanged; the Authorized To date 
is increased by 90 days. 

Final Extension If, during the extension period, you attempt to reauthorize the 
home for one year, the Authorized From date remains 
unchanged. The Authorized To date will be set one year from 
the Authorized From date. 

When completing the recertification/reapproval process, click on the Fingerprint Extension 
check box (on the F/A Home License window) to indicate if an extension is necessary. 
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Module 15: 
Closing Foster Homes 

A foster home may close at any point throughout the life cycle of the home. Home closure 
reasons vary, but often occur at key points in the life cycle of a foster home when the home and 
its applicants are being assessed/reassessed (e.g., the applicant stage, during 
recertification/reapproval). 

There are several common home closure reasons, including the following: 

• The prospective or certified/approved foster parents choose to discontinue the 
application process or to close an approved/certified home due to personal reasons. 

• An application expires (at 6 months). 
• The SCR Database Check reveals that an applicant has a prior history of abuse or 

maltreatment. 
• Information obtained for the Home Study reveals 

that the home does not comply with regulation 
standards. 

• Information recorded on medical forms results in the 
denial of the home for Home Study. 

• The Authorizing Agency determines that there is no 
further need for the foster home. 

• The Agency is closing. 
• CHCR results reveal that a prospective or 

certified/approved foster parent has been convicted of one or more crimes. 
 
Your decision to close a foster home must be based on OCFS policies and regulations. The 
reasons must be clearly documented in your contact notes and in the Closure Report. Follow 
appropriate procedures when closing a foster home. (See 18 NYCRR §443.11.) 

 
For regulatory citations 
for each of the closure 

reasons listed, see 
Appendix G: Table of Home 

Closures with Citations. 

 
Recording a home closure 
in CONNECTIONS notifies 
OCFS of the change in the 

home’s status. 

This module covers the regulatory requirements involved in 
closing a home and how CONNECTIONS can support your 
casework activities. By the end of the module, you will be able 
to: 

• identify state regulations regarding home closure;  
• open and complete the Closure Report in 

CONNECTIONS; and 
• Submit the Close Home task for supervisory approval. 
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Home Closure  
Closure of a foster home in Accepted-Active status is referred to as revocation or involuntary 
decertification, except in situations where the family has voluntarily requested to discontinue 
providing foster parenting services (18 NYCRR §443.11). 

 
Removing a child from foster 
family care involves a specific 

timeline and proper 
notifications. 

Refer to 18 NYCRR §443.5(a) 
for these regulations. 

Closing a foster home is a process that respects the rights of all 
parties involved and adheres to certain timelines. 

The only exception occurs in situations where the immediate 
health and safety of a child is at risk. If foster children are in a 
home that closes and the intent is for that home to remain 
closed, the foster children must be removed immediately. 

Revocation of a Certificate or Approval Letter 
For a revocation of a Certificate or Approval Letter, your decision to close the foster home must 
be based upon New York State regulations and must be documented clearly in the External 
Foster Home Case Record. 

The authorizing agency must advise the foster parents before the expiration date of the 
certificate or letter of approval that the agency does not plan to renew the certificate or approval. 
The certificate or letter of approval can be revoked prior to the expiration date if a situation 
arises.  A notification letter expressing the intent to close the home must be sent to the foster or 
adoptive parents at least twenty (20) days prior to closing the home. A letter indicating the 
decision to remove foster children from the home must be sent at least ten (10) days prior to 
closing the home (18 NYCRR §433.11). The only exception is in situations where the immediate 
health and safety of a foster child is at risk.  In these circumstances no advance notice is 
required to remove the child. Each agency must generate and print its own letters of notification. 
These tasks are not supported by CONNECTIONS. 

Let’s take a closer look at two home closure circumstances that commonly occur when a home 
is in Applicant status, but could happen at any point in the life cycle of a foster home: 

• Home Closure due to the results of the SCR Database Check; and 
• Home Closure due to CHRC and/or “Search and Retain” Results. 

Home Closure Due to the Results of the SCR 
Database Check 

 
See Module 9: Checking the 

status of Approvals Submitted 
for FAD Homes and New York 
State Social Service Law for 

information regarding denial of 
certification/approval due to the 

results of the 
SCR Database Check. 

An SCR Database Check must be conducted when you initially 
prepare a foster home for certification or approval, and when 
any person age 18 and over moves into the home (e.g., a 
parent of a foster parent). 

The SCR Database Check may reveal that a person has been 
an indicated subject in a report of abuse or maltreatment. If this 
happens, you need to follow regulatory procedures to revoke a 
certification or approval letter, or deny an application. 

Page 15-2 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Home Closure Due to CHRC Results 
The CHRC or “Search and Retain” function may reveal that a prospective or certified/approved 
foster parent has been convicted of one or more felony crimes (see also Module 7: Maintaining 
Person Information). 

An authorizing agency must use the information it receives from OCFS to determine whether or 
not to certify or approve a foster home, or whether or not revoke a certificate or approval letter. 

If an authorizing agency decides to revoke a certification or approval letter due to the results of 
a CHRC or “Search and Retain,” certain procedures must be followed. The family must be sent 
a written statement identifying the charge or conviction and stating the reason(s) for home 
closure. The agency must send the letter within seven days of learning of the charge or 
conviction [18 NYCRR §443.8(k)].  

As the caseworker responsible for the supervision of a foster home in this situation, you must 
conduct a safety assessment of the conditions in the household 
that determines: 

 
A Safety Assessment is 

required (in addition to other 
regulatory procedures) prior to 

removing any child from a home 
due to the results of the CHRC 

(18 NYCRR §443.8). 

 
For more information regarding 
the Search & Retain function, 

refer to 00 OCFS ADM-04 
in Public Folders on 
Microsoft Exchange. 

• whether or not the subject of the charge or 
conviction resides in the household; 

• the extent of that person’s contact with the foster 
children; and 

• the status, date and nature of the criminal charge or 
conviction 
[18 NYCRR §443.8 (g)(1)]. 

Document the Safety Assessment in the FRS using the 
Household Member Detail tab. Based upon the results of the 
safety assessment, take all appropriate steps necessary to 
protect the health and safety of the foster child or children in the 
home. This includes removal, where appropriate. These actions 
should be documented in External Foster Home Record and in 
your contact notes and the Closure Report (in 
CONNECTIONS). If revocation of the certificate or approval 
letter does occur, the foster child(ren) must be removed [18 
NYCRR §443.8(g)(2)(3)]. 

FAD Denial/Revocation Letter 
Full certification and approval of foster and adoptive homes can be denied when the results of 
the CHRC indicate that placement in the home is not in the best interest of a foster child (see 18 
NYCRR 443.8 and 00OCFS ADM-4 for further clarification). 

If a home certification/approval or recertification/reapproval is denied due to the results of the 
CHRC, the caseworker needs to provide notification of the denial in writing to the applicant(s). 

The FAD Denial/Revocation Letter (available in English and Spanish) is used to notify 
prospective or existing foster or adoptive parents whose home review has indicated a criminal 
history record. The letter states the reason(s) for denial and the process available for the review 
and/or challenge of the criminal history records. 
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The letter contains the following fields, which are pre-filled when the letter is generated: 

• Date (system date on which the letter was generated) 

• Name (the foster parents who are being denied) 

• Re: (person found with the criminal record) 

• DOB (birth date of the individual in the Re: field) 

• NYSID No. (NYS Identification number from DCJS) 

• Supervisor 

• Agency Representative (Primary Worker) 

• Telephone (Primary Worker’s telephone number) 

 

Step by Step: 
Generating and Printing the FAD Denial/Revocation Letter 
Part I: Generating the Letter 

1 On the Assigned Workload, select the home you need to send the letter to 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Select the Maintain Person task.  
4 Click on the List… button. 

The Person List displays. 
5 Click on the name of the person for whom the CHRC results caused the denial letter.  
6 Click on the Reports menu on the Person List and select FAD Denial/Revocation 

Ltr. (E) [English] or FAD Denial/Revocation Ltr. (S) [Spanish], as required.  
 
The FAD Denial/Revocation Ltr. command enables if: 

• A person has been selected on the Person List. 
• The selected person is part of a Foster or Adoptive home. 
• The Foster or Adoptive home does not have a status of “Inquiry” or “Closed.” 

If the above requirements are met, the following must be true in order 
for the letter to launch successfully: 

• An entry exists in the Fingerprint Results Received field on the Person Detail 
FA window. 

• The DOB column on the Person List contains a date of birth for the selected 
person. 

• The selected person is at least 18 years of age. 
When the letter has launched successfully the following message displays: 

“The report has been launched. Check the Report List window.” 

Letters remain unopened on the Report List for seven days before being purged. 
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Step by Step: 
Generating and Printing the FAD Denial/Revocation Letter 
Part II: Viewing and Printing the Letter 

1 Click on the RPRTS (Reports) button on the far right 
side of the CONNECTIONS Toolbar. 
The Report List displays. 

2 Confirm that the Status column reads “Done” for the 
letter you want to view. If it does not read “Done,” 
click on the Refresh button at the bottom of the 
window. 

3 Click on the letter to select it. 
The Open button enables. 

4 Click on the Open button. 
The letter displays as a Microsoft Word document. 

5 To print the letter, click on the File menu and select 
Print. 
The Microsoft Word Print dialog box displays. 

6 Click on the OK button to print. 
7 To close the document, click on the File menu and 

select Close. 
The Report List displays. 

8 To close the Report List, click on the Close button. 

The Close Home Task in CONNECTIONS 
The Task List of every foster home contains the Close Home task. This task may be used at 
any point in the life cycle of the foster or adoptive home to document a home closure in 
CONNECTIONS. A home closed in CONNECTIONS cannot be reopened until the next 
business day. 

 
Generating the letter for the first 
time generates an event on the 

Event List. 

 
You can print the letter by 

clicking on the File menu in the 
Word window. There is space at 

the top of the letter for your 
agency’s letterhead. Be sure to 

print the letter on agency 
letterhead. 

 
You can not work on this 
window in increments. All 

information must be recorded 
prior to saving and submitting.  

Selecting the Close Home task and clicking on the New 
button, opens the Close Home window. This window must be 
completed and then Saved and Submitted for supervisory 
approval.  

Home Closure Fields 
Descriptions of the fields you must complete in the Close Home window are presented below. 

Closure Reason 
You must select a Closure Reason on the Close Home window. Select the closure reason that 
best summarizes why the authorizing agency is closing the home. The Closure Reasons listed 
in CONNECTIONS are presented in the table below. 
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Closure Reasons in CONNECTIONS 

• Agency Closing 
• Applicant Does Not Permit 

Adoption Home Study 
• Applicant Physically or Emotionally 

incapable of caring for a Adopted 
Child(ren) 

• Approval not in Best Interest of 
Child(ren) Awaiting Adoption 

• Criminal History - Discretionary 
Disqualifier 

• Criminal History - Presumptive 
Disqualifier 

• Family Violence 
• Health & Safety 
• Home No Longer meets Child’s 

Needs 
• Non-Compliance with Non-

Licensing Regulations 
• Type of Home Not Needed 
• Unacceptable Medical Report 
• Adoption Disruption 

• Adoption Finalized 
• Death 
• Difference Over Policy/ Procedures/Roles 
• Difference Over Reimbursement Rates 
• Family Circumstances/Martial Problems 
• Family Illness/Health Problems 
• Family Moved 
• Family Request 
• Foster Child Behavior  
• Foster Child Physical/Mental Disabilities 
• Insufficient Services for Foster Child(ren) 
• Insufficient Support for Foster Family 
• Problems with Casework or Agency 
• Problems with Foster Child’s Family 
• Relative Assumed Custody/Guardianship 
• Duplicate Home 
• Merger 
• Other  
• Transferred to Another Licensing Agcy 

 

† If a Criminal History closure reason is selected, the Closure Type field is set automatically to “Involuntary” and the 
Recommend Reopening field defaults to “Do Not Recommend.” Both fields can be manually altered, if necessary. 
Also, upon Saving and Submitting these specific closure reasons, a message box displays reminding you that a 
“Notice of Denial/Revocation of certification/approval due to fingerprinting results” must be sent to the foster parents. 

‡ These closure reasons do not apply to Foster Homes and should not be used at this time. 

† If a Duplicate Reason closure reason is selected, the Closure Type field is system populated with “Involuntary” and 
the Recommend Reopening field defaults to “Do Not Recommend.” Both fields are non-modifiable. 

Closure Type 
In the Close Home window you must select a Closure Type of either “Voluntary” or 
“Involuntary” to categorize why the foster home is closing. Involuntary closure indicates that the 
home is being closed at the initiation of the authorizing agency. Voluntary closure indicates that 
the foster or adoptive parents are initiating the home closing. 

Recommend Re-Opening 
This field has two options. You may choose Recommend or Do Not Recommend. This 
decision should be made in advance of completing this window, and with the support of your 
supervisor. 
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Date Notification Sent 
Record the date that a notification letter was sent to the family informing them of the home 
closure. Remember that you have to send notification of home closure at least twenty (20) days 
prior to closing the home.  

Closure Report Button 
This button generates the Closure Report, a Microsoft Word template. Reasons for and actions 
surrounding the home closure should be documented in this window. 

Variations of the Home Closure Window 

Close Home Window Display Variations 

Action Window Display 

Submitting a FAD 
home for closure 

The Current Status field is protected and populated from the database. 

The Change To field is protected. For FAD homes in Inquiry status, the field 
reads “Closed;” The homes in any other status, the field reads “Pending 
Closure.” 

Changing a 
Pending Closure 

The Current Status field is protected and reads, “Pending Closure.” 

The Change To field is protected and populated with “Pending Closure” or 
“Closed;” 
 

The following fields are enabled† and populated from the database: 
 • Closure Reason • Closure Type 
 • Recommend Re-Opening • Date Notification Sent 

The Closure Report button is enabled; the check box is populated with a 
check mark if the closure report has been completed or is blank if it has not 
yet been completed. 

Viewing a FAD 
Home Submitted 
Closure Event 

The following fields are protected and populated from the database: 
 • Current Status 
 • Closure Reason • Closure Type 
 • Recommend Re-Opening • Date Notification Sent 

The Closure Report button is enabled. The Summary Closure Report is 
frozen and displays in View-only mode. 

† Provided the worker clicks on the “Yes” button in response to the message, “Saving will invalidate the 
pending Approval. Continue in Modify mode?” Otherwise, these fields are protected. 
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Home Closure Report 
The Home Closure Report is a Microsoft Template generated 
by CONNECTIONS for you to document the reasons for home 
closure, and the actions taken by the authorizing agency. Many 
of the protected fields in the template are automatically 
populated with information transferred from other areas of the 
CONNECTIONS database. Record new information in the 
unprotected sections of the document. 

The Home Closure Report is accessed via the Closure Report 
button on the Close Home window. Once the report has been 
accessed, an “√” displays in the check box next to the Closure 
Report button. The Save and Submit function on this window becomes enabled once the report 
is accessed and all required fields are completed. Use this button initiate the approval process 
once you have completed all information on the window. 

The Impact of Home Closure 
The closure of a foster or adoptive home still in Inquiry status 
does not require supervisory approval. The decision to close a 
foster or adoptive home in any other status requires supervisory 
approval. The home does not close until your supervisor/unit 
approver completes the task of approving the Close Home 
window that you Save and Submit. Once your supervisor 
completes the approval process the following actions take 
place: 

• the home/stage is removed from your Assigned Workload; and 
• The Closure Report must be accessed via the Event List, and is “frozen” and 

displays in View-Only mode. 

Accessing and Completing the Close Home Task 
The steps for accessing the Close Home and completing all close home requirements are 
detailed in the following sections. 

 

See Module 2: Getting Started 
in CONNECTIONS for tips on 

how to copy and paste 
information in Microsoft Word 

documents. 

 
Supervisory approval of the 

Close Home task triggers an 
update to the Resource 

Directory, BICS and CCRS 
during the overnight interface. 

 
If the current status of the home 

is “Pending Acceptance” and 
the associated licensing 

approval is pending, the Close 
Home window will not open; the 

following message displays:  
“A licensing change is pending 

approval. The home/facility 
cannot be closed” 

 

Step by Step: 
Completing & Submitting the Close Home 
Window (Including the Closure Report) 

1 On the Assigned Workload, select the home you need 
to close. 
The Tasks… button enables. 

2 Click on the Tasks… button. 
The Task List displays. 

3 Click on the Close Home task. 
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4 Click on the New button (use the Detail button to 
access a previously created Close Home task). 
The Close Home window displays.  

5 Click on the drop-down arrow for the Closure 
Reason field and select the appropriate closure 
reason from the resulting list. 

6 Click on the drop-down arrow for the Closure Type 
field and select the appropriate closure type from the 
resulting list. 

7 Click on the drop-down arrow for the Recommend Reopening field and select the 
recommendation choice. 

8 Record the date the close home notification was 
sent to the foster parents in the Date Notification 
Sent field.  

9 Click on the Closure Report button to generate the 
Closure Report. 
An MS Word document opens. 

10 Record information in the unprotected sections of 
the document, or paste information copied from another MS Word document  
(see Module 2: Getting Started in CONNECTIONS). 

 
On the Close Home window, the 
system automatically populates 

the Current Status and 
Change To fields. 

The Change To field is 
always “Pending Closure.” 

 
You can not work on this 
window in increments. All 

information must be recorded 
prior to saving and submitting.  

11 When you are ready to leave the window or save information, click on File and select 
Close. 
The Close Home window displays. 

12 Click on the Save & Submit button.  
The following message displays: 
“Have you completed the Closing Summary Report?” 

13 Click on the Yes button. 
The To-Do Detail window displays. 

14 Fill in the description field, as needed. 
15 Click on the Save button. 

The Task List displays. 

Closing a Duplicate Home 
A Duplicate Home occurs when the home has been recorded more than once in the 
CONNECTIONS database. The results may be the same demographic information, but two 
different Vendor ID numbers. In order to maintain the integrity of the data entered in 
CONNECTIONS it is important that caseworkers have the ability to differentiate duplicate 
homes from valid resources. CONNECTIONS allows caseworkers to search for and identify 
duplicate homes, label homes as duplicate and close duplicate homes. 

When creating a home it is necessary to conduct a thorough FA Home Search to determine 
whether the home already exists in CONNECTIONS. Using this search function, existing homes 
can be located regardless of where in the state they were created. The FA Home Search filters 
through foster homes of every status level (e.g., Inquiry, Applicant, Accepted-Active, Closed).  If 
in your search you find a home closed by another agency a worker should reopen the home to 
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avoid duplication. Locating and reopening the home is the best way to maintain data integrity 
and to keep the history of the home up to date and accurate. If a thorough search is not 
conducted, the result can be the creation of a duplicate home. 

Closing a duplicate home is a two-step process. The first step requires changing the Vendor ID 
number to a Duplicate Home number. The second step is to close the duplicate home. 

 

Step by Step: 
Closing a Duplicate Home 
Part I: Changing the Vendor ID Number 

1 From the Assigned Workload select the home 
whose vendor ID number you are changing. 
The Tasks… button enables. 

 
If you attempt to close a home 

as a duplicate without first 
changing the Vendor ID, 

the following message displays: 
”Must change VID to the 

assigned DH-#### format 
before saving.”” 

 
If primary address is different 

from the business, click on the 
Address button to record the 
Duplicate Home Vendor ID in 
the Resource Address Detail 

window.” 

 
The Duplicate Home number 

format is: 
the letters DH, 

followed by a hyphen 
and 4 digits 
[DH-####]. 

2 Click on the Tasks… button. 
The Task List Displays. 

3 Select the Maintain Non-Licensing Information 
task. 
The Detail… button enables. 

4 Click on the Detail… button.  
The Home Demographics window displays. 

5 In the Home Demographics window, click on the 
Address… button. 
The Resource Address Detail window displays. 

6 Select the Business address in the list section at the 
top of the window. 
The address information displays in the detail 
section at the bottom of the window. 

7 Highlight the Vendor ID number in the Vendor ID 
field and press the Delete key on your keyboard. 

8 Enter a new Vendor ID in the Duplicate Home 
number format (the DH number is obtained from 
your supervisor). 
The Modify button enables. 

9 Click on the Modify button. 
The new Vendor ID displays in the Vendor ID field 
with a DH number format (DH-####). 

10 Click on the OK button to close the Resource 
Address Detail window. 
The Home Demographics window displays. 

11 Click on the Save & Submit button on the Home Demographics window. 
The Task List displays. 
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Step by Step: 
Closing a Duplicate Home 
Part II: Closing the Duplicate Home 

1 Select the Close Home task. 
The New button enables. 

 

Where am I? 

Assigned Workload > FAD > 
Tasks button 

 
To complete part 2 of Closing a 

Duplicate Home Supervisory 
approval is needed to approve 
Duplicate Vendor ID change. 

 
A FAD home that has been 

closed as a duplicate 
cannot be reopened. 

 
Caseworkers are able to search 
for duplicate homes that have 

been closed by selecting 
Closed Duplicate from the 

Status menu on the FA Home 
Search window. 

2 Click on the New button. 
The Close Home window displays. 

3 Click on the drop-down arrow for the Closure 
Reason field and select Duplicate Home. 
The Change To field reads “Closed Duplicate.” 

4 Click on the Closure Report button to generate the 
Closure Report. 
An MS Word document opens. 

5 Record information in the unprotected sections of the 
document, or paste information copied from another 
MS Word document  
(see Module 2: Getting Started in CONNECTIONS). 

6 When you are ready to leave the window or save 
information, click on File and select Close. 
The Close Home window displays. 

7 For homes in “Active” or “Applicant” status, click on 
the File menu and select Save and Submit. For 
homes in “Inquiry” status, click on the Save button in 
the bottom right corner of the window.  
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Module 16: 
Maintaining Closed FAD Homes/Stages 

In addition to the responsibilities of maintaining FAD home 
information for open homes, you may be a person who is relied 
upon to make updates to Closed FAD Homes. 

 

To use the Local Data 
Maintenance window you must 
have the MAINT CLSD PERS 

Business Function.  

Contact your Security 
Coordinator if you have 

questions regarding security 
access. 

Homes receiving adoption subsidies do not have to remain 
open in CONNECTIONS to receive payment (see Module 21: 
Adoptive Homes). However, if the family changes status 
information, their record must be updated. The Local Data 
Maintenance window allows you to make updates to a home 
without having to reopen (and later close) the home.  

The Local Data Maintenance (LDM) window allows the viewing 
and updating of Person Demographic information in closed FAD 
stages. Its structure is similar to the Foster and Adoptive Home 
Record Summary (FRS). The LDM window contains 4 tabs:  

• Person Demographics • Add / Relate Person 
• Allegations • Investigation Conclusions 

 
Only the Person Demographics tab is available to FAD workers. 

In this module, we will look at how to access the Local Data Maintenance window and the 
Person Demographics tab. By the end of this module, you will be able to: 

• access the LDM window; 
• identify the sections of the LDM window; 
• use the Person Demographics tab to update closed FAD home information; and 
• navigate to the LDM Online Help System. 
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Accessing the Local Data Maintenance Window 
If you have the MAINT CLSD PERS Business Function, you can access the Local Data 
Maintenance (LDM) window through the Case Summary window.  

Access requirements for the LDM window are summarized below:  

Menu Command on Case 
Summary Window: Maintain Closed Person Demographics 

Security Attribute Needed: Maintain Closed Person Demographics 

Additional Access 
Requirements: 

FAD stage is closed 
and 

Worker must be from same district/agency as primary worker 
when stage was closed 

LDM Tabs Enabled: Person Demographics 

 
Since the stage in question will be closed, it will not appear on your Assigned Workload. It will 
be necessary for you to start with a case search.  

 

Step by Step: 
Opening the Local Data Maintenance (LDM) Window 

1 Conduct a Case Search to retrieve the home you need to update. 
(See Module 4: Retrieving Information in CONNECTIONS for instructions). 

2 From the list of results, select the FAD home/stage 
that requires maintenance. 
The Summary button enables. 

3 Click on the Summary button. 
The Case Summary window displays. 

4 Select the FAD stage to be viewed/updated, and 
click on Options. 
A drop down menu displays. 

5 Select Maintain Closed Person Demographics 
from the menu. 
The Local Data Maintenance (LDM) window displays, showing the Person 
Demographics tab. Selecting Maintain Closed Person Demographics opens the LDM 
window in modify mode. 

 

No events are generated when 
the LDM window is accessed 
through the Maintain Closed 

Person Demographics 
command. 

The LDM window consists of a heading, four tabbed sections, and a footer. Only the Person 
Demographics tab is active when the window is accessed via the Maintain Closed Person 
Demographics menu item. 
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The Layout of the LDM Window 
The Local Data Maintenance (LDM) window consists of three major sections: 

• Header 
• Tabs 
• Footer 

The Heading and Footer sections contain elements that are present no matter which section of 
the LDM window is being used. The Tabs are the sections that make up the main body of the 
LDM window and are described in detail below. 

Heading 
The heading is always present when the LDM window is open. It includes the following 
information: Case Name, Case ID, Stage ID, Report Date (if applicable), Case Status, and 
Event Status.  

Because you will be accessing the LDM window via the Maintain Closed Person 
Demographics menu item on the Case Summary window, the Event Status field will be blank.  

Footer 
The footer is always present when the LDM window is open. Only one button appears in the 
footer: the Close button. Clicking on this button closes the LDM window and returns you to the 
Case Summary window. The Close process also gives you the opportunity to save any unsaved 
changes to the LDM window. 

Tabs 
The information contained in the LDM window is organized into sections, which are represented 
by file tabs on the LDM window. Appearing from left to right, these tabs are labeled:  

• Person Demographics 
• Add/Relate Person 
• Allegations 
• Investigation Conclusions  

Remember, only the Person Demographics tab is available when the LDM window is entered 
using the Maintain Closed Person Demographics menu item. 

Information entered in the LDM window will be stored in the CONNECTIONS database. When 
you reenter the LDM window, it will be “refreshed” with the most current information. This 
information can be reviewed and, if necessary, updated further. 
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The Person Demographics Tab 
The purpose of the Person Demographics tab is to provide a place  to view and update 
information about persons associated with a closed FAD stage. The person information listed 
on this tab can only be modified if the individuals are associated with closed cases. A person’s 
information cannot be modified if that person is associated with any open, non-ARI stage. 

If you do attempt to modify information for a person in an open non-ARI stage, CONNECTIONS 
will alert you to this by providing the following message: 

“Can’t modify demographic information of people in open stages. 
Person member of Stage ID: ###” 

If you do need to correct demographic information for a person who is associated with an open 
stage, you will need to access their Person Detail window from within the FAD home/stage (see 
Module 7: Maintaining Person Information and Module 12: Maintaining FAD Homes in 
CONNECTIONS). 

If you do not have access to that person on your Assigned Workload, conduct a person search 
to determine the open stage the person is associated with. The Person Search results will also 
identify the primary worker’s name and agency. You can contact the primary worker to discuss 
any changes that are needed to the record. 

Information on the Person Demographics Tab 
The Person Demographics Tab can be separated into two grids; an Upper Grid and a Lower 
Grid. 

The Upper Grid 

The upper grid contains the following information about all persons associated with a closed 
FAD home/stage:  

• Last Name • Relation/Interest 
• First Name • Race 
• Middle Initial • Language  
• Person ID • DOD (Date of Death) 
• DOB (Date of Birth) • Approximate Date of Death  
• T (Date of Birth Type) • Religion  
• Age • Phone 
• Marital Status • Ext (Phone Extension) 
• Sex • Type 
• Ethnicity • Role 

 

Page 16-4 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



When making changes on the Person Demographics tab, it is important to remember the 
following items: 

• The Date of Death and Approximate Date of Death Flag columns can only be 
modified if a Date of Death already appears in the grid for that person. 

• Updating a person’s Date of Birth in LDM will change the person’s Date of Birth in all 
other stages containing that person. (Keep in mind that, since a person in open 
stages cannot be modified, the affected stages will all be closed stages.) 

• The Age field cannot be modified if there is an exact Date of Birth listed in the DOB 
field. If corrected DOB information for an exact DOB becomes available, correct the 
DOB field and the Age field will automatically update. If the DOB is marked 
Approximate (A), the Age column can be modified. When Age is modified, the DOB 
is recalculated and updated. 

All columns in this grid are modifiable by clicking directly on the grid cell and typing or selecting 
from the drop down commands, with the following exceptions: 

Column Modified by… 

Person ID Cannot be modified 

Race Race selection box is located elsewhere on Person 
Demographics tab. 

Ethnicity Ethnicity drop-down and selection box are elsewhere on the 
Person Demographics tab. 

Phone Number, 
Extension, Phone Type 

Maintain Primary Address/Phone Windows are accessed via 
the Address/Phone button 

Role Automatic (re)calculation when changes are saved. 

 
Clicking in a row of the grid selects that person for modification. An arrow to the left of a row 
indicates that person has been selected. 

The Lower Grid 

When a person is selected in the upper grid, the lower grid will display all person identifiers 
(SSN, CIN, etc.) for that person. Each person identifier appears in its own row of the lower grid. 
An arrow displays to the left of the row that is currently selected for editing.  

You may add new identifiers by typing and selecting from the drop-down command into the row 
of the lower grid marked with a star (the last row). To end-date an existing identifier, add a new 
row with the same Type. The End-Date will be set to the current date. 

The lower grid displays the following information for each identifier:  

• INV ID Invalid Flag • Type • Number 
• Start Date • End Date • Comments 
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The information in the lower grid is modifiable as follows: 

Column Modified by… 

INV (ID Invalid 
Flag) 

This flag can only be marked (using the drop down arrow that 
appears when clicking in the cell,). Cannot be removed. 

Marking the flag invalid will set the end date of that row to the current 
date. 

Type ID Type can be selected for new rows using the drop down arrow 
that appears when clicking in the cell. 

ID Type cannot be modified for existing rows. 

Number ID Number can be modified by clicking and typing directly in the grid. 
Cannot be modified in a row for which the End Date is set. 

Start Date Start Date is set to the current date when a new record is added. 

End Date End Date is set to current date when ID Invalid Flag is set or when 
new row with same ID type is added. 

Comment The Comment section can be modified by clicking and typing directly 
in the grid. Cannot be modified in a row that already has the End 
Date is set. 

The Race and Ethnicity of the person selected in the upper grid can be modified using the drop-
down box and list boxes in the bottom right-hand corner of the tab. The table below illustrates 
how this works. 

Box Enabled when… Modifying this box… 
Ethnicity Drop Down A person is selected in the 

upper grid. 
Updates the Ethnicity column in the 
upper grid. 
This column will display “NR” when 
the ethnicity is listed as “Not Reported 
in the upper grid. 

Ethnicity List Box A person is selected in the 
upper grid 

—AND— 
Ethnicity field is set to 
“Hispanic or Latino” 

NA 

Race List Box A person is selected in the 
upper grid. 

Updates the Race column in the 
upper grid. 
If more than one Race is selected in 
this box, the upper grid displays 
“Multiple.” 

Remember: You must click on the Save button after each change you make to the Person 
Demographics tab, for each change to be stored in the CONNECTIONS database. 
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Buttons on the Person Demographics Tab 
The Person Demographics tab also has three buttons towards the bottom of the tabbed section: 

• Address/Phone (disabled for FAD stages) 
• Save 
• Cancel 

Phone/Address Button 

The Phone/Address button is disabled for FAD stages. 

Save Button 

The Save button affects what happens to new information you have entered into the LDM 
window. To store newly recorded information in CONNECTIONS, you will select the Save 
button. This button is disabled until any changes are made on the Person Demographics tab. It 
also becomes disabled after a save, until the next time changes are made to the tab.  

Cancel Button 

If you choose not to save your information, you will click on the Cancel button. This action will 
cancel all changes made to the tab since the last save. The Cancel button is disabled until any 
changes are made on the Person Demographics tab. Clicking on the Cancel button displays 
the following message: 

“Your changes will be lost. Continue?” 

You will click on the Yes button to discard any unsaved changes. To leave the changes as they 
were entered, click on the No button. 

Closing the LDM Window 

When you have finished making all changes on the LDM window, and you have saved your 
entries, click on the Close button at the bottom of the LDM window. Clicking on the Close 
button prior to saving the LDM window displays the following message: 

“Save changes in progress.” 

Click on the Yes button to save the changes; click on the No button to discard them. 

The remaining tabs on the LDM window - Add/Relate Person, Allegations, and Investigation 
Conclusions – are not accessible when the LDM window has been entered using the Maintain 
Closed Person Demographics menu item in the Case Summary window. 
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Conducting Maintenance on a Closed FAD Home/Stage 

 

Step by Step: 
Making Changes on the Local Data Maintenance (LDM) Window 

1 Access the LDM window (see page 16-2) 

 

You must save (click on the 
Save button) after making a 

change to the Person 
Demographics tab, in order for 
that change to be stored in the 

CONNECTIONS database.  

Therefore, if more than one 
change has been made, only 

the last one, if unsaved, will be 
discarded when the No button  

is clicked. 

2 Make necessary changes to appropriate fields (e.g., 
DOB, Martial Status, Ethnicity) 

3 Click on the Save button. 
The following message displays: 
“Changes have been saved.” 

4 Click on the OK button. 
The LDM window displays. 

5 When you are done reviewing information about the 
person, close each window by clicking on Close 
button. 

LDM Online Help 
Context-sensitive help information is available for all elements of the LDM window including 
tabs, grids, buttons, and individual fields. To activate context sensitive help, simply click on an 
element (e.g., a Field Name) and press the F1 key on your keyboard. Information about that 
element of the LDM window will be displayed.  

LDM Online Help includes the following features: 

• A Table of Contents allowing access to all Help information. 
• Index and Search functions providing alternate means of finding information. 
• Interactive graphic examples of LDM window elements. Clicking on certain portions 

of a graphic within LDM Online Help will display explanations of that element. 
• Hyperlinks appear throughout the Help information. These links will take you directly 

to related information such as definitions and procedural guidelines. 
• Pressing F1 opens the LDM Help system. Information specific to the LDM window 

element that was active when F1 was pressed will be displayed. Once in the Help 
system, the table of Contents allows access to help information on other elements of 
the LDM window. 
 

The LDM Help system offers more than help on LDM window elements. Below is list of 
additional Help information that you can access on line in the LDM window. 

LDM Overview: A high level summary of LDM including a listing of its features and 
functions. This overview can be accessed directly by clicking the word Help that appears 
in the upper left corner of the LDM window and then clicking on LDM Help, which 
appears in the small menu. 
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“How Do I?” Help: Information on how to navigate within the LDM window and how to 
best utilize its functions. 

Glossary: Definitions of terms commonly used in casework as well as definitions of LDM 
window elements and concepts. 

Guidelines: Background on the legal, policy, and procedural guidelines followed by 
workers as they develop and record the information viewed in the LDM window. 

Help on Help: Instructions on how to use the LDM Online Help system. 
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Module 17: 
Reopening Closed Foster Homes  

You may need to reopen a closed foster home for a variety of reasons, such as: 

• An individual/couple inquires about becoming foster parents and states that they 
have a history of providing foster care in New York State. 

• A foster parent in your agency has taken a break due to family circumstances and is 
ready to provide care again. 

• The foster home/stage was closed by the system when the certification or approval 
period expired. 

• A foster home was closed in CONNECTIONS due to system error or administrative 
reasons. 
 

In this module, you will learn how the different reasons for closing a home affect the reopening 
of the home. Additionally, you will learn how CONNECTIONS supports the process of reopening 
foster homes/stages. 

By the end of this module, you will be able to: 

• conduct an F/A Home Search in CONNECTIONS; 
• review the results of an F/A Home Search; 
• reopen a closed home in CONNECTIONS in either Inquiry or Applicant status; and 
• assign the reopened home to a caseworker for full certification or approval. 
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Reopening Closed Foster Homes 
The reason for home closure is an important factor in 
determining the process of reopening the home. Regulations 
state that a closed home must be reopened in accordance with 
regulatory requirements {18 NYCRR 443.2(b)(19) and 
443.10(b)}. The reopened home is treated as a new inquiry, 
except in the case of closure due to system error or 
administrative reasons. 

§443.2(b)(19) states: “Treat all reopenings of foster homes that 
have closed as requests for a new certificate or approval. A 
new application must be completed regardless of how long the 
home has been closed. The only exception to this requirement 
is when a reopening occurs for administrative reasons, i.e., 
when the home should not have been closed initially but 
because it was, a reopening is necessary.” 

A common reason for home closure is the failure to complete 
the Reauthorization process in CONNECTIONS in an accurate 
and timely manner. Failure to complete the Reauthorization process in a timely manner, 
including timely approval in CONNECTIONS, will result in home closure in CONNECTIONS 
(see Module 14: Recertification and Reapproval of FAD Homes). In a situation where you have 
not fully completed the Reauthorization process (and recorded the information in 
CONNECTIONS), you must treat the home as a new inquiry. A new SCR Database Check must 
be completed and the Home Study narrative must be updated. 

 
“System error or administrative 

reasons” refers to specific 
problems with the 

CONNECTIONS system or the 
ability to access 

CONNECTIONS. 
Failure to complete the 

Reauthorization casework 
process and record the proper 

information inside 
CONNECTIONS is not 

considered a “system error or 
administrative reason.” 

When all casework outside CONNECTIONS has been completed but has not been recorded in 
the system by the expiration date (thereby causing the home to become system closed), it is 
referred to as late system entry. You will have to wait one business day before you may reopen 
the home, but you do not have to reopen the home/stage as a new inquiry. 

Inadvertent closure of a home due to system error or administrative reasons, or due to late 
system entry, must be supported with documentation in the External Foster Home Case Record. 
This documentation should verify that all of the casework activities for the Recertification or 
Reapproval process were completed in a timely manner, even though they may not have been 
recorded in the system. A Business Function Profile (BFP) of “Maintain FAD History” is required 
to correct the home history to reflect the date the recertification or reapproval was actually 
completed by the caseworker (see Module 12: Maintaining FAD Homes in CONNECTIONS). 
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The F/A Home Search 
Regardless of why you are reopening a foster home, you must start by conducting an F/A Home 
Search in CONNECTIONS. This is necessary to avoid creating a duplicate home in the system. 
This is the primary reason we are reopening the home; duplicating a home is associated with 
duplicate Vendor ID’s, and possibly with duplicate Person ID’s. Conducting a thorough F/A 
Home Search is the best way to avoid all of these hazards. 

The reason for reopening a home may affect your decision to 
conduct a “state-wide” search, and could affect the Search 
Type you choose on the F/A Home Search window. There are 
three search type options: 

• Phonetic 
• Phonetic Address 
• Exact 

 
Module 6 (Responding to an Inquiry) describes the F/A Home 
Search process in detail. Turn to Module 6: Responding to an 
Inquiry to view more information on these specific Search Types. 

Conducting an F/A Home Search 

 

Step by Step: 
Conducting an F/A Home Search 

1 Click on the Options menu on the CONNECTIONS 
Toolbar and select F/A Home. 
A fly-out menu displays. 

2 Click on F/A Home Search… on the fly-out menu. 
The F/A Home Search window displays. 

3 Click on the Clear button (or highlight the Agency 
Code and press the Delete key) to delete the 
Agency Code and perform a statewide search. 
The following field highlights in yellow: Home Name. 

4 Enter the home name in the Home Name field in the 
following format: Smith, Mary 

5 Click on the Search… button. 
The F/A Home List displays. If the search does not 
return a match, the window is blank and displays the 
following message: 
“The criteria entered results in no information being returned.” 

 
When entering a home name 
for an F/A Home Search, use 

the following method: 
Smith, Mary  

Do not place a space between 
first and last names.  

 
On occasion, a worker may 

create a FAD Home not 
realizing the home already 

exists in CONNECTIONS. The 
result is a duplicate home. 
This can lead to duplicate 
homes being reopened or 

reactivated. 
See Module 15: 

Closing Foster Homes to close 
duplicate homes. 
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Understanding the Results of the F/A Home Search 
In Module 6: Responding to an Inquiry, we conducted an F/A Home Search. The Results of the 
F/A Home Search display on the F/A Home List. The F/A Home List includes the following 
information for each FAD home/stage returned: 

• Resource Name • VID (Vendor ID) • Setting 
• Status • Sub-Agency (NYC only) • Ethnicity 
• Race • Address 1 • City 
• County • State • CD (NYC only) 
• Zip Code • Worker Name • Case ID 
• Worker Phone  • Worker Ext.  

If the F/A Home Search reveals that the home previously existed in CONNECTIONS and is now 
closed, you must determine whether or not the home should be reopened. The process of 
making this determination should include (but is not limited to) the following: 

• View Home Demographic information by clicking on the Home Demo. button at the 
bottom of the F/A Home List. 

• View the home history in CONNECTIONS (by selecting F/A Home History… from 
the Options menu on the FA Home List). 

• If the Recommend Reopening field on the F/A Home History Detail window 
indicates “Do not recommend reopening,” do more research. Try to contact the 
caseworker that previously closed the home. If the former worker is not available, 
contact the former agency for general information on the closing. If possible, try to 
get information in writing. In addition, you should document all findings in the 
External Foster Home Case Record. 

• Remember that a discussion of the situation with the potential foster or adoptive 
parent(s) should also take place. This discussion needs to be documented in the 
External Foster Home Case Record. 
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Step by Step: 
Reviewing Information on the F/A Home List 

1 On the F/A Home List, select a foster home that 
matches your search criteria. 

 

Where am I? 

CONNECTIONS toolbar > 
Options menu > FA home > FA 

Home > Search command > 
Search button 

2 Click on the Home Demo. button. 
The Home Demographics window displays. 

3 Review the Home Demographic window, then click 
on the Cancel button. 
The F/A Home List displays. 

4 Click on the Options menu and select F/A Home 
History… 
The F/A Home History window displays. 

5 Select the most recent event that has a Status of “Closed.” 
6 Click on the History Detail… button in the lower left corner of 

the window. 
The following message displays: 
“Inquire mode. Not authorized to make any changes.” 

7 Click on the OK button. 
The F/A Home History Detail window displays. 

8 Review the information in the Closure Type, Closure Reason and Recommend 
Reopening fields. 

9 When you have completed your review of this window, click on the Cancel button. 
The F/A Home History window displays. 

10 Click on the Close button in the F/A Home History window. 
The F/A Home List displays. 

Continue with the process of reopening the foster home only after you have performed all 
necessary steps to determine that the home is appropriate for reopening. 

Reopening, Saving and Assigning a Previously Closed Home 
In order for a foster home to be reopened, it must be Saved and Assigned to a worker in 
“Inquiry” or “Applicant” status. Determine which status to use (Inquiry or Applicant) by 
considering the reason for closure, the reason for reopening the home, the amount of time the 
home has been closed, and local district/voluntary agency policy and procedure. For example, 
Save and Assign in “Applicant” status if the home is being reopened by the agency that closed it 
and the closure was inadvertent. 

When a home is reopened by the agency that closed it, payments are reimbursable as soon as 
it is submitted to the supervisor/unit approver for approval. 

When a home is reopened by an agency other than the agency that closed it, payments are not 
reimbursable until the home is reopened, saved and submitted, and approved by the new 
agency supervisor/unit approver. 
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The instructions below begin on the F/A Home List, immediately following the review of 
historical information on the closed home. They continue through the process of assigning the 
home to a Primary worker. For information on how to assign a home/stage to a worker who is 
not on your Available Staff list, see Module 6: Responding to an Inquiry. 

 

Step by Step: 
Reopening, Saving and Assigning a Previously Closed Home 

1 In the F/A Home List, click on the Options menu and 
select Re-open Closed Home. 
The Reopen Home window displays. 

 

Where am I? 

CONNECTIONS toolbar > 
Options menu > FA home > FA 

Home > Search command > 
Search button 

2 Click on the drop-down arrow for the Change To field 
and select either “Inquiry” or “Applicant,” as 
appropriate. 

3 Click on the File menu and select Save and Assign. 
The Assign window displays. 

4 In the Available Staff section at the top of the Assign 
window, click on the name of the worker who is to 
have primary responsibility for the foster home/stage 
– if assigning to someone other than self. 
Proceed to Step 6 if assigning case to self. 

5 Click on the Primary button. 
The selected caseworker’s name displays in the Assignments section at the bottom 
of the window. 

6 Click on the Save button. 
The F/A Home List displays. 

7 Click on the Close button on the F/A Home List. 
The F/A Home Search window displays. 

8 Close on the Close button on the F/A Home Search. 
The Assigned Workload displays. 

After Reopening a FAD Home 
Remember that reopening a FAD home is only the first step in processing an inquiry or updating 
a FAD home/stage. A good first step in reviewing the home/stage is to access the Foster and 
Adoptive Home Record Summary (FRS). The FRS provides a comprehensive view of all 
home/stage information, and is a quick way for you to figure out what information needs to be 
added or updated first (see Module 3: Managing Your Workload for details on accessing the 
FRS). 

For information on how to record or edit home and person information, refer to the following 
modules in this guide: 

• Module 6: Responding to an Inquiry; 
• Module 7: Maintaining Person Information; and 
• Module 12: Maintaining FAD Homes in CONNECTIONS. 
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Converting Facility Type after Reopening a Foster Home 
A home originally opened as an Approved Relative Foster Home, Certified Foster Home or 
Foster/Adoptive Home may need to have its Facility Type updated upon reopening to reflect a 
change in the provision of foster care. For example, foster parents who were once approved to 
care for a relative may now want to provide foster care to non-relative foster children. The 
opposite could be true as well. 

To convert the Facility Type, an F/A Home Search must be 
performed to find the home in CONNECTIONS, then the home 
must be reopened and assigned to your Assigned Workload. As 
the caseworker responsible for completing the certification or 
approval process, you must update all information pertaining to 
the home. To convert the Facility Type, use the Maintain 
Licensing Information task. On the F/A Home License 
window, the Facility Type field can be changed to reflect the 
current situation. 

For more information on the licensing procedures, refer to Module 8: Maintaining Licensing 
Information for FAD Homes. 

The instructions below describe how to convert Facility Type after Reopening a Foster Home 
from the Assigned Workload. 

 

Step by Step: 
Converting Facility Type after Reopening a Foster Home 
 

 
If a home is being reopened and 

treated as a new inquiry, a 
Reauthorization is not needed. 
The full certification or approval 

process creates a new 
authorization timeline. 

 

Refer to the following Step-by-
Step’s for help deciding which 
task to use prior to Converting 
Facility Type: “Conducting an 

F/A Home Search” and 
“Reopening, Saving and 

Assigning a Previously Closed 
Home.” 

1 After conducting an F/A Home Search and Re-
opening the closed home; from the Assigned 
Workload, click the name of the appropriate foster 
home/stage. 
The Task button enables. 

2 Click on the Tasks button. 
The Tasks List displays. 

3 Select the Maintain Licensing Information task. 
4 Click on the Detail button. 

The F/A Home License window displays. 
5 Click on the drop-down arrow for the Facility Type 

field select as appropriate. 
The Save button enables. 

6 Click on the Save button. 
The Task List displays. 
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Module 18: 
Historical F/A Home Certificates and Approval Letters 

For a variety of reasons (e.g., foster parent’s request, audits) you may need to obtain a copy of 
an F/A Home Certificate or Approval Letter from a previous licensing period. Historical 
documents are an important feature of a case record. In this module, we will learn how 
CONNECTIONS supports this need. By the end of the module, you will be able to: 

• generate, view and print an historical F/A Home Certificate; and 
• generate, view and print an historical Approval Letter. 

 

Historical F/A Home Certificates and Approval Letters 
CONNECTIONS captures the end date (and all other information required for historical F/A 
Home Certificates and Approval Letters) each time an Accepted-Active event is changed to 
“Pending” status and is submitted for supervisory approval. 

This end date is printed on the bottom left corner of 
historical F/A Home Certificates and Approval Letters. It 
indicates the period for which the information on the 
document was valid. 

In attempting to populate historical F/A Home Certificates 
and Approval Letters, the system lists the first two 
individuals in the home, provided that they show a 
relationship/interest (Rel/Int) code of “Foster Parent” 
(recorded on the Person Detail window) and have no date 
of death. Before January 2002, if the Rel/Int code of “Foster 
Parent” was not recorded prior to or during that specific 
historic period, no names will be listed on the historical 
document. Subsequent to January 2002, a Rel/Int code of “Foster Parent” is required for at 
least 1 person in the stage. 

 
The ability to generate Approval 
Letters and Historical Approval 

Letters and Certificates was 
introduced to CONNECTIONS 

in October 2000.  
Retrieval of Approval Letters is 
not possible prior to October 

2000. 

F/A Home Certificates and Approval Letters reflect the most recent date information for the 
period in question. If dates have been corrected on the Home History window, those corrections 
will be reflected in the historical document. 

Historical documents must be generated via the Event List, not the Maintain Licensing 
Information task (which displays current licensing information only). The Event List can be 
accessed two ways: through the Assigned Workload or through the Task List. 

Effects of Historical Persons on Foster Home Certificates  
and Approval Letters 

The Remove Person – Left Home function described in Module 12: Maintaining FAD Homes in 
CONNECTIONS, affects the historical record of a FAD home, including certificates and approval 
letters. 
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When an individual is removed from a FAD home with the Remove Person – Left Home 
function, the historical certificate or approval letter retains only the Foster Parent’s name in a 
“frozen” historical document. By doing this, the historical home certificate or approval letter 
reflects accurate information for the historical period represented by that document.  

Certificates and approval letters generated after an individual has been removed from the FAD 
home via the Remove Person – Left Home function do not show the person as a member of 
the foster home. 

 

Step by Step: 
Generating and Printing an Historical 
F/A Home Certificate or Approval Letter 

1 On the Assigned Workload, click on the name of the appropriate foster home/stage. 
2 Click on the Options menu and select Event List… 

The Event List displays for the selected stage. 
3 Click on an event from the appropriate time period (the Event Description should 

read: “Changed home status to Approved-Active”). 
4 Click on the Detail… button in the bottom left corner of the Event List. 

The F/A Home License window displays. 
5 Click on the Forms menu and select Historical F/A Home Certificate or Historical 

Approval Letter, as appropriate. 
This certificate/letter displays as a Microsoft Word document. 

6 Review the document to ensure it is for the correct time period. 
7 Click on the File menu and select Print. 

The Microsoft Word Print dialog box displays. 
8 Click on the OK button. 
9 Click on the File menu and select Close. 

The F/A Home License window displays. 
10 Click on the Cancel button on the F/A Home License window. 

The Event List window displays. 
11 Click on the Close button on the Event List. 

The Assigned Workload displays.  
12 Click on the Close button on the Assigned Workload. 

The CONNECTIONS toolbar displays 
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Module 19: 
Transferring Foster Homes 

A foster home transfer involves reassigning the foster home 
across districts or voluntary agencies. Movement of a foster 
home within the same district or voluntary agency is referred to 
as a reassignment. 

 

The FRS as a Review Tool 

The Foster and Adoptive Home 
Record Summary (FRS) 

provides a comprehensive view 
of all information recorded for a 

FAD home. As you prepare 
FAD homes for transfers, use 
the FRS to quickly view each 

tab to scan for missing or 
inaccurate information. 

In this module, we will explore some of the policies and 
procedures regarding home transfers and provide instruction on 
how CONNECTIONS supports this process. 

By the end of the module, you will be able to: 

• identify the difference between a transfer and a 
reassignment; 

• identify the responsibilities of both the sending and 
receiving agencies; and 

• transfer a home/stage to another agency in 
CONNECTIONS. 

Responsibilities of Sending and Receiving Agencies 
The decision to transfer a foster home requires frequent and clear communication between the 
two agencies involved: the Sending Agency and the Receiving Agency. The duties and 
expectations of both agencies are listed in the following sections. 

Responsibilities of the Sending Agency 
Several activities must be completed before a foster home is transferred in CONNECTIONS. 
(See Appendix C: OCFS Informational Letter regarding Foster Boarding Home Records and 
Policy on Transferring Foster Boarding Homes.) 

• An agreement must be made between the two agencies completing the transfer—the 
sending agency is responsible for ascertaining acceptance of the foster boarding 
home by the receiving agency. 

• The sending agency must identify the staff person at the receiving agency to whose 
Assigned Workload the foster home/stage is being transferred. 

• All home licensing, non-licensing, maintain person and reauthorization information 
must be updated as necessary by the sending agency. 

Under no circumstances may a foster boarding home be transferred if there is a CHRC results 
letter from OCFS indicating a disqualifying crime for a foster parent, or indicating a situation 
requiring “Hold in Abeyance” for a charge or conviction related to a foster parent. 

If no foster children are already placed in the home and the foster boarding home is transferred 
prior to final certification or approval, the sending agency must apprise the receiving agency as 
to the exact status of the home, specifying met and unmet requirements. 
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If there are foster children in the home, the above applies. In addition, the sending agency must 
establish which voluntary authorized agency or social services district will have planning 
responsibility for each child in the foster boarding home and each child’s family. 

The Reauthorization document must be completed by the sending agency on home transfers 
when the home is coming due for reauthorization, or if the home is in Emergency status and is 
ready for progression to Pending Acceptance status. 

Responsibilities of the Receiving Agency 
If the home is being transferred prior to final certification or approval and any part of the CHRC 
process has taken place—even if the only step taken has been to submit the fingerprint cards to 
OCFS—the receiving agency must complete and submit the form Notice to NYS OCFS of 
Foster Home Transfer Between Authorized Agencies [see Appendix C: OCFS Informational 
Letter (00 OCFS INF-6) re: Foster Boarding Home Records and Policy on Transferring Foster 
Boarding Homes]. The receiving agency then continues with the certification or approval 
process. 

A closed home must be reopened by the receiving agency, not transferred. 

Save and Submit updates the links between CONNECTIONS and the BICS payment system. 
The receiving agency’s worker must save and submit the Interim Home Study of the transferred 
home for supervisory approval in order for the home to be updated in CONNECTIONS as the 
receiving agency’s foster home. Only after the supervisor approves the home will payments to 
that home be reimbursable. 

Vendor ID Information 
The Vendor ID number of a FAD home may need to be changed when a FAD home is being 
transferred. Vendor ID changes may be required when the Maintainer of a FAD home is 
changed during the transfer. To know if a new Vendor ID number is needed, you must always 
know who the “Maintainer” is for the home. This information is located on the Resource Detail 
window. 

All Local Districts have the same Maintainer code: SDSS. Therefore, any district can contract 
with a home and the Maintainer code will not change. 

Voluntary Agencies maintain their own homes. The Maintainer code is the same as the Agency 
code. For example, the Voluntary Agency “Little Flower” is identified by the agency code B08. 
The maintainer code for this agency is also B08. 

The table on the next page illustrates when a Vendor ID number may change. 

Page 19-2 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



 

A New Vendor ID Is  
Needed When… 

A New Vendor ID Is 
NOT Needed When… 

The “Maintainer” changes. 
This may happen when: 

The “Maintainer” does not change.  
This may happen when: 

• a home is transferred from a 
Voluntary Agency to a Local District 

• a home is transferred between Local 
Districts, and the maintainer continues to 
be SDSS. 

• a home is transferred from a Local 
District to a Voluntary Agency 

 

• a home is transferred from one 
Voluntary Agency to another 
Voluntary Agency 

 

  

 

Transferring a Home from One Agency/District to Another 
Once you have completed the casework activities noted in the beginning of this module, you will 
be ready to complete the transfer in CONNECTIONS. Remember to review all of the information 
about the home in CONNECTIONS to verify that it is accurate and current. This involves several 
tasks, including (but not limited to): Maintain Non-Licensing Information, Maintain Licensing 
Information and Maintain Person. 

The directions below will assist you in completing the transfer process, once you have the 
record in order. 

 

Step by Step: 
Transferring Foster Homes 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Select the appropriate foster home/stage to be transferred and click on the Assign 
button. 
The Assign window displays. 

3 Click on the Options menu and select Staff Search Criteria… 
The Staff Search Criteria window displays. 

4 Highlight the Agency code in the Agency field. 

 
The Agency field is pre-filled 

with the agency code of 
the worker who is 

performing the search. 

5 Enter the agency code of the worker to whom the 
home is being transferred. 
Typing in field deletes the existing Agency code. 

6 Type the first and last name of the staff person to 
whom the home/stage is being transferred. 
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7 Click on the Search button. 
The Staff List displays with the results of the staff search. 

8 Click on the appropriate staff person. 
9 Click on the OK button. 

The Assign window displays. The staff person’s name and information have been 
added to the Available Staff list at the top of the window and is highlighted. 

10 Click on the Primary button. 
The following message displays: “This action will 
remove the current primary worker from the stage. 
Continue?”  

The receiving agency must save 
and submit the Interim Home 
Study of the transferred home 

for supervisory approval to 
update CONNECTIONS (see 

page 19-2).  

11 Click on the Yes button. 
The new Primary worker’s name displays in the 
Assignment section. 

12 Click on the Save button. 
The Assigned Workload displays. 
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Module 20: 
Certified and Approved Emergency Foster Homes 

This module introduces you to homes that have been temporarily certified or approved on an 
emergency basis to provide care and board to a specific child who needs immediate placement 
in a foster home. For example, a child removed from his or her biological family may be placed 
with an aunt to provide care as an emergency foster home. Foster homes created for this 
reason are referred to as Emergency Foster Homes. 

By the end of this module, you will be able to: 

• identify the difference between Emergency Foster Homes and fully Certified and 
Approved Foster Homes; 

• identify when Certification or Approval of Emergency Homes is appropriate; 
• progress a home from “Emergency” to “Pending Acceptance” status; and 
• identify differences in how and when Emergency Homes are temporarily certified and 

approved in New York City. 
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Regulatory Information 
Emergency certification or approval of a relative or non-relative foster home is allowable when a 
child is removed from his or her own home and placed into the legal custody of a local social 
services district.  As of May 11, 2005 regulatory revisions have expanded the circumstances in 
which an authorized agency may approve or certify a foster home on an emergency basis.  
Authorized agencies can now also certify or approve foster homes on an emergency basis if a 
child needs to be placed voluntarily by his/her family of origin or as a result of a person in need 
of supervision (PINS) or juvenile delinquency proceeding.  The regulations also allow for a local 
social services district to move a foster child to a foster home approved or certified on an 
emergency basis, in exceptional circumstances when there is a compelling reason  [see 
standards set forth in 18 NYCRR §443]. 

Regulatory Requirements Prior to Placement of the Child 

Before placing a foster child with a potential caretaker or eligible relative on an emergency 
basis, the authorizing agency must secure a signed and dated statement from the potential 
caretaker or eligible relative indicating the following [from 18 NYCRR §443.7(b)]: 

• the exact relationship to the child and the child’s parent(s); 
• that the potential caretaker or eligible relative is willing to provide foster care for the 

child; 
• an assurance that the potential caretaker or eligible relative understands that the 

child is in the legal custody of the commissioner of social services; and 
• that by accepting responsibility for providing foster care for the child, the foster 

parent is agreeing to comply with foster care requirements, including but not limited 
to those involving the role and authority of the certifying or approving authorized 
agency and the social services district with legal custody of the child to supervise 
placement. 
 

An “expedited” or 24-hour Home Study must be completed prior 
to placement of the child. This assessment of the home must 
conclude that there is no apparent risk to the health and safety 
of the child. Refer to 18 NYCRR §443.7(b)(3) for a full listing of 
what should be documented in the expedited Home Study. 

 
An agency-generated, off-line 
letter may be created for each 

home indicating that it is in 
“Emergency” status.  

Send one copy of the letter to 
the foster or adoptive parents 
and retain another copy in the 
External Foster Home Case 

Record. This letter is not 
generated in CONNECTIONS. 

The authorizing agency also must obtain necessary character 
references and review agency records to determine whether or 
not the potential foster parent has a prior history of abuse or 
maltreatment. Once all of these items have been completed, 
the foster home may be certified or approved as an emergency 
foster home and the child may be placed. 

Regulatory Requirements after Placement of the Child 

A home that has successfully met all State requirements may become certified or approved as 
an Emergency Foster Home for 90 days from the date of placement of the child in the home [18 
NYCRR §443.7]. The authorizing agency will use the 90-day period to prepare the home for 
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final certification or approval (see Module 8: Maintaining Licensing Information for FAD Homes 
and 18 NYCRR §443.7). 

If the worker fails to complete the full Home Study or fails to perform any other casework activity 
(excluding the exceptions noted below), the home should be closed after 90 days.  

Emergency Home Extensions 
According to state regulations, there is only one situation where homes in Emergency status may 
be eligible for an extension. The information from State regulations, below, provides some 
background for this section on extensions. 

 

Except as described below, homes may only be certified or approved in “Emergency” status for 
90 days following the placement of the child. 

Exception: An emergency foster home certified or approved on an expedited emergency 
basis for 90 days may continue to provide foster care beyond the 90th day, when all other 
requirements for final certification or approval have been met except for completion of the CHRC 
process. 

Certification or approval of the home in “Emergency” status may continue until the completion of 
the CHRC process or unless the certification or approval is otherwise revoked by the authorized 
agency [18 NYCRR §443.7(6)(2)]. 

Extensions Related to the CHRC 
In addition to the original 90-day period, FAD Homes in Emergency status may be “extended” 
for three 90-day periods of time, for a ‘year’ (360 days) total. This does not affect 
reimbursement, since homes in Emergency status are not Title IV-E reimbursable. 

Regulatory requirements and the status of the foster home determine the ability to record these 
extensions periods in CONNECTIONS. A home is only eligible for an extension if all required 
medical reports are valid and on file. Additionally, the Date Card Sent field on the Person Detail 
FA window must be recorded for all principals in the home age 18 and older and, the Date 
Results Received field must be empty for at least one of these individuals. 

Each time the Emergency period is extended, the Authorized To date increases by 90 days 
and the Authorized From date remains unchanged. The fingerprint extension period cannot be 
extended more than 30 days prior to the Authorized To date. 
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Creating Emergency Homes in CONNECTIONS 
Emergency Homes are created in CONNECTIONS using the same methods covered earlier in 
this guide. The table below should help you find information you need to create an Emergency 
Home, and to record information for the certification/approval process. 

Casework Activity Step-by-Step Module to Refer To… 

Responding to the Emergency Home Request  Module 6: Responding to an Inquiry 

Creating FAD homes in Emergency Status Module 6: Responding to an Inquiry 

Adding/Relating People to the Home Module 7: Maintaining Person Information 

Using the FRS to View and Edit Data Module 3: Managing Your Workload 

Making Changes to the Home Module 12: Maintaining FAD Homes in 
CONNECTIONS 

Copying and Pasting in Narratives Module 2: Getting Started 

FAD Checklist for Homes in Emergency Status Module 8: Maintaining Licensing Information for 
FAD Homes 

Progressing a Certified /Approved Emergency Home 
to Accepted-Active Status 
In the previous section of this module, we discussed New York State regulations regarding the 
progression of a home from “Emergency” status to final certification or approval—known as 
“Accepted-Active” status. An Emergency Home that becomes fully certified or approved 
progresses through two phases: 

Emergency — This is the first 90-day period that begins on the day the child was placed in 
the home. 

Finally Certified or Approved — This begins at the end of the 90-day period; a one-year 
licensing/approval period begins that can be renewed through the Annual Reauthorization 
process (see Module 14: Recertification and Reapproval of FAD Homes).  

Once a home progresses to “Accepted-Active” status, a new timeline is established. 

Using the FRS 
An Emergency FAD home is already in an active status, and probably has children placed in the 
home. Since the move to an annual licensing cycle affects the To/From dates on the F/A Home 
License window, you will progress the licensing information via the Annual Reauthorization 
task on the Task List. 

The steps for completing this status progression are very similar to those involved when 
completing an Annual Reauthorization. One difference is that the Home Study narrative will not 
exist, and must be recorded in CONNECTIONS.  
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Remember that you must click on the Reauthorization checkbox on the F/A Home License 
window, to extend the timeline for the home certification/approval. 

 

Step by Step: 
Progressing an Emergency Home to Pending Acceptance Status 

1 Click on the appropriate Emergency home/stage on the Assigned Workload. 
The Tasks… button enables. 

 
Once the certification or 

approval of the home has been 
reviewed and approved by your 
supervisor, you must generate 

an F/A Home Certificate or 
Approval Letter and provide a 

copy to the foster parents  
(see Module 10: F/A Home 
Certificates and Approval 

Letters). 

 
Remember to click on the 

Fingerprint Extension check 
box if you are extending the 

current license while waiting for 
the results of the CHRC. 

(All other regulatory 
requirements must be met and 

at least one Date Card 
Received field must be blank).  

2 Click on the Tasks… button. 
The Task List displays. 

3 Select the Home Study task. 
4 Click on the New button. 

If information has been recorded into the FRS, the 
Use Prior button enables; click the Use Prior 
button. The FRS displays. 

5 Click on the Home Study Narrative tab and enter 
Home Study information in this area of 
CONNECTIONS (see Module 8: Maintaining 
Licensing Information for FAD Homes) 

6 Take time to go through all tabs of the FRS to 
review information. 

7 Click on the Submit button. 
The F/A Home License window displays. 

8 Click on the drop-down arrow for the Status field 
and select Pending Acceptance from the resulting 
list. 

9 Click on the File menu and select Save and 
Submit. 
The To-Do Detail window displays. 

10 Add Comments, if appropriate. 
11 Click on the Save button. 

The Task List displays. 
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Emergency Homes in New York City 
The regulatory requirements for Certified and Approved Emergency Foster Homes apply to all 
districts and voluntary agencies statewide, including the Administration for Children’s Services 
(ACS) in New York City. ACS has established additional procedures for processing applications 
to provide emergency foster care. 

In New York City, the CPS caseworker forwards the home 
information to the Office of Placement Administration (OPA). 
The OPA worker searches the CONNECTIONS database to 
verify that the foster home/stage does not already exist then 
creates the Emergency home in CONNECTIONS. 

The OPA worker assigns a Vendor ID number, modifies any 
information about the home, completes the F/A Home License 
window and Saves and Submits the new foster home/stage to 
the supervisor or unit approver. 

Once the OPA supervisor approves the Emergency Foster 
Home, the home’s Status changes to “Emergency.” The home 
is approved for a 90-day period. 

 
When a foster home in Emergency status is being reauthorized, the Licensing 
Information tab in the FRS will display the Anticipated Authorization Period 
Upon Approval with both an Authorized From date and an Authorized To date. 

This information displays only when the worker performs the reauthorization, 
calculating the next anticipated authorization period based on the current 

Authorized To date. CONNECTIONS cannot anticipate exactly when the worker 
will complete and obtain approval for a reauthorization, so the exact authorization 

period will display only after the supervisor has approved the reauthorization. 

For example, if a foster home in Emergency status has an authorization period of 
1/1/03 – 4/1/03 and the caseworker begins performs the reauthorization process 
on 3/15/03, the Anticipated Authorization Period Upon Approval will display as 
4/1/03 – 4/1/04. If the supervisor approves the reauthorization on 3/16/03, the 
actual authorization period upon approval will be 3/16/03 – 3/16/04, reflecting 

one year from the date on which the reauthorization was approved. 

The Anticipated Authorization Period Upon Approval does not display when the 
supervisor views the FRS from the Approval Task To-Do. 

 
ACS has created its own 24-
Hour Home Study template. 
ACS completes the 24-hour 

Home Study to open the home 
and then assigns the home to 

either DFCS or a voluntary 
agency. 

ACS CPS workers also use an 
Emergency Home Checklist.  

Next, the OPA supervisor determines whether the Division of Foster Care Services (DFCS) or a 
contract agency will supervise the home, and assigns a caseworker from the appropriate 
agency to be the Primary worker for the foster home/stage. The OPA worker assigns 
him/herself as the Secondary worker in the foster home/stage. 

Page 20-6 CONNECTIONS Step-by-Step Guide: 
(rev 04/12/2006) The Complete Guide to Support Foster and Adoptive Home Development 



Module 21: 
Adoptive Homes 

Approval of Adoptive homes in CONNECTIONS is a separate process from the certification or 
approval of foster homes. Authorized agencies operating an adoption program have an adoption 
or home finding unit that accepts public inquiries. Once an inquiry is made, the authorizing 
agency must respond to the inquiry and develop the home as a potential adoptive placement in 
accordance with New York State adoption regulations. 

The figure below highlights the major milestones completed when a child transitions from foster 
care placement to a final adoptive placement. It also clearly indicates when foster care payment 
changes to adoption subsidy. These are issues that will be expanded upon throughout this 
module. 

Figure 1: 
Major Milestones in the Process of Adopting a Child in Foster Care 

Foster Care Payments begin

Day 1 of Foster Care Placement
Reunification ProcessBegins
Concurrent Permanency Planning Begins

TPR or Surrender
Child is Freed for Adoption

Adoption Placement Agreement is Signed
Adoptive Subsidy Home may be created in CONNECTIONS

 Pre-Adoptive Placement Begins
(Child may move to a new home)
 Foster Care Payments continue

Foster Care Payments Cease
Adoption Subsidy Begins

Adoption is finalized

 
The standards for studying an individual for approval as an adoptive parent are nearly the same 
as those for the approval of a foster parent. There is one exception: In a situation where one 
spouse wants to adopt, that prospective parent must be legally separated from his/her spouse 
in order to pursue approval as an adoptive parent. 

This module presents ways that Adoptive homes differ from Foster homes. By the end of this 
module, you will be able to: 

• discuss differences in how adoptive homes are funded (vs. Foster care settings); and 
• identify how these differences are recorded/documented in CONNECTIONS. 

Responding to an Adoptive Inquiry  

First Contact: Responsibilities of the Authorizing Agency 
Once an authorizing agency receives an inquiry from a prospective adoptive parent, they are 
required to respond to the inquiry within five business days and offer the person an individual or 
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group orientation session. This session should take place within 30 days of receiving the 
inquiry. 

The orientation session should be planned for hours that are convenient to the prospective 
adoptive parent and should include the following information 
[18 NYCRR §421.11(a)-(g)]: 

• a discussion of the characteristics of children available for adoption in New York 
State (show New York State’s Waiting Children and explain its use); and 

• a discussion of the regulations regarding marriage status: married persons can adopt 
only as a couple with each partner participating, and that a married person who is 
living separate and apart from his or her spouse must have a legally recognizable 
separation agreement or decree of separation to adopt a child. 

By the end of the orientation, the authorizing agency will provide the inquiring individual with a 
copy of the adoption application and will inform him/her of the following: 

• the procedures for application and adoption study, and the availability of adoption 
subsidies; 

• of an indicated child abuse and maltreatment report; 
• that applicants are required to sign a sworn statement indicating, to the best of their 

knowledge, whether they have ever been convicted of a crime in New York State or 
any other jurisdiction; 

• that pursuant to §372(e) of the Social Services Law, an applicant may apply for a fair 
hearing if an application is not acted upon by the completion of an adoption study 
within six months or if an application is rejected; and 

• that the agency will inquire with the Division of Criminal Justice Services as to  
whether the applicant has been convicted of one or more felony crimes. 

Within five days of an orientation session, the authorizing agency will contact persons who were 
invited to the orientation session but who did not attend. These persons will be offered the 
chance to attend another orientation or an individual interview [18 NYCRR §421.11(h)]. 

Documentation of the Adoption Inquiry 

Documentation of casework activities is a vital part of the adoption process. It is important that 
you clearly organize and record the information you will collect regarding each adoption inquiry. 
We shall refer to this external record as the External Adoptive Home Case Record. 

For each inquiry, develop a record that contains: 
• a dated record of the inquiry, whether received by mail, telephone or in person; 
• a dated copy of the invitation to an orientation session; 
• a dated copy of the written acknowledgment of the inquiry; and 
• a dated record of all further communication, whether by letter, telephone or in person 

[18 NYCRR §421.11(i)]. 

This record must be kept on file, even if no application is completed, for 12 months after the last 
communication with the inquiring individual [18 NYCRR §421.11(j)]. 
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CONNECTIONS and Adoptive Inquiries 

The certification or approval of a home for pre-adoptive placement is documented in 
CONNECTIONS using the setting of Foster Home (see Module 8: Maintaining Licensing 
Information for FAD Homes). Funding for a pre-adoptive placement is actually Foster Care 
money; adoption subsidies do not begin until the finalization of an adoption. 

Record the inquiry as early as possible. Refer to Module 6: Responding to an Inquiry for 
information on how to record such information to CONNECTIONS. 

The Adoption Application 
By the end the orientation session, you must provide the prospective adoptive parent with an 
adoption application that has been approved by OCFS. This application provides a variety of 
factual information about the prospective adoptive parent(s), including: 

• name, address and identifying information; 
• age, race and religion of members of the household; 
• whether an applicant is certified or approved as a foster parent; and  
• characteristics of children sought to be adopted [18 NYCRR §421.12(a)]. 

If the prospective adoptive parents choose, they may be registered to adopt a handicapped or 
hard-to-place child with the adoptive parent registry [18 NYCRR §421.12(c)]. 

Documentation Regarding Application Information 

In addition to the documentation noted on page 21-2, the following information should be 
recorded in the External Adoptive Home Case Record: 

• the application, medical report and references; 
• summary of interviews with the applicant and visits to the applicant’s home; summary 

of agency conference clarifying the basis for each decision that affects the 
applicant’s status with the agency; and 

• copies of all correspondence with the applicant [18 NYCRR §421.12(b)]. 

CONNECTIONS and Recording of the Application Information 

Only local district workers create FAD Adoptive homes. Best practice is to create the Adoptive 
home after an Adoption Placement Agreement has been signed. The prospective adoptive 
parent inquiry will be recorded in CONNECTIONS twice to reflect the different types of payment 
each home/stage receives:  

• Initially, a home is created with a setting of Foster Care. 

• Closer to the time of an adoption finalization, a home is created with a setting of 
Adoptive Home. 

At that point, a caseworker closes the foster care case in CONNECTIONS. A new case (for the 
child) is then opened in WMS to maintain information regarding the finalized adoption subsidy. If 
the adoptive parents have an interest in adopting more children the foster care home should 

CONNECTIONS Step-by-Step Guide: Page 21-3 
The Complete Guide to Support Foster and Adoptive Home Development (rev 04/12/2006) 



remain open. The adoptive parents would have two homes created in CONNECTIONS. The 
Finalization is documented in the CCR stage in CONNECTIONS which includes the WMS 
adoption subsidy info and the closed CCR stage. The Adoptive home in CONNECTIONS 
becomes the system of record for the home receiving subsidy payments. 

Information obtained from the Application process should be recorded in CONNECTIONS, 
where recording of such information is supported. Refer to Module 7: Maintaining Person 
Information, for instruction on how CONNECTIONS supports this type of documentation. 

Decision: Determining Whether or not to Accept the Home 
for Adoption Study 
Progression of the inquiry to applicant status requires the completion of an Adoption 
Application. Applications for an adoption program are accepted on a Priority Basis, which is 
described below [18 NYCRR §421.13(a)]: 

Priority of Acceptance for Adoption Applications 

First Priority On or about April 1st of each year, OCFS will determine the age, race, 
handicap and other significant characteristics of the largest proportion 
of waiting children. First priority will be given to: 

• applicants seeking children with these characteristics; 
• foster parents seeking to adopt a child who has resided in their 

home for 12 continuous months; and 
• Native Americans seeking to adopt Native American children. 

Second Priority Second priority is given to: 

• applicants who are seeking to adopt photo-listed children who do 
not have the characteristics of the largest proportion of waiting 
children as determined by OCFS; and 

• applicants who are seeking children currently available in the care 
of the authorizing agency for whom there is not a waiting list of 
approved families. 

Third priority is given to: Third Priority 

• all other applicants (i.e., those who have expressed an interest in 
adopting children such as healthy young children who are not 
photo-listed, if such children are not available for adoption in the 
care of the authorizing agency where application was made). 
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Within 10 days of receiving a completed Adoption Application, 
the authorizing agency must send written acknowledgment and 
inform the applicant of how their application shall be responded 
to [18 NYCRR §421.13(b)].  

Written acknowledgment of 
How an authorizing agency responds to each application is 
based upon the Priority Level assigned to the application. The 
table below matches each priority level with the appropriate 
response. 

receipt of a completed 
application is not supported by 

CONNECTIONS. 
However, you can create a 

Reminder To-Do to alert you 
 when you need to create and 

send the letter of 
 acknowledgment for each 

Prospective Adoptive Home.  

Priority of Acceptance and Responses for Adoption Applications 

First priority applications are accepted for immediate adoption 
study. The letter sent to these applicants will identify: 

First Priority 

• a first appointment to be not more than 30 days from receipt 
of completed application; and 

• the name and telephone number of an agency staff person 
who can be contacted during the interval period [18 NYCRR 
§421.13(b)(1)]. 

Second priority applications are provided with a letter 
identifying: 

Second Priority 

• an estimate of when an adoption study may start; and 
• the name and telephone number of an agency staff person 

who can be contacted during the interval period [18 NYCRR 
§421.13(b)(2)]. 

Third priority applications shall receive a letter indicating: Third Priority 

• whether there is any likelihood of an adoption study being 
granted [18 NYCRR §421.13(b)(3)], or 

• that they have been rejected on the basis of “no need”—
unless the agency is able to begin the adoption study 
promptly so that it is completed within six months of 
receiving the completed application [18 NYCRR §421.13(c)]. 
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An authorizing agency may refer a prospective adoptive parent 
to another agency prior to the start of an adoption study. This is 
appropriate if the applicant has expressed an interest in a child 
photo-listed with that agency and the applicant has expressed a 
desire to be referred to that agency. 

 
Any rejection must be 

accompanied by: 
If the applicant does not wish to be referred to another agency, 
do not delay the adoption beyond normal delays related to 
priority level [18 NYCRR §421.13(d)]. 

a statement of fair hearing rights 
[§22 and §372(e) of Social 

Services Law]; 

and Waiting Lists 
a statement that the applicant 

A waiting list refers to a listing of applicants who are waiting for 
adoption study. These applicants have been identified as first, 
second and third priority. Therefore, an authorizing agency 
must maintain separate waiting lists for each category 
[18 NYCRR §421.14(a)]. 

has the option of remaining on a 
waiting list with a description of 
the procedures for exercising 

this option 
[18 NYCRR §421.13(c)(1)-(2)]. 

Each waiting list must contain the name of each applicant, the 
date the completed application was received by the agency and the characteristics of the child 
sought for adoption. See the table below for descriptions of how an authorizing agency should 
address each waiting list [18 NYCRR §421.14(b)]. 

Waiting List Time Frames 

Adoption study should start within 30 days and should be 
completed within six months of receipt of the completed application. 
These applicants have first priority in the initiation of adoption 
studies, the assignment of staff, the scheduling of individual and 
group appointments, and of conferences to review studies and 
make decisions. 

First Priority 

Adoption study should be completed within six months of receipt of 
the completed application. 

Second Priority 

The Authorizing Agency shall contact these applicants at least one 
time per year to review characteristics of waiting children and to 
ascertain their interest. 

Third Priority 

A separate waiting list should be maintained for each priority group of families whose studies 
have been completed and approved [18 NYCRR §421.14(d)]. Families are allowed to change 
their interest and adjust their priority group at any time. Use the date of this change as the date 
of new application [18 NYCRR §421.14(f)]. 
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Adoption Study Process 
As the caseworker responsible for development of the adoptive home, you must conduct an 
assessment of the applicant(s) and their home environment to determine their ability to provide 
a safe and healthy environment for an adopted child. This assessment is referred to as the 
adoption study. 

An adoption study involves working with applicants individually or in groups to obtain 
information. It includes at least one visit to the applicant’s home [18 NYCRR §421.15(a)]. A 
group orientation format may be used to provide applicants with the opportunity to interact with 
parents who have already adopted a child. This type of interaction is required by State law [18 
NYCRR §421.15(b)]. 

During the first appointment or meeting of the adoption study, you must inform the applicant of 
all items that are require by the conclusion of the adoption study: 

• A report from a physician regarding the health of each member of the household. 
• References from at least three persons, only one of which may be related to the 

applicants who can attest to the character, habits, reputation and personal 
qualifications of the applicants and their suitability for caring for a child. 

• If married, the applicants must provide proof of marriage. 
• If married and living separate and apart from his/her spouse, the applicant must 

provide proof that the separation is based upon a legally recognizable separation 
agreement or decree of separation or an affidavit executed by the prospective 
adoptive parent attesting that he or she has been or will be living separate and apart 
from his or her spouse for a period of three years or more prior to the 
commencement of the adoption proceeding. 

• If previously married, the applicant must provide proof of dissolution of marriage by 
death or divorce. 

• Evidence of employment and salary must be provided for each employed applicant. 
• A response to an agency inquiry to the State Central Register of Child Abuse and 

Maltreatment stating whether the applicant is the subject of an indicated child abuse 
or maltreatment report. 

• A response from OCFS to the CHRC, for each applicant and any person age 18 and 
older residing in the prospective adoptive home. 

• A sworn statement from each applicant indicating to the best of such applicant’s 
knowledge, such applicant or any person over the age of 18 currently residing in the 
home has ever been convicted of a crime in New York State or any other jurisdiction 
[18 NYCRR §421.15(c)]. 

Adoption Study Criteria 
The adoption study will explore specific characteristics of each applicant to assess what type of 
care the person might provide to an adopted child. Applicants for adoptive study must be at 
least 18 years old. Authorizing agencies are not allowed to set any other age parameters for 
applicants. The health of each applicant must be reported on (see previous page), and must 
show that the applicant is expected to live until the child’s majority and to have the energy and 
other abilities needed to fulfill the parental responsibilities. Physical examinations must be 
conducted within one year of the date of the adoption application. 
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Here are some personal characteristics of each applicant that will be addressed closely in the 
adoption study: 

• Capacity to give and receive affection; 
• Ability to provide for a child’s physical and emotional 

needs; 
 • Ability to accept the intrinsic worth of a child; 

Accepting the intrinsic worth 
• Flexibility and ability to change; of a child includes: 

Sharing and respecting his/her • Ability to cope with problems, stress and frustration; 
past. 

• Feelings about parenting an adopted child and 
ability to make a commitment to a child placed in the 
home; and 

Understanding the meaning of 
the separation he/she has 

experienced. 
• Ability to use community resources to strengthen 

and enrich family functioning [18 NYCRR 
§421.16(a)-(c)]. 

Having realistic expectations 
and goals. 
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Decision: Determining Whether to Approve or Reject an  
Adoption Study 
You will be required to make a recommendation to your supervisor regarding the adoption study 
for each applicant. Conclusions about the ability of an applicant to be an adoptive parent will be 
based on a variety of factors: 

• How well the adoption criteria have been met (see page 21-7) 
• The characteristics and needs of children available for adoption 
• The principles and requirements for adopting a child who is a member of a sibling 

group [see 18 NYCRR §421.2(e) and §421.18(b)] 
• The principles related to the development of the children 
• Reasons a person seeks to become an adoptive parent 
• The understanding of the adoptive parent role 
• The person’s concerns and questions about adoption 
• The person’s psychological readiness to assume responsibility for a child 
• The attitudes that each person in the applicant’s home has about adoption and that 

individual’s concept of an adopted child’s role in the family 
• The awareness of the impact that adoptive responsibilities have upon family life, 

relationships and current life style 
• A person’s self-assessment of his/her capacity to provide a child with a stable and 

meaningful relationship 
• The role of the agency in supervising and supporting the adoptive placement [18 

NYCRR §421.15(d)] 

Accepting an Adoption Study 

If, after reviewing the information noted above, you decide to accept an Adoption Study, you will 
first need to prepare a narrative summarizing the study findings and activities 
[18 NYCRR §421.15(e)(1)]. This narrative should detail how the Adoption Criteria was met and 
how each factor noted above was addressed. Overall, the summary should include all material 
available to provide a full description of the family for adoptive purposes. 

Once you have completed the adoption summary, the following activities should be completed: 

• Arrange for the applicant(s) to review the written summary (excluding sections where 
sources have requested confidentiality); 

• Encourage the applicant(s) to express their views regarding the summary; 
• Give the applicant(s) the opportunity to enter their reaction as an addendum to the 

written summary; 
• Arrange for the applicant(s) and the caseworker to sign the summary after it has 

been reviewed and any addendum has been attached; and  
• Provide a dated written notice of approval to applicant [18 NYCRR §421.15(e)(2)-

(6)]. 
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Rejecting an Adoption Study 

An application for adoption study may be rejected for many 
reasons. During the study itself, an applicant’s lack of 
cooperation may prohibit you from gathering enough 
information to make a determination. If you are able to collect 
enough information to complete an assessment, you may find 
that the applicant is physically or emotionally incapable of 
caring for an adopted child. Or you may determine that approval 
of a certain application would not be in the best interest of the 
children awaiting adoption [18 NYCRR §421.15(g)(1)-(2)]. 

 

If an applicant for adoption 
study is discontinued by mutual 

consent, you must: 

Update the applicant’s record to 
reflect the discussion leading to At least two staff members must be involved in any decision to 

reject an adoption study, and one of these individuals must be 
at a supervisory level. Record the names of the participants in 
the decision and the reason for the decision in the External 
Adoptive Home Case Record. 

the mutual agreement;  

and 

Send a letter to applicant stating 
that the adoption study has 

been discontinued by mutual Prospective adoptive parents must be informed in writing that  
their adoption study has not been accepted. This letter should 
contain the reasons for the rejection and include an offer to 
discuss the decision in person with the worker’s supervisor. If 
the rejection is based in whole or in part on the results of the 
SCR Database Check or the CHRC, the FAD 
Denial/Revocation letter is sent. 

consent. 

 
The notification letter informing 
applicants of a rejection of their 
adoption study for reasons other 

You must also inform the applicant of his/her right to a hearing 
before the department regarding the rejection of the 
application, and state the procedures to be used for this 
purpose  
[18 NYCRR §421.15(g)(3)-(8)]. 

than Criminal History Record 
Check is not currently supported 

in CONNECTIONS. 

See Module 15: Closing Foster Homes, for information on how to generate and print the FAD 
Denial/Revocation letter. 

Conclusion of the Adoption Study 

The adoption study process should be concluded within four 
months of initiation with a decision to discontinue, reject or 
approve the adoption study. This four-month standard should 
only be exceeded where illness or geographic absence of the 
applicant make the applicant unavailable, or where the study 
was interrupted by the unavailability of agency staff. See 18 
NYCRR §421.15(h) for specific procedures regarding these 
exceptions. 

 
The registering agency should 

update the Adoptive Parent 
Registry, either noting the 

approval of the applicant or 
removing the applicant if the 

adoption study has been 
discontinued or rejected   
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The Adoptive Home after Approval 
of the Adoption Study 

 
It is important to remember that the adoptive home we have 
been discussing so far goes through a few more stages of 
development. Concluding the adoption study process is a first 
step in preparing for the ultimate goal of finalizing an adoption. 

In a pre-adoptive placement, 
Foster Homes are created in 

CONNECTIONS as foster 
homes to receive foster care 

payments because the child is The next step involves distributing the newly approved adoption 
study to local districts and voluntary agencies searching for 
adoptive placements or pursuing a pre-adoptive placement of a 
child who is known to the prospective adoptive parent. 

still in the legal custody of the 
county. 

Once an adoption has been 
finalized, an Adoptive Home is 

Once a potential match is made, visitation begins between the 
child and prospective adoptive parent(s). A successful 
graduated visitation plan results in a pre-adoptive placement. If 
the pre-adoptive placement is successful, the legalization of the 
adoption of the child completes the adoption process. 

created in CONNECTIONS and 
receives adoption subsidy 

payments. 

Adoption Casework and CONNECTIONS 

Foster care payments and adoption subsidy payments are different types of payments. In order 
for the BICS payment system to make adoption subsidy payments, the Adoptive home must 
have a Vendor ID (VID) number that is different from the VID used to make foster care 
payments. 

In order to accommodate a second VID, a second FAD home must be created in 
CONNECTIONS with a Setting of “Adoptive” and an LOC of “Adoptive Home” in the F/A Home 
License window. This second home will contain the Adoption Study and will be populated by 
using the Relate function to relate residents in the Foster home to the Adoptive home (see 
Module 7: Maintaining Person Information). 

The Adoptive home in CONNECTIONS does not become active and receive payments until the 
adoption is finalized. Adoptive homes with finalized adoptive placements do not need to remain 
in Accepted-Active status in order for adoption subsidy payments to continue. However, the 
adoptive home must be kept updated at all times. Changes of address, family composition and 
other maintenance activities can be recorded by reopening a closed Adoptive home to Inquiry or 
Applicant status, correcting the information and then closing the home again. 

It is recommended that for adoptive parents with an interest in adopting more children, you 
maintain a second home and in CONNECTIONS with the setting type of Foster Home that 
indicates a Facility Type of “Foster/Adoptive Home” and a status of “Accepted-Active.” This 
foster or adoptive home must be recertified/reapproved annually to remain in Accepted-Active 
status. The Home Study needs to be updated to reflect any changes. 
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Cross Reference Guide  

Below is a cross reference guide for recording Adoptive casework activities in CONNECTIONS. 
This table identifies the casework activity and matches it to the activity required in 
CONNECTIONS. The last column provides a reference to the module in this guide where you 
can find the step-by-step directions for completing the activity. 

Casework Activity CONNECTIONS Activity Refer to… 

Determine if the prospective adoptive 
parent has a history of providing foster 
care services, or has had an adoptive 
home in the past. 

F/A Home Search Module 6 
 

Record inquiry information about the 
home. 

Home Demographics window Module 6 
 

Obtain and record general information 
(e.g., address, phone number, maiden 
name) about prospective adoptive parent. 

Module 7 Maintain Person task 

Provide fingerprint cards and document 
information regarding the CHRC. 

Module 7. Maintain Person task 
(Person Detail FA window) 

Document training/ orientations that the 
prospective foster parent attends. 

Module 7 Maintain Person task 
(F/A Home Member Training 

List/Detail window) 
Document the Adoption Study Narrative. Module 8 Home Study task 
Document certification or approval 
information, track the progression of the 
home toward Accepted-Active status, and 
submit certification or approval 
information for supervisory review and 
approval. 

Module 8 Maintain Licensing 
Information task 

Produce a Certificate or Approval Letter 
prior to the pre-adoptive placement (home 
will exist in CONNECTIONS as a foster 
home). 

Module 8 Maintain Licensing 
Information task 

Re-open an Adoption subsidy home to 
update information. 

Module 16 Re-open Closed Home 
command Module 7 

Maintain Person task (update 
person information)/ Maintain 
Non-Licensing Information 

task 

 
Module 6 

Maintain changes to home and person 
information. 

Module 6 
 

Maintain Non-Licensing 
Information task 

Module 7 Maintain Person task 
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Appendix A: 
FAD CONNECTIONS 

Glossary 
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24-Hour Home Study Prior to the placement of a child in an Emergency Home, the 
authorizing agency must complete a preliminary assessment of the 
home. This assessment is referred to as the 24-Hour Home Study, 
because it is completed quickly to facilitate immediate placement. 

In the process of preparing an Emergency Home for certification or 
approval, a full Home Study must be completed in CONNECTIONS. 
This longer home study reflects the additional assessments and 
background checks required for full certification/approval. 
 

Accepted-Active This status is used in CONNECTIONS to indicate that a home 
currently meets all state regulations for full certification/approval, 
including (but not limited to) the results to the CHRC and a 
completed/valid Medical Report.  

CONNECTIONS will automatically identify a FAD home as 
"Accepted-Active" once a supervisor has approved the initial 
certification/approval of a home/stage. 
 

Accepted-Inactive This status is used in CONNECTIONS to identify a FAD home that is 
fully certified or approved but is not currently accepting placements. 
 

Adoption Subsidy Children meeting certain eligibility requirements may be able to 
receive federal and/or state adoption assistance (for information on 
eligibility for Adoption Subsidy see 18 NYCRR, Section 426).  

This financial assistance is referred to as an Adoption Subsidy. 
Adoption Subsidies are distributed once an adoption is completely 
and legally finalized.  

In CONNECTIONS, a Setting of “Adoption” is used to identify homes 
receiving Adoption Subsidy payments. Pre-adoptive placements 
(with a Setting of “Foster Care”) receive Foster Care Payments until 
adoption finalization. 
 

Adoptive Home -  
Facility Type 

The Facility Type of "Adoptive Home" is used in CONNECTIONS 
once an adoption is finalized. It is the only option available for a 
home that is receiving Adoption Subsidy payments. 
 

Adoptive Home -  
Setting 

In CONNECTIONS, the setting of Adoptive Home is used for FAD 
homes where an adoption has been finalized. This setting option 
indicates a home that is receiving Adoption Subsidy payments. 
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Agency Name In the FAD environment, the Agency Name/Resource ID field 
displays the name of the local district or voluntary agency 
responsible for authorizing the certification or approval of the foster 
or adoptive home. Following that name is the unique system-
generated identification number for that agency. 
 

AKA Names People are frequently known by more than one name. An applicant 
or individual residing in a FAD home may have a legal name, a 
nickname, and/or a maiden name. Through the AKA Name function, 
CONNECTIONS allows you to record "also known as" (AKA) names 
for each individual residing in a FAD home. Once recorded in 
CONNECTIONS, these names are available to be searched upon. 
 

Annual 
Reauthorization 

On an annual basis, FAD homes must undergo a thorough 
assessment (documented in CONNECTIONS via the Annual 
Reauthorization task) before the certification or approval can be 
renewed.  

This process is referred to as the Annual Reauthorization, and is 
also called a Recertification or Reapproval of the home. 
Caseworkers can begin documenting their assessments using the 
Annual Reauthorization task in CONNECTIONS 90 days prior to the 
expiration of the certificate or approval. 
 

Applicant A FAD home's status can be progressed to "Applicant" in 
CONNECTIONS once a prospective foster or adoptive parent has 
submitted a completed application for Home Study. 
 

Application for Home 
Study 

Individuals interested in becoming certified or approved as foster 
parents must be provided with an Application to begin the process 
home certification or approval. This is also referred to as an 
Application for Home Study because the application is one of the 
first items to be reviewed by an authorizing agency. The application 
must be accepted in order for the applicant to continue forward to 
the Home Study process.  
 

Approval Letter An Approval Letter (or Letter of Approval) permits a relative within 
the second or third degree of the parents or stepparents to be 
reimbursed for providing foster care services to a child in the legal 
custody of the district.  

This letter is given to the foster parent(s) only after the foster home 
has met all approval requirements.  
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Approved Relative 
Foster Home  

This term is a Facility Type option for a FAD home with the setting 
of "Foster Home." This option indicates that the foster parents are 
within the second or third degree of the parents or stepparents of the 
child they are caring for. 
 

APRV - Event Status This status type is found on the Event List, and indicates that a task 
has been approved by a supervisor. 
 

Assigned Role in a 
Case 

For FAD stages in CONNECTIONS, a worker can be assigned the 
role of Primary worker, Secondary worker. 
 

Assigned Workload The Assigned Workload displays the worker's entire active caseload 
in one place. A worker's Assigned Workload identifies the worker's 
role in each stage. Some examples of information displayed on the 
Assigned Workload include the name of each stage of service, the 
type of stage and when each stage was assigned to the worker. 
 

Auth From Date In CONNECTIONS, the Auth From Date identifies the Date of 
Approval for a FAD home that is in Accepted-Active status.  

The Auth From Date is system-generated based on the date a 
supervisor approves submission of the FRS and the F/A Home 
License window for certification/recertification or 
approval/reapproval.  

The Auth From Date can be found in the heading of the FRS, on 
the F/A Home License window, and on the F/A Home Certificate or 
Approval Letter generated from the F/A Home License window. 
 

Auth To Date In CONNECTIONS, the Auth To Date identifies the date of 
expiration for a FAD home in Accepted-Active status. 

The Auth To Date is system-generated based on the date a 
supervisor approves submission of the FRS for 
certification/recertification or approval/reapproval.  

The Auth To Date can be found in the heading of the FRS window, 
on the F/A Home License window, and on the F/A Home Certificate 
or Approval Letter. 
 

BICS 
(Benefits Issuance 
Control System) 

The Benefits Issuance Control System (BICS), used for the payment 
and claiming of services cases in New York State, interfaces with 
CONNECTIONS (with the exception of Erie County and NYC ACS 
Contract Agencies).  
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Capacity The capacity of a FAD home is based upon the allocation of physical 
space in the home, and on the foster parents' interest and ability to 
care for a certain number of children. See 18 NYCRR or your 
supervisor for specific information (e.g., number of children per 
bedroom). 
 

Case A case is a documented collection of one or more situations and 
their required casework activities for addressing the protective 
and/or preventive service needs of children and their respective 
families.  

A case may contain both open and closed stages at the same time. 
Also, several stages may be open at the same time. Once all stages 
are closed, the case is closed.  

In FAD, the case is comprised of the FAD stage only. A new case is 
created in CONNECTIONS, when the home is “Saved and 
Assigned.” 
 

Case ID Number Every case has a specific number generated by CONNECTIONS. 
For FAD Homes, this system-generated number is assigned when 
the home is created and then “Saved and Assigned.” 
 

Case List The Case List enables you to view a listing of all cases which either 
meet the search criteria entered in the Case Search window or are 
associated with a person searched for using the Person Search 
function.  

The Case List displays high level case information such as Case 
Name, Case ID, etc. 
 

Category 1 Crimes This phrase refers to a method for organizing the type of crimes 
considered when a Criminal History Record Check (CHRC) is 
conducted (see 18 NYCRR 443.8).  

There are two segments to Category 1 Crimes:  

(A)  A felony conviction at any time involving child abuse or neglect; 
spousal abuse; a crime against a child (including child 
pornography), or a crime involving violence (including rape, 
physical assault or battery)  

(B)  A felony conviction within the past 5 years for physical assault, 
battery or a drug-related offense. 
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Category 2 Crimes This phrase refers to a method for organizing the type of crimes 
considered when a Criminal History Record Check (CHRC) is 
conducted. Category 2 Crimes involve a charge or conviction of any 
other crime not listed in Category 1. 
 

CCRS (Child Care 
Review Service) 

The Child Care Review Service (CCRS) is the Legacy computer 
system in New York State that tracks the activities of children 
receiving foster care, prevention, and protective services paid for by 
local districts. 
 

Certified Foster Home A Facility Type option for a FAD home with the setting of "Foster 
Home." Select this option when the potential foster parents have 
stated they do not intend to adopt foster children. 
 

Certified 
Foster/Adoptive Home 

A Facility Type option for a FAD home with the setting of "Foster 
Home." Select this option when the potential foster parents have 
stated they plan to, or will consider, adopting foster children. 
 

Closed This status identifies a FAD home that has been approved for 
voluntary or involuntary closure. Children cannot remain in a home in 
Closed status.  
 

Community District  
(CD) 

New York City addresses are organized into geographical 
subdivisions called Community Planning Districts (CDs). The CD 
displays as a two-digit code. 

The CD is listed on several windows in CONNECTIONS (e.g., F/A 
Home List) and indicates the Community Planning District in which 
the FAD home (or the household involved in a CPS stage) is 
located. 
 

COMP - Event Status This status type on the Event List indicates that a worker or a 
supervisor has completed a task in CONNECTIONS. If it is a task a 
worker must complete which requires approval, it indicates that that 
task has not yet been submitted for approval. 
 

Congregate Care - 
Setting 

The setting of Congregate Care in CONNECTIONS is used to 
indicate specific FAD facilities that are not based within a family 
residence. Congregate Care facilities are created in CONNECTIONS 
by employees of OCFS. Congregate Care facilities are operated by 
voluntary agencies. 

Congregate Care facilities are identified further by the following 
Facility Types: Group Home, Group Residence, Agency Boarding 
Home, and Institution. 
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Contract Local districts contract with voluntary agencies to arrange for specific 
services (e.g., foster care, preventive, adoption related services). 
This process must be reflected in CONNECTIONS.  

Local district staff create contract headers in CONNECTIONS to 
specify the services being provided by the voluntary agency. 
Contracts for each agency are system-generated when the FAD 
home is created in the CONNECTIONS system. These contracts 
allow CONNECTIONS to interface with BICS vendor files and CCRS 
when updates are made to facilities in CONNECTIONS.  
 

Criminal History - 
Discretionary 
Disqualifier 

This phrase refers to a potential result of the Criminal History Record 
Check (CHRC). It indicates that the CHRC results list charges or 
convictions other than those specifically listed in 18 NYCRR 
§443.8(e)(1) and 00 OCFS ADM-4.  

In this situation, a household resident (other than the potential foster 
or adoptive parents) has been charged or convicted of a Category 1 
Crime or Category 2 Crime;  
-or-  
a prospective or certified/approved foster parent or adoptive parent 
has been charged or convicted of a Category 2 Crime.  

The district or voluntary agency may exercise some amount of 
judgment in determining whether or not to deny an application or 
revoke an existing certification/approval consistent with the 
standards set forth in Art. 23A of the Corrections Law (see 00 OCFS 
Adm-4). 
 

Criminal History - 
Presumptive 
Disqualifier 

This indicates that an applicant, foster parent, approved or adoptive 
parent has a conviction of one or more "Category 1 Crimes" [see 18 
NYCRR §443.8(e)(1) and 00 OCFS ADM-4 for more detail]. 
 

Criminal History 
Record Check (CHRC) 

Authorizing agencies are required to obtain a set of prospective or 
existing foster parent’s and adoptive parent’s fingerprints, and those 
of each person over the age of 18 (including foster children) 
currently residing in the prospective or existing foster home  

These fingerprint cards are sent to OCFS, and then to the Division of 
Criminal Justice Services (DCJS). DCJS conducts research on each 
person to determine if he/she has ever been convicted of a crime.  

Results of a CHRC include Presumptive Disqualifier, Discretionary 
Disqualifier, No Record Returned, and Hold in Abeyance (see 18 
NYCRR 443.8 for more information). 
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Directories Organized tables of information within CONNECTIONS that can be 
searched upon. All staff can view (without a special security profile) 
the Office, Resource and Staff directories. To access and/or 
maintain the Unit Directory requires the appropriate security profile. 
 

Emergency Status This status is used in CONNECTIONS to identify a FAD home 
created for the purpose of providing board and care on an 
emergency, time-limited basis. FAD Homes created in Emergency 
status provide for the placement of a child in a specific home that is 
not already certified (e.g., with a relative).   

A child may be placed in a home in Emergency Status prior to full 
certification/approval of the home. A 24-hour Home Study, and a 
signed statement of caretaker relationship to the child are two of the 
requirements that must be met for a home to be placed in 
Emergency Status (18 NYCRR 443.7). 
 

Event An event is a stage-related action performed or recorded in 
CONNECTIONS. For example, a change in address, reauthorization 
or a new primary assignment is an event. CONNECTIONS 
generates events automatically once an individual has completed 
the home/stage-related action in the system. 
 

Event List The Event List provides important information about past and 
present stage/case milestones, such as assignments, stage 
changes, approvals and changes in Case status (not to be confused 
with Event status). The Event List documents what has occurred in a 
stage/case. Staff may use the Event List to monitor progress in 
developing a resource home or to determine the next steps for 
completing the home authorization process. In the Event List, there 
are five possible Event statuses: NEW, PROC, PEND, APRV, and 
COMP. 
 

Extended Accepted- 
Active  

This is when a FAD home whose active status (Accepted-Active) 
has been extended beyond the one year expiration date due to 
missing Criminal History Record Check results.  

This type of extension is allowed when a home in Accepted-Active 
status is due for Annual Reauthorization. The fingerprint results from 
one or more (CHRC) have not been received, but the home has 
otherwise met all regulatory requirements.  

Accepted-Active homes can be recertified/reapproved based on this 
process for four (4) 90-day periods while awaiting fingerprint results. 
Since the home was already in Accepted-Active status, Title IV-E 
reimbursement is not affected. 
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Extended Emergency  This is when a FAD home whose active status (Emergency status) 
has been extended beyond the initial 90-Day expiration date due to 
missing Criminal History Record Check results.  

This type of extension is allowed when a home in Emergency status 
is within 30 days of being advanced to Accepted-Active status (thus 
beginning an annual cycle). In this situation, fingerprint results from 
the CHRC have not been received but the home has otherwise met 
all regulatory requirements.  

Homes in Emergency status may be extended for three (3) 90-Day 
periods (or one year/360 days total). 
 

F/A Home Certificate This Certification to Board or F/A Home Certificate permits an 
individual (or individuals) to receive reimbursement for providing 
foster care services to children in the legal custody of the district.  

This certificate is given to the foster parent(s) only after the foster 
home has met all approval requirements. 
 

Facility Type  A Facility Type is dependent upon the Setting of a home, and serves 
to further identify the FAD facility.  

Example: Choices for the Foster Home Setting include Certified 
Foster Home, Foster/Adoptive Home and Approved Relative Foster 
Home. 
 

FAD checklist Found in the FRS (see below), this is a listing of all tasks required for 
home certification/approval and recertification/reapproval. It also 
includes a listing of casework activities necessary to create a home 
in Emergency status and activities necessary for recertification. 
 

Foster and Adoptive 
Home Record 
Summary (FRS) 

The Foster and Adoptive Home Record Summary (FRS) provides a 
comprehensive view of the FAD information you record in 
CONNECTIONS. This is accomplished through the use of a single, 
multi-tabbed window that allows you to access, view, and print FAD 
home information easily. This multi-tabbed window is organized to 
be consistent with the existing foster/adoptive home development 
process. You may record comments and contact notes at 
appropriate points throughout this process. 

The FRS is frozen upon approval by a supervisor. Historical 
information can be viewed by accessing the frozen FRS via the 
Event List. 
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Foster Boarding Home A Foster Boarding Home is defined as “a residence owned, leased 
or otherwise under the control of a single person or family who has 
been certified or approved by an authorized agency to care for not 
more than six children” [18 NYCRR §443.1(j)].  

Foster homes created on an Emergency basis is discussed in 
Module 20: Emergency Certified or Approved Foster Homes. Refer 
to Module 21: Certification and Approval of Adoptive Homes for 
information about the certification and approval of Adoptive Homes. 
 

Foster Home - Setting The Setting of “Foster Home” is used in CONNECTIONS to identify a 
FAD home currently providing foster care and/or pre-adoptive 
services. These homes receive Foster Care payment. 

The Facility Types listed below are found on the F/A Home License 
window and are used to further identify the type of FAD home. 
• Certified Foster Home 
• Approved Relative Foster Home, and 
• Certified Foster/Adoptive Home. 

 

Help on Narratives  The Help on Narratives button (found on the FRS) allows you to 
access help information for the Home Study and Annual 
Reauthorization documents. When the Help on Narratives button is 
selected while in the Home Study Narrative or Annual 
Reauthorization tabs, Help information about that document will 
immediately display. Clicking on the button while on any other tab 
will open an index of help topics relating to these narratives. 
 

History of One or More 
Crimes 

This phrase refers to a potential result of the Criminal History Record 
Check (CHRC). It indicates that a prospective foster or adoptive 
parent has been convicted of one or more felony or misdemeanor 
crimes. This result is further identified as either Criminal History - 
Presumptive Disqualifier or Criminal History - Discretionary 
Disqualifier. 
 

Hold in Abeyance A result of a Criminal History Record Check (CRHC) that indicates 
an individual has been charged with a crime; however, the charge 
has not been fully resolved. 
 

Home 
Certification/Approval 
Extensions 

New York State Foster Care regulations allow homes already in an 
active status (either Emergency or Accepted-Active status) to have 
their status extended beyond their expiration date. Extensions are 
allowed when all certification/approval and recertification/reapproval 
requirements have been met, but the results of one or more Criminal 
History Record Checks (CHRC) have not been received. In 
CONNECTIONS, this means that all Date Card Sent fields have 
been completed on the Person Detail FA window, but one or more of 
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the Date Results Received fields remains blank. The Fingerprint 
Extension check box on the F/A Home License window must be 
selected for the extension to be recognized by CONNECTIONS. 
 

Home Study  
(Initial and Interim) 

An Initial Home Study narrative documents the first assessment of a 
home as part of the preparation for certification or approval of a 
potential foster or adoptive placement. See 18 NYCRR Part 443 for 
specific instructions on items included in a Home Study narrative.  

An Interim Home Study is a reassessment of the home and an 
updating of the home information due to changes that occur during 
the annual certificate/approval period (such as foster parent 
marriage or divorce).  

The foster parent’s ability to continue providing foster care services 
is assessed, with consideration given to the impact that the status 
change has on the foster home. 
 

Identification Numbers Caseworkers use a variety of numbers to assist in the identification 
of person and home information that is stored in CONNECTIONS 
and in the External Foster Home Case Record. Examples of 
Identification Numbers include: Vendor ID Number and Resource ID 
Number. 
 

Inquiry This term refers to the status given a FAD home by CONNECTIONS 
when it is first opened or reopened for the purpose of recording an 
inquiry by the applicant(s). 
 

Legal Name Located in the Home Demographics window, this field indicates the 
official name of the facility. A Legal Name must be recorded to 
identify Foster and Adoptive homes and Congregate Care facilities. 
If this field is left blank, it defaults to the Home Name (which is 
named after the foster mother). 

It is recommended that this field be used to record both foster parent 
names in the following format: Smith,Joan/Smith,John 
 

NEW - Event Status On the Event List, this status is used to identify that a new task has 
been created and work on the task has not yet been saved to 
CONNECTIONS. 
 

No Criminal Record 
Found 

This phrase refers to a potential result of the Criminal History Record 
Check (CHRC). It means that the CHRC revealed no criminal 
convictions, no open cases, and no history of arrests. 
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No Record Found This is one result of the State Central Record (SCR) Database 
Check required of all foster or adoptive applicants and individuals 
over the age of 18 residing in their homes. This result indicates that 
the person was not found to be a subject of an indicated report of 
abuse or maltreatment to the State Central Register of Child Abuse 
and Maltreatment. 
 

No Reportable 
Criminal Record Found 

State Law makes reportable only convictions (or open arrests) for 
felonies and misdemeanors. This result of a Criminal History Record 
Check (CHRC) indicates that a history does exit for something other 
than a conviction or an open charge for a felony and/or 
misdemeanor. This could be, for example, a conviction for a violation 
or a dismissal of a charge. 
 

Office Directory A listing of office addresses and phone numbers, office staff 
members, type, region, county, agency, site and office name. 
 

On Hold This status is used in CONNECTIONS to identify a home that has 
been fully certified or approved, and may have existing placements, 
but where intake to the home has been closed to additional 
placements. 
 

PEND - Event Status This status, found on the Event List, is used to indicate that a 
completed task has been submitted to a supervisor and is pending 
(awaiting) approval. 
 

Pending Acceptance This status is used in CONNECTIONS to identify when a FAD home 
record has been submitted for supervisory approval. A FAD worker 
selects this status when using the Save & Submit command, via the 
F/A Home License window. Acceptance of the record is dependent 
upon the supervisor's actions. 

The home remains in Pending Acceptance status until a supervisor 
completes the task of approving or rejecting the submitted work. 
 

Pending Closure This status is used in CONNECTIONS to identify when the Close 
Home task has been submitted for supervisory approval. 

CONNECTIONS automatically identifies a FAD home with the status 
of "Pending Closure," when the Close Home window is submitted. 
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Pending Emergency This status is used in CONNECTIONS to identify a home is being 
submitted to a supervisor to approval for “Emergency” status. 
Acceptance of the FAD Home and child placement is dependent 
upon the supervisor's actions. Once the FAD record is accepted, the 
status of the home is system-progressed to "Emergency."  

This status also occurs when a home is already in "Emergency" but 
undergoes updates that require submission of the FRS for 
supervisory approval.  

This occurs when a Local District completes a 24 Hour Home Study, 
and progresses the home to Emergency Status, but sends the FAD 
home/stage to another agency to complete FAD Maintenance. The 
new agency will use “Pending Emergency” when changes are 
submitted for the record during the 90 day Emergency Life Cycle. 
 

Pending Matters/Hold 
in Abeyance 

This phrase refers to a potential result of the Criminal History Record 
Check (CHRC). It indicates that a final determination about the 
prospective (or current) foster or adoptive parent must be "held in 
abeyance" if (1)criminal charge for a Category 1 Crime has not been 
finally resolved or (2) the CHRC reveals a criminal conviction that 
may be a Category 1 Crime, but requires further review by OCFS. 
 

Person ID Number CONNECTIONS creates a unique Person ID Number for each 
person that is recorded in the system. Merge, Split, and Relate 
functions must be used with caution to preserve accurate Person ID 
numbers. 
 

Person Identifiers Items that help to further identify a person, such as: Social Security 
Number, CIN Numbers, and Driver’s License Number. This 
information can be recorded via the Maintain Person task. 
 

Primary Worker The Primary Worker is the person who has chief responsibility for a 
stage (FAD home) at any point in time, and therefore has full 
maintain privileges for the stage. A stage will always have one 
primary worker while it is open. 
 

PROC - Event Status This status, found on the Event List, is used to indicate when a task 
is in the process of being completed by the worker (and has not 
been submitted for approval or marked as completed). 
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Program Type  Program Types serve to further identify a foster home by specifying 
exactly what type of care the home is licensed to provide.  

For example, a home with a Program Type of “Therapeutic” is 
certified to provide a more intense level of foster care supervision.  

Program Types are defined by OCFS and authorizing agencies; they 
are not based solely on the characteristic of children currently living 
in the home. 
 

REJT - Status This status, found on the Approval Status window, is used to identify 
work that has been reviewed by a supervisor and has been rejected. 
At the same time, the Event List will display a status of COMP for the 
same event – indicating that the supervisor completed the task of 
reviewing the work. 

When work is rejected, the FAD worker must make appropriate 
changes in a timely manner, and re-submit the FAD record to the 
supervisor. 
 

Relationship/Interest 
(Rel/Int) to the Home 

Each person residing in a FAD home is identified in several ways, 
including how they are associated with the foster or adoptive parent.  

In order for their names to appear on the F/A Home Certificate and 
Approval Letter, Foster parents must be identified in 
CONNECTIONS using the Relationship/Interest code of “Foster 
Parent.”  

Caretakers who are related to foster children must be identified as 
“Foster Parent,” and not by their familial relationship (e.g. aunt, 
uncle, grandparent).  

Other adults in the home should be identified by their relationship to 
the foster parent (i.e., mother, sister, etc.). 
 

Resource This is another term used to identify a foster or adoptive home, or 
congregate care facilities in CONNECTIONS as well as other service 
providers. 
 

Resource Directory A listing of all professionals and organizations who provide services 
to clients. Resources include community and contracted providers, 
law enforcement agencies, schools, help lines, facilities and 
foster/adoptive homes. 
 

Resource ID Number Each FAD facility has a unique Resource ID in CONNECTIONS. For 
FAD homes, this ID number is generated when the home is Saved 
and Assigned. 
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Resource Lien Resource Lien is an action taken when a home has been overpaid 
unintentionally. Additional payments to the home for new expense 
are suspended until the overpaid amount has been rectified. In 
CONNECTIONS, this action can be indicated clicking in the 
Resource Lien check box on the Home Demographics window. 
 

Safety Assessment A Safety Assessment is an evaluation of the conditions (specifically 
the safety) of a foster home. Safety Assessments occur when an 
agency learns of positive results to a Criminal History Record Check 
(CHRC). 

CONNECTIONS provides a Safety Assessment template in the FRS 
where caseworkers can document their findings. 
 

SCR Database Check New York State foster care regulations require authorizing agencies 
to determine whether or not foster/adoptive parent applicants, and 
individuals residing in their homes that are  age 18 and over, have 
been the subject of an indicated report of child abuse or 
maltreatment on file with the Statewide Central Register of Child 
Abuse and Maltreatment.  
 

Search and Retain This phrase refers to a potential result of the Criminal History Record 
Check (CHRC). From an excerpt of 00 OCFS ADM-4: "It should be 
noted that after the [initial Criminal History Record Check or CHRC] 
search is made, DCJS will retain the fingerprints for a prescribed 
period, and will notify OCFS upon any future arrest for a finger 
printable offense." 
 

Search A Search in CONNECTIONS is an action in the system performed to 
find a specific type of information. Examples include: Person Search, 
Case Search, Resource Search. 
 

Secondary Worker A Secondary Worker is assigned to a FAD home/stage to complete 
specific tasks in CONNECTIONS. One or more Secondary Workers 
may be assigned to a case.  

The Secondary Worker is able to assign and unassign the 
secondary role. A Secondary Worker is not allowed to open or close 
a stage. 
 

Security Attributes Security Attributes identify what level of access a CONNECTIONS 
user has in the system. A set of Security Attributes reflects casework 
duties. These Security Attributes are grouped together to create a 
Business Function. Access to information in CONNECTIONS is 
governed by Business Function.  
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Setting The term “Setting” is used in CONNECTIONS to identify/describe 
FAD facilities. Setting choices include Foster Home, Congregate 
Care, and Adoption. 
 

Source of Inquiry This field found on the Home Demographics window, is used to 
document how a potential foster/adoptive applicant heard about, or 
became interested in, making an inquiry into becoming a 
foster/adoptive parent.  
 

Staff Directory In CONNECTIONS, a “Staff Directory” is a listing of all 
CONNECTIONS users. This directory includes names, office phone 
numbers, addresses, and skills. 
 

Stage /Stage of Service A Stage of Service is a logical grouping of related casework 
activities. In each stage there are various tasks that may be 
performed. Some tasks may be repeated and performed at key 
intervals throughout the stage (e.g., reauthorizations). Certain tasks 
must be completed in order to close a stage.  

The stages currently in CONNECTIONS include: Intake (INT), 
Investigation (INV), Foster and Adoptive Home Development (FAD), 
Family Services Intake (FSI) and Family Services Stages (FSS). 
 

Stage ID Number Every stage of service has a specific system generated ID number 
associated with it.  
 

Sub-Agency 
(NYC Only) 

Specific office sites in New York City (agency code A66) are 
classified further into sub-agencies; workers can search and sort 
FAD homes in CONNECTIONS by sub-agency. 

When a foster or adoptive home is created in CONNECTIONS by a 
New York City ACS worker (agency code A66) or transferred to a 
primary worker who is from agency A66, CONNECTIONS 
automatically populates the New York City “800” level sub-agency 
information in the F/A Home List. A foster or adoptive home in New 
York City can be associated with one of these sub-agencies. This 
field is always protected. 

Homes where the primary worker does not work for ACS do not 
display sub-agency information. 
 

Submit Button The Submit button (found on the FRS window) initiates the “Save 
and Submit” process. When this button is selected, the F/A Home 
License window displays, allowing you to Save and Submit the FRS 
and the Home License information together. The Submit button 
disables if you have not made a change and saved information on 
the FRS window.  
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Templates Uniform Microsoft Word forms that contain protected sections of text 
that cannot be altered. Information can only be recorded in the 
unprotected sections. An example is the Safety Assessment in the 
FRS.  
 

Unit Directory A listing of all supervisor units and the workers who are in/out and 
assigned to each unit (including the agency, site, zone and unit 
number). 
 

Vendor ID Number This 8-digit number (also know as the "Facility ID") is necessary for 
payment in CONNECTIONS. Obtained locally from the worker's 
supervisor, these numbers are assigned to each home when it is 
entered into CONNECTIONS. Vendor ID Numbers are unique to 
each home. Preserve Vendor ID numbers and a home's historical 
record by properly closing, reopening and transferring homes as 
needed. 
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Appendix B: 
CONNECTIONS – LEGACY Interface 
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Interfaced Automated Systems 
• CONNECTIONS records all State Central Register (SCR) reports, Child Protective Services 

(CPS) intakes and investigations, foster and adoptive home development activities, contracts and 
resources. 

• CCRS (Child Care Review Service) tracks all child movements, legal events and service plans in 
the child welfare system. 

• BICS (Benefits Issuance Control System) is the system for the payment and claiming for Non-
Services cases in upstate New York. It also generates all services payments in upstate New York 
with the exception of Erie County, and generates foster care and adoption payments in New York 
City (but not for voluntary agencies in NYC). 

• WMS (Welfare Management System) records case and child demographics, eligibility data, 
purchase of service, and it authorizes services for children and families. 

What is the Synchronization/Interface process? 

• In August 1997, the CONNECTIONS Resource Directory and FAD dialogue were created from 
CCRS and BICS data. Facilities and providers that were known to BICS remain in BICS for 
inquiry, authorization and payment. The facilities that were in CCRS remain in CCRS for inquiry 
and placement. 

• CCRS is still used for inquiry and placement, while BICS is still used for payment and claiming. 
• Each night, a batch is run that updates WMS, CCRS and BICS with data recorded. 
• All new facilities and vendors are now recorded in CONNECTIONS. 
• For example: the interface between CONNECTIONS, CCRS and BICS updates name (and other) 

information for facilities in CCRS and the name (and other) information for all CONNECTIONS 
Resources in BICS. Historical data from CONNECTIONS updates the status of FAD homes in 
CCRS. 
 
 

New Entries 
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in FAD 
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New Entries 
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Directory 
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Appendix C: 
OCFS Informational Letter regarding 

Foster Boarding Home Records and Policy on 
Transferring Foster Boarding Homes 
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Transmittal 00 OCFS INF-6  
 
September 21, 2000 
 
The purpose of this release is to set forth the existing requirements pertaining to 
retention of material in the foster boarding home record and the policy on transferring 
foster boarding homes between authorized agencies. 

Prior to implementation of the Foster Adoptive Development (FAD) component of 
CONNECTIONS, all materials related to the certification or approval, recertification or 
reapproval of foster boarding homes were retained in paper (hard copy) format by the 
authorized agency. For the purposes of this release, that record will be referred to as the 
“provider record.” While certain items relating to the foster boarding home certification, 
recertification, approval, and reapproval process may be maintained solely on the 
CONNECTIONS system, it is still necessary to maintain a paper provider record. 

The following is a listing of all necessary documentary components of the provider and 
CONNECTIONS record, and the requirements for maintaining such information. It is not 
a complete listing of all requirements for certifying, approving, recertifying or reapproving 
foster boarding homes. Complete requirements, both documentary and non-
documentary, are set forth in 18 NYCRR Parts 443 and 444.  

CONNECTIONS Step-by-Step Guide: Page C-3 
The Complete Guide to Support Foster and Adoptive Home Development  (rev 04/12/2006) 



I. Signed Application which contains at a minimum: 
A. list of all family members and their dates of birth; 
B. the marital status, religious faith, employment history, income information, 

health status/physical functioning (including any limitations) of the 
applicants; 

C. physical description of the home and the proposed living 
accommodations of a foster child or children; 

D. the history of prior applications and their status, including any reasons for 
prior rejection. 

II. Additional Submittals (at the time of Application): 
A. the names of the required number of personal references; 
B. sworn statement by applicants regarding themselves and those in the 

household over the age of 18, regarding criminal convictions;  
Note: If there is a disclosure of criminal convictions, and a decision to 
certify or approve, a statement of the reasons why the home is 
determined appropriate and acceptable is required. 

III. Verifications: 
A. employment history, work record and qualifications; 
B. personal reference letters attesting to applicant’s character and personal 

qualifications 
IV. Medical: 

A. physician-completed report form on each applicant (exam must have 
been completed not more than one year prior to the date of application); 

B. physician-completed report form on each existing foster parent at least 
once every two years; 

C. physician attestation to general health of family with each medical report 
form 

V. Signed and Dated Relationships Statement (Relative Homes Only) 
VI. Foster Parent Agreement 
VII. Expedited Home Study (Emergency Relative Homes Only)† 
VIII. Home Study † 

A. Summary of Interviews 
B. Home Assessment 

IX. SCR Database Check - Date of Submission and Results 
Note: If the applicant is the subject of an indicated report of abuse or 
maltreatment, and there is a decision to certify or approve, a statement of 
the reasons why the home is determined appropriate and acceptable is 
required. 

X. Criminal History Record Check (CHRC) - Date of Submission and Results 
Note: If there is a criminal record found, a safety assessment is 
required; if a decision is made to deny or revoke a certification or 
approval based on the CHRC, a copy of the Denial/Revocation Letter is 
required. 

XI. Summary of Agency Conference and Decision Regarding Applicant(s)† 
XII. Certificate to Board or Letter of Approval for Relative Homes ‡ 
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Note: Although the certificate is printed through the CONNECTIONS 
system, the system itself currently does not retain a copy. It is important 
at the time of certification or approval and at each subsequent 
recertification or reapproval to copy this document or the approval letter 
prior to mailing and retain it in the provider record. 

XIII. Placement Roster (names and removal dates for all children placed in the home) 
XIV. Summary or History of Training Received† 
XV. Summary of Annual (Re)Evaluation† 
XVI. Correspondence 
XVII. Complaints 
________________________ 
†
 CONNECTIONS is considered the system of record for these items.  

‡
 CONNECTIONS will become the system of record for this item when access to the certificate to board and 
the letter of approval become available in the system. 

 

CONNECTIONS requirements for authorization include: completion of 
home demographics; person-related information, including information 

on the submission of fingerprint cards and receipt of the criminal history 
background check results; resource detail; licensing information. 

CONNECTIONS requirements for reauthorization include completion of 
the F/A Home License window. 

 
Regarding the retention period for the provider record, a voluntary authorized agency 
must consult the terms of its purchase of services agreement with the social services 
district. Generally, such records must be retained for at least seven years to satisfy 
potential claiming and reimbursement issues. For all authorized agencies, it is 
recommended that all documents be retained for the entire period that the foster home is 
certified or approved. Authorized agencies may also want to consult with their counsel 
concerning extending the period of record retention for other reasons such as pending or 
potential litigation. 
 

Policy on Transferring Foster Boarding Homes 
Social Services Law §376(3) provides that no person can be certified by more than one 
authorized agency. However, it is legally permissible to transfer a foster boarding home 
between authorized agencies. (Note: the term “authorized agency” refers to both a 
voluntary authorized agency and a social services district). This may be necessary when 
a voluntary authorized agency closes of its own volition or is required to involuntarily 
cease operation. It may also occur for administrative reasons, such as the newly 
instituted plan by the New York City Administration for Children’s Services (ACS) to 
implement transfers between the voluntary authorized agencies with which ACS 
contracts, in order to support neighborhood-based placements. Social services districts 
may also need to transfer homes, if, for example, foster parents move out of the area. 
It is essential for voluntary authorized agencies considering transferring foster boarding 
homes to coordinate with the social services district(s) with which they have a contract. 
The requirements for the sending and receiving authorized agencies with regard to the 
provider record and related requirements, especially with regard to the Criminal History 
Record Check (CHRC), are outlined below. 
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Sending Agency 

If there are no foster children in the home: 
• Ascertain acceptance of the foster boarding home by the receiving 

agency. This may include coordination with the social services district with 
which the sending agency has a contract, if transfer is between two 
voluntary authorized agencies. Ascertain the effective date of the transfer 
and the name of the staff person at the receiving agency to whose 
workload the foster boarding home is being transferred.  

• Review and, if necessary, update the record, so that all documentation 
listed above is included in the External Foster Home Case Record and/or 
CONNECTIONS. All conditionally required documentation, as noted under 
II (b). IX, and X, above, must be included. 

Social services districts may transfer foster boarding homes prior to final certification or 
approval, including relative and non-relative foster boarding homes certified or approved 
on an emergency basis. Voluntary authorized agencies may also make these transfers 
to other voluntary authorized agencies unless the social services district(s) with which 
they have a contract prohibit such transfer. However, under no circumstances may a 
foster boarding home be transferred if there is a CHRC results letter from the Office of 
Children and Family Services (OCFS) that indicates a presumptive disqualifying crime 
for a foster parent, or indicates a situation requiring “Hold in Abeyance” for a charge or 
conviction related to a foster parent. (See 99 OCFS INF-7.)  
If a foster boarding home is transferred prior to final certification or approval, the sending 
agency must apprise the receiving agency as to the exact status of the home, specifying 
all met and unmet requirements.  

• Request and obtain written consent from the foster parents to transfer the 
home;  

• Provide written confirmation of the transfer to the foster parent, including 
the effective date;  

• Physically transfer the entire paper provider record to the receiving 
agency; and 

• Follow the established steps in CONNECTIONS for foster boarding homes 
in Inquiry or Applicant status to transfer (reassign) the foster boarding 
home to the receiving agency and verify acceptance by the receiving 
agency.  

If one or more foster children are in the home: 
• All items listed above; and 
• Establish which voluntary authorized agency or social services district will 

have planning responsibility for each child in the foster boarding home and 
each child’s family; if planning responsibility changes, in concert with the 
case manager at the social services district, and attendant contract 
provisions between the social services district and the voluntary authorized 
agency, follow your established procedures involving the child and family 
uniform case record.  
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Receiving Agency 

If the home is being transferred prior to final certification or approval: 
• Review the paper provider record and all FAD-related information in 

CONNECTIONS and note the exact status of the home, and those 
requirements that have been met and unmet;  

• Communicate with the sending agency if there are any discrepancies as to 
the status of the home and resolve any such discrepancies;  

• Determine whether the foster boarding home is acceptable to your agency 
to go forward with the continuation of the certification or the approval 
process. If the foster boarding home is acceptable, proceed with the 
remainder of the steps below; 

• If any part of the CHRC process has taken place, even if the only step 
taken has been to submit the fingerprint cards to OCFS, complete and 
submit the form “Notice to NYS OCFS of Foster Home Transfer Between 
Authorized Agencies” to OCFS (see Attachment 1); 

• Follow the established steps in CONNECTIONS for foster boarding homes 
in inquiry or applicant status to accept the transfer of the foster boarding 
home.  

• Continue with the certification or approval process; and 
• If there are foster children in the home, the social services district must 

adjust the WMS POS line and maintain CCRS to reflect any changes to 
Case/Child Planner. 

If the home is being transferred as a fully certified or approved 
foster home: 

• Review the paper provider record and determine that it is complete; 
• Review all FAD-related information in CONNECTIONS and determine that 

the home is appropriately certified or approved and the period is current; 
• If anything is missing, contact the sending agency. If the missing 

documentation cannot be provided, some degree of judgment must be 
used. If the information contained in the missing item or items is dated and 
would not be essential for the receiving agency to supervise the foster 
boarding home, the transfer may still take place. For example, if there is a 
current medical report, but there is a missing one that would have been 
due prior to the current one, the home may still be transferred. Under no 
circumstances may the transfer take place without the following items: 
application, sworn criminal conviction statement, current medical report, 
SCR Clearance results, CHRC results, Home Study and current 
Reevaluation. The conditionally required documentation with regard to the 
criminal conviction statement, the SCR Clearance and the CHRC, as 
noted under II. (b), IX, and X, above, must also be present. If these 
requirements cannot be met, reject the transfer.  

• Determine whether the foster boarding home is acceptable for certification 
or approval by your agency. There may be circumstances (other than 
missing documentation) where your agency finds the foster boarding home 
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unacceptable. For example, assessments based on disclosure of criminal 
convictions, or based 

• on indicated reports of abuse or maltreatment, or safety assessments 
conducted on persons with specified criminal charges or convictions may 
cause your agency to reach a different decision than that reached by the 
sending agency. Attempt to resolve this with the sending agency or reject 
the transfer. If the foster boarding home is acceptable, proceed with the 
remainder of the steps below.  

• Follow the established steps in CONNECTIONS, including Saving and 
Submitting for approval. 

• Print a new Certificate to Board for the foster boarding home, or issue a 
new Approval Letter (for an approved relative home); retain a paper copy. 

• If there are foster children in the home, the local social services district 
must adjust the WMS POS line and maintain CCRS to reflect any changes 
to Case/Child Planner.  

• Complete and submit the form “Notice to NYS OCFS of Foster Home 
Transfer Between Authorized Agencies” to OCFS. 

This form can be found as Attachment 1 and is available electronically in Public 
Folders/All Public Folders/dfa.state.ny.us/OCFS/ASFA-Policy Practice (Recovered). 
Receipt of this form by OCFS will allow OCFS to transfer agency responsibility for 
purposes of CHRC and any search and retain responses subsequently received. Forms 
must be submitted to:  
Criminal History Review Unit 
NYS Office of Children and Family Services 
PO Box 839 
Rensselaer New York 12144-9953 
Attention: Linda Fylak (Transfers) 
 
Email the form to: Linda.Fylak@dfa.state.ny.us 
Upon receipt of the form, OCFS will change the agency associated with each household 
member over the age of 18. Should any arrests of such household members occur after 
the transfer, the receiving agency will get the information from OCFS. 
s/s____________________________________________________ 
William F. Baccaglini 
Director 
Strategic Planning and Policy Development 
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Attachment 1 
Notice to NYS OCFS of Foster Home 

Transfer Between Authorized Agencies 
(To Be Completed By Receiving Agency) 

 
NAME OF FOSTER HOME ______________________________________________________ 
RESOURCE ID# /VENDOR ID# (VID)______________________________________________ 
FACILITY ID#_________________________________________________________________ 
 

RECEIVING AGENCY ID# SENDING AGENCY ID# 
RECEIVING AGENCY NAME AND 
ADDRESS 

SENDING AGENCY NAME AND ADDRESS 

PROVIDE NAMES AND NYSID# FOR ALL MEMBERS OF THE HOUSEHOLD AGE 18 
AND OVER (ATTACH ADDITIONAL SHEETS IF NECESSARY). THE NYSID# IS 
FOUND ON THE SUMMARY OF RESULTS OF THE CRIMINAL HISTORY RECORD 
CHECK LETTER. IT IS ASSIGNED BY DCJS TO EACH INDIVIDUAL FOR WHOM 
FINGERPRINTS ARE PROCESSED. THE SUMMARY OF RESULTS IS SENT BY 
OCFS TO AN AGENCY AND IS THE ONLY PLACE YOU WILL FIND THIS NUMBER.  

NAME NYSID# 
  
  
  
  
  

This is to certify that (name of agency) ________________________________ has 
received and reviewed the paper and CONNECTIONS record of the above referenced 
foster home and found such record to have all necessary and required documentation in 
accordance with 00 OCFS INF- 6.  
Effective (date of transfer) ____/____/____, (name of agency) 
_______________________ assumes responsibility for the foster home. We understand 
that for any names listed on this form, any criminal history identified on or after the date 
of transfer will be sent to our agency. 
______________________________________________________________________________ 
(signature of authorized agency representative) 
______________________________________________________________________________ 
(title and phone number) 
MAILING INSTRUCTIONS 
Mail form to: 
CRIMINAL HISTORY REVIEW UNIT 
NYS Office of Children and Family Services 
PO BOX 839 
Rensselaer NY 12144-9953 
Attention: Linda Fylak (transfers) 
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Appendix D: 
Vendor Identification Numbers 
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Each district and voluntary agency that certifies foster homes receives a block of numbers 
from OCFS to use for VID assignments. Number blocks are sent by e-mail to 
CONNECTIONS Implementation Coordinators and other identified contact people. When 
recording a new foster home in CONNECTIONS, you will need to obtain a VID from the 
assigned block for your district or voluntary agency.  

Speak to your supervisor or program director to find out who distributes the VID 
assignments at your office. Each district and agency is responsible for setting up internal 
procedures and protocols for tracking the use of the numbers. It is suggested that the 
numbers be entered onto a spreadsheet or logbook that records the number, date assigned, 
Resource ID (RID), case name, and worker name.  

Additional blocks of Vendor ID numbers may be obtained by contacting the following people: 

Duplicate Vendor ID Numbers and 
Foster Home Vendor ID Numbers: 

Maureen Connolly 
473-5745 

Maureen.Connolly@ocfs.state.ny.us 

Congregate Care Facility  
Vendor ID Numbers: 

Paula Ainspan 
486-3743 

Paula.Ainspan@ocfs.state.ny.us 

 
This procedure does not impact the locally administered process of VID assignments to 
ACS kinship foster homes or other direct care homes. Use existing procedures in those 
instances 

Note: This information is an excerpt from an instructional document mailed electronically to Training 
Strategies Group by OCFS. Modifications were made on September 15, 2005 to update the names of 
OCFS staff. 
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Appendix E: 
Certificates and Approval Letters 
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Approval Letter 
Onondaga County DSS

Approval to Board Children

RESOURCE ID EFFECTIVE DATE EXPIRATION DATE
20000742 1/16/2001 1/16/2002

ISSUED TO RELIGION
Barbara Holmes Catholic

ADDRESS
162 HOPE AVE

SYRACUSE    NY
ONONDAGA 13205

This is to certify that the above named is regarded as maintaining a suitable home at the above address only for the care of children at board and is

hereby  authorized to care at board 2 boys between the ages of 3 Years 0 Months and 3 Years 0 Months and/or 2 girls between the ages of 1 years 0

  Months and 8 Years 0 Months with a maximum capacity of 2 children.

This foster home has been granted exception(s) to the following boarding home rules:

CERT AGENCY
RESOURCE ID WORKER ID AGENCY NAME AND ADDRESS
20000440 15051 Onondaga County DSS

421 MONTGOMERY ST
FL 8
SYRACUSE NY
ONONDAGA 13202-2923

 ________________________________
(Authorizing Signature)

NOTE:  THIS CERTIFICATE IS THE PROPERTY OF THE ISSUING AGENCY AND IS TO BE RETURNED
TO THE ISSUING AGENCY WHEN CERTIFICATION IS TERMINATED.

F/A Home Certificate  
Onondaga County DSS

Certificate to Board Children

RESOURCE ID EFFECTIVE DATE EXPIRATION DATE
20000575 4/26/2001 4/26/2002

ISSUED TO RELIGION
Angela Jarret Protestant
Marty Jarret

ADDRESS
130 OAK ST

SYRACUSE    NY
ONONDAGA 13202

 This is to certify that the above named is regarded as maintaining a suitable home at the above address only for the care of children at board and

hereby authorized to care at board 4 boys between the ages of 1 Years 0 Months and 18 Years 0 Months and/or 4 girls between the ages of 1

 years 0 Months and 18 Years 0 Months with a maximum capacity of 4 children.

CERT AGENCY
RESOURCE ID WORKER ID AGENCY NAME AND ADDRESS
20000440 15051 Onondaga County DSS

421 MONTGOMERY ST
FL 8
SYRACUSE NY
ONONDAGA 13202-2923

NOTE:  THIS CERTIFICATE IS THE PROPERTY OF THE ISSUING AGENCY AND IS TO BE RETURNED
TO THE ISSUING AGENCY WHEN CERTIFICATION IS TERMINATED.
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Appendix F: 
Historical Certificates and Approval Letters
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Historical Approval Letter 
Onondaga County DSS

Approval to Board Children

RESOURCE ID EFFECTIVE DATE EXPIRATION DATE
20000742 1/16/1999 1/16/2000

ISSUED TO RELIGION
Barbara Holmes Catholic

ADDRESS
162 HOPE AVE

SYRACUSE    NY
ONONDAGA 13205

This is to certify that the above named is regarded as maintaining a suitable home at the above address only for the care of children at board and is

hereby authorized to care at board 2 boys between the ages of 3 Years 0 Months and 3 Years 0 Months and/or 2 girls between the ages of 1 years 0

  Months and 8 Years 0 Months with a maximum capacity of 2 children.

This foster home has been granted exception(s) to the following boarding home rules:

CERT AGENCY
RESOURCE ID WORKER ID AGENCY NAME AND ADDRESS
20000440 15051 Onondaga County DSS

421 MONTGOMERY ST
THE INFORMATION CONTAINED FL 8
ON THIS APPROVAL WAS SYRACUSE NY
VALID THROUGH: 4/25/1999 ONONDAGA 13202-2923
 

_________________________
(Authorizing Signature)

NOTE:  THIS CERTIFICATE IS THE PROPERTY OF THE ISSUING AGENCY AND IS TO BE RETURNED
TO THE ISSUING AGENCY WHEN CERTIFICATION IS TERMINATED.

Historical F/A Home Certificate 
Onondaga County DSS

Certificate to Board Children

RESOURCE ID EFFECTIVE DATE EXPIRATION DATE
20000575 4/26/1999 4/26/2000

ISSUED TO RELIGION
Angela Jarret Protestant
Marty Jarret

ADDRESS
130 OAK ST

SYRACUSE    NY
ONONDAGA 13202

This is to certify that the above named is regarded as maintaining a suitable home at the above address only for the care of children at board and is

 hereby authorized to care at board 4 boys between the ages of 1 Years 0 Months and 18 Years 0 Months and/or 4 girls between the ages of 1 years

 0 Months and 18 Years 0 Months with a maximum capacity of 4 children.

CERT AGENCY
RESOURCE ID WORKER ID AGENCY NAME AND ADDRESS
20000440 15051 Onondaga County DSS

421 MONTGOMERY ST
THE INFORMATION CONTAINED FL 8
ON THIS CERTIFICATE WAS SYRACUSE NY
VALID THROUGH:  8/13/1999 ONONDAGA 13202-2923

NOTE:  THIS CERTIFICATE IS THE PROPERTY OF THE ISSUING AGENCY AND IS TO BE RETURNED
TO THE ISSUING AGENCY WHEN CERTIFICATION IS TERMINATED.
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Table of Home Closures with Citations 
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Reason for Home Closure Foster Home Status Citation 

The prospective or certified/approved 
foster parent chooses to discontinue the 
application process due to personal 
reasons (Voluntary Closure). 

All Types ‡
Inquiry 

Applicant 
18 NYCRR 

Part 443 

Information recorded on medical forms 
results in the denial of the home for Home 
Study. 

All Types ‡
Applicant 

Emergency 

18 NYCRR 
§443.2(b) 

(18) 

Full Home Study reveals that the home 
does not comply with standards set by 
OCFS. 

All Types ‡
Applicant 

Emergency 

18 NYCRR 
§443.7(i) 

18 NYCRR 
§443.2(c) 

Information received from SCR Database 
Check results in denial of full Certification 
or Approval of the home. 

All Types ‡
Inquiry 

Applicant 

18 NYCRR 
§443.2(b) 

(9) 

Information received from the Criminal 
History Record Check (CHRC) results in 
denial of full Certification or Approval. 

All Types ‡ Applicant 

18 NYCRR 
§443.8 

18 NYCRR 
§443.2(c)(7) 

Application Expires (at 6 months). 

Certified Foster 
Homes 

Approved Relative 
Foster Homes 

Inquiry 18 NYCRR 
§443.2(c)(6) 

Non-renewal of Certification or Approval 
during the Re-approval or Re-certification 
process due to one the following: 

• lack of need for the Foster Home; 
• failure to meet one or more of the 

criteria for certification or approval 
as set forth in Part 443; 

• the Authorizing Agency determines 
that the home no longer meets the 
child’s needs. 

All Types ‡
Accepted-Active 

Emergency 
18 NYCRR 

§443.11 

“Search & Retain” function reveals criminal 
activity by one or both foster parents 

 

Certified Foster 
Homes 

Approved Relative 
Foster Homes 

Accepted-Active 00 OCFS 
ADM-04 
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Reason for Home Closure Foster Home Status Citation 

Revocation of Certification or Approval 
(can occur at any time during the 
certification or approval period), due to one 
of the following: 

• lack of need for the foster home; 
• failure to meet one or more of the 

criteria for certification or approval 
set forth in Part 443; 

• the Authorizing Agency determines 
that the home no longer meets the 
child’s needs; 

• the outcome of a Child Protective 
Services investigation into a report 
or abuse or maltreatment requires 
that the home be closed. 

Certified Foster 
Homes 

Approved Relative 
Foster Homes 

Accepted-Active 18 NYCRR 
§443.11 

Finalization of an Adoption. 

Certified Foster 
Homes 

Approved Relative 
Foster Homes 

Accepted-Active 
18 NYCRR 

§426  

 

Agency Closing. All Types ‡ Any status 18 NYCRR 
(B1) Article 6  

† This table does not represent a complete listing of possible home closures. 

‡ “All Types” refers to: 
• Certified Foster Homes (including Foster/Adoptive Homes) 
• Approved Relative Foster Homes 
• Emergency Certified Foster Homes 
• Emergency Approved Relative Foster Homes 
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Basic FAD Practice Exercises
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Practice Exercise 1: 
Search for a FAD Home 

Description 

You have received an inquiry from a prospective foster parent. Your first step in recording this 
inquiry in CONNECTIONS is to conduct a search to determine whether the foster home already 
exists in the database. 

The following exercise takes you through the necessary steps in CONNECTIONS for 
conducting an F/A Home Search and viewing the search results.  

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the F/A Home 
Search window. 

CONNECTIONS Toolbar Options menu. 
F/A Home command. 
F/A Home Search… 
command (sub-menu) 

2 Conduct a thorough 
search for the 
prospective foster home, 
using the name on your 
color index cards. 

F/A Home Search Home Name field 
(Last,First) 
Clear the Agency ID field 
to search statewide. 
Search button. 

3 Review the search 
results. 

F/A Home List Review the list to 
determine if the home for 
which you searched 
exists in CONNECTIONS. 
If no matches are found, 
the following message 
displays at the bottom of 
the F/A Home List: 
“The criteria entered 
results in no information 
being returned.” 

Leave the F/A Home List open for the next exercise. 
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Practice Exercise 2: 
Create a Foster Home in CONNECTIONS 

Description 

You have completed a thorough statewide search in CONNECTIONS for the prospective foster 
home. After reviewing the search results, you determine that the home does not already exist in 
the system. You are ready to record the inquiry by creating the home in CONNECTIONS. 

The following exercise takes you thorough the necessary steps in CONNECTIONS for creating 
a new foster home. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to the perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the Home 
Demographics window 

F/A Home List New… button 

2 Complete all recordable 
fields in the Home 
Demographics window 

Home Demographics Window Setting field 
(select Foster Home) 
Race field 
Ethnicity field 
Hispanic or Latino 
Origin field (if applicable) 
Religion field 
Marital field 
Inquiry source 
Language field 
Respite field 
(select Not Accepted) 

3 Record the primary 
address for the home: 
 
Upstate & LI Classes: 
1110 Route 7  
Latham, NY  12110 
 
NYC Classes: 
1110 Broadway 
New York, NY  10010 

Home Demographics Street field 
City field 
Zip field 
County field 
Select Albany 
 (Upstate & LI classes)
 or 
 Manhattan 
 (NYC Classes) 

Continued on next page 
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Where in Task Tips CONNECTIONS 
4 Record that the business 

address is identical to the 
primary address. 

Home Demographics Use as Business check 
box. 

5 Validate the address. Home Demographics Validate button. 
Yes button. 

6 Record the primary 
phone number for the 
home. 

Home Demographics Primary Phone Number 
field. 

7 Save and Assign the new 
foster home. 

Home Demographics Save and Assign button. 

8 Assign the new foster 
home to yourself. 

Assign window Verify that “your” Darryl 
Wilson is listed in the 
Assignments section in 
the lower half of the 
window. 
Save button. 

9 Open the Assigned 
Workload and verify that 
the newly created home 
is assigned to you. 

CONNECTIONS Toolbar WORK button. 
Verify that the FAD stage 
you just created displays 
on your workload. 

10 Close the Assigned 
Workload. 

Assigned Workload. Close button. 
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Practice Exercise 3: 
Generate and View the FAD Fingerprints Requirement Letter 

Description 

One of your responsibilities as a foster care caseworker is to notify the prospective foster 
parents that they and all individuals age 18 and older who reside in the foster home need to be 
fingerprinted. You need to generate the FAD Fingerprints Requirement Letter to be sent to the 
foster parents to provide this notification. 

The following exercise takes you through the necessary steps in CONNECTIONS for generating 
the FAD Fingerprints Requirement Letter. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the Assigned 
Workload. 

CONNECTIONS Toolbar WORK button 

2 Open the Task List for 
the home you created in 
Practice Exercise #2. 

Assigned Workload Click to select 
Tasks… button 

3 Open the Person List. Task List Maintain Person task 
List… button 

4 Generate the FAD 
Fingerprints Requirement 
Letter. 

Person List Reports menu 
FAD Fingerprint Req. 
Ltr. (E) [English] or FAD 
Fingerprint Req. Ltr. (S) 
[Spanish] command.  
Note the message that 
displays: “The Report has 
been launched. Check the 
Report List window.” 
OK button. 

5 Open the Report List. CONNECTIONS Toolbar RPRTS button 

6 Open the letter. Report List Click to select the letter 
Open button 
Continued on next page 
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Where in Task Tips CONNECTIONS 
7 View the letter, then 

close the document. 
FAD Fingerprints Requirement 

Letter (Microsoft Word 
document) 

Printing will not be done in 
this class.  
To print, click on the File 
menu and select the 
Print… command. 
File menu 
Close command 

8 Close the Report List. Report List Close button 

9 Close the Person List. Person List Close button 

10 Close the Task List. Task List Close button 

11 Close the Assigned 
Workload. 

Assigned Workload Close button. 
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Practice Exercise 4: 
Add People to the Foster Home 

Description 

You have completed the recording of the inquiry and created the foster home in 
CONNECTIONS. You need to add all of the individuals who live in the home (with the exception 
of foster children under the age of 18) to the FAD home record in CONNECTIONS. 

The following exercise takes you through the necessary steps in CONNECTIONS for adding a 
person to a FAD home. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the Assigned 
Workload. 

CONNECTIONS Toolbar WORK button 

2 Open the Task List for 
the home you created in 
Practice Exercise #2. 

Assigned Workload Click to select 
Tasks… button 

3 Open the Person List. Task List Maintain Person task 
List… button 

4 Add a person to the 
home. 

Person List New… button 

5 Using the first name on 
your color index card, 
conduct a thorough 
Phonetic Name person 
search to determine 
whether the person is 
known to 
CONNECTIONS. 

Person Search window First and Last Name 
fields. 
Search button 

6 Add the person to the 
FAD home. 

Person Search window New button 

Continued on next page 
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Where in Task Tips CONNECTIONS 
7 Record person 

demographics 
information. 

Person Detail window Sex field 
Ethnicity field 
Race field 
Hispanic or Latino 
Origin field (if applicable) 
Marital field 
DOB field 
Religion field 

8 Record the person’s role 
in the foster home. 

Person Detail window Rel/Int field 
(select Foster Parent) 

9 Save the person 
information. 

Person Detail window Save button 

10 Repeat steps 4-9 for the 
next person on your 
index card. 

 

Leave the Person List open for the next exercise. 
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Practice Exercise 5: 
Record Person Detail FA Home Information 

Description 

The next step in the process of recording complete person information is to record the medical 
exam date and the date on which the fingerprint card was sent for each person age 18 and 
older in the foster home. This information is recorded in the Person Detail FA window. 

The following exercise takes you through the necessary steps in CONNECTIONS for recording 
information in the Person Detail FA window. Follow the numbered tasks below. Look in the Tips 
column for help. The Where in CONNECTIONS column indicates which window you should be 
using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the Person Detail 
F/A window. 

Person List Options menu 
Person Detail FA Home 
command 

2 Record information in the 
Birth Location, General 
Info., Fingerprint 
Information and Foster 
Parent sections of the 
window for the first foster 
parent. 

Person Detail FA window Date Card Sent field  
(enter today’s date) 
Date Results Received 
field (for training purposes 
only, enter today’s date.) 
Medical Exam Date field 
(enter today’s date) 

3 Save the information. Person Detail FA window Save button 

4 Repeat steps 2 and 3 for 
the second foster parent. 

 

Leave the Person List open (with the first person’s name selected)  
for the next exercise. 
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Practice Exercise 6: 
Record Foster Parent Training Information 

Description 

The next step in the process of recording complete person information is to record information 
regarding all training each foster parent has completed. 

The following exercise takes you through the necessary steps in CONNECTIONS for recording 
training information in the F/A Home Member Training window. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the F/A Home 
Member Training 
window. 

Person List Options menu 
Home Member Training 
List/Detail command 

2 Record that the first 
foster parent attended an 
orientation session. 

F/A Home Member Training Date field  
(enter yesterday’s date) 
Title field  
(enter “Nurturing Children 
in Foster Care”) 
Type field  
(select Orientation) 
Session field (enter “1”) 
Hours field (enter “3”) 

3 Add the information to 
the list section at the top 
of the window. 

F/A Home Member Training Add button 

4 Save the information. F/A Home Member Training Save button 

5 Repeat steps 2-4 for the 
second foster parent. 

 

Leave the Person List open (with the first person’s name selected) 
for the next exercise. 
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Practice Exercise 7: 
Record Aliases (A.K.A. Names) 

Description 

The foster mother you have recorded for your FAD home is also known by her maiden name, 
Williams; she uses her married name as her legal name. You want to record the alias in 
CONNECTIONS. 

The following exercise takes you through the necessary steps in CONNECTIONS for recording 
A.K.A. names. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the A.K.A. Name 
List/Detail window. 

Person List Options menu 
A.K.A. Name List/Detail 
command 

2 Record the foster 
mother’s alias as a non-
primary name, then add it 
to the list section at the 
top of the window. 

A.K.A. Name List/Detail First and Last name 
fields 
Do not select the Primary 
check box. 
Add button 

3 Save the information. A.K.A. Name List/Detail Save button 

4 Close the Person List. Person List Close button 

5 Close the Task List. Task List Close button 
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Practice Exercise 8: 
Progress the Home to Applicant Status 
and Record the Vendor ID 

Description 

You have recorded in CONNECTIONS all of the demographic, training and other required 
information that you gathered during the inquiry phase of the home certification or approval 
process. After a careful review of all of the information, the foster home has been accepted for 
Home Study. Your next step in the development of this foster home is to advance the home to 
Applicant status. In addition, once the home has progressed to Applicant status, you will record 
the Vendor ID (VID) for the foster home. 

The following exercise takes you through the necessary steps in CONNECTIONS for 
progressing a home to Applicant status and recording the Vendor ID. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Select the FAD home 
that needs to be 
progressed and open the 
Task List. 

Assigned Workload Click to select 
Tasks… button 

2 Open the F/A Home 
License window. 

Task List Maintain Licensing 
Information task 
New button 

3 Record the Facility Type 
and Program Type for the 
FAD home. 

F/A Home License window Facility Type field 
(Select Foster/Adoptive 
Home) 
Program Type field 
(Select Regular) 
From date field 
(Enter today’s date) 

New York City classes: Record age ranges and capacity for the home. 

4 Progress the home to 
Applicant status and save 
your changes. 

F/A Home License window Status field 
Select Applicant 
Save button 

5 Open the Home 
Demographics window. 

Task List Maintain Non-Licensing 
Information task 
Detail…button 
Continued on next page 
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Where in Task Tips CONNECTIONS 
6 Record the second 

Vendor ID from your 
color index card. 

Home Demographics window Vendor ID field 
Validate button 
Note the address 
validation message. 
Yes button 

7 Save the changes. Home Demographics window Save button 

Leave the Task List open for the next exercise. 
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Practice Exercise 8a: 
Vacancy Control/Bed Maintenance 
(NYC Only) 

Description 

Now that you have created a new FAD home in CONNECTIONS, you need to record the bed 
information for the home. This information enables workers to search for available beds for 
children in need of placement. 

The following exercise takes you through the necessary steps in CONNECTIONS for creating a 
bed in the FAD home. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Select the FAD home 
that you created in 
Practice Exercise #2 
open the Task List. 

Assigned Workload Click to select 
Tasks… button 

2 Open the Vacancy 
Control Bed Maintenance 
window. 

Task List Vacancy Control Bed 
Maintenance task 
Detail… button 

3 Add a bed, record its 
characteristics and save 
the information. 

Vacancy Control Bed 
Maintenance 

Add Beds button 
Status field 
(Select Vacant) 
Male/Female Min/Max 
Age fields 
Bed Location field 
Physical field 
Learning field 
Emotional field 
Behavioral field 
HIV field 
Save button 
The following message 
displays: “Changes have 
been saved.” 
OK button 
Continued on next page 
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Where in Task Tips CONNECTIONS 
4 Close the Vacancy 

Control Bed Maintenance 
window. 

Vacancy Control Bed 
Maintenance window 

Close button. 

5 Close the Task List. Task List Close button. 
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Practice Exercise 9: 
Record the Home Study, Maintain Licensing Information 
and Submit the Home for Supervisory Approval 

Description 

With the completion of the previous exercises, you are now ready to record the home study and 
to complete the licensing information, after which you will be ready to submit the prospective 
foster home to your supervisor for approval. 

The following exercise takes you through the necessary steps in CONNECTIONS for recording 
the home study, maintaining licensing information and submitting the home to your supervisor 
for approval. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Open the FAD Record 
Summary to access the 
home study. 

Task List Home Study task 
New button 

2 Open and record the 
home study narrative. 

Foster and Adoptive Home 
Record Summary (FRS) 

Home Study Narrative 
tab 
Initial Home Study check 
box 
Save button  
(The following message 
displays: “Changes have 
been saved.”) 
OK button 
Standard Home Study 
radio button 
Retrieve/Edit Narrative 
button 
Record information in the 
home study narrative 
(Microsoft Word 
document). 
Continued on next page 
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Where in Task Tips CONNECTIONS 
3 Close the home study 

document. 
Home Study Narrative 

(Microsoft Word document) 
File Menu 
Close command 
(The following message 
displays: “Save 
changes?”) 
Yes button 

4 Submit the Home Study. Foster and Adoptive Home 
Record Summary (FRS) 

Submit button 

5 Record the approved age 
ranges and capacity for 
the home, progress the 
home to Pending 
Acceptance status, then 
Save and Submit for 
supervisory approval. 
NYC: Age range and 
capacity recorded in 
Practice Exercise #8. 

F/A Home License Min Year, Month, Max 
Year, and Month fields  
(both male and female, as 
applicable) 
Capacity field 
Status field 
Select Pending 
Acceptance 
File menu 
Save and Submit 
command 

6 Send the resulting Task 
To-Do to your supervisor. 

To-Do Detail Enter comments, if 
desired, in the 
Description/Notes field 
Save button 

7 Close the Task List. Task List Close button 

8 Close the Assigned 
Workload. 

Assigned Workload Close button 
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Practice Exercise 10: 
Maintenance Exercise  
(Remove Person – Left Home) 

Description 

The second individual you added in your Review Practice Exercises has left the FAD Home due 
to divorce. Since this individual’s former occupancy in the home needs to remain part of the 
FAD home’s historical record in CONNECTIONS, use the Remove Person – Left Home function 
to record that person’s departure. 

The following exercise takes you through the necessary steps in CONNECTIONS for removing 
a person from a FAD home when that individual no longer lives in the home. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Select the FAD home 
that you created in your 
Review Practice 
Exercises open the Task 
List. 

Assigned Workload Click to select 
Tasks… button 

2 Open the Person List. Task List Maintain Person task 
List… button 

3 Select the person and 
perform the removal 
function. 

Person List Click to select 
Options menu 
Remove Person – Left 
Home command 
The following message 
displays: “Are you sure 
you want to Remove 
Person – Left Home?” 
Yes button. 

4 Close the Person List. Person List Close button. 

5 Close the Task List. Task List Close button. 
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Practice Exercise 11: 
Close a Foster Home 

Description 

The foster home you created has been approved by your supervisor and is now in Accepted-
Active status. All necessary information has been received and recorded in CONNECTIONS. 
The home is ready to accept foster children. A few days later, the prospective foster mother 
contacts you and states that she will not be able to provide foster care services, since her father 
recently developed a serious illness and she needs to care for him. You need to close the foster 
home. 

The following exercise takes you through the necessary steps in CONNECTIONS for closing a 
foster home. 

Follow the numbered tasks below. Look in the Tips column for help. The Where in 
CONNECTIONS column indicates which window you should be using to perform the task. 

Task Chart 

Task Where in 
CONNECTIONS Tips 

1 Select the home to be 
closed, then open the 
Task List. 

Assigned Workload Click to select 
Tasks… button 

2 Open the Close Home 
window. 

Task List Close Home task 
New button 

3 Record the home closure 
information. 

Close Home Closure Reason field 
(Select Family 
Illness/Health Problems) 
Closure Type field 
(Select Voluntary Closure)
Recommend Re-
Opening field  
(Select Recommend) 
Date Notification Sent 
field  
(enter a date reflecting 20 
days ago) 

4 Complete the closure 
report. 

Close Home Closure Report button 
Record information in the 
resulting MS Work 
document 
File menu 
Close command 
Continued on next page 
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Where in Task Tips CONNECTIONS 
5 Save the information and 

submit the home closure 
to your supervisor for 
approval. 

Close Home Save and Submit button 
(The following message 
displays: “Have you 
completed the Closing 
Summary Report?”) 
Yes button 

6 Send the Task To-Do for 
the home closure 
approval to your 
supervisor. 

To-Do Detail Enter comments, if 
desired, in the 
Description/Notes field. 
Save button 

7 Close the Task List. Task List Close button 

8 Close the Assigned 
Workload. 

Assigned Workload Close button 
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Appendix I: 
Security Awareness Materials 
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Appendix J: 
Defining Mild, Moderate And Severe Child 

Characteristics For Vacancy Control Maintenance 
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Introduction 
In an effort to achieve maximum efficient vacancy utilization in the Vacancy Control 
System (in CONNECTIONS), the Office of Placement Administration (OPA) is providing 
definitions of the terms, Mild (1), Moderate (2) and Severe (3) as applied to child and 
bed characteristics. OPA has defined the terms listed below, and illustrated them with 
specific examples of the applicability of the terms to child and bed characteristics. In 
addition, there is a list of “Additional” definitions that may be helpful in maintaining the 
Vacancy Control System. 

Definitions 

The definitions of Mild (1), Moderate (2) and Severe (3) as applies to Behavior, 
Emotional, Physical and Learning characteristics, have varying degrees of subjectivity, 
from the perspective of both the OPA placement worker and the foster care agency 
Intake Coordinator. There are, however, certain guidelines to provide some uniformity of 
definition:  

• “0”- usually applies to characteristics that present no known condition or problem; 
or, child and bed characteristics may be left blank. 

• Mild - usually applies to characteristics that present a minor condition or problem 
that does not significantly affect functioning. Mild is represented by the  
Number 1. 

• Moderate - usually applies to characteristics that present a condition or problem 
that may affect functioning and that may require specialized services or 
treatment. Moderate is represented by the Number 2. 

• Severe - usually applies to characteristics that present a serious condition or 
problem that significantly affects functioning and that requires intensive services 
or treatment. Severe is represented by the Number 3. 
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Specific Examples 

Following, are some examples of Mild, Moderate and Severe characteristics to illustrate the 
definitions: 
Behavior: Frustration 
1. Mild  - Easily frustrated, but remains under control 
2. Moderate - Loses temper easily, but exhibits no violent behavior  
3. Severe - Loses temper and loses control, causing harm to self, others or property 
Emotional: Bed Wetting 
1. Mild - Occasional bed wetting 
2. Moderate - Some bed wetting that may require some treatment 
3. Severe - Frequent bed wetting that requires special treatment 
Physical: Newborn (Substance Abuse) 
1. Mild - Evidence of substance abuse during pregnancy- no sign of any delay at this 

time 
2. Moderate - Evidence of substance abuse during pregnancy- some indication of delay 
3. Severe - Evidence of substance abuse during pregnancy, significant physical and 

developmental delays; fetal alcohol syndrome 
Learning: School Achievement 
1. Mild - Minor difficulty in maintaining grades 
2. Moderate - Some learning problems - 2 levels below age group in reading and math  
3. Severe - Major learning problems requiring intensive educational testing and 

services 
Additional Definitions 
In addition to the definitions described above, there are two characteristics that require 
explanation:  

• To describe a child’s HIV status, the indication is “YES” / “ NO.”  
• To describe the range of intelligence for a child, the following levels apply: 

Average Intelligence- 90-109> 
Borderline Retardation- 70-89 (70 
and above is within the normal range)
Mild Retardation- 55-69 
Moderate Retardation- 40-54 
Severe Retardation- 25-39 
Profound Retardation - 0-24 
Un-testable- <0  
 

* Mild - Capable of developing social and verbal 
skills up to a 6th grade level and sufficient for 
self-support 
* Moderate - Capable of some communication 
and learning vocational skills; difficulty with 
social functioning 
* Severe - Poor motor and verbal skills; some 
limited ability to perform supervised work 
* Profound - Requires constant care, structured 
environment; limited self-care 
* Un-testable - Requires constant care and 
supervision; unlikely to acquire self-care skills. 
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Appendix K: 
Criminal History Record Checks  

(Fingerprint Card and Waiver) 
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03 OCFS INF -01 introduced a revised fingerprint card and associated directions applicable to 
applicants to be certified or approved as foster or adoptive parents and persons over the age of 18 who 
reside with such applicants. Furthermore, this INF introduced a new form and procedure designed to 
eliminate submission of fingerprint cards for the purpose of obtaining a criminal history record check for 
those persons previously fingerprinted for one of the following purposes: applicants for certification or 
approval as a foster or adoptive parent; applicants for day care center and/or group family day care 
licensure, employment or volunteer; family day care and/or school age child care registrations, 
employment or volunteer; household members over the age of eighteen of applicants who would 
otherwise be required to submit a fingerprint card.  

The card was been simplified to specifically include only those fields that apply to foster care/adoption.  
A replacement chart is attached to this INF with complete directions for each field. This chart replaces 
Attachment 2 in 00 OCFS ADM-04. Of particular note are two new fields on the card. These are the 
CONNECTIONS Home Resource ID# and the CONNECTIONS Person ID#. These fields are required 
entry for all districts and agencies that certify/approve foster and/or adoptive homes on 
CONNECTIONS. It should be noted that this will require homes to be entered through save and assign 
of “Inquiry”, and persons entered in these homes on the CONNECTIONS Person List/Detail window, in 
order to obtain these system generated ID numbers. These fields should be left blank for New York 
State adoption agencies not serving publicly funded foster children and for out-of-state adoption 
agencies. Districts and agencies should assess their current procedures to determine the sequencing 
of these activities, and procedures should be adjusted so that fingerprint cards given to applicants and 
those household members over the age of 18 have these fields already completed by the district or 
agency. 

Please note, disclosure by the applicant or household member of his or her Social Security Number 
(SSN) is voluntary, and not mandatory. SSN’s will be utilized to assist DCJS staff in performing criminal 
history record checks. These facts should be made known to all persons who are required to be 
fingerprinted.  

New Waiver Form 

For each new applicant for foster care or adoption, districts and agencies should ask whether the 
applicant or those household members over the age of 18 have ever been previously fingerprinted for 
any one of the following: 

• certification or approval as a foster parent or adoptive parent 
• day care / child care employment / volunteer 
• day care child care registration 
• day care licensure 
• household member over the age of 18 in any applicable category above. 

If they have, the Waiver form should be used in lieu of requiring re-fingerprinting. Each applicant and 
household member over the age of 18 must complete and sign a separate waiver form and the district 
or agency must complete the fields so designated for them as follows: 

• New Facility/Provider/Agency ID # (item 12) 
• CONNECTIONS Resource ID # (item 13) 
• CONNECTIONS Person ID # (item 14) 
• New Facility/Provider/Agency Name and Address (item 15). 
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In addition, districts and agencies must review and verify one form of identification listed on the Waiver, 
and complete the shaded gray fields pertaining to the identification used and attest to that by signing 
the form. (See Attachment 1 for completion instructions.) 

OCFS, in conjunction with DCJS, has established a policy regarding closed homes, “search and retain” 
and the timing of expungement of fingerprints from the DCJS database in order to allow the waiver 
process to successfully achieve the expected results. As long as a foster or adoptive home remains 
open with your district or agency, any new arrests reported for anyone in those homes who had been 
previously fingerprinted will be sent to the certifying/approving district or agency in the usual manner.  
When a home is closed in CONNECTIONS, or for New York State adoption agencies not serving 
publicly funded foster children and out-of-state adoption agencies, when the Notification of Adoption 
Finalization is submitted to the Fingerprint Unit, any new arrest notices sent by DCJS to OCFS will not 
be sent to the district or agency that closed the home. Such information will be retained by OCFS; 
however, it should be noted there is a built-in lag time before CONNECTIONS closings become 
available to the Fingerprint Unit. This is to allow for system closings that quickly reopen. Therefore, it is 
possible that a subsequent arrest notice could be sent out during this brief interim period.   

Although fingerprint card expungement requests continue to go from OCFS to DCJS annually as the 
law requires, with regard to foster and adoptive home members, these requests will only be made 
under the following circumstances: 

• such person is associated with a closed foster/adoptive home; and,  
• such person is not associated with any other open foster/adoptive home in any other district or 

agency; and, 
• if such person had been active in day care/child care, he or she has been closed by the day 

care/ child care process either through enforcement or voluntarily (all associations); and, 
• the most recent closing has been in effect for three years.  

Ultimately, an indicator will exist in CONNECTIONS to designate when expungement has occurred.  
You will be advised when that functionality is supported. If a Waiver form is used and the fingerprints 
have been expunged, the district or agency will be notified that new fingerprints must be submitted. 
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Attachment 1 

Waiver for Submission of a Duplicate Fingerprinting Card 

Instructions for Completion 

 

This form is designed to eliminate the need to submit new fingerprint cards to the New York State 
Office of Children and Family Services (NYS OCFS) for the purpose of obtaining a criminal history 
background check for applicants for day care center/group family day care licenses, employment or 
volunteers; family day care/school age child care registrations, employment or volunteers; and for 
applicants for certification or approval as a foster or adoptive parent. This form is also used for 
household members over the age of eighteen (18) of applicants who would otherwise be required to 
submit a fingerprint card. This form only applies to individuals who have been previously fingerprinted 
for the purposes described above. 

INSTRUCTIONS 

PLEASE COMPLETE ALL ITEMS ON FORM  - LEAVE AREAS BELOW SHADED HEADINGS BLANK 

1. Enter applicant’s or household member’s Last Name 

2. Enter applicant’s or household member’s First Name 

3. Enter applicant’s or household member’s Middle Initial 

4. Enter ‘M’ for Male or ‘F’ for Female 

5. Enter applicant’s or household member’s Date of Birth  (mm/dd/yyyy) 

6. Enter applicant’s or household member’s CURRENT Street Address 

7. Enter applicant’s or household member’s Social Security Number (SSN)  

[Disclosure of SSN is voluntary, and not mandatory.  SSN will be used to assist DCJS staff in 
performing criminal history record checks.] 

8. Enter applicant’s or household member’s CURRENT city and state for above address  

9. Enter applicant’s or household member’s Zip Code 

10. Alias and/or Maiden Name – Enter any alias or maiden name. Enter any applicable complete name 
in which the given and/or surname is different than those entered on items 1 thru 3. 

11. Check here if this is a new address – The address given in items 6 & 8 is different from address 
when previously fingerprinted 

12. New Facility/Provider/Agency ID # - The ID # is the license number of the day care facility or 
provider, or the authorized agency ID # to which you are now applying. 

13. FOR FOSTER/ADOPTIVE APPLICANTS AND/OR HOUSEHOLD MEMBERS ONLY: Enter 
Resource ID# of the home as it appears on CONNECTIONS. [NYS adoption agencies not serving 
publicly funded foster children and out-of-state adoption agencies leave this field blank.] 

14. FOR FOSTER/ADOPTIVE APPLICANTS AND/OR HOUSEHOLD MEMBERS ONLY: Enter the ID# 
of the person (listed in fields 1-3) as it appears on CONNECTIONS. [NYS adoption agencies not 
serving publicly funded foster children and out-of-state adoption agencies leave this field blank.] 
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15. New Facility/Provider/Agency name and address – The address of the day care facility or provider, 
or authorized agency to which you are now applying. 

16. Additional Information – Current Role – Check the box that corresponds with the role for which you 
are currently applying. 

17. Have you previously been fingerprinted for Day Care, Foster Care or Adoption purposes through:  

The NYS Office of Children and Family Services (OCFS); or  

By a local social services district or voluntary authorized agency? 

Check ‘Yes’ ONLY if you have been previously fingerprinted by one or more of these organizations.  If 
you check “No”, this form does not apply to you.  A fingerprint card will be required. 

18. Previous Facility/Provider/Agency – Enter Facility/Provider/Agency ID # for all locations with which 
you have previously been affiliated, where you were required to submit a fingerprint card to NYS OCFS 
in relation to day care, foster care or adoption. 

19. Previous Address – Address at which you resided when you were previously fingerprinted 

  (If different from address in box #8) 

20. This form must be signed and dated by applicant or household member. 

This form will only be accepted when fully completed according to the instructions listed above, and 
authorized by the foster or adoptive agency / social services district representative or by the Bureau of 
Early Childhood Services day care licensing representative. Upon completion, this form should be 
submitted, in lieu of an additional fingerprint card, to the OCFS Criminal History Review Unit, P.O. Box 
839, Rensselaer, NY 12144. 
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Attachment 2 
(rev. 11/02) 

Directions for Completing the Fingerprint Card 

The table below lists the elements on the fingerprint card and directions for completion.  Shaded 
rows must be completed by the authorized agency.  All other rows can be completed by the 
person who is to be fingerprinted, except field 28. 

Field No. Element Directions 

1. Name Complete last, first and middle name 

2. Street Address Enter residence house number and street 

3. Apt/Bldg# Enter apartment and/or building number 

4. City Enter city  

5.  State Enter state 

6. Zip  Enter ZIP code 

7. Alias or Maiden Name Enter any other name person may be known as 

8.  Sex Enter M or F 

9. Race See codes on back of card 

10. Ethnicity See codes on back of card 

11. Skin See codes on back of card 

12. Hair See codes on back of card 

13. Eyes See codes on back of card 

14. Weight Enter weight 

15.  Height Enter height in feet and inches 

16. Date of Birth Enter month, day and year of birth 

17. Age Enter age 

18. Place of Birth (State or 
County) 

Enter State, if not New York; otherwise enter 
County 

19. Contributor Prefilled 

20. Agency ID No. Enter 3 character Agency code followed by an 
individual identifier assigned by the authorized 
agency  [maximum field size is 8 characters in 
total] 
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Field No. Element Directions 

21. Social Security Number Enter social security number [Disclosure of SSN 
is voluntary, and not mandatory.  SSN will be 
used to assist Division of Criminal Justice 
Services staff in performing criminal history 
record checks.] 

 

22. Date Fingerprinted Enter the month, day, and year the fingerprints 
were taken 

23.* REASON 
FINGERPRINTED (Check 
One) 

Check one code for this referral using the 
following categories: 

foster parent [FP]; 

relative foster parent [RFP]; 

adoptive parent [AP];  

household member of foster parent over 18 
[FHM]; 

household member of relative foster parent over 
18 [RHM]; 

household member of adoptive parent over 18 
[AHM]; 

foster child over 18 [FC]   

24. CONNECTIONS Home 
Resource ID# 

NYS local social services districts and voluntary 
authorized agencies - Home must be entered on 
CONNECTIONS to obtain the Home Resource 
ID#.  It will be system generated when Inquiry is 
saved and assigned.    

NYS adoption agencies not serving publicly 
funded foster children and out-of-state adoption 
agencies leave this field blank. 

24a. CONNECTIONS Person 
ID# 

NYS local social services districts and voluntary 
authorized agencies - Home must be entered on 
CONNECTIONS and person must be associated 
with the home to obtain the Person ID#. It will be 
system generated when a home member is 
added or related to the FAD Person List.  

NYS adoption agencies not serving publicly 
funded foster children and out-of-state adoption 
agencies leave this field blank. 

25. License Type/Job Title Prefilled  
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Field No. Element Directions 

26. Signature of Person 
Fingerprinted  

This should be signed at the time of fingerprinting 

27. Authorized Foster or 
Adoption Agency – name 
and address 

Complete Agency name and full mailing address 

28. Signature of Person Taking 
Prints 

This should be signed at the time of fingerprinting 
by the person taking the prints 

   

*  Failure to complete this field will result in the fingerprint card being returned to the submitting 
agency. 
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